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    Preface

    IBM® Enterprise Content Management (ECM) solutions provide efficient and effective ways to capture content, manage the content and business processes, discover insights from the content, and derive actions to improve business processes, products, and services. 

    This IBM Redbooks® publication introduces and highlights some of the IBM ECM products that can be implemented and integrated together to create end-to-end ECM solutions:

    •IBM Case Manager

    •IBM Datacap

    •IBM Content Manager OnDemand

    •IBM Enterprise Records

    •IBM Watson™ Content Analytics

    •IBM Content Classification

    IBM Case Manager is the basic building block for the ECM solution built in this book. The ECM solution is a generic solution that handles customer requests and inquiries regarding products, services, and their accounts. 

    IBM Datacap is integrated into the ECM solution to provide document and image captures from scanning and mobile devices. Data is extracted from the captured content, and is used as additional case information. Optionally, this extracted data can be a starting point for new cases.

    IBM Content Manager OnDemand is used to archive a company’s computer-generated output. It is integrated into the ECM solution to provide quick retrieval of customers’ transaction information, which caseworkers need to determine how best to handle customers’ requests.

    IBM Enterprise Records is added into the ECM solution to provide a records management capability for selective case documents.

    IBM Watson Content Analytics is added into the ECM solution to provide content analysis of the historical case data, and to help business analysts gain insights, observe trends, and discover defects and issues in products and services.

    IBM Content Classification is added into the ECM solution to provide automated handling of web inquiries and questions submitted by customers through the company’s portal. Optionally, this automated process serves as a starting point for new cases on an as-needed basis.

    For each product involved in the ECM solution, this IBM Redbooks publication briefly describes what it is, its functions and capabilities, and provides step-by-step procedures for installing, configuring, and implementing it. In addition, we provide procedures for integrating these products together to create an end-to-end ECM solution to achieve the overall solution objectives. 

    Not all of the products are required to be integrated into an ECM solution. Depending on your business requirements, you can choose a subset of these products to be built into your ECM solutions.

    This book serves as a hands-on learning guide for information technology (IT) specialists who plan to build ECM solutions from end-to-end, for a proof of concept (PoC) environment, or for a proof of technology environment. For implementing a production-strength ECM solution, also refer to the following resources:

    •IBM Knowledge Center (http://www-01.ibm.com/support/knowledgecenter/)

    •IBM Redbooks publications (http://www.redbooks.ibm.com/)

    •IBM Software Services (http://www-01.ibm.com/software/sw-services/)

    Authors

    This book was produced by a team of specialists from around the world working at the IBM International Technical Support Organization (ITSO), Poughkeepsie Center.

    Wei-Dong Zhu is an Enterprise Content Management Project Leader and Solution Consultant with IBM ITSO and IBM Software Group (SWG) in the US. Jackie joined IBM in 1996, and has developed software and solutions in accounting, insurance, and digital media areas. She has also managed and led the production of numerous IBM Redbooks publications in the Enterprise Content Management area. Jackie holds a Master of Science degree in Computer Science from the University of Southern California.

    Ben Davies is an IBM Datacap Technical Specialist supporting document and imaging capture opportunities across Europe as a pre-sales subject matter expert (SME). He joined IBM as a graduate in 2007, and has worked on Imaging and Capture since the acquisition of Datacap, Inc. in 2010. He has built up a wealth of knowledge on the Datacap product, assisting clients and IBM Business Partners in both the UK and Europe. He was a co-author of the first IBM Redbooks publication related to Datacap, Implementing Imaging Solutions with IBM Production Imaging Edition and IBM Datacap Taskmaster Capture, SG24-7969. Ben holds a bachelor’s degree in Multimedia Computing from Liverpool John Moores University in the UK.

    Isuru Fernando (Izzy) is a Client Solutions Advisor with the IBM Australia and New Zealand Software Group. Isuru believes that data can change the way we understand and interact with each other, and much of the work he does at IBM is centered around helping organizations use IBM products and technology to transform crude data into actionable insights. Isuru has fifteen years of industry experience working in Software Development, Architecture, Software Strategy, and Product and Brand Management. Before this he was part of the Embedded Systems and Robotics research group at the University of Auckland. Isuru has a strong academic background with Undergraduate and Postgraduate degrees in Engineering, and is a published author in peer-reviewed journals.

    Blair Groff is the North American Content Manager OnDemand Solution Leader, and is an established SME. Blair joined the IBM SWG in 2006 after graduating from the University of Toronto with his Bachelor of Science degree in Computer Science. Blair is responsible for the pre-sales and post-sales support activities required to position and present the IBM ECM suite of products. He has authored enablement materials, including the Proof of Technology labs, implemented first-of-its-kind solutions, and aided in the creation of online documentation.

    Sven Hapke is a Senior IT Specialist acting as ECM Architect in Germany. He joined IBM in 1995, and has more than 15 years of experience in the field of ECM. In the ECM field, he worked as Client Technical Professional and was supporting SWG Services during project delivery, both as a programmer in the ECM space and as a solution architect. Currently, Sven acts as an ECM solution architect for bigger clients in Germany, and is the focal point for ECM cloud solutions in Germany, Austria, and Switzerland. He holds a diploma in Computer Science from the University of Bremen.

    Abraruddin Khan (Abrar) is an Advisory Software Engineer at IBM SWG. He has 10 years experience in the ECM field. Abrar has been involved in many areas of IBM FileNet® P8 software development, and has published several technical white papers. Abrar holds a Bachelor of Science degree in Computer Science and Engineering.

    Johnson Liu is a Software Engineer with IBM SWG in the United States for IBM Case Manager. Johnson developed IBM Case Manager Client for mobile and desktop, in addition to many early training workshops, white papers, and code samples. Johnson has expertise and supports clients in the areas of widget development, user interface, and solution deployment and conversion. Johnson has a Bachelor of Science degree from the University of California in Business Information Management.

    Josemina Magdalen is a Senior Team Leader and Principle Architect for the IBM Israel Software Group. Josemina has worked in Natural Languages Processing research and development (machine translation, text classification and search, and data mining) for over 24 years. Josemina joined IBM in 2005, and has worked in the ECM Engineering Group doing software development projects in text categorization, filtering and search, and text analytics. Josemina co-authored the Redbooks publications IBM Classification Module: Make It Work for You, SG24-7707 and IBM Watson Content Analytics: Discovering Actionable Insight from Your Content, SG24-7877.

    Yuki Makino is a Software Engineer for IBM Watson Content Analytics in Japan. He joined IBM in 2009, and has 5 years of software development experience in distributed system and large-scale data processing. Yuki has worked in in-memory distributed database development, parallel programming language research (X10), and text analytics development (Watson Content Analytics). Yuki holds a Master’s degree in Engineering from the University of Tokyo.

    Mike Prentice is a business process management (BPM)/ECM Solution Architect in the United States. He has 20 years of experience in architecture, design, and building BPM/ECM solutions as a consultant and supporting IBM Business Partners. He has worked at IBM for 6 years. His areas of expertise include case management, BPM, ECM, solution architecture, and solution design with object-oriented principals. He has written extensively about FileNet and non-FileNet leading practices around solution implementation for Advanced Case Management (ACM), BPM, and ECM.

    Special thanks to the following people for their vision, sponsorship, and commitment for this book project:

    Mohammed Attar
Ian Story

    Special thanks to the development and support management team. Without their support and lending of their team members’ expertise, we could not have completed this book:

    Ruen Dineros
Seiji Hamada
Torbjorn Johansson 
Tim Lai
William Lobbig
Dana Morris
Oren Paikowsky
Martin Shramo
Yajie Yang

    Thanks to the following people for their contributions to this project:

    Yoav Ben-Yair
Eliahu Ben-Reuven
David Epstein
Guenther Flaig 
John M Handrop
Long He
Ruth Hildebrand-Lund
Hubert Hwang
Takeshi Inagaki
Hiroaki Kikuchi
Sayaka Kuroki
Brett Morris
Victoria Mazel
Yutaka Moriya
Takuma Murakami
Chi Nguyen
Darik Siegfried
Jane Singer
IBM Software Group, in IBM Israel, China, and US

    Richard Conway
IBM Global Business Services®

    Whei-Jen Chen
IBM ITSO Redbooks organization

    Now you can become a published author, too!

    Here’s an opportunity to spotlight your skills, grow your career, and become a published author—all at the same time! Join an ITSO residency project and help write a book in your area of expertise, while honing your experience using leading-edge technologies. Your efforts will help to increase product acceptance and customer satisfaction, as you expand your network of technical contacts and relationships. Residencies run from two to six weeks in length, and you can participate either in person or as a remote resident working from your home base.

    Obtain more information about the residency program, browse the residency index, and apply online:

    ibm.com/redbooks/residencies.html

    Comments welcome

    Your comments are important to us!

    We want our books to be as helpful as possible. Send us your comments about this book or other IBM Redbooks publications in one of the following ways:

    •Use the online Contact us review Redbooks form:

    ibm.com/redbooks

    •Send your comments in an email:

    redbooks@us.ibm.com

    •Mail your comments:

    IBM Corporation, International Technical Support Organization
Dept. HYTD Mail Station P099
2455 South Road
Poughkeepsie, NY 12601-5400

    Stay connected to IBM Redbooks

    •Find us on Facebook:

    http://www.facebook.com/IBMRedbooks

    •Follow us on Twitter:

    http://twitter.com/ibmredbooks

    •Look for us on LinkedIn:

    http://www.linkedin.com/groups?home=&gid=2130806

    •Explore new Redbooks publications, residencies, and workshops with the IBM Redbooks weekly newsletter:

    https://www.redbooks.ibm.com/Redbooks.nsf/subscribe?OpenForm

    •Stay current on recent Redbooks publications with RSS Feeds:

    http://www.redbooks.ibm.com/rss.html

  
[image: ]
[image: ]

IBM Enterprise Content Management product and solution overview

    In this chapter, we introduce the IBM Enterprise Content Management (ECM) solution built for the scenario in this book, and the ECM products and components involved in this solution. 

    This chapter describes the following products and components:

    •IBM Case Manager

    •IBM Content Navigator

    •IBM Datacap

    •IBM Content Manager OnDemand

    •IBM Enterprise Records

    •IBM Watson Content Analytics

    •IBM Content Classification

    1.1  Introduction

    An ECM solution might consist of multiple components to achieve the many objectives of an enterprise. To build such a solution, you might install and configure multiple products, integrate them together, and implement the solution across these products and components. 

    There are many products in the IBM ECM portfolio that provide a variety of functions and capabilities for an ECM solution. This book describes building a generic ECM solution from end-to-end using these IBM ECM products. 

    This chapter provides a high-level description of the products involved in the ECM solution. The installation, configuration, and integration of these products were first performed on a traditional system. We implement the ECM solution with multiple stages, each adding additional functionalities. The solution building process is then repeated on IBM SoftLayer, the platform that we advise and encourage you to use to build your ECM solution. 

    You do not need to install and implement all of the products described in this solution. We select to integrate these IBM ECM products for our solution because we want to highlight these products, and show how they can be integrated together to provide the powerful functionalities that your business might need. Based on your business requirements, you can selectively install, configure, and integrate these products for your own ECM solution. 

    The solution-building process provided in this book serves as a learning guideline for a proof of concept (PoC) and proof of technology environment. It is beyond the scope of this book to provide a definitive guide for implementing a production ECM solution. 

    1.2  IBM Softlayer

    IBM SoftLayer provides a high-performing cloud infrastructure. Data centers around the world use IBM SoftLayer to run solutions and services. For more information about IBM SoftLayer, refer to Chapter 3, “Building a cloud-based ECM solution with IBM SoftLayer” on page 21.

    1.3  IBM Case Manager

    IBM Case Manager enables you to manage content-driven, structured, and unstructured processes in dynamic, highly collaborative, and flexible means. Knowledge workers are not constrained by a strict, predetermined process route seen in other business process management (BPM) tools. Rather, the knowledge workers are empowered with the ability to start tasks dynamically to resolve the case that they are working. 

    IBM Case Manager enables your organization to simplify the design of complex workflows created and managed by BPM tools, and provides maximum flexibility. For example, it enables you to create a solution where, at any step of a process, you can create ad hoc tasks, such as specially requesting a manager to review a document, requesting additional information that is not pre-determined from a client, running a product replacement, or creating cross-selling opportunities.

    In a structured, predetermined process, many of the ad hoc tasks are not captured, because they are done outside of the process tool, for example, using email. Not capturing these tasks leads to gaps in the audit trail, and misunderstanding about why certain decisions were made. With a traditional BPM tool, to close this gap, a complex and convoluted process must be mapped out, with routes between every possible outcome. 

    Using IBM Case Manager, you can manage changes in a process by adding new tasks ad hoc. IBM Case Manager provides task routing that complements the traditional process mapping. Tasks provide the ability to break a larger process into a series of smaller fragments. Each fragment encapsulates a traditional process map. For example, a task can be requesting a manager to review a document, or requesting additional information from a client.

    Tasks can be started at any or all of the process steps. This provides flexibility, and empowers knowledge workers to perform their job, track decisions, and expedite the work. Because all tasks are run in IBM Case Manager, a full audit trail is maintained and, more importantly, reviewers can understand the logic behind the decisions made within the case. 

    By fragmenting the one large process into multiple tasks, the complexity of the convoluted process can be dramatically scaled down. This significantly reduces development time, maintenance cost, and time required to make changes.

    With the ECM solution build described in this book, we show you how IBM Case Manager achieves a balance between formal and informal processes, through the application of tasks within the process.

    1.4  IBM Content Navigator

    IBM Content Navigator is a ready-to-use, standards-based user interface for content management solutions, including collaborative document management, production imaging, case management, and report management solutions. More importantly, IBM Content Navigator is a flexible and powerful user platform for building custom ECM applications by using open, web-based standards.

    IBM Content Navigator provides a unified interface for the following IBM ECM products and other products:

    •IBM Content Manager

    •IBM FileNet Content Manager

    •IBM Case Manager

    •IBM Content Manager OnDemand

    •IBM Enterprise Records

    •Third-party repositories through the open Content Management Interoperability Services (CMIS). 

    For our ECM solution build, we use IBM Content Navigator as the primary user interface within a desktop browser, and through a mobile app.

    1.5  IBM Datacap

    IBM Datacap extracts information from document images for use in ECM solutions and line-of-business applications. These document images can be created through scanning, mobile capture, or other means. IBM Datacap is the universal capture portal that captures, classifies, recognizes, validates, verifies, and exports data and document images quickly, accurately, and cost effectively.

    In our “paperless” world, many organizations are producing more paper documents, and they need to find a way to manage these papers efficiently and capture their data for usage. The management of paper can become costly, time-consuming, and a risk to the organization, because physical documents are often misplaced, misfiled, and damaged. 

    Furthermore, the physical documents can contain information that must be entered manually into other line-of-business applications. For example, invoices into a customer relationship management (CRM) system, or claims in a case management solution. By implementing IBM Datacap, organizations reduce their paper management costs in several ways:

    •Users have immediate access to a digital copy of the document.

    •Multiple users can access the same document simultaneously.

    •Documents are no longer misplaced or misfiled.

    •Information can be automatically lifted and read from the pages, and does not need to be manually typed in.

    •Physical space is saved and recaptured.

    •Outsourced storage costs are saved for third-party physical document repositories.

    •Physical documents can be shredded.

    For our ECM solution, we use IBM Datacap to provide document capture functionality, and to extract valuable information from a form that is captured using a mobile application.

    1.6  IBM Content Manager OnDemand

    IBM Content Manager OnDemand offers enterprise report management that provides high-speed report archiving, and delivers instant electronic access to bills, statements, and other print archive information. It helps organizations respond more quickly to customer inquiries, and manage access to electronic reports used to communicate activities and performance throughout an organization. 

    By implementing IBM Content Manager OnDemand, you can have significant return on investment (ROI), because you can transform costly high-volume print output to electronic information capture and presentation. IBM Content Manager OnDemand performs the following functions:

    •Processes the print output of business applications

    •Extracts index fields from the data

    •Stores the index information in a relational database

    •Stores the output stream in the system

    IBM Content Manager OnDemand can store virtually any format of data, and it excels with the management of several print output formats:

    •Advanced Function Presentation (AFP)

    •Line Data

    •American Standard Code for Information Interchange (ASCII)

    •Extended Binary Coded Decimal Interchange Code (EBCDIC)

    •Portable Document Format (PDF)

    •Extensible Markup Language (XML)

    For example, IBM Content Manager OnDemand fully integrates the AFP, including management of resources, indexes, and support for full fidelity rendering, and reprint of documents. 

    IBM Content Manager OnDemand provides comprehensive storage management capabilities in two primary ways. Firstly, it provides compression algorithms that compress a typical report in 2:1 - 30:1 ratios. Secondly, it offers bundling, and ready-for-use integration with IBM Tivoli® Storage Manager for hierarchical storage management. 

    With IBM Content Manager OnDemand, you can archive newly created and frequently accessed reports on high-speed disk storage volumes, and automatically migrate them to other, cheaper storage volumes as they age. IBM Content Manager OnDemand solutions can be implemented to support small office environments, or large enterprise installations with petabytes (PB) of information. 

    For our ECM solution, we use IBM Content Manager OnDemand to capture and manage employee transaction records. We also enable the retrieval of this information to the required users within the context of a case.

    1.7  IBM Enterprise Records

    IBM Enterprise Records is a records repository for unstructured data that can capture, declare, classify, store, and dispose of electronic and physical records according to fiscal, legal, and regulatory requirements. IBM Enterprise Records enables organizations to declare content stored in the following content repositories as records, and then manage them accordingly:

    •IBM FileNet Content Manager

    •IBM Case Manager

    •IBM Content Manager

    •IBM Content Manager OnDemand

    •Non-IBM ECM repositories

    IBM Enterprise Records is built upon the IBM FileNet P8 content repository infrastructure, which improves operational efficiencies, and reduces costs associated with managing and synchronizing disparate repository silos. With a single, unified repository, you can quickly find and produce all relevant records.

    IBM Enterprise Records provides the ability to streamline records-based activities to help enforce compliance without requiring user participation. This ability, known as IBM ZeroClick, is designed to enforce records management policies without additional workload or participation from users. 

    IBM ZeroClick helps to reduce user-related error and, most importantly, ensures leading practice records management. You can use IBM Enterprise Records to classify records, apply retention policies on them, apply holds on records, store electronic and physical records according to fiscal, legal, and regulatory requirements, and destroy records according to schedule.

    For our ECM solution, we use IBM Enterprise Records to automatically declare documents as records when certain conditions are met, and manage these records thereafter.

    1.8  IBM Watson Content Analytics

    IBM Watson Content Analytics collects and analyzes structured and unstructured content in documents, email, databases, websites, and other enterprise repositories. By providing a platform for crawling, importing content, parsing data, analyzing content, and creating a searchable index, Watson Content Analytics helps you to perform text analytics across all data in your enterprise, and to make that data available for analysis and search. 

    Analytics on structured information is not new. However, approximately 80% of an organization’s information consists of unstructured information. This wealth of information is untapped. 

    Watson Content Analytics helps organizations derive new business understanding and visibility from the content and context of unstructured information. Watson Content Analytics also provides enterprise search capability that helps organizations to make content from multiple structured and unstructured sources searchable by enterprise users. 

    Overall, Watson Content Analytics provides the two main capabilities of Content Analytics and enterprise search.

    Content Analytics

    Across a wide range of industries, Content Analytics helps tackle various information challenges, such as the following needs:

    •Improve customer satisfaction through high-volume analysis of customer satisfaction comments and feedback.

    •Gain better visibility into the marketplace through automated news, surveys, and brand analysis.

    •Better anticipate customer needs by identifying trends in unstructured customer communications.

    •Optimize document-intensive processes through intelligent classification, and routing of content items.

    •Get ahead of product quality problems through complaint, warranty, repair, and support ticket analysis.

    •Reduce fraud by intelligently parsing forms, documents, and communication.

    •Enhance research and investigations through combined data and Content Analytics.

    Watson Content Analytics enables you to pose questions that fall outside the scope of standard data-driven business intelligence, and help you to identify new topics, areas, and questions that deserve further investigation. Traditional analytics tools enable you to discover the who, what, and where. With Watson Content Analytics, you can discover the how and why.

    Enterprise search

    Watson Content Analytics also provides an enterprise search capability. Users search based on search collections. A search collection is a crawled and indexed repository that is ready to be searched. Users are presented with a rich user search experience:

    •Delivers analytics-driven search with enhanced faceted navigation, and selection of content based on concepts, corporate taxonomy, and entities buried in the unstructured text

    •Enables knowledge workers to search, and explore content through an intuitive, and easily extensible search application

    •Improves knowledge worker productivity by breaking down information silos, and making relevant information available more quickly and easily

    Watson Content Analytics helps organizations transform their business by improving productivity, maximizing existing information assets, and enhancing business insight. 

    For our ECM solution, we use Watson Content Analytics to discover trends and gain additional insight from our case information, and to help improve product and service qualities. 

    1.9  IBM Content Classification

    IBM Content Classification can automatically classify documents into categories or topics, by analyzing their content. The appliance learns from example how to identify a certain category. The categories can be used by the ECM application in the decision-making process. IBM Content Classification uses a combination of text-based analysis and rule-based analysis to determine how each document is classified. 

    With IBM classification technology, applications can understand and classify unstructured free-form text. It learns how to distinguish and classify data based on its acquired information, and it can be set to continue learning and gathering information at production time based on user actions in the application workflow.

    By using IBM Content Classification in various areas of a business, you can accomplish these goals:

    •Reduce or avoid manual processes that are associated with subjective decision making around unstructured content.

    •Streamline the ingestion of that content into your business systems.

    •Use that information within those business systems. 

    By reducing the human element in the process, IBM Content Classification ensures accuracy and consistency, and enables auditing while simultaneously driving down labor costs.

    For our ECM Solution, we use Content Classification to automatically classify incoming emails, and to start a case when needed.

    The rest of this book describes the following topics:

    •Our use case

    •The ECM solution that we build

    •The steps involved in installing and configuring the ECM products

    •How to integrate them together

    •Our implementation process
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Use case scenario

    This chapter provides an overview of the use case scenario used in this IBM Redbooks Publication. It describes the actors involved in the scenario, the overall scenario, and detailed steps. The IBM Enterprise Content Management (ECM) solution build for this scenario involves multiple IBM ECM products. This chapter describes how each product or component plays a role in the scenario, and the overall ECM solution.

    2.1  Use case scenario overview

    This section outlines the simple scenario used in this book. We aim to create a scenario that is not industry-specific. This use case scenario and the resulting ECM solution should be applicable to many organizations. 

     

    
      
        	
          Note: This book is created as a reference guide to showcase a set of capabilities of IBM ECM products, their integration, and solution implementation. It is not intended to be a definitive guide to create a production-ready solution.

        
      

    

    When working through this scenario, we encourage you to learn the capabilities of various IBM ECM products, and to discover how you can integrate and apply them to your ECM solution to meet your enterprise requirements.

    2.1.1  Actors

    The scenario consists of the following internal and external actors:

    Client (Jackie)	Is a customer of fictional Company A, who has a concern about the product and service she recently received.

    Customer Services Representative (George) 

    	Is responsible for the initial screening and management of inbound calls from clients. 

    Specialist (Rebecca)	Is assigned product-specific and service-specific questions and concerns that the customer service representative cannot manage.

    Manager (Tim)	Is responsible for the review of exceptions, for example refund requests over a set value.

    2.1.2  Scenario

    Our scenario begins when Jackie places a call to fictitious Company A, because she has had issues with a product and service she recently received. George, the Customer Service Representative, receives the call. His conversation with Jackie helps George determine that a new case is required, because the path to resolution is outside of his responsibilities in the organization. 

    He captures the required information to create the new case within IBM Case Manager. George ends the call with Jackie and submits the new case for processing.

    Shortly after the creation of the new case, Jackie receives an automatically generated correspondence. The email provides the details for her case, a link to check the current status of her case, and a thank-you note for continued patronage. By providing a link to the case status, it enables Jackie to track the status of her case, and ultimately reduce the need to place a call back to Company A. 

    In parallel to sending the correspondence, the case is assigned to Rebecca, the product and service specialist. Like many employees at Company A, Rebecca travels regularly to client locations. When she is at the airport, she uses her tablet to securely log in to Company A’s mobile application (app). Within the app, she accesses her current case queue, and opens the new task item for Jackie’s case. 

    Using the mobile app, Rebecca is presented with the relevant case data, and supporting documentation that is stored in the IBM Case Manager repository. Looking over the information, Rebecca determines that she requires more information, so she calls Jackie. During the discussion, Rebecca requests additional supporting documentation from Jackie. 

    Using her tablet, Rebecca quickly creates a Request more information task, which automatically sends an email to Jackie that outlines the required information, including a form to complete, sign, and send back. Before the call ends, Rebecca asks Jackie if there is anything else she can assist her with. 

    Jackie pauses for a moment, and asks Rebecca if she can update her contact information. Rebecca, initiates an ad hoc task, captures the updates from Jackie, and assigns the task to George because he has access to the customer relationship management (CRM) system. 

    Through this interaction, we have seen that, by using the mobile app, Rebecca has access to her case workload and client information anywhere. This enables her to take advantage of what otherwise would have been unproductive time in an airport. Secondly, using her years of experience Rebecca initiated a task to request additional information from Jackie. 

    IBM Case Manager has empowered the knowledge worker, Rebecca in this scenario, to make the decisions required that resulted in a successful resolution. Based on the conversation with Jackie, Rebecca believes that a refund or product replacement is required. To make the correct decision, Rebecca needs additional supporting documentation from Jackie. 

    This is not the situation for most of the other cases that Rebecca has worked on. This is a special situation in Jackie’s case. This is one example of the power of tasks within IBM Case Manager.

    Through the interaction of Rebecca and Jackie, we also see a second example, the use of ad hoc tasks. At the end of the call, we saw that Jackie requested an update to her contact information. In many organizations, such as Company A, this information is managed within a separate system, and is not part of Rebecca’s role. 

    Rebecca knows that this is part of George’s responsibility, so she creates an ad hoc task within IBM Case Manager, and sends the request for him (or another person on his team) to perform. If there were a structured workflow, it would 
have been nearly impossible to anticipate that request, or another special request from Jackie. 

    Without IBM Case Manager, a complex workflow would have been required to manage that request. As you see within this book, through minimal configuration, we can enable Rebecca to make those requests without leaving the Case Manager interface, nor the need for a complex workflow.

    After Jackie fills out the form and gathers the requested supporting documentation, she opens the Company A mobile app on her phone. Using the app on her phone, she takes a picture of the documentation, and submits it. After it is submitted, the new batch of documents is securely sent to, and processed by, IBM Datacap. 

    IBM Datacap reads the bar code on the form, ensures that it has been signed, and uploads it to IBM Case Manager. After IBM Case Manager receives the new supporting documents, it automatically adds the documents to the case, and notifies Rebecca that they have arrived.

    When Rebecca is back in the office, she logs in to IBM Case Manager with a browser on her desktop to continue processing Jackie’s case. Rebecca reviews the newly added documents, and makes a note in the case comments. 

    The note states that, based on the information received, Jackie should either receive a refund or a product replacement. Rebecca submits the decision for a refund for Jackie. Based on the cost of the refund, IBM Case Manager might automatically route the case to Tim, Rebecca’s manager. 

    Tim receives the request. Based on his role, Tim accesses additional information before making his decision. In Company A, IBM Content Manager OnDemand is used to capture and archive customers’ transaction history, reports, and monthly statements. Tim retrieves Jackie’s transaction history and monthly statement from IBM Content Manager OnDemand. With the details laid out neatly in front of him, Tim agrees that a refund is the appropriate action to take. 

    Tim starts the refund or replacement task, and sends the case back to George to deliver the outcome to Jackie. At the same time, the transaction information that Tim retrieved from IBM Content Manager OnDemand also becomes part of the document that is attached to Jackie’s case, for auditing purposes. 

    George receives Jackie’s case outcome in his case queue. He generates the outcome correspondence, which is sent directly to Jackie. After this is done, the case is considered closed. Based on the company policy and government regulation, some of the case documents must be declared as records. Therefore, when the case is closed, the required case document is automatically declared as a record to be retained within the company-defined retention period. 

    2.1.3  Detailed steps

    The following section provides a summary of the key steps involved in the scenario, as shown in Figure 2-1.

    [image: ]

    Figure 2-1   Solution overview diagram

    The following list describes the steps shown in Figure 2-1:

    1.	Jackie, the client, makes a call.

    2.	The call is received by George, the client service representative (CSR).

    3.	George captures the required details in IBM Case Manager.

    4.	IBM Case Manager initiates a new case.

    5.	The system generates and sends a thank-you correspondence to Jackie.

    6.	The case is routed to Rebecca, the appropriate specialist.

    7.	Rebecca works from an airport, and accesses her case using the mobile IBM Case Manager Client.

    a.	Rebecca calls Jackie to gather more information. A request for supporting documentation form is sent to Jackie.

    b.	Before ending the call, Jackie requests that her contact information be updated. Rebecca initiates a Client information update task that is routed and run by George, the CSR, because he has access to that system.

    8.	Using her mobile phone, Jackie takes a picture of the completed form, and other supporting documents. They are uploaded to the case through the mobile user interface (UI).

    9.	When she is back in the office, Rebecca is notified of the arrival of the supporting documents. She reviews the documentation and determines that a refund or replacement should be issued.

    10.	IBM Case Manager automatically routes the refund request to Tim, Rebecca’s manager, because the amount of the refund is over the normal amount.

    11.	Tim is presented with all of the supporting documentation, including a client transaction history for Jackie.

    12.	Tim approves the refund request:

    a.	A Process refund or replacement task is initiated by Tim.

    b.	The case is routed to George to send out the correspondence to Jackie. 

    13.	For corporate governance reasons, some of the documents involved in the case are automatically declared as records.

    2.2  Role of solution components in the scenario

    The following sections provide an overview of each solution component’s role.

     

    
      
        	
          Solution component and IBM ECM product naming convention: Solution components in the scenario are associated with IBM ECM products. In this book, we loosely refer to a solution component and the particular IBM ECM product that provides the component as the same thing. Although they are technically not the same thing, we use them interchangeably for simplification of wording and description in this book.

        
      

    

    2.2.1  IBM Case Manager

    IBM Case Manager is used to drive the case created by George, the CSR. It captures and manages the documents and information pertaining to the concern raised by Jackie, the client. 

    IBM Case Manager is key to the ECM solution, because it provides the flexibility required to manage exceptions that typical business process management (BPM) solutions cannot easily address. You see how easily Rebecca, the specialist, can manage the ad hoc requests made by Jackie, create a request for additional information, and automatically route the case to her manager for additional screening. 

    Using IBM Case Manager for the ECM solution, we accomplish the following tasks:

    •Design the case application.

    •Work in the IBM Case Manager Builder tool.

    •Define the case properties.

    •Define the roles.

    •Define the document classes that are involved in the case.

    •Create the required tasks.

    •Deploy and test the case application.

    2.2.2  IBM Content Navigator

    IBM Content Navigator acts as the primary interface for Company A employees. Initially, you can work with the ready-for-use, browser-based client. Later in the scenario, you see how both Rebecca, the specialist, and Jackie, the client, can use the mobile app to capture supporting documents and access the case.

    Using IBM Content Navigator for the ECM solution, we accomplish the following tasks:

    •Configure a user desktop.

    •Configure the mobile app.

    •Interact with the mobile app to process case work. 

    •Interact with the mobile app to capture the supporting documents.

    •Run user tasks, such as processing case work.

    2.2.3  IBM Datacap

    IBM Datacap manages the intake and processing of a form, and supporting documentation, received from Jackie. Jackie uses the IBM Content Navigator mobile app to take a picture of the product in question, and the form that she completed. She also uses the app to submit this information. IBM Datacap identifies and captures the pages with the image and form that Jackie submitted. IBM Datacap extracts data from the pages and uploads them to the case.

    Using IBM Datacap for the ECM solution, we accomplish the following tasks:

    •Configure an IBM Datacap FastDoc application.

    •Configure the IBM Content Navigator mobile app to work with the FastDoc application.

    •Interact with the mobile app to capture a form and supporting documents.

    2.2.4  IBM Content Manager OnDemand

    IBM Content Manager OnDemand is an add-on component to the ECM solution that provides the ability to archive and retrieve customers’ transactions, and reports that help resolve customers’ issues.

    IBM Content Manager OnDemand stores the company’s transaction reports. When the case is routed to Tim, Rebecca’s manager, for final approval, he is presented with a list of the reports, the invoice and payment journals, pertaining to Jackie’s purchase. 

    IBM Content Manager OnDemand and IBM Case Manager are integrated in such a way that the reports archived by IBM Content Manager OnDemand can be retrieved directly by Tim within the ECM solution. Tim does not need to change applications, or use different UIs, to get the information that he needs to make an informed decision. 

    Using IBM Content Manager OnDemand for the ECM solution, we accomplish the following tasks:

    •Define new report types.

    •Load the transaction reports.

    •Retrieve the reports within the context of the case.

    •Save the reports as part of the case data.

    2.2.5  IBM Enterprise Records

    IBM Enterprise Records is an add-on component that provides enterprise-level records management capability to the ECM solution. Company A requires the ECM solution to be designed to uniquely combine content, process, and connectivity into a compliance infrastructure:

    •Automate and streamline records-based activities.

    •Eliminate unnecessary user participation.

    •Enforce compliance.

    IBM Enterprise Records is used, during the case closure processing, to automatically declare the required case documents as records, to meet corporate governance requirements. This is done automatically, without requiring intervention or participation by any of the users. The automated records declaration process helps to ensure that the corporate governance is being met. 

    Using IBM Enterprise Records for the ECM solution, we accomplish the following tasks:

    •Define a file plan.

    •Define a disposition schedule.

    •Define a records declaration template.

    •Declare records without user intervention.

    2.2.6  IBM Watson Content Analytics

    IBM Watson Content Analytics is an add-on component to the ECM solution that enables an analyst from Company A to perform an extra level of investigation into the actual product or service that is having an issue. The analyst can harness the power of Watson Content Analytics to determine if there has been a trend that raises concerns about a particular product or service. 

    By performing this analysis, Company A can proactively identify potential defects, and improve their product and service lines, rather then being reactive.

    Using Watson Content Analytics for the ECM solution, we accomplish the following tasks:

    •Configure access to the solution data.

    •Define analysis facets.

    •Perform sentiment analysis (real language analysis).

    2.2.7  IBM Content Classification

    IBM Content Classification is an add-on component to the ECM solution that enables Company A to automatically classify content submitted by customers through Company A’s main web page. If the content indicates that the customer has an issue that requires Company A to handle, IBM Content Classification integrated with IBM Case Manager can enable automatic initiation of a case investigation on behalf of the customer. 

    The automatic classification of content by IBM Content Classification saves the manual steps that would otherwise be done by a clerk, and therefore reduces potential errors. For our scenario, IBM Content Classification is used to classify any content submitted by customers through the web. There might be thousands of content instances submitted by customers each day.

    Content Classification ascertains the customer question from this submitted content, and determines the appropriate response. These responses can include a link to the frequently asked questions (FAQs) section of Company A’s website, or a link to a thread in a discussion forum. 

    In our scenario, when needed, IBM Content Classification can enable a case to be created within the ECM solution. Through the implementation of IBM Content Classification at this step, Company A reduces their call volume and serves their clients more quickly.

    Using IBM Content Classification for the ECM solution, we accomplish the following tasks:

    •Configure IBM Content Classification.

    •Create and deploy the IBM Content Classification resource.

    •Integrate IBM Content Classification into the ECM solution.

    For more information about the solution components, refer to Chapter 1, “IBM Enterprise Content Management product and solution overview” on page 1.

    The rest of this book provides steps-by-step procedures for installing, configuring, and integrating various ECM products (solution components), and for implementing the ECM solution. 
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Building a cloud-based ECM solution with IBM SoftLayer

    This chapter describes what must be provided to build an IBM Enterprise Content Management (ECM) solution in a cloud infrastructure. It uses the use case described in this book, and illustrates how the described step-by-step procedures can be applied to a cloud infrastructure.

    Specifically, we describe how to order an IBM SoftLayer server, starting from nothing and ending with a Windows-based server, functional and accessible with an administrative account.

    3.1  Introduction

    Most IBM ECM capabilities can be implemented as a cloud-based service. Some preconfigured capabilities are available as software as a service (SaaS) patterns. However, the more complex scenarios often need to be tailored to specific customer requirements, and therefore are built onto a more generic platform as a service (PaaS) offering. 

    On July 8, 2013, IBM announced that it had acquired SoftLayer, a cloud computing infrastructure provider with offerings including on-demand dedicated servers, virtual cloud servers, and private clouds. IBM SoftLayer is a cloud leader in the Internet-centric and small and medium business (SMB) segment, providing an innovative infrastructure as a service (IaaS) platform designed for web-native, performance-intensive applications.

    IBM SoftLayer is particularly focused in the areas of mobile, social, gaming, and analytics, with 21,000 customers worldwide. SoftLayer was headquartered in Dallas, Texas, US, with data centers and network points-of-presence in the United States, Asia, and Europe.

    This IBM Redbooks publication describes how to integrate a large set of ECM capabilities to address a specific set of customer requirements. Most ready-made SaaS ECM offerings do not cover this broad set of capabilities. Therefore, the best option is to start with a PaaS implementation. This option can easily be built from IBM Softlayer, by using its self-service implementation of provisioning x86-based server systems, including an operating system (OS).

     

    
      
        	
          Note: A virtual server capable of containing the scenarios described in this book can cost between $300 and $400 per month. The offering is charged on a monthly basis against the credit card used to place the order. 

          The service can be canceled monthly one day before the Anniversary Billing Date through written notice via the Customer Portal. See the following website for further details:

          http://cdn.softlayer.com/SoftLayer_MSA.pdf

        
      

    

    After the server is up and running, the installation and configuration of solution components described in this book takes place just as though the server is a normal Windows server in a local data center. The only difference is that it cannot be accessed physically with a directly attached console. Interaction takes place remotely, for instance, using remote console software such as Remote Desktop.

    3.2  Ordering an IBM SoftLayer server

    There are two ways to order an IBM SoftLayer server:

    •Order a server for the first time.

    •Order additional servers.

    The steps for ordering a new server differ between these two options. Therefore, both options are described here. 

    Following the installation procedures described in this book, the IBM SoftLayer virtual server is equipped with Microsoft Windows Server 2008 R2. Windows is a specific requirement for the IBM Datacap component. 

    Depending on the scenarios that are set up, and the version-specific software compatibility matrix of the components used in these scenarios, newer releases of Windows can be used instead. Other operating systems might also be supported. However, the procedure describes a Windows-based installation and configuration.

    3.2.1  Ordering a SoftLayer server without an existing SoftLayer ID

    Follow these steps to order your first SoftLayer server:

    1.	Point a browser to this URL:

    http://www.softlayer.com

    Select the PRODUCTS & SERVICES menu, as shown in Figure 3-1. Choose Virtual Server from the Servers menu.
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    Figure 3-1   Front page of the SoftLayer site with PRODUCTS & SERVICES selected

     

    
      
        	
          Note: During the order session, whenever a longer period of inactivity occurs, SoftLayer does provide the option to chat with a specialist. This is offered in a pop-up dialog.

          If you do not want to use this option, close the pop-up by clicking No Thanks at the upper right corner of it. Otherwise, seek help by starting 
a chat.

        
      

    

    2.	Start defining the virtual server by pulling the slider for Cores, random access memory (RAM), and Storage to the amount specified in Table 3-1, as shown in Figure 3-2 on page 25.

    Table 3-1   Softlayer Server Configuration details

    
      
        	
          Configuration Item

        
        	
          Detail

        
      

      
        	
          Data center

        
        	
          Dallas

        
      

      
        	
          Processors

        
        	
          4 x 2.0 Gaze Cores

        
      

      
        	
          RAM

        
        	
          16 gigabytes (GB)

        
      

      
        	
          Operating System

        
        	
          Windows Server 2008 Datacenter Edition R2 

        
      

      
        	
          First Disk

        
        	
          100 GB storage area network (SAN)

        
      

      
        	
          Second Disk

        
        	
          200 GB SAN

        
      

      
        	
          Network Operations

        
        	
          5.000 GB Bandwidth

        
      

      
        	
          Uplink Port Speed

        
        	
          100 megabits per second (Mbps)

        
      

      
        	
          Advanced Monitoring

        
        	
          Monitoring Package - Basic

        
      

    

    3.	Select the preferred service charge method by clicking the red button that shows the service charge, as presented in Figure 3-2.
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    Figure 3-2   Basic virtual SoftLayer server definition

    4.	On the next definition pane, add the remaining details from Table 3-1 on page 24 to the server definition, as illustrated in Figure 3-3. Click ADD TO ORDER to proceed to the billing step.
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    Figure 3-3   Additional SoftLayer server details definition

    5.	After the order is verified, a CHECKOUT page is presented, as shown in Figure 3-4 and Figure 3-5 on page 28. Complete your contact information and billing information and click Submit Order.

     

    
      
        	
          Note: The contact information can be used to generate a user ID for SoftLayer. This ID can then be used to order additional products or services, or to change an existing setup, as described in 3.2.2, “Ordering additional servers with an existing SoftLayer ID” on page 28.
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    Figure 3-4   SoftLayer CHECKOUT page, top section

    The bottom section of the CHECKOUT page is shown in Figure 3-5.
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    Figure 3-5   SoftLayer CHECKOUT page: bottom section

    After placing the order, chapter 3.2.3, “Final non-interactive order process steps and provisioning” on page 33 describes the remaining steps toward the provisioned server.

    3.2.2  Ordering additional servers with an existing SoftLayer ID

    To order an additional SoftLayer server, follow these steps:

    1.	Browse to the following URL: 

    https://manage.softlayer.com

    2.	Log in to the self-service portal by providing your user ID and password using your personal credentials. The login window is presented in the browser, as shown in Figure 3-6 on page 29. If you do not already have a SoftLayer ID, follow the process described in 3.2.1, “Ordering a SoftLayer server without an existing SoftLayer ID” on page 23. Click Login to access the Softlayer portal page.
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    Figure 3-6   Softlayer login window

    3.	On the portal, navigate to the Sales menu, as shown in Figure 3-7. Select the appropriate product. For the purposes of this book, a test system that has a life span measured in months rather than years is sufficient. Select Add Virtual Server (monthly) to start configuration.
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    Figure 3-7   Softlayer portal with sales menu open for selection of product

    4.	Configure the server. This configuration covers hardware characteristics, software that should be set up or added to it, and services to manage the system. 

    Configure the hardware details for the server by selecting the appropriate options from the drop-down lists. Select the configuration value that you want (Figure 3-8 on page 31). The test system for this book follows the specification provided in Table 3-2. Click Continue Your Order to proceed to the final order step.

    Table 3-2   Softlayer server configuration details

    
      
        	
          Configuration Item

        
        	
          Detail

        
      

      
        	
          Data center

        
        	
          Dallas

        
      

      
        	
          Processor

        
        	
          4 x 2.0 Gaze Cores

        
      

      
        	
          RAM

        
        	
          16 GB

        
      

      
        	
          Operating System

        
        	
          Windows Server 2008 data center Edition R2

        
      

      
        	
          First Disk

        
        	
          100 GB SAN

        
      

      
        	
          Second Disk

        
        	
          200 GB SAN

        
      

      
        	
          Network Operations

        
        	
          5.000 GB Bandwidth

        
      

      
        	
          Uplink Port Speed

        
        	
          100 Mbps

        
      

      
        	
          Advanced Monitoring

        
        	
          Monitoring Package - Basic

        
      

    

    Figure 3-8 shows the configuration value.
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    Figure 3-8   Softlayer server hardware, software and service selection

    5.	On the Order Summary and Billing page (Figure 3-9), verify the settings. 
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    Figure 3-9   Softlayer final order step

    6.	Enter the server name (ecmredbook) and domain (softlayer.com), as shown in Figure 3-10, and click Finalize Order at the bottom of this page.
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    Figure 3-10   Softlayer server name definition

    7.	After placing the order, a first receipt is presented, as shown in Figure 3-11. This is the final interactive step. The system is ordered.
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    Figure 3-11   Softlayer order receipt

    3.2.3  Final non-interactive order process steps and provisioning

    These interactive self-service steps are followed by one call back from a Softlayer representative, verifying that the order is valid. After that, a sequence of status emails is sent, each documenting a milestone toward the provisioning of the server. There is one mail for each of these subjects (in this order):

    •Your SoftLayer Technologies Inc Order # <order number> has been received: This email has the order ID, and is a notification that the request was received.

    •Your SoftLayer Technologies Inc Order # <order number> has been approved: This email has the order ID, and is a notification that the request was accepted and will be processed.

    •Getting Started with SoftLayer an IBM Company: 
This email contains links to how-to guides for getting started using the new image, when that image is provisioned.

    •Your SoftLayer Virtual Server (<server name>) has been provisioned: 
This email informs you that provisioning was finalized, and has information about how to get to the access information using a web application.

    After receiving the final (fourth) email, go to the indicated URL, log in with credentials used when ordering the service, and retrieve the access information. When the access information is available, the server can be used as any remote server, and the scenarios documented in this book can be implemented.
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Installing and configuring IBM Case Manager

    This chapter describes the procedure to set up an IBM Case Manager 5.2 environment using the IBM Case Manager Platform Installation Tool (CMPIT).

    The chapter provides information about the following topics:

    •Prerequisites

    •IBM CMPIT packages to be downloaded

    •Running IBM CMPIT Installer

    •Downloading and installing fix packs

    •Verifying installed components

    4.1  Overview

    The setup process for IBM Case Manager and the underlying IBM FileNet P8 Platform includes the steps:

    1.	Downloading IBM CMPIT components.

    2.	Running the IBM CMPIT Installer.

    3.	Downloading FileNet P8 Platform and IBM Case Manager fix packs.

    4.	Installing FileNet P8 Platform and IBM Case Manager fix packs.

    5.	Verifying installed components.

    The IBM CMPIT provides a series of scripts that install and configure all of the supporting software and applications to create a complete FileNet P8 version 5.2 Platform and IBM Case Manager 5.2 environment. The supporting software components include IBM DB2® database server, IBM Tivoli Directory Server, and IBM WebSphere® Application Server. 

    The installation tool configures an IBM Case Manager development environment that can be used to create, deploy, and test solutions. After the automatic installation and configuration is complete, you must install the minimum required fix packs before you can begin to use the FileNet P8 and IBM Case Manager applications.

    The layout of the installed components is shown in Figure 4-1.
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    Figure 4-1   CMPIT components

    Figure 4-2 shows the use case solution components we build for this book. In this chapter, we build IBM Case Manager, one of the core components for the IBM Enterprise Content Management (ECM) solution.
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    Figure 4-2   Use case context in relation to the overall solution components

    4.2  Prerequisites

    The minimum and advised hardware and software configuration is described in Table 4-1.

    Table 4-1   Hardware software configuration

    
      
        	
          Component

        
        	
          Minimum

        
        	
          Advised

        
      

      
        	
          Processors

        
        	
          2 

        
        	
          4 

        
      

      
        	
          Memory (random access memory, RAM) 

        
        	
          8 gigabytes (GB) 

        
        	
          16 GB 

        
      

      
        	
          Disk space (available) 

        
        	
          80 GB 

        
        	
          120 GB 

        
      

      
        	
          Operating system (OS)

        
        	
          Microsoft Windows Server 2008 R2 (with Service Pack 1) 

        
        	
          Windows Server 2012 

        
      

    

    Detailed system requirements are available on the following website:

    http://www-01.ibm.com/support/docview.wss?uid=swg27038470

     

    
      
        	
          Note: Ensure that no other software products are running on the server before starting the IBM CMPIT installer. The machine must be a clean Windows Server 2008 or 2012 installation and should not have any of the IBM CMPIT components previously installed on it.

        
      

    

    4.3  Downloading IBM CMPIT components

    The required supporting software, FileNet P8 Platform and IBM Case Manager components, shown in Table 4-2 on page 39, can be downloaded from IBM Passport Advantage®:

    http://www.ibm.com/software/passportadvantage/pao_customer.html

     

    
      
        	
          Note: Passport Advantage downloads are only available to customers who have purchased IBM Case Manager. Contact your IBM Sales representative for details.

        
      

    

    Table 4-2 shows the required components.

    Table 4-2   IBM CMPIT components

    
      
        	
          Software 

        
        	
           Part number (Windows)

        
      

      
        	
          FileNet P8 Content Platform Engine 5.2 

        
        	
           CIUS4ML

        
      

      
        	
          FileNet P8 Content Platform Engine Client 5.2 

        
        	
           CIV1JEN

        
      

      
        	
          IBM Case Foundation 5.2 

        
        	
           CIX12ML

        
      

      
        	
          IBM Content Navigator 2.0.2 

        
        	
           CIN6ZML

        
      

      
        	
          IBM Case Manager 5.2.0 

        
        	
           CIX17ML

        
      

      
        	
          IBM DB2 9.7 Restricted License 

        
        	
           CZL3UML

        
      

      
        	
          IBM Tivoli Directory Server 6.3 Client-Server 

        
        	
           CZKG4ML

        
      

      
        	
          IBM WebSphere Application Server 8.5 (1 of 3) 

        
        	
           CI6XNML

        
      

      
        	
          IBM WebSphere Application Server 8.5 (2 of 3) 

        
        	
           CI6XPML

        
      

      
        	
          IBM WebSphere Application Server 8.5 (3 of 3) 

        
        	
           CI6XQML

        
      

      
        	
          IBM Installation Manager 1.5.2 

        
        	
           CI6XDML

        
      

    

    The software updates, shown in Table 4-3, can be downloaded from IBM Support Fix Central: https://www.ibm.com/support/fixcentral/.

    Table 4-3   Software updates

    
      
        	
          Software

        
        	
           Download file

        
      

      
        	
          IBM Case Manager Platform Installation Tool

        
        	
          CI41PML.zip

        
      

      
        	
          IBM DB2 9.7 Fix Pack 5

        
        	
          DB2-ntx64-server-9.7.500.702-FP005 executable file: v9.7fp5_ntx64_server.exe

        
      

      
        	
          IBM WebSphere Application Server 8.5 Fix Pack 2

        
        	
          8.5.0-WS-WAS-FP0000002-part1.zip 8.5.0-WS-WAS-FP0000002-part2.zip

        
      

      
        	
          FileNet Content Platform Engine 5.2 Fix Pack 2

        
        	
          5.2.0.2-P8CPE-WIN-FP002

        
      

      
        	
          FileNet Content Platform Engine Client 5.2 Fix Pack 2

        
        	
          5.2.0.2-P8CPE-CLIENT-WIN-FP002

        
      

      
        	
          IBM Case Foundation 5.2 Fix Pack 2

        
        	
          5.2.0.2-P8CaseFoundation-WIN-FP002

        
      

      
        	
          IBM FileNet Workplace XT 1.1.5.2

        
        	
          1.1.5.2-WPXT-FP002-WIN

        
      

    

    After downloading the software components and updates, rename the installers as shown in Table 4-4. 

    Table 4-4   Rename installers

    
      
        	
          Software installer 

        
        	
           Rename to this

        
      

      
        	
          IBM Case Manager

        
        	
           icm.zip

        
      

      
        	
          FileNet Content Platform Engine

        
        	
           ce.zip

        
      

      
        	
          FileNet Content Platform Engine Fix Pack 2

        
        	
           cefp.zip

        
      

      
        	
          FileNet Content Platform Engine Client

        
        	
           cec.zip

        
      

      
        	
          FileNet Content Platform Engine Client Fix Pack 2

        
        	
           cecfp.zip

        
      

      
        	
          IBM Case Foundation

        
        	
           icf.zip

        
      

      
        	
          IBM Case Foundation Fix Pack 2

        
        	
           icffp.zip

        
      

      
        	
          IBM Content Navigator

        
        	
           icn.zip

        
      

      
        	
          FileNet Workplace XT

        
        	
           wpxt.zip

        
      

      
        	
          WebSphere Application Server 

        
        	
          WAS_V8.5_1_OF_3.zip WAS_V8.5_2_OF_3.zip WAS_V8.5_3_OF_3.zip

        
      

      
        	
          WebSphere Application Server 8.5 Fix Pack 2

        
        	
          WAS_V8.5_FP2_1_OF_2.zip WAS_V8.5_FP2_2_OF_2.zip

        
      

      
        	
          Tivoli Directory Server Client-Server

        
        	
           tds.zip

        
      

      
        	
          DB2 version 9.7 Fix Pack 5

        
        	
           db2.zip

        
      

      
        	
          DB2 Restricted License

        
        	
           db2lic.zip

        
      

      
        	
          IBM Installation Manager

        
        	
           im.zip

        
      

    

     

    
      
        	
          Note: When renaming the DB2 Fix Pack installer, make sure that the file name does not have a .exe extension at the end.

        
      

    

    4.4  Running the IBM CMPIT Installer

    Log in as the (local) Administrator user and go to the IBM CMPIT software folder.

     

    
      
        	
          Note: Open the <installer_root>\Windows\cmpit.properties file and verify that the LICENSE_ACCEPTED_# parameter is set to TRUE for each software component. Save and close the file.

        
      

    

    Complete the following steps:

    1.	Run the 5.2.0.1-CMPIT-WIN-FP001.EXE installation tool.

    2.	In the first window, specify your locale and click OK.

    3.	On the Specify Download Directory window, click Choose to browse to the directory that contains the downloaded software components, as shown in Figure 4-3.
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    Figure 4-3   Specify download directory

    4.	Optionally, specify and confirm the administrator password. If you do not enter a password, the installation program uses a default password, as shown in Figure 4-4.
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    Figure 4-4   Specify administrator password

    5.	Review the Preinstallation Summary and click Install to begin the installation (Figure 4-5).
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    Figure 4-5   Preinstallation Summary

     

    
      
        	
          Note: The installation processes can take approximately two to three hours, depending on your hardware configuration.

        
      

    

    6.	On successful completion of the installation, the message shown in Figure 4-6 is displayed.
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    Figure 4-6   Installation complete

    4.5  Troubleshooting installation errors

    If the installer fails due to errors, review the installation log files:

    •C:\Program Files (x86)\IBM\cmpit\cmpit520_fp1_install_log.txt

    •C:\Program Files (x86)\IBM\cmpit\cmpit520_fp1_install_stderr.txt

    Then refer to the Installing and Configuring IBM Case Manager 5.2 with FileNet P8 5.2.0 on single server.pdf guide, specifically the troubleshooting section and the section about how to rerun the CMPIT installation, for tips about troubleshooting installation errors and relaunching the CMPIT installer:

    http://ibm.co/1vO51vG

    4.6  Downloading FileNet P8 Platform and IBM Case Manager fix packs

    You must download and install the current fix packs for the FileNet P8 Platform and IBM Case Manager components from IBM Support Fix Central:

    https://www-933.ibm.com/support/fixcentral/

    The minimum fix pack levels required are listed in Table 4-5.

    Table 4-5   Minimum fix pack levels

    
      
        	
          Software

        
        	
           Download file

        
      

      
        	
          Content Platform Engine 5.2 Fix Pack 3

        
        	
           5.2.0.3-P8CPE-WIN-FP003a.zip

        
      

      
        	
          Content Platform Engine Client 5.2 Fix Pack 3

        
        	
           5.2.0.3-P8CPE-CLIENT-WIN-FP003a.zip

        
      

      
        	
          IBM FileNet Workplace XT 1.1.5.2 Interim Fix 1

        
        	
           1.1.5.2-WPXT-IF001-WIN.exe

        
      

      
        	
          IBM Content Navigator 2.0.2 Fix Pack 3

        
        	
           ICN2023_Windows.zip

        
      

      
        	
          IBM Case Manager 5.2 Fix Pack 1

        
        	
           5.2.0.1-ICM-WIN-FP001.zip

        
      

    

    4.7  Installing FileNet P8 Platform and IBM Case Manager fix packs

    This section describes the instructions to install the FileNet P8 Platform and IBM Case Manager fix packs.

    4.7.1  Installing the FileNet Content Platform Engine Fix Pack

    To install the FileNet Content Platform Engine Fix Pack, complete the following steps:

    1.	Log in as the (local) Administrator user and go to the downloaded FileNet Content Platform Engine Fix Pack archive folder. 

    2.	Extract the contents of the fix pack archive.

    3.	Run the 5.2.0.3-P8CPE-WIN-FP003.exe fix pack installer.

    4.	Select the components to install, as shown in Figure 4-7.
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    Figure 4-7   Choose components

    5.	The installer detects the previously installed version and updates the files in that location.

    6.	Enter the Compatibility Layer Server URL, as shown in Figure 4-8.

     

    
      
        	
          Note: We suggest using the default value displayed by the installer.
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    Figure 4-8   Compatibility layer server URL

    7.	Enter the Config URL, as shown in Figure 4-9.

     

    
      
        	
          Note: We suggest using the default value displayed by the installer.
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    Figure 4-9   Specify config URL

    8.	Review the Preinstallation Summary and click Install.

    9.	After the installation is complete, configure and deploy the upgraded FileNet Engine EAR file as follows:

    a.	Start the FileNet Configuration Manager using the start menu, as shown in Figure 4-10.
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    Figure 4-10   FileNet Configuration Manager

    b.	Click File → Upgrade Profile and verify the profile summary, as shown in Figure 4-11.
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    Figure 4-11   Upgrade profile summary

    c.	Click Next and enter the Application server administrator user name P8Admin and password (refer file C:\Program Files (x86)\IBM\cmpit\
accounts.txt). 

    d.	Click Test Connection and then click Finish, as shown in Figure 4-12.
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    Figure 4-12   Upgrade profile configuration

    e.	Review the application server property settings and click OK, as shown in Figure 4-13.
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    Figure 4-13   Review application server settings

    f.	Open (double-click) the Configure Login Modules task and then click Run Task, as shown in Figure 4-14.
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    Figure 4-14   Configure login modules

    g.	Open (double-click) the Configure Bootstrap and Text Extraction task and then click Run Task, as shown in Figure 4-15.
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    Figure 4-15   Configure bootstrap and text extraction

    h.	Undeploy the FileNet Engine application:

    i.	Log in to the WebSphere Integrated Solutions Console using the following URL:

    https://<localhost>:9043/ibm/console/

    	User name: P8Admin

    	Password: Refer file C:\Program Files (x86)\IBM\cmpit\
	accounts.txt

    ii.	Go to Applications → Application Types → WebSphere enterprise applications.

    iii.	Select FileNetEngine and click Stop.

    iv.	Select FileNetEngine again and click Uninstall, as shown in Figure 4-16.
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    Figure 4-16   Uninstall application

    i.	Click Save.

    j.	Return to the FileNet Configuration Manager, open (double-click) the Deploy Application task and click Run Task, as shown in Figure 4-17.

    [image: ]

    Figure 4-17   Deploy application

     

    
      
        	
          Note: After the Deploy Application task completes, restart the WebSphere Application Server.

        
      

    

    4.7.2  Installing the FileNet Workplace XT interim fix pack

    Complete the following steps to install the FileNet Workplace XT interim fix pack:

    1.	Log in as the (local) Administrator user and go to the downloaded FileNet Workplace XT interim fix pack archive folder. 

    2.	Run the 1.1.5.2-WPXT-IF001-WIN.exe interim fix pack installer.

    3.	The installer detects the installed version of FileNet Workplace XT and prompts you to back up the configuration files, as shown in Figure 4-18. Click OK.
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    Figure 4-18   Backup existing configuration 

    4.	On the next window, select the Generate a .ear file for deployment option, as shown in Figure 4-19. Click Next.
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    Figure 4-19   Select installer options

    5.	Review the installation summary as shown in Figure 4-20. Click OK.
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    Figure 4-20   Installation summary

    6.	Install the current FileNet Content Engine Client files on FileNet Workplace XT:

    a.	Go to the FileNet Content Platform Engine Client Fix Pack archive folder.

    b.	Extract the contents of the fix pack archive.

    c.	Run the 5.2.0.3-P8CPE-CLIENT-WIN-FP003.exe fix pack installer.

    d.	Enter the FileNet Content Platform Engine Client Download Parameters as shown in Figure 4-21:

     •	Host name: localhost

     •	Port number: 9080

    e.	Click Next.
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    Figure 4-21   Content Platform Engine client download parameters

    f.	Select only Workplace XT and clear all other FileNet P8 Applications, as shown in Figure 4-22. Click Next.
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    Figure 4-22   Select FileNet P8 applications

    g.	Select WebSphere Application Server as the Application server type and click Next.

    h.	On the URLs for EJB Transport window, review the displayed values as shown in Figure 4-23 on page 61. Click Next.

     

    
      
        	
          Note: We suggest using the default value displayed by the installer.
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    Figure 4-23   URLs for EJB Transport

    i.	On the next window, review the displayed Component Manager URL, as shown in Figure 4-24. Click Next.

     

    
      
        	
          Note: We suggest using the default value displayed by the installer.
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    Figure 4-24   Component Manager URL

    j.	Select option Create the deployment file now on the next window as shown in Figure 4-25. Click Next.
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    Figure 4-25   Deployment file creation

    k.	Click Next to stop the IBM Case Foundation components. Review the Preinstallation Summary and click Install.

    l.	Click Next to start the IBM Case Foundation components.

    m.	Click Done.

     

    
      
        	
          Note: The updated FileNet Workplace XT application is deployed to the WebSphere Application Server, along with the FileNet Case Manager applications described in 4.7.4, “Installing the IBM Case Manager Fix Pack” on page 66.

        
      

    

    4.7.3  Installing the IBM Content Navigator Fix Pack

    Complete the steps to install the IBM Content Navigator Fix Pack:

    1.	Log in as the (local) Administrator user and go to the downloaded IBM Content Navigator Fix Pack archive folder. 

    2.	Extract the contents of the fix pack archive.

    3.	Run the IBM_CONTENT_NAVIGATOR-2.0.2.3-WIN.exe fix pack installer.

    4.	The installer detects the previously installed version, as shown in Figure 4-26.
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    Figure 4-26   Content Navigator upgrade

    5.	Review the Preinstallation Summary, as shown in Figure 4-27. Click Install.
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    Figure 4-27   Pre installation summary

    6.	After the installation is complete, start the IBM Content Navigator Configuration and Deployment Tool from the start menu, as shown in Figure 4-28.
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    Figure 4-28   IBM Content Navigator Configuration Tool

    7.	Click File → Open Deployment Profile. Browse to the C:\Program Files (x86)\IBM\cmpit\install-scripts\profiles\NexusConfig folder and select the NexusConfig.cfgp file, as shown in Figure 4-29. Click Open.
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    Figure 4-29   Open deployment profile

    8.	In the Edit Profile Properties window, select IBM FileNet P8 and click Finish.

    9.	Open (double-click) the tasks as shown in Figure 4-30 on page 66. Review the task parameters and then click Run Task to run the task:

    a.	Update the FileNet P8 Client Connector Files.

     

    
      
        	
          Note: After completing this task, you must exit and relaunch the IBM Content Navigator Configuration Tool.

        
      

    

    b.	Configure FileNet Process Engine for IBM Content Navigator.

    c.	Configure the IBM Content Navigator web application.

    d.	Build the web application.

    e.	Deploy the web application.

     

    
      
        	
          Note: After the Deploy the web application task completes, restart the WebSphere Application Server.

        
      

    

    Figure 4-30 shows the IBM Content Navigator tasks.
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    Figure 4-30   IBM Content Navigator tasks

    4.7.4  Installing the IBM Case Manager Fix Pack

    Complete the following steps to install the IBM Case Manager Fix Pack:

    1.	Log in as the (local) Administrator user and go to the downloaded IBM Case Manager Fix Pack archive folder. 

    2.	Extract the contents of the fix pack archive.

    3.	Run the 5.2.0.1-ICM-WIN-FP001.exe fix pack installer.

    4.	Select the locale on the welcome window. 

    5.	Review the prerequisite screens for the Workplace XT and IBM Content Navigator components. Click Next.

    6.	The installer detects the previously installed version and displays the location. Click Next. Review the Preinstallation Summary and click Install.

    7.	After the installation is complete, launch the Case Manager Configuration Tool from the start menu, as shown in Figure 4-31.
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    Figure 4-31   IBM Case Manager configuration tool

    8.	Click File → Open Profile. Browse to the C:\Program Files (x86)\IBM\cmpit\install-scripts\profiles\DeployICM folder and select DeployICM.cfgp, as shown in Figure 4-32. Click Open.
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    Figure 4-32   Open profile

    9.	Add a new task, Update the Content Platform Engine Client Connector files, as shown in Figure 4-33.
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    Figure 4-33   Add task to profile

    10.	Open (double-click) the tasks as shown in Figure 4-34 on page 70. Review the task parameters and click Run Task to run the tasks:

    a.	Update the FileNet Content Platform Engine Client Connector files.

     

    
      
        	
          Note: After completing this task, you must exit and relaunch the IBM Case Manager Configuration Tool.

        
      

    

    b.	Configure the Case Management Object Stores.

    c.	Create IBM Case Manager applications.

    d.	Deploy the IBM Case Manager application programming interface (API).

    e.	Register the IBM Case Manager Services plug-in.

    f.	Deploy FileNet Workplace XT.

    g.	Deploy IBM Case Manager Builder.

    h.	Deploy the IBM Case Manager Help System.

    i.	Deploy and Register Widgets Package.

    j.	Deploy the Forms Application.

    k.	Register the IBM Case Manager administration client plug-in.

    l.	Register Project Area.

     

     

    
      
        	
          Note: After the Register Project Area task completes, restart the WebSphere Application Server.

        
      

    

    Figure 4-34 shows the IBM Case Manager configuration tool.
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    Figure 4-34   IBM Case Manager tasks

    4.8  Verifying installed components

    Verify the version of each installed component by accessing the ping pages listed in Table 4-6.

    Table 4-6   Component ping pages

    
      
        	
          Component

        
        	
           Ping page

        
      

      
        	
          FileNet Content Platform Engine

        
        	
          http://<localhost>:9080/FileNet/Engine

        
      

      
        	
          IBM Process Engine

        
        	
          http://<localhost>:9080/peengine/IOR/ping

           

          User name: P8Admin 

          Password: See the file C:\Program Files (x86)\IBM\cmpit\accounts.txt

        
      

      
        	
          IBM Content Navigator

        
        	
          http://<localhost>:9080/navigator/Ping

        
      

      
        	
          IBM Case Manager

        
        	
          http://<localhost>:9080/CaseManager/CASEREST/v1/info

           

          User name: P8Admin 

          Password: See the file C:\Program Files (x86)\IBM\cmpit\accounts.txt

        
      

    

    Verify that you can log in to each component using the URLs listed in Table 4-7.

    Table 4-7   Component access URL

    
      
        	
          Component

        
        	
           Access URL

        
      

      
        	
          IBM Case Manager Builder

        
        	
          http://<localhost>:9080/CaseBuilder

           

          User name: P8Admin 

          Password: Refer file C:\Program Files (x86)\IBM\cmpit\ accounts.txt

        
      

      
        	
          IBM Case Manager Client

        
        	
          http://<localhost>:9080/navigator/?desktop=icm

           

          User name: P8Admin 

          Password: Refer file C:\Program Files (x86)\IBM\cmpit\
accounts.txt

        
      

      
        	
          IBM Case Manager Administration Console

        
        	
          http://<localhost>:9080/navigator/?desktop=icmadmin

           

          User name: P8Admin 

          Password: Refer file C:\Program Files (x86)\IBM\cmpit\ accounts.txt

        
      

      
        	
          IBM Content Navigator Administration Console

        
        	
          http://<localhost>:9080/navigator/?desktop=admin

           

          User name: P8Admin 

          Password: Refer file C:\Program Files (x86)\IBM\cmpit\
accounts.txt

        
      

      
        	
          FileNet Workplace XT

        
        	
          http://<localhost>:9080/WorkplaceXT

           

          User name: P8Admin 

          Password: Refer file C:\Program Files (x86)\IBM\cmpit\
accounts.txt

        
      

      
        	
          FileNet Content Platform Engine Administration Console

        
        	
          http://<localhost>:9080/acce

           

          User name: P8Admin 

          Password: Refer file C:\Program Files (x86)\IBM\cmpit\
accounts.txt

        
      

      
        	
          WebSphere Application Server administrator

        
        	
          https://<localhost>:9043/ibm/console/

           

          User name: P8Admin 

          Password: Refer file C:\Program Files (x86)\IBM\cmpit\
accounts.txt
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Implementing the IBM Case Manager use case

    In this chapter, we implement the IBM Case Manager use case scenario through the creation of a simple solution. This solution is built within IBM Case Manager and showcases the capabilities of IBM Case Manager 5.2. The solution, Customer Response Management, is a generic yet simple solution that serves as the building block for the final IBM Enterprise Content Management (ECM) solution where other IBM ECM products can integrate into. 

    This chapter shows how to accomplish the following tasks:

    •Create the solution.

    •Deploy the solution in IBM Case Manager Builder.

    •Test and validate the solution in IBM Case Manager Client. 

    5.1  Overview

    IBM Case Manager enables users to design and build a case management system easily. Caseworkers can manage cases through IBM Case Manager Client. Caseworkers can open and resolve work items, or create ad hoc tasks in IBM Case Manager Client. You can design a case management solution within IBM Case Manager Builder, and make changes to that solution. 

    Figure 5-1shows the use case diagram. For this IBM Case Manager piece, we are focusing only on the workflow and pieces that involve the routing of tasks and documents between roles and in the workflow.
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    Figure 5-1   Use case diagram for IBM Case Manager

    The following list describes an overview of the use case:

    Problem	Companies have situations where they must respond to and resolve customer requests, whether it is about their products, services, or account information. 

    Scenario	Our IBM Case Manager solution use case serves to demonstrate how a customer can call, and where a customer service representative (CSR) caseworker4 can initiate a new case.

    	It also shows how the CSR can then pass that case off to a Specialist, who handles the replacement or refund of the product or service. If needed, the Specialist can route the case to a Manager for further approval. The Manager sends the case back down to the CSR so that he or she can communicate the decision to the customer. 

    For more information about IBM Case Manager 5.2, see Advanced Case Management with IBM Case Manager, SG24-7929, on the following website:

    http://www.redbooks.ibm.com/abstracts/sg247929.html?Open

    For more information about our use case, refer to Chapter 2, “Use case scenario” on page 11.

    5.2  Prerequisites

    For prerequisite information, refer to Chapter 4, “Installing and configuring IBM Case Manager” on page 35. 

    5.3  How this ties into the scenario

    Case management was developed because certain business applications performed by knowledge workers require a great deal of flexibility, adaptability, control, and collaboration to achieve successful outcomes. Traditional ECM systems, and the structured control of business process management (BPM) are insufficient to meet the requirements of these applications. 

    In certain industries, such as healthcare, insurance, and the legal profession, case management is fairly well understood. The case management approach, however, can be successfully applied to a broad set of business applications. Doing so gives knowledge workers and businesses the capabilities that they need to achieve their business objectives.

    In this use case scenario, we start with IBM Case Manager Platform Installation Tool (CMPIT) that installs and configures the basic components of IBM Case Manager and IBM FileNet P8 in Chapter 4, “Installing and configuring IBM Case Manager” on page 35. In this chapter, we show how to implement an ECM solution with the basic case management capability. 

    In later chapters of this book, we integrate other IBM ECM products to add additional functions and capabilities to the ECM solution. 

    A business analyst can use IBM Case Manager to transform problems and scenarios into working solutions that can be managed with cases, roles, and processes in IBM Case Manager. For example, our use case scenario calls for a way for a company to handle customer requests, whether they be account-related, product-related, or service-related. A company can have various employees who are CSRs, Specialists, and Managers. 

    IBM Case Manager can declare a case type to be of Request, add the appropriate case properties of the request, and assign appropriate members to be roles in the solution. A business analyst can then construct the necessary workflow in the case type and get a a simple IBM Case Manager solution up and running with a few steps, as shown in this chapter. 

    In the event that the solution requires customization, the solution or application developer can easily create a new user interface pane (page) layout with different rows and columns, change the widget sizes, or create a custom property view to lay out the case properties. 

    With more complex scenarios, the solution or application developer has the Model application programming interface (API) toolkit that they can use in IBM Case Manager 5.2 to access IBM Case Manager classes and actions to 
build from.

    Implementing a robust and effective case management solution requires a software platform with a range of capabilities: 

    •Content management

    •Process management

    •Business rules

    •Collaboration

    •Analytics

    The solution must integrate seamlessly into the work environment of the case participants. The user interface must provide flexibility and enable a high degree of collaboration among the participants. For example, the interface must enable a user to dynamically add more tasks to a case already in process.

    At the end of this chapter, we have a simple working solution based on IBM Case Manager 5.2 that can be readily integrated into the other ECM products described in this book. 

    5.4  Instructions

    In this section, we provide information about how to create a solution in IBM Case Manager Builder, and then how to navigate through the solution in IBM Case Manager Client. 

    A solution is a set of related business problems or case types that tries to solve that problem. In a solution, we define documents, tasks, processes, and the attributes and roles of that business problem or case type. 

    Figure 5-2 shows the process of how to design and build a solution for IBM Case Manager.
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    Figure 5-2   IBM Case Manager solution building design and build process

    For detailed, step-by-step procedures to create a complete IBM Case Manager solution, refer to the IBM Redbooks publication, Advanced Case Management with IBM Case Manager, SG24-7929, on the following website: 

    http://www.redbooks.ibm.com/abstracts/sg247929.html?Open

    5.4.1  Creating a solution

    We create the Customer Response Management solution in IBM Case Manager Builder. To do so, follow these steps:

    1.	Start IBM Case Manager Builder and click the Add a solution link. 

    2.	When prompted, specify a name and a solution prefix for the solution. See Figure 5-3 for our use case scenario input.
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    Figure 5-3   Adding a solution in IBM Case Manager

    5.4.2  Adding case properties

    After adding the solution, you can edit the solution and start designing the solution within IBM Case Manager Builder:

    1.	In IBM Case Manager Builder, if you are not already on the Properties tab, click the Properties tab. 

    2.	Click Add Property to add the case properties. The properties are all string data types with the exception of dispute resolution resolved (boolean), invoice date (datetime), transaction date (datetime), and invoice total (float). For our solution, we add the following case properties, as shown in Figure 5-4 on page 80:

     –	Case ID

     –	Customer City

     –	Customer Country

     –	Customer Email

     –	Customer ID

     –	Customer Name

     –	Customer Phone

     –	Customer State

     –	Customer Street Address

     –	Customer Zip

     –	Description

     –	Dispute Resolution Response

     –	Dispute Resolution Resolved 

     –	Form Type

     –	Product ID

     –	Request Type

     –	Resolution

     –	Service ID

     –	Signature

     –	Total Amount

     –	Transaction Date 

     –	Invoice Total

     –	Invoice Date 

     –	Invoice Number

     

    
      
        	
          Note: These case properties can be organized into a custom view within a specific case type. Different views provide different layouts for the Properties widget in a case type in IBM Case Manager Client. For details about how to create a custom view, see the IBM Knowledge Center for IBM Case Manager 5.2:

          http://www.ibm.com/support/knowledgecenter/SSCTJ4_5.2.0/com.ibm.casemgmt.help.doc/acmsdh60.htm

        
      

    

    Figure 5-4 shows adding case properties.
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    Figure 5-4   Adding case properties in IBM Case Manager 5.2

    5.4.3  Adding roles

    A role defines and groups caseworkers by the type of work that they do. 

    To add roles in IBM Case Manager Builder, click the Roles tab, and then click Add Role to add the roles. 

    In our solution, we have three different roles:

    •Customer service representative

    The CSR is the main point of contact for the customer. In this simple example, the CSR takes a call from the customer and opens the case. In other scenarios, the CSR can open a case through other products, or a new case can be opened automatically.

    •Specialist

    The Specialist handles the evidence correspondence with the customer, and reviews the request that is routed from the CSR. 

    If needed, the Specialist routes to the Manager based on the total amount involved in handling the customer request. The Specialist can work on a case using IBM Case Manager on the desktop browser, or using a mobile device.

    •Manager

    The Manager handles any routed cases from the Specialist, and makes a final decision whether to approve or disapprove the case resolution. The Manager can also ask for more evidence from the Specialist. After the Manager makes the decision, it is communicated to the CSR.

    Figure 5-5 shows the three roles that we created for the sample solution.
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    Figure 5-5   Adding roles in IBM Case Manager 5.2

    5.4.4  Adding in-baskets

    An in-basket is used to view, open, and work with tasks and work items assigned to you or others in your role. An in-basket displays work items. Work items that were specifically assigned to you are in your personal in-basket as a caseworker. The work items assigned to a specific role are displayed in the role in-basket.

    A caseworker can handle work items directly from the in-basket by opening the work item. In-baskets can also be filtered to reduce the number of work items that are shown. 

    An in-basket can be configured to display the next work item automatically when the caseworker completes the opened work item. A caseworker can also add documents from a local system, the repository, or even a mobile device into the work item when the work item is opened from the in-basket widget in IBM Case Manager Client.

     

    
      
        	
          Note: By default, the in-baskets for each role and the personal in-basket are created already in IBM Case Manager Builder.

        
      

    

    5.4.5  Adding document types

    Document types are another item that we define in the IBM Case Manager solution. Document types help you to organize and associate documents that belong to a specific case type. There are various ways that documents can be added to a case instance, whether it is manual or automatic. 

    In the later sections of the book, we provide information about how different products can automate the adding and handling of documents in a case. 
The document types can be found under the Documents tab in IBM Case Manager Builder.

    In our solution, we define a document type to group and organize similar documents together. Then we can associate properties, which we defined in the case properties section earlier, to each specific document type.

     

    
      
        	
          Note: The properties associated with each document type should be unique and specific to that document type, because it serves as a way to identify that document type. 

        
      

    

    To add document types, click the Document Types tab and then click Add Document Type. 

    The following list includes the document types that we define in our solution:

    •Customer Thank You Correspondence

    The Customer Thank You Correspondence is a document type that is sent to the customer after the CSR initiates contact with the customer and creates a new case. The CSR sends this correspondence document to the customer to confirm that the customer has contacted the company and a case has been opened with their request. Information regarding their case ID and other case properties are included in this document.

    •Evidence Correspondence

    The Evidence Correspondence is a document type that is sent to the customer when the Specialist needs the customer to complete information regarding the product or service request type. The Specialist first sends the customer the document. The customer then fills it out and submits it back to the Specialist. There are different methods to send and receive this document by the Specialist. 

    At this stage of the solution building, we focus on the manual methods. In later chapters, we provide information about how other ECM products can automate and make this step more efficient.

    •Request Decision Correspondence

    The Request Decision Correspondence is a document type that is sent to the customer just before the case is completed. The CSR receives approval that the case is completed from either the Specialist or Manager. 

    In the case that the total amount is greater than $5,000 and requires management approval, the Manager approves the case resolution. Afterward, the CSR generates a document, notifying the customer of the outcome of the case, and then provides pertinent information about the case to the customer.

    •Request Classification

    The Request Classification is a document type that serves to integrate with the IBM Content Classification product. When incoming web comments from customers are classified using IBM Content Classification, and the comments require special handling, they are considered as this type of document. This classification initiates a new case with the available information.

    There are also IBM Content Navigator plug-ins available for download on IBM developerWorks® that can analyze the content of a document before it is added to a repository:

    http://ibm.co/1sfGHlN

     

    
      
        	
          Note: The IBM Content Navigator plug-in for IBM Content Classification enables a user to manually add a document and analyze the content of the document before it is added. Automating this process is described in Chapter 17, “Implementing an IBM Content Classification  use case” on page 539.

        
      

    

    You might also have additional document types depending on your own business needs and scenario. 

    For more information about document types in IBM Case Manager 5.2, see the following IBM Knowledge Center topic:

    http://www.ibm.com/support/knowledgecenter/SSCTJ4_5.2.0/com.ibm.casemgmt.help.doc/acmsdh09.htm

    5.4.6  Adding pages

    An IBM Case Manager solution can have multiple user interface (UI) screens. These screens are called pages for the solution. There are various pages that are available by default when you first create a solution in IBM Case Manager Builder. For the simplicity of this use case, we keep the default pages. A key highlight is that we have a ready-for-use working system by default when we created a solution and after we deploy the solution in IBM Case Manager Builder. 

    There are many ways to customize pages within Page Designer in IBM Case Manager Builder, including using the IBM Case Manager Model application programming interface (API) and the IBM Content Navigator API, as shown in Figure 5-6. 

    IBM Case Manager includes seven page types for every deployed solution:

    •Solution

    •Case Details

    •Add Case

    •Split Case

    •Add Task

    •Work Details

    •Custom Task Details
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    Figure 5-6   Editing the Cases page using Page Designer in IBM Case Manager Builder

    For this use case, we interact with the Cases, Work, Case Details, and Work Details pages. The pages can be found under the Pages tab in IBM Case Manager Builder.

    For more information about how to create a custom page in IBM Case Manager, see the following IBM Knowledge Center topic:

    http://www.ibm.com/support/knowledgecenter/SSCTJ4_5.2.0/com.ibm.casemgmt.help.doc/acmwrh00.htm

    You can obtain more information about the following topics:

    •Using the Page Designer component to customize pages with different layouts, custom property views, and custom page layouts

    •Using IBM Case Manager Model API with different customization scenarios

    To learn more, see Advanced Case Management with IBM Case Manager, SG24-7929:

    http://www.redbooks.ibm.com/abstracts/sg247929.html?Open

    5.4.7  Adding case types

    In our IBM Case Manager use case, we use only one case type, called Request. The case types can be found under the Case Types tab in IBM Case Manager Builder. 

    After creating a new case type named Request, it is important to configure what document type (defined earlier) can initiate a new case when a document of that particular document type is checked into the repository. 

    In our use case example, we define Request Classification to be the document type to initiate a new case, as shown in Figure 5-7.

    [image: ]

    Figure 5-7   Setting a document type as the starting document type in Case Manager Builder

    For more information about how to configure an initiating document type for a solution, see the IBM Knowledge Center for IBM Case Manager 5.2:

    http://www.ibm.com/support/knowledgecenter/SSCTJ4_5.2.0/com.ibm.casemgmt.development.doc/acmdv132.htm

    After creating the case type, it is important to add the case properties defined earlier to this specific case type. Figure 5-8 shows how to add a case property to the case type.
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    Figure 5-8   Adding properties to the case type in Case Manager Builder

    Creating a custom view

    In our solution, we created a custom view that lists the properties in a logical fashion. Custom views can be found under the Views section on the left side, as shown in Figure 5-9.
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    Figure 5-9   Accessing a custom view in IBM Case Manager Builder

     

    
      
        	
          Note: We have set the default view to be our custom view, View1. This overrides all of the pages that have a Properties widget on them to use this custom view, unless the Properties widget is set to use another custom view.

        
      

    

    In the next section, we cover how to define tasks in the step editor for this case type.

    5.4.8  Adding tasks in Step Editor

    In IBM Case Manager, a task is a specific activity that is performed as part of a case. A task can consist of one to many steps. The following list describes different types of tasks that can be predefined in IBM Case Manager:

    Required tasks	A required task is a task that is required for the case and can be started automatically or manually based on some pre-condition(s).

    Optional tasks	An optional task is a task that is optional for the case and can be started automatically or manually based on some pre-condition(s).

    Discretionary tasks	A discretionary task can be created or added by caseworker after a case is created. 

    Container tasks	A container task is a task that contains other tasks, which are subtasks. Container tasks can be set to start automatically, manually, or discretionary. 

    Subtasks	A sub task is a task within a container task. A sub task starts after its container task moves to the working state.

     

    
      
        	
          Note: To simplify a task, it is important to break up a large task into smaller, manageable tasks, and to divide each part of the workflow into each task.

        
      

    

    A task can also be a custom task, which means that caseworkers have the ability to open an ad hoc task to address any unexpected or one-time scenarios that come up. For example, in our use case, the CSR might make a one-time request to the Manager to review a certain work item because the customer has called in several times about the same request.

    A custom task differs from a discretionary task in that, when a caseworker adds a custom task, they are able to perform the following actions:

    •Insert a specific work item.

    •Define a decision point.

    •Provide a route that continues the task flow.

    •Delay the start of a work item until a specific date or for a specific amount 
of time. 

    For more information about tasks, see the following IBM Knowledge Center topic: 

    http://www.ibm.com/support/knowledgecenter/SSCTJ4_5.2.0/com.ibm.casemgmt.help.doc/acmsdh10.htm

    In our use case, we created three required tasks and two optional tasks within our case type in IBM Case Manager Builder, as shown in Figure 5-10.
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    Figure 5-10   The tasks for the use case in Case Manager Builder

    The next few sections describe each task that we created.

    Initial Large Request task

    The Initial Large Request task involves the CSR and the Specialist roles. This required task is started if the total amount involved is equal to or greater than 5000.

    The CSR receives a work item to send the Customer Thank You Correspondence document to the customer. After the CSR completes this task, the Specialist gets a work item to attach the Evidence Correspondence document type to send to the customer. This is the task that we focus on for this use case.

    Figure 5-11 shows the steps of the Initial Large Request task in the use case.
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    Figure 5-11   Initial Large Request task in Step Editor

    Initial Request task

    The Initial Request task is a required task that has a precondition set that the total amount is less than 5000. The Initial Request task is similar to the Initial Large Request task. The Initial Request steps are shown in Figure 5-12.
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    Figure 5-12   Initial Request steps

     

    
      
        	
          Note: Initial Large Request and Initial Request are part of a container set. Sets can be defined in the tasks section of a case type.

        
      

    

    Update Customer Info task

    The Update Customer Info task is an optional task that has a precondition that the request type is set to account. In our specific solution, we set it to a sub-step called System Update Customer Info. Depending on your own business needs or scenario, a service might need to be triggered to update the customer information if it exists in an external database outside of IBM Case Manager. 

    In our example, the CSR can take this step and update any of the case properties pertaining to the customer information. The steps for this task are shown in Figure 5-13.
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    Figure 5-13   Update customer info steps

    Process Evidence task

    The Process Evidence task is a required task that has a precondition set if the Evidence Correspondence document type is added to the case. This Evidence Correspondence document type can be added manually or in an automated fashion using IBM Datacap, as described in the later chapters. 

    After the Evidence Correspondence document is added to the case, a work item is assigned to the Specialist who needs to review the evidence. Then the Specialist can choose whether to refund or replace the product or service. 

    It is routed to the Manager, who can then approve, disapprove, or request additional evidence. For our use case scenario, the Manager approves the request and sets the Dispute Resolved property to be true to start the next required task, Send Final Response.

    The steps for the Process Evidence task are shown in Figure 5-14.
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    Figure 5-14   Process Evidence task in Step Editor

    Send Final Response task

    The Send Final Response task is a required task that has a precondition that Dispute Resolved is set to true. This is the final step of our use case scenario where after the Manager approves or disapproves the product or service, the CSR gets a work item to send the Request Decision Correspondence document to the customer. 

    The CSR attaches the document to the case, and then completes this step. The steps of the Send Final Response task are shown in Figure 5-15.
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    Figure 5-15   Send Final Response task steps

    These tasks in our solution are simplified, and can be expanded to meet your business needs or scenarios. More product integration and complex use cases are described in the later sections of this book.

    5.5  Verifying the solution in IBM Case Manager Client

    We validate the solution through IBM Case Manager Client in this section:

    1.	Make sure to click Save and Close in the upper right to exit Case Manager Builder with your saved changes. 

    2.	Next, click the Commit option on your solution to commit your saved changes. This is beneficial if multiple users are editing the solution at the same time. 

    3.	Next, click the Deploy option to deploy the solution. 

    These options are shown in Figure 5-16.
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    Figure 5-16   Commit and deploy for Case Manager Builder

    You can access IBM Case Manager Client by either clicking Test on the Customer Response Management solution, or by going to the following URL:

    http://<hostname>:<port>/navigator/?desktop=icm

     

    
      
        	
          Note: It is important to remember to commit and deploy your changes to the solution each time you validate the solution in IBM Case Manager Client. 

        
      

    

    Assigning your user to the roles

    Because this is a new solution, we want to add our user to the roles we created in the Customer Response Management solution: 

    1.	Click the solution menu on the far right and selecting a role, as shown in Figure 5-17.
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    Figure 5-17   Manage roles in Case Manager Client

    2.	After clicking Manage Roles, you can assign your user to the following roles: 

     –	Customer Service Representative

     –	Specialist

     –	Manager 

    Adding a case

    After entering your roles, you can see IBM Case Manager Client with the Cases and the Work pages, as shown in Figure 5-18.
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    Figure 5-18   Case Manager Client in IBM Case Manager

    To add a case, follow these steps:

    1.	Click Add Case under the Cases tab to add a new case. This opens the Add Case page, where you can enter values that were added in the case type window during IBM Case Manager Builder, as shown in Figure 5-19. 
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    Figure 5-19   Add Case page for Case Manager Client

    We complete the fields on this page manually, but in a more complex use case, we can start external data services calls to automatically complete these fields based on the Customer ID lookup. This involves some customization to the page, but can be integrated with IBM Case Manager. 

    In addition, new cases can be automatically opened when a document is processed, such as the Request Classification document type. We are able to automatically map document values from the document to the new case and create cases that way as well. In this example, we manually enter the values in a simple scenario.

    2.	After entering the values needed, we set the total amount to be greater than 5000 so that we can start the Initial Large Request task for this example and add the case.

    Opening the Send Thank You Correspondence work item

    As the CSR role, when we navigate to the Work page, we can see that we have one work item available in our in-basket widget on the page, as shown in Figure 5-20.
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    Figure 5-20   Work page for the Customer Service Representative in Case Manager Client

    To open the Send Thank You Correspondence item, follow these steps:

    1.	Click that work item. The Work Details page opens, as shown in Figure 5-21. 

    Note that the Properties widget is on the left in our previously defined custom view. In the center of the page, the Case Information widget contains the three tabs labeled Documents, Tasks, and History.
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    Figure 5-21   Work Details page for Send Thank You Correspondence

    2.	We can click the Correspondence folder, then the Letter folder, to choose where we want to store the Customer Thank You Correspondence document in our repository. 

    3.	Then we click Add in the Case Information widget to specify if we want to store a document from our local system or from the repository. If there is already a document added to the repository, we can select to store from the repository. If the document is stored on the local file system, we can select store from file system and it is made available on the repository for later uses.

    4.	With the appropriate configuration (not covered in this chapter), a caseworker can send a direct link to the document to the customer. This might require the customer to be able to log in or view the document with certain credentials. It is important to note that the CSR can send a direct link to this document, or send an email of this document to the customer directly, as shown in Figure 5-22.
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    Figure 5-22   Send a link or email to document in Case Manager Client

     

    
      
        	
          Note: Do not forget to ensure that you select the appropriate document type when adding documents to the case. In this case, we want to ensure that the Customer Thank You Correspondence document type is selected.

        
      

    

    5.	After selecting the appropriate option, we can complete this work item by clicking Complete on the far right of the page.

    Continuing on a case with a different role

    To continue a case with a different role, follow these steps:

    1.	Switch roles to the Specialist role in the upper right of IBM Case Manager Client, as shown in Figure 5-23.
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    Figure 5-23   Changing roles to Specialist in Case Manager Client

    2.	After navigating to the Work page, we can now see that the in-basket widget for the Specialist role has a new work item, as shown in Figure 5-24.
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    Figure 5-24   Viewing a work item in the Specialist in-basket widget

    3.	After you open this work item, it opens in the Work Details page. This work item enables the Specialist to provide the customer with the Evidence Correspondence document that is not yet filled out. 

    4.	After the customer completes it, the Specialist can attach the Evidence Correspondence document type to the case. The Specialist can also access this work item or case using a mobile device, which is described in Chapter 7, “Implementing an IBM Case Manager use case for mobile applications” on page 119. 

    5.	Following the same steps as the previous step, the Specialist can add the Evidence Correspondence document under the Documents tab for the Case Information widget, and then complete the work item. 

    6.	We then expect this document to be received from the customer, whether it is through email, fax, or other means. In this use case scenario, the customer can return the Evidence Correspondence document, and the Specialist can manually check it back into the case. 

    Alternatively, IBM Datacap can classify and ingest the document automatically as described in Chapter 9, “Implementing an IBM Datacap and Mobile Capture application use case” on page 185. 

    Adding a custom task

    IBM Case Manager enables a user to create an ad hoc task at any point during a case’s life. An example of this is if the customer is a high-profile customer that requires some special attention, or if the customer requires clarification about the case that was opened. The Specialist or CSR can create a custom task and assign it to the Manager to review. 

     

    
      
        	
          Note: The business analyst or solution developer needs to go into the case type in Case Manager Builder and then select the box labeled Enable caseworker to create custom tasks first.

        
      

    

    To add a custom task, follow these steps:

    1.	The CSR or the Specialist can do a search for the case on the Cases page using the Search widget. 

    2.	After opening the case in the Case Details page, the caseworker can then add a new custom task, as shown in Figure 5-25.
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    Figure 5-25   Adding a custom task

    3.	You can specify the values using the Custom Task Editor, and then click Validate.

    4.	Click Start to start the custom task, as shown in Figure 5-26.
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    Figure 5-26   Custom task editor

    For more information about custom tasks, see the IBM Knowledge Center for IBM Case Manager 5.2: 

    http://www.ibm.com/support/knowledgecenter/SSCTJ4_5.2.0/com.ibm.casemgmt.client.doc/acmrth09.htm

    Continuing the case with a task as initiated from a document type

    To continue the case, follow these steps:

    1.	After the Evidence Correspondence document is checked into the case, the Review Evidence task starts and a work item gets routed back to the Specialist, as shown in Figure 5-27. 
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    Figure 5-27   The Review Evidence task in the Specialist in-basket widget

    2.	After the Specialist reviews the Evidence Correspondence document from the customer, the Specialist can either respond with “refund” or “replace” within the Work Details page. 

    3.	The Manager then receives a work item.

    Escalating a case for Managerial approval

    To escalate a case, follow these steps:

    1.	After switching to the Manager role, navigate to the Work page and open the Manager Approval work item, as shown in Figure 5-28.
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    Figure 5-28   Manager Approval work item in Manager’s in-basket

    2.	The Manager is expected to gather analysis about this specific case, because the total amount is greater than 5000. In this simple use case, the Manager can review the case properties exposed on the Work Details page, and review the document types added by the CSR and the Specialist. 

    In a more complex scenario, the Manager can use IBM Watson Content Analytics and IBM Content Classification to do some detailed analysis into content in the repository about the specific customer or invoice, and make a more informed decision.

    3.	The Manager makes a decision, either approve, disapprove, or request additional evidence. In this use case scenario, the Manager approves the work item and completes it. 

    4.	Next, the Customer Service Representative closes the case and communicates to the CSR.

    Completing a case

    After the Manager approves the work item, switch roles to the Customer Service Representative. The Send Request Decision work item is in the Customer Service Representative’s in-basket widget as shown in Figure 5-29 on page 105.
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    Figure 5-29   Send Request Decision work item in Customer Service Representative’s in-basket

    5.	The CSR can add the Request Decision Correspondence document type to the case, and then complete the work item. The Request Decision Correspondence document is sent out to the customer, communicating the decision of the case that was opened. The CSR can then complete the case on the Work Details page.

    5.6  Using IBM Case Manager administration client

    The IBM Case Manager administration client is a web-based application that can help manage and administer your case management system, including your solutions. The IBM Case Manager administration client is useful for functions that a solution administrator would perform many times during a solution migration or deployment process, such as copying, importing, or exporting a solution, which topics are covered in this section.

    To access the IBM Case Manager administration client, use the following URL: http://<localhost>:<port>/navigator/?desktop=icmadmin

    Copying a solution

    Copying a solution can be useful to make a backup copy or to duplicate a solution for versioning purposes. Copying a solution can be done in IBM Case Manager Builder, but the IBM Case Manager administration client provides some extra options to the solution administrator. 

    To copy a solution, follow these steps:

    1.	After navigating to IBM Case Manager administration client, open the Design object store node and then open the Solutions folder. 

    2.	Right-click the specified solution and select Copy to open the wizard, as shown in Figure 5-30.
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    Figure 5-30   Starting copy on a solution in IBM Case Manager administration client

    3.	When the wizard opens, specify a different solution name and a solution prefix. 

    4.	Select the appropriate options according to your solution needs, as shown in Figure 5-31.
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    Figure 5-31   Copy solution wizard in IBM Case Manager administration client

     

    
      
        	
          Note: If you are already aware of validation errors, and can confirm that they do not interfere with your solution (such as creating additional steps in Process Designer), you can select Skip Validation.

        
      

    

    5.	Select Next and Finish on the copy solution wizard to copy your solution. Now we cover how to export a solution.

    Exporting a solution

    For solution migration purposes or other reasons, it might be necessary to export the solution using IBM Case Manager administration client: 

    1.	This can be done from the Design Object Store node and within the Solutions folder, as shown in Figure 5-32. 
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    Figure 5-32   Starting export solution in IBM Case Manager administration client

    2.	After the export solution wizard appears, follow the instructions displayed to export the solution as a compressed file package, which you can download and use for migration purposes. 

    Importing a solution

    Importing a solution can be useful for solution migration purposes, and can be done through the IBM Case Manager administration client. Importing a solution requires you to already have the exported solution package from the previous section:

    1.	This can be done from the Design Object Store node by clicking Import Solution as shown in Figure 5-33.
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    Figure 5-33   Starting import solution in IBM Case Manager administration client

    2.	Follow the instructions displayed after the wizard comes up to import the solution into your case management system. It is important to remember to deploy the solution after importing.

    For more information about how solution deployment and migration works in IBM Case Manager, see the following IBM Knowledge Center topic:

    http://www.ibm.com/support/knowledgecenter/SSCTJ4_5.2.0/com.ibm.casemgmt.design.doc/acmdc032.htm

    For a guide on the solution migration and deployment process, see IBM Case Manager 5.2 Solution Deployment Guide in developerWorks:

    https://www.ibm.com/developerworks/community/blogs/e8206aad-10e2-4c49-b00c-fee572815374/entry/ibm_case_manager_5_2_solution_deployment_guide?lang=en

    Configuring security and audit configurations

    In the IBM Case Manager administration client, you can configure security and audit on case management objects that are controlled from the Content Platform Engine. 

    For security, you can assign permissions to different users, groups, and roles to different areas or objects within a solution. These set of permissions are called a security configuration. There is a set of wizards available for the audit and security configurations for each solution:

    1.	To navigate to the wizard, select your Design object store, and select the appropriate solution. 

    2.	Right-click the solution and then select either configure security or configure auditing, as shown in Figure 5-34. 

    3.	Then, follow the instructions displayed for each window in the appropriate wizard.
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    Figure 5-34   Navigating to the security and auditing wizard

    For more information about security and auditing, see the following IBM Knowledge Center topic:

    http://www.ibm.com/support/knowledgecenter/SSCTJ4_5.2.0/com.ibm.casemgmt.design.doc/acmsc002.htm?lang=en

    Also, the developerWorks article, ICM 5.2 Security Model Considerations and Best Practices, provides information about the security and auditing examples and use cases in detail: 

    https://www.ibm.com/developerworks/community/blogs/e8206aad-10e2-4c49-b00c-fee572815374/entry/icm_5_2_security_model_considerat_ions_and_best_practices?lang=en

    5.7  IBM Case Manager complex use cases

    This section lists some of the many ways to enhance the Customer Response Management ECM solution. These complex use cases enable a solution developer or business analyst to add more functionality to IBM Case Manager. 

    ECM product integration

    As described in the later chapters of this book, there are many ECM products that can integrate with IBM Case Manager to provide powerful capabilities and functions to this ECM solution. 

    Initiating documents with automated document ingestion

    For more information about how to configure a solution to create a new case and document ingestion methods, see the following IBM Knowledge Center topic:

    http://www.ibm.com/support/knowledgecenter/SSCTJ4_5.2.0/com.ibm.casemgmt.development.doc/acmdv132.htm?lang=en

    External data services

    External data services can be extremely helpful when it comes to integrating external data systems with IBM Case Manager. You can use external data services to automatically populate the fields in a situation when the CSR opens a case based on the customer ID. 

    For more information about external data services, see the following IBM Knowledge Center topic:

    http://www.ibm.com/support/knowledgecenter/SSCTJ4_5.2.0/com.ibm.casemgmt.development.doc/acmdv101.htm

    Page customization and custom widget packages

    Customization of pages can vary from basic, intermediate, and advanced scenarios. Simple and intermediate page customization scenarios can include making a custom page layout or making a custom property view. You can also add custom actions using the widget settings for each ready-for-use widget in IBM Case Manager. 

    More advanced customization of pages uses custom scripts written using JavaScript, the Case Manager Model API, and the Content Navigator API. 

    Regarding the effort and expertise level that are required to develop a custom widget for mobile, it all depends on the complexity of the widget and the level of the customization. To develop widgets for IBM Case Manager, a developer must have knowledge about the Dojo framework and web development. 

    In addition, a knowledge about the process of developing and registering IBM Case Manager Page widgets is required. Knowledge about IBM Case Manager and IBM Content Navigator APIs are also preferred.

    Page customizations include but are not limited to the following scenarios:

    •Adding a button to the toolbar

    •Enumerating documents

    •Adding entry templates using custom action

    •Adding an attachment to file into the case without navigation to case folder

    •Creating an in-basket filter

    Custom widgets in IBM Case Manager are an advanced way to extend even more functionality and capability into IBM Case Manager using Dojo widgets that can be extended to use the IBM Case Manager existing widgets. Custom widgets enable the application developer to develop custom widgets that can be added to any page, and can behave like an existing IBM Case Manager widget.

    More details about these different customization scenarios and custom widget development can be found in Advanced Case Management with IBM Case Manager, SG24-7929: 

    http://www.redbooks.ibm.com/abstracts/sg247929.html?Open
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Installing and configuring an IBM Case Manager mobile application

    This chapter contains information about how to install and configure the IBM Content Navigator mobile application (app) to use IBM Case Manager. 

    This chapter describes the steps to configure the Customer Response Management solution that is created in this book so that it is accessible on a mobile device. Chapter 10, “Installing and configuring an IBM Content Manager OnDemand system” on page 259 covers different use cases of IBM Case Manager on the mobile app after you have successfully configured mobile capabilities for IBM Case Manager in this chapter.

    6.1  Overview

    With the IBM Content Navigator mobile app, you can browse, search, check-in or check-out, and review documents in a given repository. With IBM Case Manager in the IBM Content Navigator mobile app, you can access the normal functionality of IBM Case Manager with added mobile features.

    Figure 6-1 shows the use case solution components we build for this book. In this chapter, we build the IBM Content Navigator mobile component.
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    Figure 6-1   Use case context in relation to the overall solution components

    6.2  Prerequisites for this chapter

    The follow are the requirements for the scenario described in this chapter:

    •IBM Content Navigator mobile app from the Apple App Store

    •An Apple iPad with the current iOS version. 

    •A functional IBM Case Manager system (v5.2.0 or later)

    •Any necessary firewalls or network settings configured for your mobile device

    6.3  Instructions

    This section provides details about how to install and configure the IBM Content Navigator mobile app, and the IBM Case Manager desktop for mobile access. 

     

    
      
        	
          Note: The IBM Content Navigator mobile app and IBM Case Manager continue to be updated, so screen captures and features might vary.

        
      

    

    6.3.1  Installing the IBM Content Navigator Mobile App

    This section covers how to download the IBM Content Navigator mobile app from the Apple App Store onto an iOS device such as an Apple iPad. 

    Download IBM Content Navigator Mobile App from App Store

    To download the mobile app, follow these steps:

    1.	On your mobile device, open the Apple App Store and search for IBM Content Navigator () or follow the following direct link: 

    https://itunes.apple.com/us/app/ibm-content-navigator/id538507846?mt=8

    2.	Wait for the mobile device to download and install the IBM Content Navigator mobile app. After the download and installation process is done, you see the option to open the mobile app (as shown in Figure 6-2), and the IBM Content Navigator mobile app appears on the home page of your mobile device.
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    Figure 6-2   IBM Content Navigator in App Store

    6.3.2  Configuring IBM Case Manager for Mobile

    This section assumes that you have already successfully installed and configured IBM Case Manager using the IBM Case Manager Platform Installation Tool (CMPIT). If you do not have a CMPIT installation, refer to Chapter 4, “Installing and configuring IBM Case Manager” on page 35.

    To configure IBM Case Manager client for mobile apps, follow these steps:

    1.	Log in to IBM Content Navigator administration page. You can get there by entering the following URL into your browser:

    http://<servername>:<port>/navigator/?desktop=admin

    2.	After going to the IBM Content Navigator administration page, open the IBM Case Manager desktop and click the Mobile tab. Ensure that you enable mobile application access and select the appropriate options to enable users to perform the following actions (see Figure 6-3):

     –	Add photos from the camera and photo library.

     –	Add documents and create folders to the repository.

     –	Open documents in other applications.

    3.	Save your changes. You have now configured your IBM Case Manager desktop in IBM Content Navigator with the IBM Content Navigator mobile app.
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    Figure 6-3   Configuring IBM Case Manager desktop for mobile

    6.3.3  Configuring IBM Content Navigator mobile app

    After the IBM Content Navigator mobile app is downloaded to your mobile device, open the mobile app.

    IBM Content Navigator prompts you to set a passcode for the first time. You must enter that passcode each time that you open the mobile application.

    Connecting to your IBM Case Manager desktop

    To connect to the IBM Case Manager desktop, follow these steps:

    1.	After you have ensured that you have enabled mobile application access to your IBM Case Manager desktop, enter the name of the connection and the IBM Content Navigator URL of the server that you want to connect to, like that shown in Figure 6-4. For example consider the following URL:

    http://<servername>:<port>/navigator/
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    Figure 6-4   Connecting to an IBM Case Manager server in the IBM Content Navigator mobile app

    2.	Next, you enter the IBM Case Manager credentials of the server that you want to connect to, as shown in Figure 6-5, and then tap Save in the upper right. You can enable the IBM Content Navigator app to remember your credentials for future logins.
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    Figure 6-5   Entering credentials to connect to IBM Case Manager in the mobile app

    Accessing IBM Case Manager client for mobile

    After you successfully log in, you can search and browse your repositories in the IBM Content Navigator mobile app. Also, you can access the IBM Case Manager client for mobile by tapping on the folder icon, as shown in Figure 6-6.
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    Figure 6-6   Accessing IBM Case Manager client for mobile from IBM Content Navigator mobile app

    After that, the IBM Case Manager Client loads. In Chapter 7, “Implementing an IBM Case Manager use case for mobile applications” on page 119, we provide information about how to navigate and use IBM Case Manager client for mobile in the IBM Content Navigator mobile app.
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Implementing an IBM Case Manager use case for mobile applications

    This chapter describes the use case implementation for IBM Case Manager on the IBM Content Navigator mobile application (app).

    Using IBM Case Manager on a mobile device enables users to manage a case or work item on the go, and can keep the user connected to the status or state of a case. Caseworkers can process a case with the customer, or do an onsite visit and add photos or documents pertaining to the case.

    This chapter provides information about how using IBM Case Manager on a mobile device can enhance the Customer Response Management solution in this book. 

    7.1  Overview

    Adding mobility for the caseworker is the next step, and an important step, to enable users of IBM Case Manager and IBM Content Navigator to access content, work items, and business processes on the go with their mobile devices. Always being connected and informed is what the IBM Content Navigator mobile app with IBM Case Manager achieves. 

    Figure 7-1shows the use case diagram. In this diagram, we are focusing only on the mobile pieces where the user can access the content on a mobile device.
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    Figure 7-1   Use case diagram for IBM Case Manager mobile

    With the IBM Content Navigator mobile application, IBM Case Manager now has the following benefits:

    •Work with cases everywhere

    •Does not require changing the existing case desktop solution

    •Mobile-specific case workflows can also be designed

    As shown in the architecture diagram in Figure 7-2 on page 121, the user defines a page layout in IBM Case Manager Builder, and then two representations are laid out: 

    •One for desktop

    •One for mobile

    The IBM Content Navigator mobile app renders each page for the specified role with the according mobile or desktop version. In our case, we focus on describing the mobile version.
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    Figure 7-2   Architecture for rendering two representations for IBM Case Manager on mobile app

    As shown in the second architecture diagram in Figure 7-3 on page 122, the mobile version of IBM Case Manager Client does not simply render the same user interface (UI) as the desktop version, but injects mobile versions of the widgets and user interface to render the mobile interface of IBM Case Manager Client. This gives the mobile interface of IBM Case Manager Client a more mobile-friendly interface for users.

    Figure 7-3 shows the architecture for rendering mobile components.
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    Figure 7-3   Architecture for rendering mobile components into IBM Case Manager Client

    7.2  Prerequisites

    See Chapter 6, “Installing and configuring an IBM Case Manager mobile application” on page 113 for prerequisites.

    7.3  How this ties into the scenario

    This section provides information about the benefits of IBM Case Manager in a mobile space, and how IBM Case Manager client for mobile uses the functionality of IBM Case Manager on the desktop with the extensibility and flexibility of a mobile platform.

    IBM Case Manager client for mobile

    IBM Case Manager client for mobile extends the value of mobile Enterprise Content Management (ECM) to IBM Case Manager customers. It enhances the responsiveness and collaboration of all caseworkers. It also facilitates optimizations of work processes using lightweight mobile devices. 

    We can define two types of caseworkers in this scenario:

    •Office caseworker on-the-go

    The solution maintains a similar user experience across devices. There is no additional investment required for adding mobile support to a case solution.

    •Mobile caseworker

    IBM Case Manager client for mobile presents a mobile-specific user experience for enhanced productivity. 

    Design your solution once and display it on two platforms

    When you design your pages for your solution in IBM Case Manager Builder, these page layouts only have to be defined once to display in either the desktop browser or the mobile app, as shown in Figure 7-4. The desktop browser and the mobile app use the same layout. On the mobile app, the layouts are populated with mobile-enhanced widgets and native iOS user interface when needed. 
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    Figure 7-4   IBM Case Manager Client presented on desktop and on mobile

    7.4  Instructions

    The section provides instructions for various use cases that demonstrate IBM Case Manager client for mobile. These use cases involve our ECM solution, specifically the Customer Response Management solution, and the IBM Case Manager system that is set up with this book.

    7.4.1  Accessing IBM Case Manager Client

    After successfully logging in to your IBM Case Manager system using the IBM Content Navigator mobile app, you are presented with IBM Case Manager client for mobile. In our particular Customer Response Management solution, we load the Cases page first, as shown in Figure 7-5.

    Here we can navigate IBM Case Manager Client as a particular role, just as we would for the desktop version of IBM Case Manager Client. The Cases and Work tab are presented, in addition to the ability to search for cases on the Cases page. Next, we search for a case and open it.
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    Figure 7-5   Cases page on IBM Case Manager client for mobile

    7.4.2  Searching and opening a case

    You can search for cases using the Search widget on the Cases page using the mobile app. After the Case List widget renders the search results, you can open a specific case, show a link to the case, send a link to the case, show comments, or even add a custom menu action. This is important because the Customer Service Representative (CSR) can search cases on the desktop version in the same way that a Specialist can search for cases on the mobile app.

    As shown in Figure 7-6, we search for a case and then open it. We can see a special mobile-injected user interface when the user holds their finger on a case on the mobile device. A pop-up dialog appears that is mobile-specific, and that enables the user to navigate the mobile app in a more fluid fashion.
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    Figure 7-6   Search for a case and then open it in mobile Case Manager Client

    7.4.3  Adding a photo to the case

    After opening a case, you can perform a variety of actions, such as update a case property or add a document to the case. A specific feature to IBM Case Manager client for mobile is adding documents or photos directly from the mobile device. In our Customer Response Management solution, the Specialist can take a photo of the defective product and add it to the case.

    After you enabled the IBM Content Navigator mobile app to access your photos on the mobile device, you can add the photo to the case, as shown in Figure 7-7 on page 126. Likewise, you can also select a document. 

    This is important, because the Specialist can take a photo of the product when he or she does an onsite visit with the customer as part of their work item. This enables the CSR or the Manager to have more context about the case, and for the Specialist to keep track of the case with photos from the mobile device.

    Figure 7-7 shows adding a photo using the mobile app.
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    Figure 7-7   Adding a photo to a case in IBM Case Manager client for mobile

    After you choose a photo, you can click Add on the dialog window to add it to the case. For documents in other applications, you can select Open With in the other mobile app to open it in IBM Content Navigator to add it.

    Working on a work item and adding a custom task

    Using the mobile app, you can also open a work item and work on it, especially if you are a caseworker who is constantly in the field and away from a traditional office setting. You can also open a custom task that enables you to create an ad hoc task as a result of something that occurs in the field, as shown in Figure 7-8. For example, in the Customer Response Management solution, the Specialist might need to create a custom task to request the Manager look at a serious product defect when visiting a customer site. 
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    Figure 7-8   Adding a custom task in IBM Case Manager client for mobile

    7.5  Mobile Case Manager complex use cases

    There are additional complex use cases that can bring further capabilities to IBM Case Manager on the mobile app. These complex scenarios can be done through customization on the desktop app, and then rendered through the mobile app. The custom widgets here showcase one of the many ways to take advantage of a mobile device with IBM Case Manager.

    As shown in Figure 7-9, you can build a custom application, so that you can extend your own mobile application to the mobile platform, and add new capabilities into IBM Content Navigator or IBM Case Manager. The following list includes some optional extended capabilities: 

    •Mobile web application using Dojo Mobile or a similar framework

    •Extend from mobile-optimized layout of IBM Content Navigator

    •Extend from IBM Content Navigator native iOS client

    •Hybrid mobile application using IBM Worklight®
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    Figure 7-9   Architecture diagram to show how to use mobile applications for ECM

    Regarding the registration of custom widgets with IBM Case Manager on the mobile platform, it is important to notice that there is no difference between desktop widgets and mobile widgets in terms of registration. The widgets might differ in the Dojo libraries that they use for the purpose of being mobile compliant.

    For more information about these options to extend your own mobile application, see Customizing and Extending IBM Content Navigator, SG24-8055:

    http://www.redbooks.ibm.com/abstracts/sg248055.html?Open

    IBM Case Manager can be customized through the use of custom widgets. Figure 7-10 shows a custom widget that displays a map to guide the caseworker to a specific location, and another custom widget that enables the user to take a photo to attach to the case, and then later add a signature. 

    On the right side of Figure 7-10, you can see the Case Information widget, which is a ready-for-use widget with IBM Case Manager. In this customization, we added a new tab to the Case Information widget that hosts the Google map. To interact with the Google map, we used the Google JavaScript application programming interface (API) from the following website:

    https://developers.google.com/maps/documentation/javascript/tutorial

     

    
      
        	
          Note: When using external APIs such as Google JavaScript API, make sure to note the loading order of the libraries. To avoid issues, make sure to use the asynchronous functions of the APIs to ensure that all required dependencies are loaded correctly. This can be done using specific API mechanisms, or Dojo’s loading libraries, such as Dojo/On. 
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    Figure 7-10   Case Information and custom widget on IBM Case Manager client for mobile

    As shown in Figure 7-11, a custom widget enables the caseworker or customer to sign using his or her finger on the iPad, and then file t	hat signature into the case. The custom widget enables the user to add a new image to the case and add a signature to the case. Adding a new image to the case is done using the standard IBM Content Navigator APIs.

    To create the custom widget that enables adding a signature to a case, follow these steps:

    1.	Create a new dialog with a custom layout that will be built using Dojo. To support the signature functionality, add a Canvas element to the HTML template.

    2.	The implementation of the signature was done using three specific Dojo libraries: 

     –	Dojo Touch

     –	Dojo Gesture

     –	Dojo DomGeometry

    These specific libraries were used to support the functionality both on desktops and mobile devices, while using other implementations will result in an unexpected behavior on different devices.

    3.	When the user taps on the Save button, an event is fired to the underlying widget from which the signature image file is added to the case. 
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    Figure 7-11   Signature custom widget in IBM Case Manager client for mobile

     

    
      
        	
          Note: For support questions and answers about IBM Content Navigator mobile and IBM Case Manager client for mobile, post a question or view an answer on the following forum: 

          https://www.ibm.com/developerworks/community/forums/html/forum?id=11111111-0000-0000-0000-000000002868
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Installing, configuring, and deploying IBM Datacap and Mobile Capture program

    This chapter describes a pattern for deploying IBM Datacap and Mobile Capture program (Datacap), and its associated modules, on a single-server install pattern. 

    At a high level, the chapter provides information about the following topics:

    •Overview of IBM Datacap

    •Deployment considerations

    •Installation steps

    At the end of this chapter, you should be able to deploy the complete IBM Datacap stack that is required for use in the scenario.

    8.1  Overview of IBM Datacap

    IBM Datacap is an IBM Enterprise Content Management (ECM) product that provides advanced document capture capability in an ECM solution. Document capturing is an important requirement in managing the entire document imaging lifecycle. 

    The purpose of IBM Datacap is to digitize paper documents, extract useful information from them, and feed them into other business processes downstream. In this instance, the downstream processes are those that are managed using IBM Case Manager. The strength of IBM Datacap is its ability to perform these tasks with a high degree of automation and accuracy.

    Figure 8-1 shows the use case solution components we build for this book. In this chapter, we build IBM Datacap, one of the core components of the ECM solution. The shaded boxes with solid lines in the figure represent the components and products that we have already built.
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    Figure 8-1   Use case context in relation to the overall solution components

    Efficiency is derived from extracting pertinent data from the source paper document to automatically classify, index, organize, and route the document to the appropriate people, or to an automated processor. The data is extracted by using optical character recognition (OCR) or intelligent character recognition (ICR), bar codes, or other image technologies. 

    When the source is electronic documents, such as email messages and attachments, add-on components automatically extract and convert the individual attachments to a format that is suitable for long-term preservation. The IBM Platform also helps to ensure that the data is accurate (true to the original) and correctly formatted and normalized against your vendor database, client database, or purchase order system. 

    IBM Datacap also helps to ensure that the data can be used reliably in the business process. This capability applies to imported electronic documents, providing data consistency and validation across all of the types of media used for your business documents. IBM Production Imaging Edition provides business process automation and optimization tools to route the documents reliably, and to present them to users in a business context.

    8.1.1  IBM Datacap components and architecture

    IBM Datacap can be installed both as a single-server pattern, and in a multi-system client/server pattern. In production scale environments, the typical installation configuration for IBM Datacap is one where the various IBM Datacap components are installed on separate, dedicated machines.

    Performing a complete installation of IBM Datacap on a single machine enables you to set up and run IBM Datacap quickly, and without affecting anyone else in your organization. The installation method that is chosen for the scope of this is that of a single-machine install. Our aim is to demonstrate simple, entry-level installation, configuration, and building of an IBM Datacap application on a cloud environment. Figure 8-2 illustrates some of the main components installed. 
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    Figure 8-2   High-level IBM Datacap component diagram

    8.2  Deployment considerations

    IBM Datacap can be installed in a multi-server configuration. This makes it possible for IBM Datacap to scale to meet high-performance requirements. The multi-server setup also provides the flexibility to be deployed in a pattern that meets an organization’s best practice guidelines. An example of installation in a client/server environment can be found on the following website:

    http://www-01.ibm.com/support/knowledgecenter/SSZRWV_8.1.0/com.ibm.dc.install.doc/dc_install_cs.htm?lang=en

    In this book, we go over the process of installing IBM Datacap (Datacap) in a single-server configuration. To compliment the instructions that follow, and to see up-to-date detail for a single-server installation, see the following IBM Knowledge Center page:

    http://www-01.ibm.com/support/knowledgecenter/SSZRWV_8.1.0/com.ibm.dc.install.doc/dcain432.htm?lang=en

    8.2.1  Prerequisites 

    You can find the detailed hardware and software requirements for IBM Datacap on the following website:

    http://www-01.ibm.com/support/docview.wss?uid=swg27022094#DATA

    You can download the required installation file used in this chapter, IBM Datacap V8.1.0 Multiplatform Multilingual (CI9YJML), from IBM Passport Advantage:

    http://www-01.ibm.com/software/passportadvantage/pao_customer.html

    8.3  Installation steps

    In the scope of this book, IBM Datacap components are installed, configured, and run on a single Microsoft Windows machine. At a high level, the following steps are those that we take to install the IBM Datacap modules: 

    1.	Installing IBM Datacap

    2.	Configuring IBM Datacap Web

    3.	Installing IBM Datacap Web services

    8.3.1  Datacap installation

    The following components include those that are deployed by the install process:

    •IBM Datacap server service

    •IBM Datacap Rulerunner service (single thread)

    •IBM Datacap web client

    •IBM Datacap Taskmaster web services (wTM)

    •IBM Datacap Report Viewer 2 (RV2) web application

    •IBM Datacap FastDoc Capture

    You must configure the single machine for IBM Datacap authentication. The Datacap server service, Datacap Web application pool, RV2 application pool, and IBM Datacap Rulerunner Service use the default LocalSystem account on the single machine. In short, the Windows account that is used when you log in to the single machine must have administrator rights.

    The IBM Datacap installation and configuration steps are performed in the following sequence:

    1.	Add the local system account to the single machine’s Administrators group.

    2.	Run the IBM Datacap installation program, and install the Datacap software components and any additional components for which you have a license on the single machine.

    3.	Generate and Export the encryption keys.

    4.	Start the Datacap server service.

    5.	Run the Datacap TravelDocs application.

    6.	Stop the Datacap server service.

    7.	Configure Datacap Web.

    Installing IBM Datacap in a single-machine pattern

    Complete the following steps to install IBM Datacap:

    1.	Double-click to run IBM Datacap Capture installation program. The InstallShield Wizard welcome window displays (Figure 8-3 on page 136).

     

    
      
        	
          Note: The Windows local system account that is used needs to have Administrator rights. Ensure that the account is a member of the Administrators group.

        
      

    

    Figure 8-3 shows the InstallShield Wizard welcome window.
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    Figure 8-3   The InstallShield Wizard welcome window of the Datacap installation

    2.	Read and accept the terms and conditions of the license agreement.

    3.	Click Custom from the Setup type (Figure 8-4).
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    Figure 8-4   Select Custom when prompted for the Setup Type

    4.	Do not clear the default selections. Leave them as they are.

    5.	Confirm that the Taskmaster Server is selected for install. Expand the Taskmaster Client component and ensure that all of the components are selected for install. See Figure 8-5. 
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    Figure 8-5   Ensure that all of the components of the Taskmaster Client and Server are selected for installation

    6.	Confirm that wTM is selected for installation.

    7.	Expand the Connectors components. The first component is the connector to IBM FileNet P8, as shown in Figure 8-6. Select this feature for installation. Click Next when complete.
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    Figure 8-6   Select the FileNet P8 connector, which is typically listed first in the list

    8.	At a successful installation, you are presented with a window similar to Figure 8-7. Click Finish to complete.
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    Figure 8-7   A successful installation of Datacap

    Generating encryption keys

    You must generate security keys that enable Datacap to encrypt and decrypt passwords. To replace existing keys with new keys, you can specify a parameter to generate encryption keys to a local store. You can specify a different parameter to export the encryption keys from the local keystore to a file that can be imported to other computers.

    You must generate and use the security encryption keys that enable Datacap to encrypt and decrypt the passwords that are used by users, services, and processes to access the Datacap server service, and to log in to databases. In a single machine configuration, you must generate and export the encryption keys that all of the Datacap components on the single machine use.

    To generate encryption keys and export them, follow these steps:

    1.	Open a command prompt and navigate to the C:\Datacap\Taskmaster folder. 

    2.	Run the key management program by entering the dcskey.exe gnk e command. The parameters perform a generation and then an export:

     –	gnk: Generates, but does not export, encryption keys in the local keystore. You can use this parameter any time you need to replace existing keys with new keys. Note that if you were to generate a new key to replace an existing key, the newly exported keys would then need to be imported onto all other Datacap users in your configuration.

     –	e: Exports the encryption keys from the local keystore to a dc_KTF.xml key transport file. You can use this file to import the keys to other computers. If no keys exist in the keystore, the e parameter generates new ones before the export. If keys exist in the keystore, the e parameter exports those keys.

    A successful run of the command results in a window similar to that shown in Figure 8-8.
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    Figure 8-8   Successfully generating and exporting a Datacap encryption key

    8.3.2  Configuring the Datacap website

    You are able to run tasks through Internet Explorer when the Datacap web client is set up and configured. The following sections detail the procedure of configuring the Datacap website.

    Validating Microsoft .NET Framework and IIS

    When installing the Datacap web services, Microsoft Internet Information Services (IIS) needs to be installed before the Microsoft .NET Framework 3.5.1. If you are not sure if these components are installed in the correct sequence, the use of the ASP.NET IIS registration tool (aspnet_regiis.exe) enables you to register the .NET Framework with IIS. 

     

    
      
        	
          Note: Ensure that you are using an Administrator account to run these commands. aspnet_regiss.exe requires to be run in Administrator mode.

        
      

    

    The following steps illustrate how to use the registration tool:

    1.	Click the Start menu, right-click the Command Prompt window, and select Run as administrator.

    2.	Change the directory to where the aspnet_regiis.exe program is located. It is in C:\Windows\Microsoft.NET\Framework\v4.0.30319\.

    3.	Type aspnet_regiis.exe -i (make note if the -i switch). Figure 8-9 shows what your command prompt should look like. Press Enter to run the command.
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    Figure 8-9   Showing running of the aspnet_regiis.exe program with the -i switch

    4.	Progress messages are displayed indicating the start and completion. Figure 8-10 shows a successful run. After complete, close the Command Prompt window.
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    Figure 8-10   A successful run of the aspnet_regiis.exe -i command

    Configuration of the required IIS components

    There are specific IIS Web Server Role Services that need to be enabled and installed. For completeness, this section makes the assumption that none of the components are installed, and takes you through the installation of each of the components:

    1.	Click the Start menu. Select Administrative Tools and click Server Manager.

    The next few steps take you through installing the required Common HTTP Features components.

    2.	In the Server Manager hierarchy pane, expand Role Services, right-click, and select Add Required Role Services. You should be presented with a window, as shown in Figure 8-11 on page 141.

    3.	Expand Web Server and expand Common HTTP Features. Under Common HTTP Features enable Static Content, Default Document, Directory Browsing and HTTP Errors. Take particular care to clear WebDAV Publishing. (In the next section where you install and configure wTM, the WebDAV Publishing service installation prevents the wTM PUT method from functioning). Your settings should reflect those shown in Figure 8-11. 
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    Figure 8-11   Enabling the required Common HTTP Features

    4.	Click Next to continue the installation. You should see a window similar to Figure 8-12.
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    Figure 8-12   Showing the progress of installing the Common HTTP Features required by TMweb

    5.	On the Installation Results window, verify that the selected components are all listed as showing “Installation succeeded”. A successful installation is shown in Figure 8-13.
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    Figure 8-13   Successful installation of the Common HTTP Features required by TMweb

    The next few steps take you through installing the required Application Development components.

    6.	In the Server Manager hierarchy pane, expand Role Services, right-click and select Add Required Role Services. You would be presented with a window as shown Figure 8-14.
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    Figure 8-14   Add Role Services

    7.	Expand Web Server and expand Application Development. Under Application Development, enable ASP.NET, .NET Extensibility, ASP, ISAPI Extensions and ISAPI Filters. 

    Your settings should reflect those shown in Figure 8-15.

    [image: ]

    Figure 8-15   Enabling the required Application Development components

    8.	Click Next to confirm the components. 

    9.	You can visually verify the components, as shown in Figure 8-16. Click Install to continue the installation.
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    Figure 8-16   The required Application Development components ready for installation

    10.	Figure 8-17 shows a successful installation. 
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    Figure 8-17   Successful installation of the required Application Development components

    The next few steps take you through installing the required Health and Diagnostics components.

    11.	Similar to the previous steps, go to Add Required Role Services. Then Expand Web Server and expand Health and Diagnostics. Under Health and Diagnostics, enable HTTP Logging and Request Monitor. Your settings should reflect those shown in Figure 8-18.
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    Figure 8-18   Enabling the required Health and Diagnostics components

    12.	As in the installation for the previous components, click Next and Finish to continue the installation. 

    Figure 8-19 shows a successful installation for Health and Diagnostics components.
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    Figure 8-19   Successful installation of the required Health and Diagnostics components

    The next few steps take you through installing the required Security components.

    13.	Similar to the previous steps, go to Add Required Role Services. Then Expand Web Server and expand Security. Under Security, enable Request Filtering.

    14.	As in the installation for the previous components, click Next and Finish to continue the Installation. 

    The next few steps take you through installing the required Performance components.

    15.	Similar to the previous steps, go to Add Required Role Services. Then Expand Web Server and expand Performance. Under Performance, enable Static Content Compression. 

    Your settings should reflect those shown in Figure 8-20.
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    Figure 8-20   Enabling the Performance components required 

    16.	As in the installation for the previous components, click Next and Finish to continue the installation. 

    Figure 8-21 shows a successful installation for the Performance component.
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    Figure 8-21   Successful installation of the required Performance component

    The next few steps take you through installing the required Management Tools component.

    17.	Similar to the previous steps, go to Add Required Role Services. Expand Web Server and expand Management Tools. Under Management Tools, enable IIS Management Console. 

    Your settings should reflect those shown in Figure 8-22.
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    Figure 8-22   Enabling the required Management Tools component

    18.	As in the installation for the previous components, click Next and Finish to continue the installation. 

    Figure 8-23 shows a successful installation for the Management Tools component.
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    Figure 8-23   Successful install of the Management Tools component required 

    19.	Close the Server Manager window.

    Creating the Datacap website

    The following steps install and configure the Datacap website and also configures the tmweb.net application pool in IIS.

    1.	From the Start menu, navigate to the Taskmaster Web Server Configuration by selecting All Programs → Datacap → Administrator → Taskmaster Web → Taskmaster Web Server Configuration. See Figure 8-24 on page 154. When User Account Control (UAC) is on, the User Account Control window opens. Click Yes.
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    Figure 8-24   Launching the Taskmaster Web Server Configuration

    2.	If all of the items that are listed in the information box are Found, click OK. See Figure 8-25.
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    Figure 8-25   All of the IIS Components required for Taskmaster Web are found

    3.	The Taskmaster Web Server Configuration panel launches. See Figure 8-26. Click Configure.
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    Figure 8-26   The Taskmaster Web Server Configuration panel

    4.	An information box indicating a successful configuration opens. See Figure 8-27. Click OK and Then Exit. 
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    Figure 8-27   Taskmaster Web Server successfully configured

    At this stage, the site for Taskmaster Web is created. The next series of steps are about configuring IIS using the IIS Manager.

    5.	From the Start menu, navigate to the IIS Manager by selecting Control Panel → System and Security, then double-click Internet Information Services (IIS) Manager. See Figure 8-28.
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    Figure 8-28   Launching the IIS Manager

    6.	In the Connections pane, expand the computer node (in this particular example the computer node is EC4A01-W1), expand the Sites node, and expand the Default Web Site. 

    7.	The tmweb.net site should be displayed. If it is not displayed, right-click the site and select Refresh. See Figure 8-29.
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    Figure 8-29   Displaying the properties for the tmweb.net in IIS Manager

    8.	Now, in the Application Pools pane, select the tmweb.net application pool. In the Actions pane on the right, in the Edit Application Pool section, click Advanced Settings. See Figure 8-30.
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    Figure 8-30   Selecting advanced settings for the tmweb.net Application Pools

    9.	When clicking the Advanced Setting in the previous step, a window as shown in Figure 8-31 opens.
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    Figure 8-31   Advanced Settings for the tmweb.net application pool

    10.	Scroll to the Process Model section and click the browse button (ellipses) to the right of Identity. See Figure 8-32.
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    Figure 8-32   Clicking the Identity of the Process Model in Advanced Settings for tmweb.net

    11.	Clicking the browse button to the right of Identity opens an Application Pool Identity dialog window, as shown in Figure 8-33.
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    Figure 8-33   Application Pool Identity window 

    12.	In the Application Pool Identity window, change the Built-in account to LocalSystem, as shown in Figure 8-34. Click OK.
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    Figure 8-34   Changing the Application Pool Identity to LocalSystem

    13.	In the Process Model section, set Load User Profile to True. See Figure 8-35. Click OK to close the Advanced Settings window.
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    Figure 8-35   Set the Load User Profile to True

    14.	Back in the ISS Manager, expand the Sites node in the Connections pane. 

    15.	Expand the Default Web Site node. Select the tmweb.net site and, in the middle pane, double-click Session State. See Figure 8-36.
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    Figure 8-36   Selecting the Session State for tmwen.net

    16.	Scroll to the Cookie Settings section. Change the Name to tmweb. See Figure 8-37. In the far right Action pane, click Apply.
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    Figure 8-37   Changing the Cookie Settings name to tmweb

    17.	Back in the Connections pane, select Default Web Site. In the far right Actions pane, under Manage Web Site, click Restart. See Figure 8-38.

    [image: ]

    Figure 8-38   Restarting the Default Web Site after settings have been applied

    Adding the tmweb.net address as a trusted site

    You must add the tmweb.net address as a trusted site in a single-machine installation to prevent Internet Explorer from blocking access to the Taskmaster website. In a single-machine installation, you can enter the default server address as a trusted site for Internet Explorer access to the Taskmaster website.

    Complete the following steps to add the tmweb.net address:

    1.	Open Internet Explorer.

    2.	On the Tools menu, select Internet Options to open the Internet Options dialog. 

    3.	Click the Security tab to display the options.

    4.	Select trusted sites and click Sites to open the Trusted Sites dialog.

    5.	Enter the default server address http://localhost in the Add this website to the zone field, then click Add.

    6.	Close the Trusted Sites dialog and select OK to close the Internet Options dialog.

    Configuring Internet Explorer 

    This procedure provides instructions on how to set up Internet Explorer using the Taskmaster Web Client Configuration tool in a single-machine configuration. When you configure Internet Explorer, you can use the Taskmaster Web client for processing tasks. This procedure also provides instructions on how to test your configuration of Internet Explorer.

    Configure Internet Explorer as follows:

    1.	From the Start menu, select All Programs → Datacap → Administrator → Taskmaster Web → Taskmaster Web Client Configuration. See Figure 8-39. When User Access Control is on, the User Account Control window opens. Click Yes.
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    Figure 8-39   Launching the Taskmaster Web Client Configuration

    2.	Ensure that http://localhost is the default URL that is displayed. See Figure 8-40. Click Configure.
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    Figure 8-40   Details needed for the Taskmaster web configuration

    3.	A successful configuration displays a window as shown in Figure 8-41. Click OK, and Exit.
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    Figure 8-41   Successful completion of the Taskmaster web configuration

    4.	Start Internet Explorer and enter the URL for Taskmaster Web, followed by the tmweb.net virtual directory and the test page, http://localhost/tmweb.net/ ietest.aspx. Click Test. When User Access Control is on, the first time you access the test page, the User Access Control window opens. 

    5.	Click Yes to download the Datacap TIFF Viewer, Thumbnails, and DataEdit Controls.

    6.	The green check marks are displayed when the test completes successfully. You should see a window similar to Figure 8-42. Note that If the Datacap TIFF Viewer does not download, switch to the 32-bit version of Internet Explorer and repeat this procedure from step 1.
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    Figure 8-42   Successful verification of Taskmaster Web

    8.3.3  Starting and validating

    To verify that the Taskmaster server is running, complete the following steps:

    1.	Click Start → All Programs → Datacap → Administrator → Taskmaster → Taskmaster Server Manager.

    2.	On the Service tab in Taskmaster Server Manager, verify that the status is Running.

    3.	If the status is not Running, click Start.

    4.	Confirm that the status is Running and then click Close. The server is now running in the background.

    The Datacap install includes a sample application called TravelDocs. To open the TravelDocs application:

    1.	Click Start → All Programs → Datacap → Developer → Datacap Studio.

    2.	In the Select Application window, select the TravelDocs application and click Next.

    3.	In the Taskmaster Login window, ensure that the NT authentication check box is not selected.

    4.	Enter these values for the fields:

     –	User ID: admin

     –	Password: admin

     –	Station ID: 1

    5.	Click Finish.

    8.3.4  Installing Taskmaster Web Services

    The wTM enables you to interact with Datacap using a simple Representational State Transfer (REST) application programming interface (API). Importantly, wTM is also used by the Mobile iOS application.

    The steps that you must follow to install and configure Taskmaster Web include ensuring that the required IIS components are installed, and creating the Taskmaster website. You use the Taskmaster Web Server Configuration tool to set up the Taskmaster website for a single-machine configuration. A single-machine configuration requires the tmweb.net application pool to be set for the LocalSystem account. 

    The wTM installation and configuration steps are performed in the following sequence:

    1.	Ensuring that an account exists for wTM

    2.	Setting up permissions on the Datacap folder

    3.	Ensuring that the needed IIS components are installed

    4.	Installing wTM

    5.	Configuring the wTM website, application pool, and advanced settings

    6.	Configuring Internet server API (ISAPI) extensions

    7.	Validating the wTM installation

    Ensuring that an account exists for wTM

    Datacap does not require that a unique Windows account is set up for wTM. In our installation, wTM is installed on the same web server and uses the same Windows account.

    Authenticating wTM

    Datacap and wTM can be configured to use a variety of Taskmaster authentication, or to use one of the following external authentication methods:

    •Taskmaster authentication (TMA)

    •Windows Active Directory Service Interfaces (ADSI)

    •Windows Active Directory Lightweight Directory Services (ADLDS)

    •Lightweight Directory Access Protocol (LDAP)

    •Low-Level Lightweight Directory Access Protocol (LLLDAP)

     

    
      
        	
          Note: Taskmaster Web Services trusts that only authorized connections can access the wTM Hypertext Transfer Protocol (HTTP) Internet Protocol (IP) address. 

        
      

    

    In this build, we use Datacap authentication. wTM uses the definitions in the C:\Datacap\wTM\web.config file to determine the names of the keys that are stored in the Taskmaster Application Manager. 

    The following steps show where to locate these definitions:

    1.	Open Windows Explorer and navigate to C:\Datacap\wTM\web.config.

    2.	Open the web.config file in a text editor (or, if you do not have a preferred text editor, use Notepad, which should be installed by default on Windows).

    3.	Verify that the following settings “pathUser” “pathPassword” and “pathStation” matches those shown in Figure 8-43:

     –	pathUser

     –	pathPassword

     –	pathStation

    In a default web.config file, this is around line 62 of the file.
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    Figure 8-43   Default web.config file

    Setting permissions on the Datacap folder

    The wTM account requires the appropriate security permissions on the Datacap folder. During the initial installation and configuration of the Datacap server, other accounts were granted the appropriate security permissions. 

    Use the following steps to set the permissions on the Datacap folder:

    1.	Open Windows Explorer, navigate to C:\Datacap.

    2.	Right-click the Datacap folder and select Properties.

    3.	Click the Security tab to display it. 

    4.	Click Edit. 

    5.	Add or ensure that the Administrator group is set at a minimal to allow Read. 

    We have left the defaults. The Administrator group has full control of the Datacap folder, as shown in Figure 8-44.
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    Figure 8-44   The permissions dialog for the Administrator group

    6.	Add or ensure that the Users group is set at a minimal to allow Read. (We have left the defaults, as seen in Figure 8-45).
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    Figure 8-45   The permissions dialog for the Users group

    Ensuring that the needed IIS components are installed

    The required IIS components were configured when you set up Taskmaster Web (“Configuration of the required IIS components” on page 140). The following steps describe how to verify that the required IIS components are indeed installed:

    1.	From the Start menu, select Administrative Tools → Server Manager.

    2.	In the Server Manager hierarchy pane, expand Roles, and then select Web Server (IIS).

    3.	In the Web Server (IIS) pane, expand Role Services, and under Common HTTP Features, ensure that Static Content, Default Document, Directory Browsing, and HTTP Errors are installed.

     

    
      
        	
          Note: Take particular care to clear WebDAV Publishing. Installing the WebDAV Publishing service prevents the wTM PUT method from functioning. 

        
      

    

    4.	In the Role Services pane, under Application Development, ensure that the ASP.NET, .NET Extensibility, ASP, ISAPI Extensions, and ISAPI Filters are installed.

    5.	In the Role Services pane, under Health and Diagnostics, ensure that HTTP Logging and Request Monitor are installed.

    6.	In the Role Services pane, under Security, ensure that Request Filtering is installed.

    7.	In the Role Services pane, under Performance, ensure that Static Content Compression is installed.

    8.	In the Role Services pane, under Management Tools, ensure that IIS Management Console is installed.

    9.	Close the Server Manager window.

    In case any one of the services are not installed, use the procedure described in “Configuration of the required IIS components” on page 140 to install the required service.

    Installing wTM

    wTM is selected as a default component when installing Datacap. wTM is installed along with the Datacap installation. See 8.3.1, “Datacap installation” on page 135 for the Datacap installation details.

    Configuring the wTM website

    Complete the following steps to configure the wTM website:

    1.	Start the IIS Manager. Go to Start → Administrative Tools → Internet Information Services (IIS) Manager.

    2.	In the Connections pane, expand the computer node (in this case, the computer node is EC4A01-W), right-click Sites, and select Add Web Site. 

    3.	Set Site name to wTM. The Application pool is automatically set to wTM. 

    4.	Under Content Directory, set Physical path to C:\Datacap\wTM (which is the installation folder for wTM).

    Your settings should reflect those shown in Figure 8-46.
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    Figure 8-46   Setting the site name for wTM

    5.	Under Binding, select the IP address of the web server. Change the port number to 90. We do this because when Taskmaster Web and wTM are installed on the same web server, Taskmaster Web will not work unless wTM is assigned a different port number. 

    Your settings should reflect those shown in Figure 8-47.
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    Figure 8-47   Setting the port for wTM

    6.	Click OK to close the Add Web Site dialog.

    7.	In the Connections pane, click Application Pools.

    8.	In the Application Pools pane, select the wTM application pool, 

    9.	In the Actions pane (the pane on the far right), under the Edit Application Pool section, you see Advanced Settings, as shown in Figure 8-48.
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    Figure 8-48   The layout of the Application Pool’s Advanced setting

    10.	Click Advanced Settings under Edit Application Pool. The Advanced Settings dialog opens.

    11.	Under the General section ensure that the following settings have been made:

     –	The .NET Framework Version is set to v4.0.

     –	Enable 32-Bit Applications is set to True.

     –	Managed Pipeline Mode is set to Integrated.

     –	Start Automatically is set to True. See Figure 8-49.
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    Figure 8-49   Settings for the General section in Advanced Setting for the wTM Application Pool

    12.	In the Process Model section, Find the Identity row and click the browse button to the right of Identity. The Application Pool Identity window opens. 

    13.	Select Custom account and click Set. The Application Pool Identity window is as shown in Figure 8-50.
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    Figure 8-50   The wTM Application Pool Identity window

    14.	In the Set Credentials window (which opens when you click Set in the previous step), enter p8admin for the User Name. For the Password, see the C:\Program Files (x86)\IBM\cmpit\accounts.txt file. 

    15.	Click OK, as shown in the Set Credentials window in Figure 8-51.
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    Figure 8-51   The Set Credentials window for the wTM Application Pool Identity

    16.	Still staying in the Process Model section, set the Load User Profile to True. Your settings should resemble those shown in Figure 8-52.
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    Figure 8-52   The required settings for the wTM Application Pool

    17.	In the Actions pane, under Application Pool Tasks click Recycle.

    18.	In the Connections pane, under the computer node (in this case, the computer node is EC4A01-W), then under the Sites node select wTM.

    19.	In the Actions pane, which is the right-most pane under Manage Web Site, click Restart. See Figure 8-53.
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    Figure 8-53   Restarting the wTM Web Site

    Configuring ISAPI extensions

    The ISAPI extensions need to be enabled for all verbs such as GET, PUT and POST. The following steps show how to enable the ISAPI extensions by configuring the web services extension list:

    1.	Start the IIS Manager by going to Start → Administrative Tools → Internet Information Services (IIS) Manager.

    2.	In the Connections pane, expand the computer node (in this case, the computer node is EC4A01-W). Select the wTM website and, in the wTM Home pane, double-click Handler Mappings.

    3.	In the list view of the Handler Mappings, scroll down to find the svc-ISAPI-4.0_32bit. Ensure it is enabled. You should see a window similar to Figure 8-54.
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    Figure 8-54   Ensuring that svc-ISAPI-4.0_32bit is enabled in the Handler Mappings

    4.	Select svc-ISAPI-4.0_32bit. In the right Actions pane, click Edit Feature Permissions. 

    5.	Select Read, Script, and Execute. Your settings should reflect Figure 8-55. Click OK.

    [image: ]

    Figure 8-55   The Edit Feature Permissions for svc-ISAPI-4.0_32bit

    6.	Select svc-ISAPI-4.0_32bit. In the right Actions pane, click Edit. This opens the Edit Script Map dialog, similar to Figure 8-56.
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    Figure 8-56   The Edit Script Map dialog

    7.	Click Request Restrictions. This opens the Request Restrictions dialog.

    8.	On the Request Restrictions dialog, click the Verbs tab. Select All verbs. Your setting should be similar to Figure 8-57. Click OK. 
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    Figure 8-57   Enabling All Verbs in the Request Restrictions dialog

    9.	On the confirmation window, click Yes.

    Validating the wTM installation

    You can validate the wTM installation by viewing the wTM help page. 

    Open Internet Explorer and enter the help page URL: 

    http://<WebServerName or IP address>:<port number>/ServicewTM.svc/help

    In this example, the URL is the following website:

    http://127.0.0.1:90/ServicewTM.svc/help

    You should see the help page, as shown in Figure 8-58.
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    Figure 8-58   Help page of wTM demonstrating a successful installation
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Implementing an IBM Datacap and Mobile Capture application use case

    This chapter provides information about the capabilities and considerations of using readily available mobile devices, such as mobile camera phones or miniature tablets for image capture.

    It also covers a simple use case for the application of such capabilities. The chapter then goes on to describe how this particular use case can be developed into a working solution.

    9.1  Overview

    IBM Datacap is a powerful tool for capturing content from a variety of entry points in differing formats, and extract indexing and application data, for storage into various backend systems. It helps eliminate labor-intensive document preparation and manual data entry, therefore expediting the capture process, and improving data accuracy.

    IBM Datacap can help you perform the following tasks:

    •Capture content from a variety of ingestion points, including scanners, multifunction devices (MFDs), fax servers, email systems, web enabled mobile devices, and file systems.

    •Capture machine print, handprint, check box, and bar code data using multiple recognition engines, such as optical character recognition (OCR), intelligent character recognition (ICR), and optical mark recognition (OMR),. to reduce manual data entry.

    •Apply validation routines and methods using database lookups, mathematical calculations, patterns, and check digits to ensure data accuracy.

    •Integrate with a variety of IBM and non-IBM Enterprise Content Management (ECM) repositories, including IBM Content Manager, IBM FileNet Content Manager, IBM FileNet Image Services, OpenText LiveLink, EMC Documentum, and Microsoft SharePoint.

    IBM Datacap provides two approaches to building capture applications. 

    The first approach is to use IBM Datacap Studio. This enables application developers to build an application from the ground up using their own approach and methodology. This provides powerful and granular customization of the capture application.

    The alternative approach is to use IBM Datacap FastDoc. This provides a base level framework, entry-level user interface (UI), and rapid application development (RAD) environment to expedite and standardize the development process. 

    After the core application is developed, the application developer can then use IBM Datacap Studio to make alterations and enhancements to the capture application where needed.

    Historically, IBM Datacap FastDoc was its own application, and was a separate download and install from the core IBM Datacap product. However, in IBM Datacap 8.1 and later, the FastDoc component was included in the core product to provide the enhancements.

    For the IBM Datacap use case being addressed in this book, we use the capabilities of IBM Datacap FastDoc to build our application. The following list includes some advantages of this approach:

    •Standardized approach to building an application

    •RAD capabilities to speed up the development process

    •A simplified way of building a capture application and exporting out to IBM FileNet Content Manager

    9.2  Introduction to mobile capture

    In today’s market, customers expect answers to their questions in real time. They expect paper to process in a similar time frame to digital requests. In short, the customer expects more and faster functionality.

    One possible way of meeting this demand is to capture your paper-based documents at the point of origin. Capture the image while the signature is still wet on the page. By capturing immediately, this removes delay in transferring the paper to a central location for preparation and scanning. It also removes the risk of loss or theft of highly sensitive documents.

    Other use case scenarios include mobile workers who are away from the office for extended periods of time. They might also work in more remote locations where transport of a dedicated scanning device is simply not practical or possible.

    Historically, images were captured solely on dedicated scanning devices using either a sheet feeder, or a glass panel. These devices are typically set up and maintained for optimum scanning of documents.

    Use of a mobile camera on a mobile device differs significantly from this approach. Cameras can distort images in a variety of ways. In the following section, we cover a few of the shortcomings to be aware of when using a mobile device.

    Exposure used

    Exposure is about how much light you let into the camera. Too much light, and your images appear washed out; too little light, and they will be too dark. It is possible to correct a poorly exposed image using software afterward, but only to a certain degree. Software can also guide you to capturing an optimally exposed image, as you see in the use case example. 

    An example of good, underexposed, and overexposed is shown in Figure 9-1.
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    Figure 9-1   Examples of good, overexposed, and underexposed images

    Angle the captured image

    If the paper is not aligned to the camera lens, it can appear distorted. This is known as the keystone or tombstone effect. The captured image results in dimension distortion, making it look like a trapezoid, the shape of an architectural keystone. When applying technologies such as OCR, this can cause undesirable results due to differences in character size and shape. 

    It also does not provide a suitable representation of the original document for storage. It is possible to correct a misaligned page using software, as you see in the use case example. Examples of an angled image and a fixed image are shown in Figure 9-2.
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    Figure 9-2   Examples of an angled image and fixed image

    Image blur

    Due to the fact that a mobile device is operated by a user holding the device in their hand, there is the possibility of hand shake or wobble. This can cause image blurring not usually encountered when using a stable desk scanner. This can affect the quality of the captured image, affecting the definition of the image characters and therefore the OCR results. 

    It is possible to correct an element of image blur using software. An example of a blurred and fixed image is shown in Figure 9-3.
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    Figure 9-3   Example of a blurred and fixed image

    Skewing

    Although skewing still occurs on dedicated scanners, it can be more acute on a mobile device. When using a mobile camera, there are no physical guidelines or rails to align images against. Therefore, obtaining that perfectly aligned scan is tricky. Use of software can de-skew images. 

    Typically, this is done by identifying lines and words on a page, and using these as the reference point to determine the skew angle. An example of a skewed and de-skewed image is shown in Figure 9-4.

    [image: ]

    Figure 9-4   Example of a skewed and de-skewed image

    Resolution used

    The image resolution used determines the level of detail used to capture an image. The greater the resolution in dots per inch (dpi), the more detail that can be captured, and therefore interrogated, during the capture process. Similarly, the lower the resolution used, the less detail that can be captured. The result is that OCR results can differ greatly depending on the resolution used. 

    The issue here is that the higher the resolution used, the larger the file size, and therefore increasing the storage cost. In the case of mobile capture, the amount of bandwidth required to transfer the image also increases with image size, which can also exacerbate cost and upload times. An optimum image size and resolution is therefore desirable. This is covered later in this use case. An example of a high-resolution and low-resolution image is shown in Figure 9-5.
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    Figure 9-5   Example of a high-resolution and low-resolution image

    Color versus black and white 

    For OCR, it is desirable to capture an image in black and white. This is because it provides a clear distinction between what is a mark and what is background. Mobile cameras, by default, take an image in color and then convert it to black and white. Therefore, there is the possibility of losing definition you might have captured if you were using a dedicated scanner. 

    Although IBM Datacap does support color OCR, for the purpose of this use case, we will use black and white OCR.

    The user

    With all of these issues, we must also take one other factor into consideration: The user. Mobile capture users are typically users who have had no education about how to prepare or scan documents optimally. Some will not be too concerned if the image is skewed or distorted. In their minds, the image is captured, so their job is complete. Therefore, we should look, where possible, to guide these users into capturing an optimal image. 

    9.3  Representational state transfer

    The IBM Content Navigator Mobile application makes use of IBM Datacap Taskmaster web services (wTM), which was released in IBM Datacap 8.1 to drive the functionality of the mobile app. 

    wTM is a Microsoft Internet Information Services (IIS) application (app) which serves out several endpoints from IBM Datacap. Interfacing to these endpoints over a network, and using them in a variety of combinations, enables an app to be constructed to work remotely with IBM Datacap.

    For an introduction to representational state transfer (REST), read the IBM developerWorks article, RESTful Web services: The basics: 

    http://www.ibm.com/developerworks/webservices/library/ws-restful/

    If you are interested in exploring this topic, IBM provides a test tool created to introduce wTM. The test tool is located at the following website:

    http://www.ibm.com/developerworks/apps/download/index.jsp?contentid=832522&filename=wTMSample.zip&method=http&locale=

    9.4  The mobile use case

    Users have a requirement to capture images, but they face several challenges in capturing the images correctly. In this book, we define two scenarios for the use of mobile capture. 

    When a customer signs up for an account, they are typically required to sign and date a form to give acknowledgment to the terms and conditions of that contract. If the user is present at a physical location where the form is printed, this does not prove a problem. The form is simply printed, completed by the customer and captured immediately or sent through email to a central scanning location.

    However, if the customer signs up using internet or telephone, typically a form is either provided through standard mail or using a digital document the user prints themselves. Either way, these documents both require signing and dating by the customer, and must be sent back to the central organization.

    One possible way of speeding this process up is to use a mobile capture device, such as a mobile camera phone, to speed up this process. In this book, we demonstrate how we can deliver this functionality using IBM Content Navigator and IBM Datacap. In addition, we demonstrate how this process can also embrace a more standard centralized capture approach using a centralized mailroom.

    9.4.1  Form design

    Companies have control over the forms and documents that they produce and distribute to customers. If you have this control, you can create forms with specific characteristics that aid in delivering more accurate capture results. In the following section, we detail some of the considerations that you should make when designing your form for capture.

    Bar codes

    Bar codes are machine-readable labels that contain encoded information. There are a variety of different formats, which have been developed over the years for a variety of applications. Originally, they were primarily used to automate the supermarket check-out process, but their application scanning has helped streamline the paper-based capture process. 

    Usage ranges from simple page/document separation and page/document classification, to supplying a large amount of structured data relevant to a document page. 

    The advantage of using a bar code over simple OCR text is both speed and accuracy. Bar codes can be quickly identified on a page, and their content extracted. Certain bar codes also have an element of redundancy built into them, allowing for some corruption of the captured image to occur without altering the data being captured.

    The following list includes the currently supported bar codes in IBM Datacap: 

    •INDUSTRY 2 OF 5

    •INTERLEAVED 2 OF 5

    •IATA 2 OF 5

    •DATALOGIC 2 OF 5

    •INVERT 2 OF 5

    •BCD MATRIX

    •MATRIX 2 OF 5

    •CODE 32

    •CODE 39

    •CODABAR 2

    •CODE 93

    •CODE 128

    •EAN-13

    •EAN-8

    •UPC-A

    •UPC-E

    •ADD 5

    •ADD 2

    •UCC128/EAN-128

    •PATCH CODE

    •POST NET

    •PDF417

    •DATAMATRIX

    •CODE 39 EXT

    •CODE 93 EXT

    •QR CODE

    •ROYAL MAIL

    •AUSTRALIAN POST 4-STATE CODE

    •AZTEC

    If we are looking at storing a simple value, we would typically look to use a Code 39 bar code. These are common, and used in a variety of capture applications. Typically, when building separator sheets, we look to include two copies of the bar code: One in a horizontal orientation and one in a vertical orientation. 

    The reasoning for this is that noise incurred at scan time, for example, a scratch on the scanner lens,			 can potentially corrupt one of the bar codes. The noise can affect the capture process. Having redundancy of two bar codes in different orientations helps reduce the chances of this issue occurring. An example of a 
3 of 9 bar code is shown in Figure 9-6.
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    Figure 9-6   Example of a 3 of 9 bar code

    Other bar codes, such as the QR Code, are now commonplace, and benefit from an element of redundancy built into them. These are known as levels L, M, Q, and H, and correspond from approximately 7% - 30% redundancy. This means that different levels of corruption can be accounted for, yet the data can still be retrieved within those limits. 

    They also benefit from the ability to store a large amount of data in the bar code, for instance, using Extensible Markup Language (XML) structure. As a result, these are good bar codes to use for the capture process.

    For the development of this use case application, we have chosen to use the 3 of 9 bar code. This is for simplicity purposes. However, in a more complex implementation, we would look to use the QR Code. An example of a QR code is shown in Figure 9-7.
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    Figure 9-7   Example of a QR code

    It is important to place a bar code where it has space around it. A few millimeters (mm) of white space on each side is required to prevent any corruption from nearby pixels. Where it is placed on the page, that is, upper left, lower right, and so on, is not important. This is because the bar code engine can find its location on the page automatically, and extract data at the same time.

    Bar codes do not need to be located exactly on the horizontal or vertical axes, therefore enabling the use of pre-printed bar code stickers if the process dictates. A possible use case is for separation in a mailroom, where an operator simply attaches a sticker with a standard value to a page to indicate the start of a new document.

    IBM Datacap also has the ability to capture the XY coordinates of a bar code that it finds, for use in other processes.

    For further tips on good form design, refer to the IBM Redbooks publication, Implementing Imaging Solutions with IBM Production Imaging Edition and IBM Datacap Taskmaster Capture, SG24-7969.

    9.4.2  Forms to capture

    For the use case, we will be capturing the following forms for processing in IBM Datacap:

    Complaint Letter Summary	To be signed and dated by the customer

    Invoice	Proof of purchase

    Context Image	Image of the complaint product

    The first two forms are shown in Figure 9-8 on page 195 and Figure 9-9 on page 196.

    Details of what we will be capturing, and how we do this, are described later in this chapter.
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    Figure 9-8   Complaint Letter Summary to be signed and dated by the customer

    Figure 9-9 shows the Invoice form.
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    Figure 9-9   Invoice for proof of purchase

    9.5  Application copying and basic setup

    After initial IBM Datacap system setup and testing, we advise making a backup of the base FastApp application. The reasoning is it can be easy to inadvertently make changes to the base FastApp application. This might cause unwanted issues later. Trying to resolve these issues can be problematic, and reverting to the base backup provides a quicker alternative. 

    To copy the base application, use Windows Explorer to make a copy of the c:\datacap\FastApp directory. Name this copy with a meaningful name. In this example, the name is FastAppBackup (Figure 9-10 on page 197). This is our base application backup.
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    Figure 9-10   Base application copy

    IBM Datacap FastApp provides the base framework application that we want to use in our development process. We do not want to alter this base application. We need to make a copy for development purposes.

    To make a copy, follow these steps:

    1.	In Datacap Studio, click the Datacap Application Wizard ([image: ]) and click Next.

    2.	Choose Copy an existing RRS application and click Next.

    3.	Select the FastApp entry from the drop-down list to select the base application. Select the Rename Copy option and enter a new name of FastComplaints, as shown in Figure 9-11. This is the application name that we use to build our IBM Datacap application.
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    Figure 9-11   The first window in the Datacap application wizard

    4.	Click Next, then click Finish to complete the process.

    5.	Click Close when completed. Then close IBM Datacap Studio.

    6.	Open Windows Explorer. You see a new application exists in c:\Datacap. If you open c:\Datacap\datacap.xml, you also see an entry is made for “FastComplaints” (Figure 9-12).
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    Figure 9-12   The datacap.xml file showing the entry made for this application

    You have now built the framework for your new application.

    9.6  Inbound image conversion

    IBM Datacap FastDoc is built to load images create by a scanner (ISIS or TWAIN), or import digital images in either Portable Document Format (PDF) or Tagged Image File Format (TIFF) from the file system. It is not built to receive images from mobile capture. We therefore need to add functionality to the application to deal with this content.

    IBM Content Navigator Mobile captures images in JPG format. For this application, we aim to work with Black and White Group 4 TIFF images. Therefore, we need to convert the inbound JPG images to Black and White TIFF. To convert the image, follow these steps:

    1.	Open Datacap Studio and load the FastComplaints application using the standard user credentials:

     –	Username: admin

     –	Password: admin

     –	Station ID: 1

    2.	Go to the RuleManager tab, in the Ruleset pane, and select the FastComplaints node. 

    3.	Right-click and select Add Ruleset to add a new ruleset to the application. This ruleset is used to build in this conversion process. 

    4.	The new ruleset is added at the bottom of the Ruleset list called Ruleset1, as shown in Figure 9-13.
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    Figure 9-13   Adding a Ruleset to the FastComplaints application

    5.	Click the new ruleset, Ruleset1, and expand the Function level.

    6.	Click the Actions Library tab. Expand the ocr_a library and select the OCRA_ConvertImage2BW action. Now select the Function1 node under RuleSet1 that you created earlier.

    7.	Click Add To Function. The action is added to the new Ruleset. Set its parameter to ori, as shown in Figure 9-14.
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    Figure 9-14   Showing how to add an action to a new Ruleset

    8.	We now rename the new Ruleset. Click Ruleset1, wait one second, and then click again. The UI now enables you to rename the Ruleset. Rename it Convert to BW.

    9.	In a similar approach, rename the Rule node beneath the ruleset to Page: Convert to BW. The naming is not important, but it is a leading practice to name the rule to match the level that it relates to.

    10.	The new Ruleset still has a small red x on it. Click the lock icon in the Ruleset pane and select Publish Ruleset. 

    11.	Click the Task Profiles tab, and select the Profiler Task Profile. Expand it to see the existing Task Profiles. Click the Profiler node, and then click the lock icon.

    12.	Click the new Ruleset created Convert to BW and click Add Ruleset to Profile, as shown in Figure 9-15.
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    Figure 9-15   Showing the Convert to BW

    13.	The ruleset is added to the bottom of the Task Profile list. Select the ruleset and use the green arrow icons to move it to the top of the list. Click Save and then unlock the Task Profiles.

    We have not yet assigned this to a page type yet. We do this later.

    You have now added an image conversion ruleset to your Profiler Task Profile.

    9.7  Bar code recognition

    IBM Datacap FastDoc has bar code recognition rules defined ready-for-use. However, these are designed for use with patch code separator sheets to define the starting point of a new document. Because the use case that we deal with does not use this functionality, we must add a new bar-coding ruleset specifically for capturing the bar code values from our forms. Note this bar code functionality searches the entire image for bar codes.

     

    
      
        	
          Note: When page-level bar code recognition is run, the XY coordinates of the bar codes found are stored in page-level variables. These are used in our application to determine the location of the signature strip. These are visible in the Page XML files, PageID.xml and Profiler.xml, in the batch directory of each batch.

        
      

    

    To add the new functionality, follow these steps:

    1.	Right-click FastComplaints in the Ruleset pane and select Create new Ruleset. A new ruleset is created at the bottom of the ruleset list. As done before, rename the ruleset to FindBarcodes and rename the rule beneath it from Rule1 to Page: Find bar codes on page.

    2.	We now need to add a bar code action to the page. Open the Action Library pane on the right side and expand Barcode_P. Add the GetBarcodeBP action, as shown in Figure 9-16.
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    Figure 9-16   Showing the GetBarcodeBP action

    3.	Save and publish the Ruleset. 

    4.	Add the FindBarcodes Ruleset to the Profiler workflow by clicking the padlock icon on the Task Profiles pane, selecting Profiler, and then selecting the new FindBarcodes Ruleset that we just created. 

    5.	To add it, click Add Ruleset to Profile. 

    6.	Move the newly added Ruleset so that it is located just after Barcode in the Task Profile pane.

    7.	Save the Task Profiles by clicking the Save icon and then the Padlock icon, as shown in Figure 9-17.
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    Figure 9-17   Showing the Padlock icon when saving the Task Profile

    8.	We now need to add the bar code ruleset to the DCO. In the right Document Hierarchy pane, click the padlock icon. Now click the Other page to select it. 

    9.	Next, highlight the Page: Find bar codes on page rule that we just created under FindBarcodes. Click Add To DCO to add the rule to the DCO, as shown in Figure 9-18.
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    Figure 9-18   Showing how to add the rule to the DCO

    10.	Click the Save icon on the Document Hierarchy pane and then click the Padlock icon.

    11.	We now need to tell the system what type of bar codes to look for. This is not strictly necessary, but it helps narrow down what we will capture. We do this on the Other page, because at this point all of the pages have not been identified.

    12.	Click the Zones tab to show the zoning options, as shown in Figure 9-19.
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    Figure 9-19   The Zones tab

    13.	Click the Padlock icon on the DCO Document Hierarchy pane. Next, click page Other. 

    14.	In the bottom half of the window, right-click the Properties tab and select Show Tabs. Now click BAR/P to select the options for bar-coding, as shown in Figure 9-20. A new tab called BAR/P appears.
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    Figure 9-20   Showing the BAR/P to select appropriate options for barcoding

    15.	Within the BAR/P tab, under Properties, look for bar code Type and click it. From the drop-down menu, select CODE 39 for the 3 of 9 bar code, and 
click OK. 

    Make sure that this is the only option selected, as shown in Figure 9-21.
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    Figure 9-21   Showing the position of CODE39

    9.7.1  Bar code confidence settings

    Because we are scanning from a camera image, the image quality of a bar code might be affected by the image quality reasons described earlier. Therefore, we need to change the default confidence value for the bar code recognition. In prior releases this was set at 81%, but lowered to 75% in new releases. 

    To alter this, we need to hard-code a page level variable on the Other page:

    1.	With the DCO still locked, right-click page Other and select Manage Variables, as shown in Figure 9-22.
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    Figure 9-22   Showing the location of Manage Variables

    2.	Here we need to add our variable. Click New and add the name ReqConf. Ensure that you use the correct case. Press Enter once, as shown in Figure 9-23.
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    Figure 9-23   Adding ReqConf

    3.	You see this was added to the list. Add a value of 5 to change to a confidence of 50%. Then click Done. You have altered the confidence level for this page to enable bar code capture.

    4.	You can now save the DCO by clicking the Save (disk) icon and then clicking the Padlock icon.

    You have now added 3 of 9 bar code recognition to your application.

    9.8  Fingerprinting

    When Fingerprinting is enabled, IBM Datacap generates a fingerprint that describes each incoming page. The fingerprint can include information about the relative densities of different regions of the page, or the location of text on the page.

    For example, an incoming page is compared to the existing set of defined fingerprints. If a match within a given confidence threshold is encountered, IBM Datacap then records the ID of the matching fingerprint in the runtime batch hierarchy. The match is not exact, because the data on the page is most likely slightly different. However, you are just looking for the best match possible.

    If a match occurs, IBM Datacap loads the matched Fingerprints zone locations to perform zonal capture, and associates the fingerprints page type to the inbound image.

    Due to the nature of mobile capture, matching a fingerprint can be unpredictable, and might not always produce the most desirable outcomes when doing zonal OCR. Therefore, we must use alternative techniques to enable capture.

    9.8.1  Disabling Fingerprinting in IBM Datacap FastDoc applications

    IBM Datacap FastDoc by default uses Fingerprints, but these can be turned off. This is typically done in the FastDoc UI. However, this cannot be done for mobile capture intake. We therefore need to use a page-level variable to override the usage:

    1.	Within IBM Datacap Studio, Expand the FingerprintMatching ruleset under the central Rulesets pane. You see that it compares a batch-level 
@B. fdMatchFP variable to a value of False. If this matches False at run time, none of the other rules are run due to use of the skipchildren action. 

     

    
      
        	
          Note: The value of True or False is determined during an option defined at scan time within the FastDoc Scan pane. Because we are using mobile ingestion, we do not have access to define this, so we must override it.

        
      

    

    2.	In the left pane under Document hierarchy, click the Padlock icon to lock the DCO. In a similar way to the bar code confidence setting, right-click the FastDoc node and select Manage Variables.

    3.	Find the variable named “fdMatchFP”, and change its value from True to False, then click Done, as shown in Figure 9-24.

    [image: ]

    Figure 9-24   Showing the location of fdMatchFP

    4.	In the Document hierarchy pane, click the Save icon, then click the Padlock icon to unlock the DCO.

    You have now switched off Fingerprinting in your application.

    9.9  Workflow configuration

    As of the time that this book is published, IBM Datacap FastDoc is not designed, ready-for-use, to receive images from mobile devices, so we must make some additional alterations to enable this functionality.

    9.9.1  Existing workflow

    The following steps describe how to alter FastDoc to receive images from mobile devices:

    1.	Open TMWeb in Internet Explorer by browsing to the following location:

    http://localhost/tmweb.net/

    2.	Log in using the standard credentials for application FastComplaints:

     –	Username: admin

     –	Password: admin

     –	Station ID: 1

    3.	Click the Administrator tab.

    4.	Expand the Main Job under the Fast Complaints workflow. 

    5.	Select Scan from the Main Job.

    6.	Scan is currently configured with the Multiple Setup. This enables image load to be carried out using a variety of sources. However, this does not enable image load from mobile devices. 

    9.9.2  New workflow for mobile

    We create a new workflow to enable ingestion from mobile. This then provides two workflows. One workflow (current workflow) for ingestion from scanner, and one workflow for ingestion from mobile.

    Complete the following steps to create a new workflow:

    1.	Open TMWeb in Internet Explorer by browsing to http://localhost/tmweb.net/.

    2.	Log in using the standard credentials for application FastComplaints:

     –	Username: admin

     –	Password: admin

     –	Station ID: 1

    3.	Click the Administrator tab.

    4.	Click FastCompliants and click New.

    5.	Rename this to Mobile Job and enter a description of Job for mobile capture, as shown in Figure 9-25.
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    Figure 9-25   Renaming the Job for mobile capture

    6.	Select Mobile Job then click New to create a new Task. Call this task MobileCapture with a description of Ingest mobile images.

    7.	Change the mode to Batch Creation and click Apply, as shown in Figure 9-26.
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    Figure 9-26   Changing the mode to Batch Creation

    8.	Change the Program to use Mobile Capture from the drop-down list. Click OK to any warning message.

    9.	Click Setup.

    Figure 9-27 shows the Mobile Capture settings. If Mobile Capture is not selected, the capture workflow is not exposed to the IBM Content Navigator Mobile App.
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    Figure 9-27   Showing the Mobile Capture settings

    We now need to add the remaining Task Profiles.

    10.	Select Mobile Job and click New.

    11.	Name the new task Profiler. Click Apply. This then inherits the capture settings of the existing Profiler task in Main Job.

    12.	Do the same for Verify and Export to produce a result like that shown in Figure 9-28.
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    Figure 9-28   Showing a successful result for Mobile

     

    
      
        	
          Note: Any change that you make to one of these inherited Task Profiles will replicate across all workflows using it. Therefore, consider that any change you make in the setup affects all of the workflows.

        
      

    

    9.10  Shortcut, Station, User, and Group setup

    Use the following configuration steps to set up shortcut, station, user, and group:

    1.	Open TMWeb in Internet Explorer by browsing to http://localhost/tmweb.net/.

    Log in using the standard credentials for the FastComplaints application:

     –	Username: admin

     –	Password: admin

     –	Station ID: 1

    2.	Because this is a demonstration system, to keep things simple, we grant all users access to all functionality. In a production environment, new user groups and permissions must be created to lock down access. This is covered in more detail in the IBM Datacap Information Center and relevant IBM Datacap training:

    http://pic.dhe.ibm.com/infocenter/datacap/v8r1m0/index.jsp

    9.10.1  Shortcuts

    Use the following steps to configure shortcuts: 

    1.	Click the Administrator tab and go to Shortcuts.

    2.	Click New and enter a name of Mobile. 

    3.	Select Mobile Capture in the list of permissions in Mobile Job, as shown in Figure 9-29. Click Save.
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    Figure 9-29   Showing the location of Mobile Capture which needs to be selected

    4.	Click Scan under the ID column and ensure that Scan is the only option selected in the list of permissions under Main Job. Click Save.

    5.	Click Profiler under the ID column and ensure that Profiler is the only option selected in the list of permissions under both Main Job and Mobile Job. Click Save.

    6.	Click Verify under the ID column and ensure that Verify is the only option selected in the list of permissions under both Main Job and Mobile Job. Click Save.

    7.	Click Export under the ID column and ensure that Export is the only option selected in the list of permissions under both Main Job and Mobile Job. Click Save.

    We have now given the shortcuts the ability to run batches within either of the two workflows Main Job and Mobile Capture.

    8.	Click Verify under the ID and change the Shortcut Mode to Manual, and then click Save. This enables the verify batches to appear in a list view at verify time.

    9.10.2  Stations

    Use the following steps to configure Stations: 

    1.	Click the Administrator tab and go to Stations.

    2.	We use station ID 1 as the default. Click station 1 and ensure that all tasks are selected, as shown in Figure 9-30.
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    Figure 9-30   Showing the location of all of the tasks that need to be selected

    9.10.3  Users

    Use the following steps to configure Users:

    1.	Click the Administrator tab and go to Users.

    2.	We use the Admin user as default. Click user Admin. 

    3.	Ensure that all of the options are selected in the Privileges section.

    4.	Ensure that all of the tasks are selected in the Permissions section.

    5.	Click Save User.

    9.10.4  Groups

    Use the following steps to configure Groups:

    1.	Click the Administrator tab and go to Groups.

    2.	Select Everyone and select all of the boxes on the right side to grant access to all. This removes all access restrictions. Click Save Group.

     

    
      
        	
          Note: In a production environment, new user groups and permissions must be created to lock down access. This is covered in more detail in the IBM Datacap Information Center and relevant IBM Datacap training:

          http://pic.dhe.ibm.com/infocenter/datacap/v8r1m0/index.jsp

        
      

    

    9.11  IBM Datacap FastDoc operation

    																																												IBM Datacap FastDoc has two modes of operation: 

    •Admin enables the user to create new document types, add and delete fields, create and alter validation routines, and create and alter the export process. This mode provides the RAD capabilities described earlier to create a new capture application.

    •User provides a similar UI to the Admin mode, but this mode does not make functionality available to make changes to the documents, fields, validation, and export. As stated earlier, IBM Datacap FastDoc provides a capability to double as a RAD tool and User Interface. The User mode provides that User Interface without the RAD capabilities. 

    9.11.1  Configuring your application within IBM Datacap FastDoc

    For the purposes of development, we use these ready-for-use credentials. After development is completed, we change the system to use Active Directory.

    The first time this runs, it might take a few seconds to open.

    You can run IBM Datacap FastDoc in a stand-alone environment where FastDoc manages its own batches, or as a client to the IBM Datacap Server.

    You can create applications on FastDoc as a stand-alone client on your local computer, an integrated Datacap client, or both.

    9.11.2  Local mode

    FastDoc operates as an easy to use, stand-alone client that scans, manually indexes, and uploads batches of documents to repositories and file systems without using Datacap Server or other Datacap components. In Local mode, you can run smaller, less complicated jobs without setting up templates, programming, or system configuration with Datacap Server.

    9.11.3  Datacap client mode

    FastDoc runs as a client for Datacap applications that scans, auto indexes, and uploads batches of documents to Datacap Server. For example, you can use FastDoc to process invoice image files for the IBM Datadoc Taskmaster Accounts Payable Capture application. In this mode, FastDoc can use the Datacap Server to further develop the application by using Datacap Studio and Application Manager.

    9.11.4  Capture Images

    You can run your batches locally and upload them to Datacap Server in the background later by using the Datacap Web Client Upload service.

    For the purposes of this book, we use Datacap client mode because this mode enables automation of our capture process, and also enables use of the Datacap Web Client for further interactions through Internet Explorer.

    The following steps show how to set up and run the capturing of images: 

    1.	Open FastDoc (Admin) and enter the standard user name and password. It might take a few seconds to start the UI. You might want to copy this link from the Start → All Programs → Datacap → Administrator → Application Clients.

    Username : admin

    Password : admin

    Station ID : 1

    2.	Click the Taskmaster tab, as shown in Figure 9-31.
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    Figure 9-31   Showing the Taskmaster tab

    3.	Double-click the Scan link, as shown in Figure 9-32.
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    Figure 9-32   Showing the Scan tab

    4.	Click View in the lower left of the pane, as shown in Figure 9-33.
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    Figure 9-33   Showing the Disk Scan options

    5.	Select Disk Scan. Note that the option for physical scanning is through ISIS or TWAIN. If we used a standard scanner, we could choose either of these options.

    6.	Click Scan and select the sample documents and images we created earlier. 

    7.	The images are loaded into the scanner UI, as shown in Figure 9-34.
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    Figure 9-34   Showing the FastDoc panel with the loaded image of the document

    8.	Click Done. You are brought back to the main window.

    9.	Double-click the Profiler tab. This runs the OCR and other image processes.

    10.	When the OCR and other relevant image processing is complete, double-click Verify to show the captured images.

    9.11.5  Build the fields

    In the next step, we must create our document type and define the fields that we want to capture. Using FastDoc enables you to build this rapidly.

    Complete the following steps to build the fields in FastDoc: 

    1.	In the upper left corner of the verify pane, enter a value for the new document type. Call it EvidenceCorrespondence and click the green +. This creates a new page type in the Datacap DCO.

    2.	Create the fields detailed in Table 9-1 by entering the field name and clicking Add Field.

    Table 9-1   Fields used

    
      
        	
          Field name

        
        	
          Description

        
      

      
        	
          FormTypeBC

        
        	
          This is the bar code value for the Form Type. 

        
      

      
        	
          CaseIDBC

        
        	
          This is the bar code value for the Case ID.

        
      

      
        	
          CustomerName

        
        	
          This captures the name of the customer.

        
      

      
        	
          CustomerID

        
        	
          This captures the ID of the customer.

        
      

      
        	
          Signature

        
        	
          This captures the presence of a signature.

        
      

      
        	
          InvoiceNo

        
        	
          This captures the invoiceNumber from the invoice.

        
      

      
        	
          Total

        
        	
          This captures the invoice total from the invoice.

        
      

    

    9.11.6  Locate and capture

    For each of the fields listed in this section, set the defined settings by clicking the Cog icon as shown in Figure 9-35, and clicking the Locate tab. This defines how Datacap detects the contents for the field.
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    Figure 9-35   Showing the location of the Cog icon

    FormTypeBC

    This field is populated later in our capture process from the two bar codes on our form. Table 9-2 shows the settings for each of the fields. 

    Table 9-2   Settings for FormTypeBC

    
      
        	
          Zonal Recognition

        
        	
          False

        
      

      
        	
          From Page OCR

        
        	
          False

        
      

      
        	
          Field ICR

        
        	
          False

        
      

      
        	
          Capture bar code

        
        	
          False

        
      

      
        	
          Optical Mark

        
        	
          False

        
      

      
        	
          Locate Using Keyword

        
        	
          False

        
      

    

    CaseIDBC

    This field is populated later in our capture process from the two bar codes on our form. Table 9-3 shows the settings for each of the fields. 

    Table 9-3   Settings for CaselDBC

    
      
        	
          Zonal Recognition

        
        	
          False

        
      

      
        	
          From Page OCR

        
        	
          False

        
      

      
        	
          Field ICR

        
        	
          False

        
      

      
        	
          Capture bar code

        
        	
          False

        
      

      
        	
          Optical Mark

        
        	
          False

        
      

      
        	
          Locate Using Keyword

        
        	
          False

        
      

    

    CustomerName

    Table 9-4 shows the settings for each of the fields. 

    Table 9-4   Settings for CustomerName

    
      
        	
          Zonal Recognition

        
        	
          False

        
      

      
        	
          From Page OCR

        
        	
          False

        
      

      
        	
          Field ICR

        
        	
          False

        
      

      
        	
          Capture bar code

        
        	
          False

        
      

      
        	
          Optical Mark

        
        	
          False

        
      

      
        	
          Locate Using Keyword

        
        	
          True

        
      

    

    The CustomerName field uses keyword lookup to get the location based upon the full-page OCR. The following steps show how this can be configured: 

    1.	Enter Customer Name in the first empty field below the plus (+) and minus (-) signs. Then click + to add the value.

    2.	Add the following additional variants. These are to allow for any variants from the OCR characters. When you build your application, you must note the common OCR problems and add them to your variants:

     –	Customer name

     –	CUSTOMER NAME

     –	Customer Name

     –	CustomerName 

    3.	If you struggled with the variants, you can look at the OCR text results in the raw text file in the current batch directory. Go to C:\Datacap\FastComplaints\batches\<BATCHNO>, and look at TM00001.txt.

    4.	In the second drop-down list, select Find First. This finds the first occurrence of one of the keywords that we entered in the last step.

    5.	In the third drop-down list, select Go Right. This informs the capture process to step to the right of a match to the first keyword found.

    6.	In the fourth drop-down list, select Group Right to group words that are close to each other from the word captured in the last step.

    7.	Click Test to test the process. You should be able to capture your value.

    CustomerID

    Table 9-5 shows the settings for each of the fields.

    Table 9-5   Settings for CustomerID

    
      
        	
          Zonal Recognition

        
        	
          False

        
      

      
        	
          From Page OCR

        
        	
          False

        
      

      
        	
          Field ICR

        
        	
          False

        
      

      
        	
          Capture bar code

        
        	
          False

        
      

      
        	
          Optical Mark

        
        	
          False

        
      

      
        	
          Locate Using Keyword

        
        	
          True

        
      

    

    CustomerID uses keyword lookup to get the location based upon the full page OCR. The following steps show how this is configured: 

    1.	Enter Customer ID in the first empty field below the + and - signs. Then click + to add the value.

    2.	Add the following additional variants. These are to allow for any variants from the OCR characters. When you build your application, you must note the common OCR problems and add them to your variants:

     –	Customer ID

     –	CUSTOMER ID

     –	CustomerID

     –	CUSTOMERID

    3.	If you struggled with the variants, you can look at the OCR text results in the raw text file in the current batch directory. Go to C:\Datacap\FastComplaints\batches\<BATCHNO> and look at TM00001.txt.

    4.	In the second drop-down list, select Find First. This finds the first occurrence of one of the keywords that we entered in the last step.

    5.	In the third drop-down list, select Go Right. This informs the capture process to step to the right of a match to the first keyword found.

    6.	In the fourth drop-down list, select Group Right to group words that are close to each other from the word captured in the last step.

    7.	Click Test to test the process. You should be able to capture your value.

    Signature

    Table 9-6 shows the settings for each of the fields.

    Table 9-6   Settings for Signature

    
      
        	
          Zonal Recognition

        
        	
          True

        
      

      
        	
          From Page OCR

        
        	
          False

        
      

      
        	
          Field ICR

        
        	
          False

        
      

      
        	
          Capture bar code

        
        	
          False

        
      

      
        	
          Optical Mark

        
        	
          True

        
      

      
        	
          Locate Using Keyword

        
        	
          False

        
      

    

    Signature uses OMR to capture the presence of a signature in a dynamic zone. The following steps show how this is configured:

    1.	Click the Validate tab. In the Choice List section, select the Enable option.

    2.	Add the following options for OMR. Simply Enter the value and click the + sign to add:

     –	Yes

     –	No

    3.	We dynamically set the zone for the OMR later.

    4.	You see the field now has a drop-down list and the values Yes and No.

    InvoiceNo

    Table 9-7 shows the settings for each of the fields. 

    Table 9-7   Settings for InvoiceNo

    
      
        	
          Zonal Recognition

        
        	
          False

        
      

      
        	
          From Page OCR

        
        	
          False

        
      

      
        	
          Field ICR

        
        	
          False

        
      

      
        	
          Capture bar code

        
        	
          False

        
      

      
        	
          Optical Mark

        
        	
          False

        
      

      
        	
          Locate Using Keyword

        
        	
          True

        
      

    

    InvoiceNo uses keyword lookup to get the location based upon the full page OCR. The following steps show how this can be configured: 

    1.	Enter Invoice No in the first empty field below the + and - signs. Then click + to add the value.

    2.	Add the following additional variants. These are to allow for any missed OCR characters. When you build you application, you must note the common OCR problems and add them to your variants:

     –	Invoice Number

     –	INVOICE NUMBER

     –	INVOICE NO

     –	Inv No

    3.	If you struggled with the variants, you can look at the OCR text results in the raw text file in the current batch directory. Go to C:\Datacap\FastComplaints\batches\<BATCHNO> and look at TM00001.txt.

    4.	In the second drop-down list, select Find First. This finds the first occurrence of one of the keywords that we entered in the last step.

    5.	In the third drop-down list, select Go Right. This informs the capture process to step to the right of a match to the first keyword found.

    6.	In the fourth drop-down list, select Group Right to group words that are close to each other from the word captured in the last step.

    7.	Click Test to test the process. You should be able to capture your value.

    Total

    Table 9-8 shows the settings for each of the fields. 

    Table 9-8   Settings for InvoiceNo

    
      
        	
          Zonal Recognition

        
        	
          False

        
      

      
        	
          From Page OCR

        
        	
          False

        
      

      
        	
          Field ICR

        
        	
          False

        
      

      
        	
          Capture bar code

        
        	
          False

        
      

      
        	
          Optical Mark

        
        	
          False

        
      

      
        	
          Locate Using Keyword

        
        	
          True

        
      

    

    Total uses keyword lookup to get the location based upon the full page OCR. The following steps show how this can be configured: 

    1.	Enter Invoice Total in the first empty field below the + and - signs. Then click + to add the value.

    2.	Add the following additional variants. These are to allow for any missed OCR characters. When you build you application, you must note the common OCR problems and add them to your variants:

     –	Invoice Total

     –	INVOICE TOTAL

     –	INVOICETOTAL

     –	InvoiceTotal

    3.	If you are struggled with the variants, you can look at the OCR text results in the raw text file in the current batch directory. Go to C:\Datacap\FastComplaints\batches\<BATCHNO> and look at TM00001.txt.

    4.	In the second drop-down list, select Find First. This finds the first occurrence of one of the keywords that we entered in the last step.

    5.	In the third drop-down list, select Go Right. This informs the capture process to step to the right of a match to the first keyword found.

    6.	In the fourth drop-down list, select Group Right to group words that are close to each other from the word captured in the last step.

    7.	Click Test to test the process. You should be able to capture your value.

    9.11.7  Complete

    We have now created our fields and the basic capture routines. Note that this was done rapidly. We add the Validation and Export options later. The following steps show how to Submit and Export:

    1.	Click Submit to complete the document, as shown in Figure 9-36.
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    Figure 9-36   Showing the location of the Submit button

    2.	Now double-click the Export tab.

    3.	Close the FastDoc UI.

     

    
      
        	
          Note: If you have the FastDoc (admin mode) UI open in the verify mode, do not try to lock the DCO in Datacap Studio, because it can cause a multiple lock between the application, which in turn causes a deadlock.

        
      

    

    9.11.8  Dynamic Capture of bar codes

    The following steps populate both the FormTypeBC and CaseIDBC fields that we defined in 9.11.6, “Locate and capture” on page 217:

    1.	Open Datacap Studio, select FastComplaints as the application, and log in using the following credentials:

    Username : admin

    Password : admin

    Station ID : 1

    2.	Expand the DCO in the Document Hierarchy pane on the left side. 

    You can see the new page and the new fields the we created using FastDoc, as shown in Figure 9-37.
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    Figure 9-37   Showing the new filed that were created

    3.	Create a new ruleset in the central Ruleset pane as you did earlier, and call it Set Page By bar code.

    4.	Build the ruleset, as shown in Figure 9-38.
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    Figure 9-38   Showing the Set Page By bar code ruleset

    This ruleset sets the page type dependent upon the value of the bar code. In this instance, if the capture process found the first bar code on the page with a value of “EV1.2”, it sets that page type to “EvidenceCorrespondence”.

    5.	Add the rule Page: Set Page By bar code from the Set Page By bar code RulesSet to the Other page, as shown in Figure 9-39.
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    Figure 9-39   Adding a rule from the Set Page By bar code

    6.	Create a new Ruleset as you did earlier, and call it SetFieldByBarcode.

    7.	Build the ruleset as shown in Figure 9-40 using the methodology that we used earlier.
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    Figure 9-40   Building the ruleset

    8.	We leave the second argument of the ruleset blank, because the action automatically adds the value from the variable to the Text variable of the DCO object that we attach the action to. In this instance, it writes it to the field. 

    9.	Lock the DCO by clicking the Document hierarchy Padlock icon.

    10.	Expand the EvidenceCorrespondence page and add the rule Field: Set Form Type to the FormTypeBC field.

    11.	Add the rule Field: Set CaseID to field CaseIDBC. Figure 9-41 shows this applied.
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    Figure 9-41   Adding the rule Field: Set CaseID to filed CaseIDBC

    12.	Save and lock the DCO using the same approach used earlier (click the Disk icon and then the Padlock icon).

    13.	Next, we need to add these RuleSets to the Task Profiles, as shown in Figure 9-42. The order in which they appear is important.
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    Figure 9-42   The order in which the Rules appear in the Task profiles is important

    9.12  Signature verification

    We now need to build the signature verification. For reasons we mentioned earlier, we cannot use fixed zones and fingerprinting. Therefore, we need a more dynamic routine to determine the zone for the fingerprint. This requires some minor custom scripting.

     

    
      
        	
          Note: Datacap does not compare the signature to an existing sample signature and determine if they match. It simply detects for the presence of pixels, and whether the quantity of these pixels is over a given threshold. If the quantity exceeds the threshold, it indicates that a signature is present.

        
      

    

    9.12.1  Script development 

    IBM Datacap enables development of actions in VBScript and .NET C#.

    VBScript 

    The following list describes the advantages of using VBScript: 

    •Simple to develop, without a requirement to compile when changes are made to code

    •Widely known language and well-documented

    •Easy to test and develop, with no need to install an integrated development environment (IDE)

    •Use of Notepad or other text editor

    The following list describes some disadvantages of using VBScript: 

    •Lacks the ability to compile and protect source code

    •Is not strongly typed

    •Lacks ease of integration with 3rd party application programming interfaces (APIs)

    C#

    The following list describes the advantages of using C#: 

    •Can be compiled and deployed as a DLL to simplify deployment and maintain versioning and security of source code

    •Readily available third-party APIs in the C# language

    The following list describes some disadvantages of using C#:

    •Requirement to install IDE.

    •Dynamic link library (DLL) must be registered, which can be problematic in some implantation scenarios.

    9.12.2  Use of script in IBM Datacap

    For this application, we use the sample included in this book. This was written in VBScript for ease of use and deployment. A basic understanding of VB Scripting is advisable.

    The sample actions used here are for demonstration use only. They are not warranted by IBM. You would need to fully test them, and provide support to use them.

    The code in this book can be copied into a Notepad document and saved as the following file:

    C:\Datacap\FastComplaints\dco_FastComplaints\rules\FastComplaintsCustom.rrx

    Alternatively, download the sample file that is associated with this book as a downloadable material. 

    Place the sample file in the following folder: 

    C:\Datacap\FastComplaints\dco_FastComplaints\rules

    When the complaint form was developed, we specifically placed our bar codes in a location next to the signature zone. This was done to enable their location to be captured and used as anchors to determine our signature zone.

    When bar code detection runs, it creates several page-level variables holding the bar code locations. By using these values, we can dynamically locate our signature even if the size of the form changes.

    Figure 9-43 depicts how this works:

    •Use the bar code 0s Upper Y coordinates to determine the signature zone Upper Y coordinate.

    •Use the image left value to determine the signature zone Upper X coordinate.

    •Use the bar code 1 Lower Y coordinate to determine the signature zone Lower Y coordinate.

    •Use the bar code 1 Upper X coordinate top determine the signature zone Lower X coordinate.
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    Figure 9-43   Illustrating how the bar code detection works

    This functionality is delivered using the following actions: 

    •CreateFields: (DCO Action Library) 

    This is run at the field level to create the two OMR child fields. When OMR works, we need a zone for Yes. In this instance, that is the signature area. We also need a zone for No. This is a small area where pixels are unlikely to exist within the same signature zone.

    •SetBarcodeDimensionsToField: (Custom Action Library) 

    This copies the coordinates from a defined bar code indicated by the first argument. The following list includes the arguments:

     –	ARG1: Bar code number to copy from

     –	ARG2: Yes or No to copy the Top coordinate (Upper Y)

     –	ARG3: Yes or No to copy the Bottom coordinate (Lower Y)

     –	ARG4: Yes or No to copy the Left coordinate (Upper X)

     –	ARG5: Yes or No to copy the Right coordinate (Lower X)

    We call this action twice for both bar codes, to capture the required coordinates.

    •CopyBarcodeCoordinateToRight: (Custom Action Library) 

    Copies the coordinates from the designated location to the Lower X of the current field:

     –	ARG1: Bar code number to copy from

     –	ARG2: Yes or No to copy the Top coordinate (Upper Y) to the Right Coordinate

     –	ARG3: Yes or No to copy the Bottom coordinate (Lower Y) to the Right Coordinate

     –	ARG4: Yes or No to copy the Left coordinate (Upper X) to the Right Coordinate

     –	ARG5: Yes or No to copy the Right coordinate (Lower X) to the Right Coordinate

    •ZoneLeft_ImageLeft: (Zones Action Library) 

    Set the Upper X coordinate of the current field to the value of the left-most part of the image. This is usually 0.

    We then use two additional custom actions, SignatureYesZone and SignatureNoZone. These are run at the child fields. They inherit the parent zone coordinates defined previously, and create a larger zone for the Yes and a small zone for the No. 

    This is dynamic, dependant upon the values set for the whole signature zone, and is shown in Figure 9-44.
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    Figure 9-44   Illustrating how the signature zones work

    •RecogOMRThreshold 

    FastDoc uses the ABBYY engine OMR detection, but for our custom section, we use another action. The first argument defines the threshold at which a positive detection of pixels occurs. The second defines background noise. The value of 2 and 0 are ideal for use in signature detection on large OMR spaces.

    The following steps show how to configure the signature recognition:

    1.	If DStudio is still open, close and reopen it, select FastComplaints as the application, and log in using the following credentials:

    Username : admin

    Password : admin

    Station ID : 1

    2.	The custom actions were loaded into the DStudio action library as shown in Figure 9-45. This was achieved by copying the sample code to the following file:

    C:\Datacap\FastComplaints\dco_FastComplaints\rules

    [image: ]

    Figure 9-45   Showing the custom actions that were loaded 

    3.	Figure 9-46 shows how to set up the combination of rules and actions. Using the approaches described earlier in this chapter, create the appropriate ruleset, rules, and actions.
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    Figure 9-46   Showing the required rulesets, rules, and actions

    4.	The rules then need to be added to the DCO, as shown in Figure 9-47, using the approaches described earlier in this chapter.
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    Figure 9-47   Showing the specific rules that need to be added to the DCO

    5.	Save and publish the Signature Ruleset created using the approaches used earlier in this chapter.

    6.	Save and unlock the DCO.

    7.	Close DStudio.

    Example B-1 on page 602 provides the source code for the Signature script.

    9.13  Validation setup

    To ensure the quality of the data that we captured, we can apply validation routines on a field-by-field level. Validation can be as simple as defining the length of a field and the type of characters allowed, or it can involve more complex validations against database values.

    The following steps show how validation can be configured and set up:

    1.	Open FastDoc (Admin) and enter the standard user name and password:

     –	Username: admin

     –	Password: admin

     –	Station ID: 1

    It might take a few seconds to start the UI. You might want to copy this link from the Start → All Programs → Datacap → Administrator → Application Clients.

    2.	Click the Taskmaster tab. 

    3.	Double-click Scan.

    4.	Click View in the lower left of the window.

    5.	Select Disk Scan. 

    6.	Click Scan and select the sample documents and images we created earlier. The images are loaded into the scanner UI. Click Done. You are brought back to the main window.

    7.	Double-click the Profiler tab. This runs the OCR and other image processes.

    8.	When complete, double-click Verify to show the captured images and see the data populated in all the fields.

    9.	Select the FormTypeBC field and click the Cog icon, then click the Validate tab, as shown in Figure 9-48.
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    Figure 9-48   Showing the validation tab in FastDoc

    10.	Apply the following validations for each field:

     –	FormTypeBC

    Table 9-9 shows the settings for each of the fields.

    Table 9-9   The FormTypeBC field settings

    
      
        	
          Rule

        
        	
          Details

        
      

      
        	
          Date

        
        	
          No

        
      

      
        	
          Minimum Length

        
        	
          1

        
      

      
        	
          Maximum Length

        
        	
          0

        
      

      
        	
          Data Type

        
        	
          Alphanumeric + Punctuation

        
      

      
        	
          Remove Spaces

        
        	
          False

        
      

      
        	
          Connection String

        
        	
           

        
      

      
        	
          SQL Statement

        
        	
           

        
      

      
        	
          Allow Override

        
        	
          True

        
      

    

     –	CaseIDBC

    Table 9-10 shows the settings for each of the fields. 

    Table 9-10   The CaselDBC field settings

    
      
        	
          Rule

        
        	
          Details

        
      

      
        	
          Date

        
        	
          No

        
      

      
        	
          Minimum Length

        
        	
          1

        
      

      
        	
          Maximum Length

        
        	
          0

        
      

      
        	
          Data Type

        
        	
          Alphanumeric

        
      

      
        	
          Remove Spaces

        
        	
          False

        
      

      
        	
          Connection String

        
        	
           

        
      

      
        	
          SQL Statement

        
        	
           

        
      

      
        	
          Allow Override

        
        	
          True

        
      

    

     –	CustomerName

    Table 9-11 shows the settings for each of the fields.

    Table 9-11   The CustomerName field settings

    
      
        	
          Rule

        
        	
          Details

        
      

      
        	
          Date

        
        	
          No

        
      

      
        	
          Minimum Length

        
        	
          1

        
      

      
        	
          Maximum Length

        
        	
          0

        
      

      
        	
          Data Type

        
        	
          Alphanumeric 

        
      

      
        	
          Remove Spaces

        
        	
          False

        
      

      
        	
          Connection String

        
        	
           

        
      

      
        	
          SQL Statement

        
        	
           

        
      

      
        	
          Allow Override

        
        	
          True

        
      

    

     –	CustomerID

    Table 9-12 shows the settings for each of the fields.

    Table 9-12   The CustomerID field settings

    
      
        	
          Rule

        
        	
          Details

        
      

      
        	
          Date

        
        	
          No

        
      

      
        	
          Minimum Length

        
        	
          1

        
      

      
        	
          Maximum Length

        
        	
          0

        
      

      
        	
          Data Type

        
        	
          Numeric

        
      

      
        	
          Remove Spaces

        
        	
          True

        
      

      
        	
          Connection String

        
        	
           

        
      

      
        	
          SQL Statement

        
        	
           

        
      

      
        	
          Allow Override

        
        	
          True

        
      

    

     –	Signature

    Table 9-13 shows the settings for each of the fields.

    Table 9-13   The Signature field settings

    
      
        	
          Rule

        
        	
          Details

        
      

      
        	
          Date

        
        	
          No

        
      

      
        	
          Minimum Length

        
        	
          1

        
      

      
        	
          Maximum Length

        
        	
          0

        
      

      
        	
          Data Type

        
        	
          Alphanumeric

        
      

      
        	
          Remove Spaces

        
        	
          False

        
      

      
        	
          Connection String

        
        	
           

        
      

      
        	
          SQL Statement

        
        	
           

        
      

      
        	
          Allow Override

        
        	
          True

        
      

    

     –	InvoiceNo

    Table 9-14 shows the settings for each of the fields. 

    Table 9-14   The InvoiceNo field settings

    
      
        	
          Rule

        
        	
          Details

        
      

      
        	
          Date

        
        	
          No

        
      

      
        	
          Minimum Length

        
        	
          1

        
      

      
        	
          Maximum Length

        
        	
          0

        
      

      
        	
          Data Type

        
        	
          Numeric

        
      

      
        	
          Remove Spaces

        
        	
          True

        
      

      
        	
          Connection String

        
        	
           

        
      

      
        	
          SQL Statement

        
        	
           

        
      

      
        	
          Allow Override

        
        	
          True

        
      

    

     –	Total

    Table 9-15 shows the settings for each of the fields.

    Table 9-15   The Total field settings

    
      
        	
          Rule

        
        	
          Details

        
      

      
        	
          Date

        
        	
          No

        
      

      
        	
          Minimum Length

        
        	
          1

        
      

      
        	
          Maximum Length

        
        	
          0

        
      

      
        	
          Data Type

        
        	
          Numeric + Punctuation

        
      

      
        	
          Remove Spaces

        
        	
          True

        
      

      
        	
          Connection String

        
        	
           

        
      

      
        	
          SQL Statement

        
        	
           

        
      

      
        	
          Allow Override

        
        	
          True

        
      

    

    11.	Click Submit to complete the verification. 

    9.14  Export setup

    Export is used to define the ECM system that we want to upload our images and properties to. 

    First, we need our Document Class and Property names to map to the Datacap fields.

     

    
      
        	
          Note: the fields in Datacap can have completely different names than those in the ECM repository.

        
      

    

    The following steps show how to configure and set up the Export:

    1.	Open FastDoc (Admin) and enter the standard user name and password:

    Username : admin

    Password : admin

    Station ID : 1

    It might take a few seconds to start the UI. You might want to copy this link from the Start > All Programs > Datacap > Administrator > Application Clients.

    2.	Click the Taskmaster tab. 

    3.	Double-click Scan.

    4.	Click View in the lower left of the window.

    5.	Select Disk Scan. 

    6.	Click Scan and select the sample documents and images that we created earlier. The images are loaded into the scanner UI. 

    7.	Click Done. You are brought back to the main window.

    8.	Double-click the Profiler tab. This runs the OCR and other image processes.

    9.	When complete, double-click Verify to show the captured images and see the data populated in all the fields.

    10.	Select the FormTypeBC field and click the Cog icon, then click the Export tab, as shown in Figure 9-49.
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    Figure 9-49   Showing the Export tab

    11.	For each of the fields, enter the repository field names shown in Table 9-16.

    Table 9-16   The map for each of the Datacap fields to the repository fields

    
      
        	
          Datacap field

        
        	
          Repository name

        
      

      
        	
          FormTypeBC

        
        	
          CTRM_FormType

        
      

      
        	
          CaseIDBC

        
        	
          CTRM_CaseID

        
      

      
        	
          CustomerName

        
        	
          CTRM_CustomerName

        
      

      
        	
          CustomerID

        
        	
          CTRM_CustomerID

        
      

      
        	
          Signature

        
        	
          CTRM_Signature

        
      

      
        	
          InvoiceNo

        
        	
          CTRM_InvoiceNumber

        
      

      
        	
          Total

        
        	
          CTRM_InvoiceTotal

        
      

    

    12.	Next, we need to define the repository connection details. Click the Cog icon on the main bar, as shown in Figure 9-50.
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    Figure 9-50   Showing the location of the cog

    13.	Add the details shown in Table 9-17 to the FileNet connection tab.

    Table 9-17   The value settings in the FileNet connections tab

    
      
        	
          Property

        
        	
          Value

        
        	
          Description

        
      

      
        	
          Save to FileNet Content Manager

        
        	
          True

        
        	
          Switch to enable the export

        
      

      
        	
          User

        
        	
          P8Admin

        
        	
          FileNet user name

        
      

      
        	
          Password

        
        	
          IBMFileNetP8

        
        	
          FileNet password

        
      

      
        	
          URL

        
        	
          http://localhost:9080/wsi/FNCEWS40MTOM/

        
        	
          URL of FileNet MTOM connection point

        
      

      
        	
          Object Store

        
        	
          TARGET

        
        	
          Object Store where to store the document

        
      

      
        	
          Document Class

        
        	
          CTRM_EvidenceCorrespondence

        
        	
          Document Class in the Object store to use

        
      

      
        	
          Folder

        
        	
          /MyDocs/

        
        	
          Folder where the document is to be stored

        
      

    

    14.	An example is shown in Figure 9-51 on page 241.
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    Figure 9-51   The value settings in the FileNet connections tab

    9.15  Final test for desktop image capture

    You have now built the entire application. You can now run the entire capture process by running Scan, Profiler, Verify, and Export within FastDoc, and the document is exported into FileNet.

    9.16  Mobile setup

    This section takes you over the details for the Mobile setup. 

    9.16.1  Datacap mobile configuration additional steps

    The next step is to add any additional rules to allow for Mobile capture. We did not do this earlier, because the new pages are now created. Perform the following steps: 

    1.	Add the Page: Convert to BW rule from the Convert to BW ruleset to the Other, MainPage, Trailing_Page, and EvidenceCorrespondence pages.

    2.	Add the Page: Find bar codes on page rule from the FindBarcodes ruleset to the MainPage, Trailing_Page, and EvidenceCorrespondence pages.

    3.	Add the Remove lines and noise rule from the ImageClean ruleset to the Trailing_Page and EvidenceCorrespondence pages.

    4.	Add the Page: Set Batch Vars rule from the Set Page By bar code ruleset to MainPage, Trailing_Page, and EvidenceCorrespondence.

    We can also add additional fields to be populated in the app by the user. An example being the location of the user, or any additional comments the user might want to add to the capture process. This can be done easily in DStudio by adding some Batch-level fields.

    5.	Lock the DCO and right-click the root node called FastDoc. Select Add and then select Field. Do this twice to add two fields shown in Table 9-18. 

    Table 9-18   The two fields that are added

    
      
        	
          Field name

        
      

      
        	
          Location

        
      

      
        	
          Comments

        
      

    

    These fields then appear in the mobile app later. For the purposes of this use case, we do not export them, but we can observe the fields being populated in the batch XML files later.

    9.16.2  Mobile app configuration

    The mobile app is available for both iOS and Android. The source code is also available on JazzHub:

    https://hub.jazz.net/project/ecmmobile/IBM%20Content%20Navigator%20for%20Mobile%20Source/overview

    For the use case, download the mobile app as described in Chapter 8, “Installing, configuring, and deploying IBM Datacap and Mobile Capture program” on page 131.

    The following steps detail the configuration and setup on the mobile app:

    1.	Tap the Navigator icon on the iPhone or iPod Touch to start the application, as shown in Figure 9-52.
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    Figure 9-52   The Mobile Application prompting for the password

    2.	You should now be prompted with a request for your app password.

    3.	Enter your password.

    4.	Dependant upon whether you have configured IBM Content Navigator on your device, you might already have an entry. 

    5.	To add an IBM Datacap connection, tap the + sign in the top right corner as shown in Figure 9-53.
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    Figure 9-53   Adding the servers in the Mobile application

    6.	Choose your connection type from the drop-down list. Select Datacap and tap Done, as shown in Figure 9-54.
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    Figure 9-54   Selecting the connection type from the mobile application

    7.	For the server name, enter a value relating to the name of the application, and add a prefix that indicates to the user that it is a Datacap Connection, Datacap Complaints, as shown in Figure 9-55.
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    Figure 9-55   The New server settings

    The prefix in Figure 9-55 shows that it is a Datacap connection.

    8.	Enter the server address noting the requirement for the port number, for example, http://192.168.4.21:90.

    9.	Enter your user credentials as used before:

    Username : admin

    Password : admin

    10.	Choose the Application by tapping the APPLICATION drop-down list. This queries Datacap wTM for all available applications. Choose FastComplaints and tap Done. 

    11.	Select your Profile by tapping the PROFILE drop-down list. This queries Datacap wTM for the workflow within the application. The one we configured with Mobile ingestion shows in the drop-down list. 

    12.	Choose Mobile Job and tap Done, as shown in Figure 9-56.
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    Figure 9-56   Selecting the Mobile Job workflow

    13.	Tap Save in the upper right to save this configuration.

    14.	Tap Datacap Complaints to start the capture application, as shown in Figure 9-57.
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    Figure 9-57   Start of the capture process 

    15.	If you see the Tap here to add a page, you have a successful configuration.

    16.	Tap Datacap Complaints to start the capture application.

    17.	Tap Tap here to add a page, as shown in Figure 9-58.
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    Figure 9-58   Showing Adding a page from the Mobile App

    18.		You are presented with some options.

    Table 9-19 Gives a description of the options for scanning a document from the mobile application.

    Table 9-19   Describing the various options

    
      
        	
          Add New Page

        
        	
          This scans in a new page. This enables further image processing to be carried out on the image after it is captured. Note that the deskew will not function if you choose “Add Photo”.

        
      

      
        	
          Add Existing Page

        
        	
          Permits a user to upload a previously captured page from your photo album.

        
      

      
        	
          Add new Photo

        
        	
          This scans in an image. No deskew is available, because this is a photo image. You can also add multiple images simply by repeatedly tapping the snapshot icon.

        
      

      
        	
          Add Other File 

        
        	
          This enables the user to add another file from another application on your iOS device. To do this, navigate to the file in the other app, then select Open In, then choose Navigator.

        
      

    

    19.	Choose Add New Page. You are presented with a camera window.

     

    
      
        	
          Note: The icons on the upper left of the window either turn the flash on or off. The icon on the upper right also enables you to turn a grid, frame, a combination of both, or neither, on the image window. This is provided to help align images when performing capture. Examples are shown in Figure 9-59.
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    Figure 9-59   Showing the document being scanned by the mobile application 

    20.	After you have lined your image up, press the Shutter icon to capture the image.

    21.	You now see the image with the borders automatically detected, as shown in Figure 9-60.
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    Figure 9-60   Showing the borders being automatically detected 

    22.	If you tap the Expand and Contract icons, you can turn this detection feature on or off. These are shown in Figure 9-61.
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    Figure 9-61   Showing the location of the Expand and Contract icons 

     

    
      
        	
          Note: This feature works by automatically identifying the edges based upon a contrasting background.

        
      

    

    23.	After you captured your image, and automatic detection has occurred, experiment by pulling the corners of the shape (Tap and hold the corner of the zone, then drag to location). 

    Note that you get a zoomed-in circular section of the image to aid in the alignment of the image zone, as shown in Figure 9-62.
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    Figure 9-62   Showing the manual alignment of the borders 

    24.	When you are happy with the image, tap the Done icon in the lower right side.

    You are now provided with some image manipulation capabilities.

    Figure 9-63 shows the quality level, which is automatically determined by analyzing the image captured. The quality indicator indicates that capture from the image is likely to be poor. This indicator is not assessing the OCR quality. No OCR is occurring on the device. All OCR is occurring on the central IBM Datacap Server. The quality indicator works by querying the exposure and brightness of the image to determine its suitability.
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    Figure 9-63   Showing the quality indicator

    25.	Tapping the Rotate icon rotates the image. This is shown in Figure 9-64.
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    Figure 9-64   Illustration of the rotation icon

    26.	Tapping Color icon makes the image black and white. Tapping this icon again makes the image color. This is shown in Figure 9-65.
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    Figure 9-65   Illustration of the Color icon

    27.	Tapping the Settings icon enables you to tweak the image Compression, Contrast, and Brightness. This is shown in Figure 9-66.
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    Figure 9-66   Illustration of the settings icon

    28.	You might have to change the pagetype. Tap the icon at the top of the window and select Other.

    29.	You now want to add an additional page. Tap Add New Page. You are presented with a camera window. Capture the Invoice Document and follow the same process as before.

    30.	You might have to change the page type. Tap the icon at the top of the window and select Other or TrailingPage.

    31.	Next, take a photo of the context, which is an image of the complaint article. This is photos to show the context of the incident. Tap the Tap here to add a page icon and select Add Photo.

    32.	To complete image capture, tap Done.

    33.	You now see a list of the image that you have captured. 

    34.	Drag the icon on the left of the window, as shown in Figure 9-67, and tap Properties. This displays a list of values that you can enter. These values are created in Datacap at the batch level, as we did earlier. The values that you enter, therefore, are stored as batch level variables for use within your Datacap application. 

    35.	For this application, enter a value for Location and Comments. If wanted, these fields can be left blank and populated automatically by the capture process, and viewed at verification time in the app. When you are satisfied, swipe back to the selection window.
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    Figure 9-67   Showing the drag icon on the left of the mobile application

    36.	Because you have captured several images, you might want to remove some of them. Slide you finger over the image that you want to remove. 

    37.	If you want to reorder, you tap, hold, and drag the image to reorder. See Figure 9-68 for an example.
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    Figure 9-68   Showing the captured images 

    38.	When you are satisfied with the structure of the batch, tap Submit to the top right side of the window.

    39.	You see each image upload to the server.

    40.	When complete, you are presented with a queue ID. The queue ID is the unique reference number for a batch for mobile and wTM. To understand the importance of this, we suggest doing the wTM lab as mentioned earlier in the lab guide.

    41.	Tap OK to return to the main menu.

    42.	Slide the icon shown in Figure 9-67 on page 252 and tap the Batch Monitor icon. You are presented with the Batch Monitor, which gives a status of all of the batches in progress.

    43.	Tap Pending for the batch that you want to look at, as shown in Figure 9-69.

    [image: ]

    Figure 9-69   Showing the list of batches 

    You might want to check the Profiler.xml file in the batch to see the values in the header for those completed in the app.

    9.17  Datacap and Content Classification

    In the mobile use case described in this book, we use bar codes on our image as the method of page and form identification. For reasons described earlier in this chapter, we disabled the ready-for-use Fingerprinting, because this is not suited to mode of capture. 

    It is important to note, however, that there are several other methods that you can use for identification and classification of pages. One of these is use of IBM Content Classification. (Note that additional licenses might be required. Consult with your local IBM Sales Representative)

    IBM Content Classification provides text-based classification services for IBM Datacap. As previously mentioned, IBM Datacap uses several classification methods to process captured documents, such as bar code, pattern recognition, and fingerprint recognition. Integration with IBM Content Classification provides an additional level of classification based on text analytics. 

    IBM Content Classification uses machine learning technology. It is taught to identify PageTypes learning for a series of examples for each PageType. The classification information is stored in an asset of type Knowledge Base. The integration between IBM Datacap and IBM Content Classification is described in the following web page:

    http://www-01.ibm.com/support/knowledgecenter/api/content/SSBRAM_8.8.0/com.ibm.classify.admin.doc/c_AG_datacap_int.html

    Datacap has the ability to use these capabilities during the capture process to help automate classification and page identification. Using the OCR text captured from an image, we can present this to IBM Content Classification for content analysis. 

    The Knowledge Base is queried within IBM Content Classification, and the most relevant classification category is returned to IBM Datacap with a confidence level. Within IBM Datacap, we can then assign the pagetype aligned to this classification category. 

    When the classification category is returned, a confidence level is also delivered. This enables for adjustment of the accuracy levels versus the amount of manual interaction required in the system (or the amount of automation required). If we set a low confidence level, a large percentage of pages will be automatically classified. If we set a high confidence level, a larger number of pages will fall below this level.

    Pages that fall below this level can be manually worked on by a knowledge worker to determine the required classification category. These classified pagetypes can then be returned to IBM Content Classification for automated learning and adjustments to the classification process. 

    To add this capability into IBM Datacap is simple. Note that what we describe here is not for use in the use case we have implemented for this book. This is provided as information should you want to use it in your applications.

    In Figure 9-70 on page 256, we create a Ruleset with two Rules. 

    •The first rule we set at the batch level. Using actions from the IBM Content Classification library, we create a connection to the IBM Content Classification server using port 18087 (the default port) on our local server. The next step is to define the Knowledge Base that we want to use, along with the confidence level. The confidence level determines if the classification returned should be applied to the page. 

    •The next rule is attached to the page level. We place this on pagetype Other because these pages are yet to be classified. Note that OCR has already been carried out, and an associated text file has been produced using the standard CreateTextFile for the Recog_Shared library. FindFingerprintCC takes the OCR text from the text file and sends it through port 18087 to the IBM Content Classification server. 

    •IBM Content Classification processes the text and returns a classification category and associated confidence level. If the confidence level is above the value defined at the batch level using SetProblemValueCC, the pagetype is switched to the name of the classification category. Any pages falling below this confidence level are left as they are (they remain as pagetype Other).

    Figure 9-70 shows the two rules.
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    Figure 9-70   Ruleset showing the first two rules used for Classification

    Now that our pages have been processed with IBM Content Classification, we will have pages returned to the available classification categories. We might also have pages still remaining as pagetype Other. This is where we use the next ruleset, as shown in Figure 9-71.
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    Figure 9-71   The third ruleset used for Classification

    By attaching a ruleset similar to the one in Figure 9-71 on page 256 to pagetype Other, we set the remaining pages to pagetype LowConfidence, along with both batch-level and page-level variables indicating that a low confidence page is present. 

    We can then detect whether a fixup task should be triggered. The ruleset in Figure 9-72 checks for the presence of the variables that would have been created if a low confidence page was detected, and splits the tasks to a fixup task.
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    Figure 9-72   Ruleset that checks for the presence of the variables 

    After we run the fixup task and assign the pagetypes, we can inject the new pagetypes and their content back into IBM Content Classification for learning purposes. The RuleSet shown in Figure 9-73 shows how to update the Knowledge Base. This uses the pagetype as the classification category, and the OCR as the content.
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    Figure 9-73   Ruleset showing how to update the Knowledge Base
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Installing and configuring an IBM Content Manager OnDemand system

    This chapter describes the setup of an IBM Content Manager OnDemand (Content Manager OnDemand) system in the context of the use case that is described in Chapter 2, “Use case scenario” on page 11. In the use case, Content Manager OnDemand is used to archive transaction history and reports for the company. 

    By integrating Content Manager OnDemand in the IBM Enterprise Content Manager (ECM) solution, the caseworker can gain a more precise historical view about the requesting customer. This information helps inform a decision, and supports documentation of the actions taken to answer or settle the request.

    10.1  Overview 

    IBM Content Manager OnDemand is a high-volume, high-performance document and computer-generated output archiving and retrieval system. It is optimized to archive computer-generated output, such as printed lists, statements, or invoices. It supports automatic index extraction, and loading documents with index values provided by external applications. 

    Content Manager OnDemand minimizes storage consumption by compression and intelligent resource (fonts, graphics, and forms) handling, where applicable. It can be integrated into Line of Business applications using application programming interfaces (APIs), and supports IBM Content Navigator as a ready-to-use client application.

    This chapter provides information about, how Content Manager OnDemand has to be installed in the context of the simple use case described in Chapter 2, “Use case scenario” on page 11.

    Figure 10-1 shows the use case solution components that we build for this book. In this chapter, we build Content Manager OnDemand, one of the core components for the ECM solution. The shaded boxes with solid lines in the figure represent the components and products that we have built so far.
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    Figure 10-1   Use case context in relation to the overall solution components

    10.2  Prerequisites

    Content Manager OnDemand has some dependencies on other middleware components that must be installed before the actual installation of Content Manager OnDemand. Though these dependencies can be fulfilled by using the included install packages that come with Content Manager OnDemand, in this scenario they are already laid down through the installation of other components as described in the following sections.

    10.2.1  Software prerequisite

    Complete the installation of the following components before proceeding with Content Manager OnDemand installation:

    •IBM Case Manager: For Content Manager OnDemand, IBM DB2 is used, which was installed in the IBM Case Manager installation procedure. The installation of IBM Case Manager is described in Chapter 4, “Installing and configuring IBM Case Manager” on page 35. 

    •Alternatively, a normal DB2 installation can also fulfill the prerequisite. The software and hardware prerequisites for Content Manager OnDemand are documented on this website:

    http://www-01.ibm.com/support/docview.wss?uid=swg27021456

    10.2.2  Software packages required

    To install Content Manager OnDemand, the software packages stated in Table 10-1 must be downloaded for a basic IBM Content Manager OnDemand installation including server, client and Java API:

    http://www-01.ibm.com/software/passportadvantage/pao_customer.html

    Table 10-1   IBM Content Manager OnDemand Enterprise Records installer

    
      
        	
          Software

        
        	
          Part number (Windows)

        
      

      
        	
          IBM Content Manager OnDemand 9.0

        
        	
          CIV7TML

        
      

      
        	
          IBM Content Manager OnDemand Clients 9.0

        
        	
          CIV7YML

        
      

      
        	
          IBM Content Manager OnDemand Web Enablement Kit 9.0

        
        	
          CIV7ZML

        
      

    

    10.3  Deployment considerations

    As for most enterprise applications, there are several different options to deploy Content Manager OnDemand. For instance, Content Manager OnDemand can be split across several virtual or physical systems to meet high-performance requirements, or it can be connected to IBM Tivoli Storage Manager for handling higher storage demands or functional requirements. 

    For the use case described in this book, a single-server installation is performed, and no high availability (HA) or disaster recovery (DR) requirements are taken into account. Also, Content Manager OnDemand uses the local hard disk drive (HDD) as storage.

    10.4  Instructions

    This section describes the step-by-step process of how Content Manager OnDemand must be installed. As a final step, the section describes how the installation can be verified.

    10.4.1  Installation of IBM Content Manager OnDemand 

    The install program for Content Manager OnDemand is provided in an archive package. The following steps show how to install the Content Manager OnDemand after downloading the installation package:

    1.	Extract the Package named IBM_CMOD_V9.0_WIN_ML to a local directory. 

    2.	After extraction, a structure similar to the one shown in Figure 10-2 is created. 
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    Figure 10-2   Selection of the install program

    3.	Select the install program named odwin and start it by double-clicking or right-clicking and using the menu.

    4.	Accept the default installation language (english) by clicking OK, as shown in Figure 10-3.
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    Figure 10-3   Installation language selection

    5.	To install Content Manager OnDemand, you must accept the product license. Select the I accept terms in the license agreement option on the Software License Agreement dialog (Figure 10-4). Click Next to proceed.
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    Figure 10-4   Software License Agreement dialog

    6.	The Introduction shown in Figure 10-5 illustrates how the installation program is to be used. Click Next.
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    Figure 10-5   Introduction to the installation procedure

    7.	The next dialog enables you to select the installation directory. Though any local directory can be used, accept the default directory shown in Figure 10-6. After selecting a directory, click Next.
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    Figure 10-6   Selection of the installation target directory

    8.	The dialog shown in Figure 10-7 on page 267 summarizes the chosen selections. This is the final step where changes can be made by going back to the other dialogs by clicking Previous. To start the installation, click Install. This installation might take a few minutes to complete.

     

    
      
        	
          Important: If the system you are installing on shuts down during the installation process, you experienced an incompatibility issue. Depending on software versions, different versions of the underlying Secure Sockets Layer (SSL) support libraries can be in use. These cause an unplanned system shutdown. 

          To avoid this issue, stop all DB2 services before installing IBM Content Manager OnDemand 9.0.
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    Figure 10-7   Installation summary

    9.	After the installation is completed, the installation program prompts whether the readme file should be displayed, as illustrated in Figure 10-8. Choose No to advance to the final dialog step.
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    Figure 10-8   The readme file display dialog

    10.	The final window presents the after-installation summary, as presented in Figure 10-9. Click Done to exit the installation program.
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    Figure 10-9   Installation complete

    After the installation is completed, IBM Content Manager OnDemand files are saved under the selected directory. When in installer, accepted the default values. The file structure is located under the following directory:

    C:\Program File\IBM\OnDemand for Windows\V9.0

    10.4.2  Configuration for IBM Content Manager OnDemand repository

    Before any further options are installed, the Content Manager OnDemand repositories must be configured. This procedure configures the instance if not already defined:

    •File systems used to hold intermediate data

    •The database for system control data

    •Metadata

    •Long term storage for stored objects

    It also creates a set of Windows services to control the repository operation. Follow the steps in all five following sections to finish the initial configuration.

    Creating Content Manager OnDemand instance and server

    To start the configuration program and set up global information, follow these steps:

    1.	From the Windows Start menu (Figure 10-10), select the IBM OnDemand for Windows program group, and start the Configuration program.
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    Figure 10-10   Windows Start menu opened to start Content Manager OnDemand Configurator

    2.	The Configurator starts with an empty full-screen window. As illustrated in Figure 10-11, start the configuration of a new server by selecting New Server from the File menu.
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    Figure 10-11   Start the New Server configuration

    3.	Content Manager OnDemand has a concept of instances. Each Content Manager OnDemand system is represented as a single instance. One instance can have one library server and one or multiple object servers, depending on scalability and performance requirements. 

    Because this is the initial configuration and no instances are already defined, after starting the New Server procedure, the configurator asks for the instance name, along with some more information as presented in Figure 10-12. Accept the default value ARCHIVE as the name, and do not enable tracing. Select Next to advance to the next step.
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    Figure 10-12   Creation of an instance

    4.	The first information about the server is collected on the Server dialog shown in Figure 10-13. As described, an instance must always have one Library Server and one Object Server. Therefore, the first server created is a Library and Object Server. 

    5.	Do not add any information for LDAP configuration, and click Next to proceed to the directory configuration described in “Configuring Content Manager OnDemand server directory” on page 273.
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    Figure 10-13   Content Manager OnDemand Server type selection

    Configuring Content Manager OnDemand server directory

    The following steps define the file system directories used to store intermediate information:

    1.	The Directory dialog provides default values for Temporary File Path and Print File Path. The Data Directories section does not yet hold any values. Figure 10-14 shows these initial configuration states.
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    Figure 10-14   Content Manager OnDemand server directory dialog

    2.	Click Add to populate the Data Directories section. The field validation logic detects that the c:\arstmp directory does not exist, and asks for approval to create it, as illustrated in Figure 10-15. Select Yes to create it and proceed to the next step.
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    Figure 10-15   Content Manager OnDemand server file path creation

    3.	After agreeing to the directory creation, a window appears to define the first Data Directory. Figure 10-16 shows the definition of the directory name (c:\arsload is the default, select OK to define it) and the approval request to create it (lower half of the figure). Select Yes to create the directory and return to the directory dialog.
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    Figure 10-16   Content Manager OnDemand server data directory selection and creation

    4.	The fully populated directory dialog is shown in Figure 10-17. Click Next to proceed to database data collection described in “Creating Content Manager OnDemand server database” on page 277.
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    Figure 10-17   Content Manager OnDemand server fully defined directories

    Creating Content Manager OnDemand server database

    The following steps present, what values are needed to create the database for Content Manager OnDemand:

    1.	The database shown in the dialog in Figure 10-18 provides some fixed values already defined. These include the database type (preset to DB2) and a not-yet-defined database file system section. The fixed values are derived from the Instance name given on the first dialog step, and from the currently logged on user. 

    The default choice for the database type is DB2. Because this scenario has DB2 already installed, accept this choice. Do not select Use Tivoli Storage Manager for DB2 files. Click Add to enter a database file system.
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    Figure 10-18   Content Manager OnDemand server database dialog

    2.	The dialog shown in Figure 10-19 is populated with the default directory to hold the database files. Accept that value by clicking OK.
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    Figure 10-19   Content Manager OnDemand server database file system definition

    3.	After selecting OK, the configuration program asks for approval to create the directories if they do not exist, as shown in Figure 10-20 on page 279. Along with the database file system, two more directories are created by default:

     –	A directory for primary indexes defaulting to c:\arsdbpri

     –	A directory for database log archival defaulting to c:\arsdbarc

    For both directories, approval for creation is requested. Accept both by pressing OK. After the directories are created, click Next to go to the storage definition as described in “Defining Content Manager OnDemand server storage” on page 279.

    Figure 10-20 shows the directory creation dialog.
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    Figure 10-20   Content Manager OnDemand server database file system creation approval

    Defining Content Manager OnDemand server storage

    This section shows how the storage for the Content Manager OnDemand server in our scenario can be defined.

    To define server storage, follow these steps:

    1.	The storage definition starts with the dialog shown in Figure 10-21. 
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    Figure 10-21   Content Manager OnDemand Server storage definition dialog

    There are two types of storage supported by Content Manager OnDemand on Windows-based or UNIX-based systems:

     –	Cache Only

    The objects are only stored in file systems locally connected to the server that the Content Manager OnDemand system is installed on. This is good for demonstration, development, or functional test systems. For a production system or a non-functional test system, this is in most cases not the ideal configuration in terms of long-term storage support.

     –	Tivoli Storage Manager

    In most production setups, Content Manager OnDemand is connected to Tivoli Storage Manager. This setup offloads storage management to a separate solution component. 

    The benefit of this setup is that storage becomes transparent to Content Manager OnDemand, and it can be managed independently. It also enables independent scaling of the storage component, online replacement of storage components, and many other important features. For details, see the product website:

    http://www.ibm.com/software/products/en/tivostormana

    Because this is a system that is only set up to explain integration concepts, choose the simplest setup option. Leave the Cache Only option selected, and proceed by clicking Add to add a file system folder to be used for the cache.

    2.	The dialog to add file system directories to the cache area is shown in Figure 10-22. Accept the default and click OK.
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    Figure 10-22   Content Manager OnDemand add server object cache storage area

    3.	If the directory does not already exist, the configuration application prompts for approval to create it, as illustrated in Figure 10-23. Accept this by selecting Yes.
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    Figure 10-23   Content Manager OnDemand approve server to create a cache directory 

    4.	Before the final step for storage definition, the configuration program notifies the user that it has updated the database configuration to match the storage definition information. The information panel is shown in Figure 10-24. Acknowledge this information by clicking OK.
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    Figure 10-24   Content Manager OnDemand server DB2 user exit information

    5.	Finally, to start the procedure to create the instance and server configuration as it is described in “Configuring Content Manager OnDemand”, click Finish on the dialog shown in Figure 10-25.
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    Figure 10-25   Content Manager OnDemand server storage definition overview

    Configuring Content Manager OnDemand

    The final task is to transform all collected information into database definitions, and create the database for Content Manager OnDemand from it. On the Windows platform, the configuration program also creates Windows services to control the operation of Content Manager OnDemand.

    To configure Content Manager OnDemand, follow these steps:

    1.	On the Windows services definition dialog shown in Figure 10-26, complete the fields for User ID and Password. Only select the This User ID does not have a password option (for the user to have no password) if you used a technical user that actually had no password.
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    Figure 10-26   Content Manager OnDemand server windows service configuration

     

    
      
        	
          Important: The User ID must have the windows privilege to “logon as a service”. If the User ID does not have this privilege, the service does not start automatically. If the service is started manually and the User ID does not have the privilege, Windows prompts for approval to add that privilege to the user.

        
      

    

    2.	Start database creation by clicking Create Local Database Now in the dialog shown in Figure 10-27.
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    Figure 10-27   Content Manager OnDemand server start database creation dialog

    3.	The following two dialogs indicate the progress when creating the configuration of IBM Content Manager OnDemand. The dialog in Figure 10-28 on page 288 displays the actual progress when creating the database and Content Manager OnDemand’s basic configuration tables. 

    The dialog in Figure 10-29 on page 289 displays the final status, and it provides the ability to check every step’s logging information. Click OK to finish the instance and server configuration and return to the configuration program window.

    Figure 10-28 shows the configuration progress.

    [image: ]

    Figure 10-28   CMOS server database creation progress

    Figure 10-29 shows the completed settings.
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    Figure 10-29   Content Manager OnDemand server database creation finished dialog

    4.	Exit the configuration program by closing the window illustrated in Figure 10-30, or by selecting File → Exit from the menu bar.
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    Figure 10-30   Content Manager OnDemand server close configuration program

    5.	After the configuration program is stopped, IBM Content Manager OnDemand is set up properly and ready for operation. You can start it by accessing the Windows services application and searching for a service called OnDemand LibSrvr (ARCHIVE). Start this service.

     

    
      
        	
          Note: The name of the Windows service varies. It depends on the actual Instance name given when starting the server configuration for the first server, as presented in Figure 10-12 on page 271.

          There are three more services related to Content Manager OnDemand, as illustrated in Figure 10-31. However, for the sake of this scenario, the additional ones are not needed.
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    Figure 10-31   Content Manager OnDemand server configured Windows services

    10.4.3  Installing Content Manager OnDemand client software

    To administer and verify the configuration and operation of IBM Content Manager OnDemand, two client applications are installed:

    •The administration client called OnDemand32 Administrator English

    •The windows client application called OnDemand32 English

    The language indicator might vary, depending on what language pack is installed.

    This procedure is described in the following seven simple steps:

    1.	To start the installation, extract the compressed package for the complementary metal-oxide semiconductor (CMOS) clients. The package has a name similar to IBM_CMOD_CLI_9.0_WIN_ML. 

    2.	From the resulting directory structure, start the installation program by double-clicking setup.exe, as illustrated in Figure 10-32.
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    Figure 10-32   Content Manager OnDemand Clients start the installation program

    3.	The installation program starts, as illustrated in Figure 10-33. Choose Next to advance to the next step.
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    Figure 10-33   Content Manager OnDemand Clients installation welcome window

    4.	Choose Custom as installation type on the dialog presented in Figure 10-34, and leave the target directory set to the default directory. Select Next to advance to the next step.
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    Figure 10-34   CMOS clients installation type and target directory selection

    5.	From the selection of Clients to install, select Client and Administration. Proceed by clicking Next on the dialog illustrated in Figure 10-35.
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    Figure 10-35   Content Manager OnDemand Clients selection

    6.	On the dialog shown in Figure 10-36, the target application group for the Windows Start menu is defined. The default name is set to IBM OnDemand32. Accept that and click Next.
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    Figure 10-36   Content Manager OnDemand Clients Windows Start menu entry definition

    7.	The final step before the installation summarizes the taken decisions is presented in Figure 10-37. Choose Next to start the installation process, or use Back to return to previous dialogs to make changes.
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    Figure 10-37   Content Manager OnDemand Clients installation summary

    8.	While installing, a dialog similar to the one shown in Figure 10-38 is presented. After the installation process is done, click Next and then Finish on the final dialog to stop the installation program.
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    Figure 10-38   Content Manager OnDemand Clients installation process

    10.4.4  Installing Content Manager OnDemand Web Enablement Kit

    This component is used to connect IBM Content Navigator with the Content Manager OnDemand content repository. These three steps are needed to finalize this task:

    1.	Install the IBM Content Manager OnDemand Web Enablement Kit (ODWEK).

    2.	Configure the Windows server, the application server, and IBM Content Navigator to use ODWEK.

    3.	Build a test configuration in IBM Content Navigator to perform the test.

    The steps for each task are described in the following sections.

    Installing ODWEK

    The first task is to install ODWEK on the server that is also running IBM Content Navigator.

    To install ODWEK, follow these steps:

    1.	To start the installation program, extract the package file named ODWEK Install Package and start the install program called odwekwin from the resulting directory structure, as shown in Figure 10-39.
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    Figure 10-39   ODWEK: Start the installation program

    2.	Choose English as language for the installation by clicking OK in the dialog presented in Figure 10-40.
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    Figure 10-40   ODWEK: Choose installation program language

    3.	The installation introduction dialog describes details about the installation process, as shown in Figure 10-41. Click Next to start the installation procedure.
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    Figure 10-41   ODWEK installation introduction

    4.	In the dialog illustrated in Figure 10-42, choose I accept the terms in the license agreement to be able to start the installation procedure. Click Next to navigate to the next step.
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    Figure 10-42   ODWEK: Accept the software license agreement

    5.	Leave the default installation directory set to 
C:\Program Files\IBM\OnDemand Web Enablement Kit\V9.0, as shown in Figure 10-43. Click Next to advance to the next step.
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    Figure 10-43   ODWEK: Accept the default installation directory

    6.	To start the installation process, accept the installation summary shown in Figure 10-44 by clicking Install. If changes must be made, use Previous to return to the wanted dialog.
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    Figure 10-44   ODWEK installation summary

    7.	While the installation process is running, a dialog like that in Figure 10-45 is shown. It automatically advances to the next step, when ready.
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    Figure 10-45   ODWEK installation process is running

    8.	Choose not to display the readme file on the dialog illustrated in Figure 10-46 by clicking No.
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    Figure 10-46   ODWEK installation finished and ready to present the readme file

    9.	End the installation program by clicking Done on the final dialog, as shown in Figure 10-47.
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    Figure 10-47   ODWEK: Finish the installation and close the installation program

    Configuration of server components to use ODWEK

    To use ODWEK for IBM Content Navigator to connect to IBM Content Manager OnDemand, a few configurations must be adjusted. The necessary steps vary between different operating systems. This procedure describes the actions for a Windows-based system:

    1.	Add the ODWEK library paths to the Windows PATH environment variable.

    2.	Add the ODWEK Java archive (JAR) files to the application servers CLASSPATH.

    3.	Perform the basic ODWEK configuration using the IBM Content Navigator administration desktop.

    Prepare the Windows PATH variable

    ODWEK uses several native libraries to connect to Content Manager OnDemand. On Windows, these must be loaded from the System’s PATH environment variable. To add the library directories to this variable, follow these steps:

    1.	From the Windows Control Panel, start the System and Security configuration component. The configuration pane is shown. 

    2.	Choose Advanced system configuration to start the System Property, as shown in Figure 10-48. 

    3.	Click Environment Variables to open the environment configuration dialog.
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    Figure 10-48   ODWEK Windows system environment configuration

    4.	After the Environment Variables configuration dialog is presented, choose Path from System variables, as shown in Figure 10-49. Ensure not to use User variables, because they do not apply system-wide, but only for the current users’ sessions. 

    5.	Click Edit to advance to the final step.
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    Figure 10-49   ODWEB system environment variable definition

    6.	On the dialog presented in Figure 10-50, add these two directories to the end of the Path:

     –	C:\Program Files\IBM\OnDemand Web Enablement Kit\V9.0

     –	C:\Program Files\IBM\OnDemand Web Enablement Kit\V9.0\lib64 

    Use the semicolon (;) to separate the new entries from the existing ones, and between them.
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    Figure 10-50   ODWEK PATH system environment definition

    7.	Click OK until all dialogs are closed and the View basic information about your computer is displayed. Close that dialog by clicking the Windows Close button.

    Adding ODWEK JAR files to the application server’s CLASSPATH

    This section shows how to use the IBM WebSphere Integrated Console to manipulate the CLASSPATH setting for an application server. This section does not talk about the cluster version of WebSphere Application Server (known as WebSphere Application Server Network Deployment). Follow these steps to add JAR files:

    1.	Open the WebSphere Integrated Console for the server by pointing a browser to the following URL:

    http://localhost:9060/ibm/console

    The browser window shows the WebSphere console, as illustrated in Figure 10-51.
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    Figure 10-51   ODWEK start configuration of WebSphere Application Server class path

    2.	Log in to the console using the administrator defined when installing WebSphere Application Server. The default in this scenario defines the user P8admin with the password IBMFileNetP8.

    3.	After logging in, the console is presented as shown in Figure 10-52.
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    Figure 10-52   ODWEK WebSphere Application Server console window

    4.	In the Servers section on the left side of the windows, expand the tree by clicking Servers → Server Types → WebSphere application servers.

    5.	In the right side of the window shown in Figure 10-53, click the link for server1. 
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    Figure 10-53   ODWEK WebSphere Application Server instance selection

    6.	After opening the server instance’s definition by clicking the server entry, the details of that server instance are presented as shown in Figure 10-54.
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    Figure 10-54   ODWEK WebSphere Application Server instance details pane

    7.	On the detail pane, at the right, scroll down to Java and Process Management in the section Server Infrastructure. Expand it by clicking the plus (+) sign and open the link Process Definition, as illustrated in Figure 10-55.
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    Figure 10-55   ODWEK WebSphere Application Server open the process definition

    8.	When the Process Definition pane is displayed as shown in Figure 10-56, select Java Virtual Machine on the right side of the window. 
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    Figure 10-56   ODWEK WebSphere Application Server server definition pane

    9.	The details pane for the Java virtual machine (JVM) is displayed as presented in Figure 10-57. 
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    Figure 10-57   ODWEK WebSphere Application Server add classpath entry to JVM process definition

    10.	Add the ODWEK Java Archive file to the class path: 

    C:\Program Files\IBM\OnDemand Web Enablement Kit\V9.0\api\ODApi.jar

    If the class path is empty, insert the complete path and file name shown before this paragraph into the text box. If the text box already has content, add the complete path and file name to the end. Each entry has its own line. They are not separated by special characters.

    11.	Click OK on the bottom of the details pane (illustrated in Figure 10-58) and select Save as soon as it is presented on top of the details pane shown in Figure 10-59 on page 315.
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    Figure 10-58   ODWEK WebSphere Application Server persist new classpath definition 
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    Figure 10-59   ODWEK WebSphere Application Server save configuration

    12.	Close the WebSphere Application Server console by logging out (choosing Logout at the upper right of the browser window) and closing the browser window, as shown in Figure 10-60.
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    Figure 10-60   ODWEK WebSphere Application Server log out of console

    13.	Restart the Application Server by using these two shortcuts on the Windows desktop: 

    a.	Stop WebSphere Application Server Server: After starting it, wait until the command window closes.

    b.	Start WebSphere Application Server Server: After starting this script, it might take a few minutes. Wait until the command window closes. 

    Defining application-wide settings

    To enable ODWEK for use with IBM Content Navigator, some application-wide settings must be configured. The corresponding procedure is described in the following steps:

    1.	To start the IBM Content Navigator administration desktop, point a supported browser to the appropriate URL. In most cases, the URL looks similar to this:

    http://<hostname>:<portnumber>/navigator?desktop=admin

    In the described scenario, use the following URL in Firefox:

    http://localhost:9080/navigator?desktop=admin

    2.	The browser presents the logon window as illustrated in Figure 10-61. Log on using the default ID p8admin with the password of IBMFileNetP8.
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    Figure 10-61   ODWEK IBM Content Navigator logon window

    3.	To change ODWEK-specific settings, select Settings on the left side of the Content Navigator window. Open the Content Manager OnDemand tab on the right side of the window, as presented in Figure 10-62 on page 317.

    Two settings must be configured:

     –	ODWEK temporary directory: This directory is use by ODWEK during run time to store temporary content.

     –	Trace directory: If trace is enabled, trace files are written to this directory.

    These directories can be anywhere on a locally accessible file system. In this scenario, they are located under the installation directory of the ODWEK component:

    C:\Program Files\IBM\OnDemand Web Enablement Kit\V9.0

    The directories have the following names:

     –	ODWEK_temp

     –	ODWEK_trace
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    Figure 10-62   ODWEK Content Navigator application-wide settings for ODWEK

    4.	Click Save and Close to persist the settings into Content Navigator’s configuration data store and log out of the administration desktop, as illustrated in Figure 10-63.
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    Figure 10-63   ODWEK Content Navigator log out of administration

    5.	Close the browser windows after logging out.

    6.	The final step is to actually create the directories as configured for Content Navigator. Do this by using the Windows command window and issuing the following commands:

     –	mkdir C:\Program Files\IBM\OnDemand Web Enablement Kit\V9.0\ODWEL_temp

     –	mkdir C:\Program Files\IBM\OnDemand Web Enablement Kit\V9.0\ODWEL_trace

    You can also create the directories using Windows Explorer.

    7.	Restart the WebSphere Application Server by using these two shortcuts on the Windows desktop: 

    a.	Stop WebSphere Application Server Server: After starting it, wait until the command window disappears.

    b.	Start WebSphere Application Server Server: After starting this script, it might take a few minutes. Wait until the command window closes. 

    Creating Verification Environment in IBM Content Navigator

    To enable IBM Content Navigator to access IBM Content Manager OnDemand using the ODWEK, a few configuration steps must be completed. These steps are described in this chapter.

    The first sequence describes how a new repository definition of IBM Content Manager OnDemand is created using the IBM Content Navigator administration desktop.

    1.	To start the IBM Content Navigator administration desktop, point a supported browser to the appropriate URL. In most cases, the URL looks similar to the following URL:

    http://<hostname>:<portnumber>/navigator?desktop=admin

    In the described scenario, use the following URL in Firefox:

    http://localhost:9080/navigator?desktop=admin

    The browser presents the logon window shown in Figure 10-61 on page 316. Log on using the default ID p8admin with the password of IBMFileNetP8.

    2.	First, a connection to IBM Content Manager OnDemand must be configured. To start this, navigate to the Repositories on the left and click it. 

    3.	A tab as illustrated in Figure 10-64 displays on the right side of the window. From the New Repository menu, select the repository type Content Manager OnDemand.
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    Figure 10-64   IBM Content Navigator start repository creation

    4.	On the first page of the dialog for the new repository, some mandatory information must be provided, as shown in Figure 10-65. To proceed, complete the following information:

     –	Display name: Provide any name that describes the connection properly. For this scenario, use OD.

     –	Server name: This can be the IP address or host name of the system where Content Manager OnDemand is running. For the purpose of this implementation, use localhost.
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    Figure 10-65   Configuring Content Manager OnDemand repository in Content Navigator

    5.	After all of the information is provided, click Connect to verify the connection. 

    6.	A Log in pane is provided, as shown in Figure 10-66. Use an administrator of the repository that should be connected. In this scenario, the administrator for Content Manager OnDemand is admin with the password of ondemand.
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    Figure 10-66   IBM Content Navigator repository logon pane

    7.	If the Log in pane closed without an error message and the next tab is activated (not disabled anymore), as shown in Figure 10-67, the login is successful. Accept the remaining default values by clicking Save and Close.
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    Figure 10-67   Content Navigator connected to Content Manager OnDemand

    To enable a user to use the new repository, a desktop must include it. Because we only use this desktop to verify operations, we configure it to be nominal. It only connects to the Content Manager OnDemand repository, and only contains the search feature of IBM Content Navigator. Perform the following steps to create the desktop:

    1.	Open the Desktops tab by clicking Desktops on the left side of the administration desktop. A tab like the one presented in Figure 10-68 is shown. 

    2.	Click New Desktop to start creating a new desktop.
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    Figure 10-68   IBM Content Navigator desktops tabulator

    3.	On the General tab of the New Desktop dialog (shown in Figure 10-69 on page 323), enter a name and select the repository created to control access to this desktop. Do this by completing the information in the following text boxes:

     –	Name: Enter OD as the name of the desktop. Note, that the ID is derived from the name given to a desktop.

     –	Authentication → Repository: In the Authentication section, choose the repository OD from the list of available repositories.
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    Figure 10-69   Creating a new desktop for Content Manager OnDemand

    4.	Limit the functionality of the desktop by configuring its appearance. Select the Appearance tab illustrated in Figure 10-70 and scroll down to the Features section. 

    5.	Focus on the Displayed Features setting first. Delete all features but Search from the right list box by selecting them one by one and clicking the Left arrow between the two list boxes.
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    Figure 10-70   IBM Content Navigator configure features of a new desktop

    6.	On the same tab, scroll down a bit more until the Default Repository setting is visible, as shown in Figure 10-71. Note that all settings except for Search and Browse are disabled, because these features are not part of the desktop anymore. Select OD as the default repository for Search and Browse.
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    Figure 10-71   IBM Content Navigator select default repository for features

    7.	Accept the defaults for all remaining settings and click Save and Close to persist the new desktop configuration and log out of the administration desktop.

    8.	Close the browser window.

    10.4.5  Verifying installation

    As a final task, the installation is verified. For this, the built-in log facility is queried through normal user client channels. The verification is done in two steps. 

    The first verification is done by using the Windows client. This can be conducted directly after installing the client, and has no dependencies on the installation or configuration of ODWEK. It shows correct operation of the Content Manager OnDemand repository and basic communication to clients, and is carried out by querying the system log folder. 

    The second step is performed by using the IBM Content Navigator. It verifies the correct installation and configuration of ODWEK and IBM Content Navigator again by accessing and querying the system log folder.

    Verification with OnDemand Windows client

    To verify basic Content Manager OnDemand operation and communication, follow these instructions:

    1.	Start the Content Manager OnDemand Windows client from the Windows Start menu, as shown in Figure 10-72, and log it to the client with the Content Manager OnDemand administrator using User ID admin with a password of ondemand.
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    Figure 10-72   Content Manager OnDemand verification: Start it from Windows

    2.	Double-click the System Log folder from the folder list window, as shown in Figure 10-73. This opens the search dialog for that folder.
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    Figure 10-73   Content Manager OnDemand verification: Select the System Log folder

    3.	Scroll down to the criteria Time Stamp as illustrated in Figure 10-74 and change the operator to Between. As the search interval, choose a date starting before Content Manager OnDemand was installed ranging to the end of the current year, using the follow syntax:

    yyyy-mm-dd (for year-month-day as in 2014-01-01 and 2014-12-31)
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    Figure 10-74   Content Manager OnDemand verification: Enter a date range to query for log entries

    4.	The query result contains some entries, and is presented in the bottom half of the dialog, as shown in Figure 10-75.
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    Figure 10-75   Content Manager OnDemand verification: Results displayed in the Windows client

    5.	If some entries are presented, IBM Content Manager OnDemand is up and running. If not, double-check the date range and rerun the query. Alternatively, other criteria can be used.

    6.	Close the Content Manager OnDemand Windows Client.

    Verification with IBM Content Navigator

    To verify that IBM Content Navigator can be used to query IBM Content Manager OnDemand, this procedure is used to access the built-in log facility of Content Manager OnDemand:

    1.	Start a supported browser and go to the desktop configured for Content Manager OnDemand, as shown in Figure 10-76. Enter the following URL:

    http://localhost:9080/navigator?desktop=OD

    Use User ID admin with a password of ondemand to log in.
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    Figure 10-76   Content Navigator verification

    2.	From the search window shown in Figure 10-77, on the left side of the window, expand the All Searches section and select the System Log search definition. The right side of the window opens the search dialog presenting all of the criteria that can be queried.
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    Figure 10-77   Content Manager OnDemand Content Navigator verification: select search for System Log

    3.	Scroll down the right window side to the criteria Time Stamp, as shown in Figure 10-78, and change the operator to Between. As the search interval, choose a date starting before Content Manager OnDemand was installed ranging to the end of the current year, using the following syntax:

    yyyy-mm-dd (for year-month-day as in 2014-01-01 and 2014-12-31)
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    Figure 10-78   Content Manager OnDemand Content Navigator verification: Enter time interval to query log entries

    4.	The query result contains some entries and is presented in the dialog, as shown in Figure 10-79. The search criteria are collapsed, and the dialog changed to display the result set.
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    Figure 10-79   Content Manager OnDemand Content Navigator verification: query results presented on the right window side

    5.	If some entries are presented, Content Manager OnDemand is up and running and Content Navigator is configured correctly. If not, double-check the date range and rerun the query. Alternatively, other criteria can be used.

    6.	Log out and close the browser window.
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Implementing an IBM Content Manager OnDemand system use case

    The use case scenario described in Chapter 2, “Use case scenario” on page 11 illustrates how decisions about how to resolve a case can be taken with less risk by incorporating more information about the customer or person filing a claim or starting a request. This information can come from online systems, such as enterprise resource planning (ERP) systems, or from archives containing current and historic information about transaction performed with a customer. 

    For this scenario, the Specialist or Manager might need to gain insight by looking at historic information about transactions between the fictitious Company A and a customer. This historic data often originates from print streams, such as booking journals or invoices sent to customers. IBM Content Manager OnDemand is an archive system optimized to handle large volumes of printed information and manage them efficiently. 

    This chapter describes how invoices and booking journals can help a caseworker or a Manager to come to a decision. The access to this information is integrated into the caseworker environment, eliminating the need to start additional programs to gain further insight.

    11.1  Overview

    The scenario from Chapter 2, “Use case scenario” on page 11 describes how invoices and payment journals are used to verify the decision about how to settle the request or complaint. The first part of this chapter briefly documents the preconditions for successfully implementing this solution component. 

    The second part describes the configuration of IBM Content Manager OnDemand (Content Manager OnDemand) to hold Invoices sent out to customers in Portable Document Format (PDF), and how Content Manager OnDemand is configured to load the payment journal. Finally, this chapter describes how the information is made accessible from the caseworker’s environment. Two ways of integration are outlined:

    •Using the search feature of IBM Content Navigator to directly access Content Manager OnDemand

    •Using Content Federation Services to integrate Content Manager OnDemand information into the IBM FileNet P8 Platform that is used by IBM Case Manager. This way, the user does not need to know that a separate component is involved.

    11.2  Prerequisites

    To store invoices and journals in Content Manager OnDemand, and to connect that information to the caseworker environment, some prerequisites must be in place. This chapter describes the prerequisites for the three stages of storing, retrieving, and records declaring information.

    11.2.1  Software prerequisites

    The following list describes the required software: 

    •To store information in Content Manager OnDemand, the repository software must be installed and configured, as described in Chapter 10, “Installing and configuring an IBM Content Manager OnDemand system” on page 259.

    •For connecting Content Manager OnDemand to the caseworker environment, that environment must be able to access Content Manager OnDemand. Follow the steps in 10.4.4, “Installing Content Manager OnDemand Web Enablement Kit” on page 296 and “Configuration of server components to use ODWEK” on page 304. 

    An additional way to connect is documented in 11.4.4, “Configuring FileNet Content Federation Services to integrate Content Manager OnDemand with a FileNet P8 catalog” on page 375.

    •For the IBM FileNet Content Federation Services integration, IBM Case Manager must be installed and set up as documented in Chapter 4, “Installing and configuring IBM Case Manager” on page 35. 

    11.2.2  Configuration prerequisites

    The configuration steps for Content Manager OnDemand and its integration into the case environment are part of this chapter. These steps refer to files contained in the additional material related to this book. Extract the following parts of that material to a local file system (for instance c:\temp\CMOD is a good place to start with) connected to the system used for this scenario:

    •CMOD-Invoice.zip

    •CMOD-Payments.zip

    Extract both archive files into separate sub directories. If c:\temp\CMOD was used as the root for the extract operation, this generates the structure shown in Figure 11-1.
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    Figure 11-1   Structure of sample data to load into Content Manager OnDemand

    11.3  How this ties into the scenario

    Information from IBM Content Manager OnDemand is used to look at the transaction history between a client and the fictitious Company A to understand the best way that a complaint or request can be resolved or answered. Depending on the amount of money it would cost to settle the issue, it is the Specialist or Manager’s duty to examine the history and judge whether the resolution with a requesting client is worth the price.

    To ease the caseworker job, the information from Content Manager OnDemand is presented in the context of IBM Case Manager. This enables the caseworker to seamlessly access the data and incorporate it into the case. It can even be automatically locked down as a record at the end of a case, if needed.

    Content Manager OnDemand holds two different types of information:

    Invoices	Each invoice that the fictitious Company A sends to clients is kept, to comply with laws and for future reference. In the use case, this information is used to verify that the complaining client has purchased the product or service in question.

    Payment journal	All payments received are listed in a journal. Those journals are archived and indexed automatically by extracting values from the journal. This information is used in the use case to verify that the fictitious Company A has a good relationship to the complaining client.

    Figure 11-2 shows the use case diagram for this book. Content Manager OnDemand is integrated in the scenario for the caseworker environment. Also, at the end of the scenario, Content Manager OnDemand integrates with Enterprise Records to declare content retrieved from Content Manager OnDemand as a record in the context of a finished case.
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    Figure 11-2   Use case context in relation to overall solution

    In the use case, information from Content Manager OnDemand is used by the Specialist (Rebecca) to gain insight about the client relationship, and by the Manager (Tim) to verify that Rebecca’s conclusion is worthwhile. 

    Content Manager OnDemand can be queried directly, by using Content Navigator connected to Content Manager OnDemand. It can also be queried indirectly, by using Content Navigator connected to FileNet P8, and using FileNet Content Federation Services to tie Content Manager OnDemand data into FileNet P8.

    After following the instructions of this chapter, the case solution is enriched with the integration of historical data, and the caseworker can gain a 360° view about the client.

    11.4  Configuring IBM Content Manager OnDemand for invoices and payment reports

    This chapter contains the steps needed to enable Content Manager OnDemand to store Invoices using the generic indexer and payment reports by using the more Advanced Function Presentation (AFP) Conversion and Indexing Facility indexer (ACIF). In both cases, three configuration objects must be created:

    •An application group. An application group contains the storage management attributes of, and index fields for, the data that is loaded into Content Manager OnDemand.

    •One or more applications reflecting to the application group. An application describes the physical characteristics of a report to Content Manager OnDemand. Typically, an application is defined for each program that produces output to be stored in Content Manager OnDemand, or for different versions (for example, different layouts, like one layout per year) of output from the same application.

    •One or more folders. A folder is the user’s way to query and retrieve data that is stored in Content Manager OnDemand. It contains information about how and what data can be queried and how it is displayed.

    For invoices, the configuration is done step-by-step separately for the three configuration objects. The payment report is configured using the Extensible Markup Language (XML) import administration feature, a more streamlined way of configuring objects based on existing definitions. This, for instance, is a good method to move definitions from a development stage or a test stage into production.

    11.4.1  Configuration to load invoices

    The invoices that are used in this scenario look similar to the one illustrated in Figure 11-3 on page 340, and are coded as PDF documents. A few of these sample invoices are loaded to provide information that actually can be used when navigating through the scenario. The invoices are indexed with the following index fields:

    •InvoiceNumber

    •InvoiceDate

    •Recipient

    •Amount

    Preparing the input files for the load

    All of this information is contained in the invoice as text, and can be extracted automatically using Content Manager OnDemand’s PDF indexing capabilities. However, to use PDF indexing, third-party software is required (Adobe Acrobat). This capability is not used here. Instead, we show how index values can be provided externally by adding an index file to the data that should be loaded. 

    One index file with a specific layout can be used to load multiple data objects:

    •A generic section. This section at the beginning of the file has a few optional comments on what this load is about, and what code page was used to create the index file. The following keywords are used in this section:

     –	COMMENT

     –	CODEPAGE

    •The main part of the index file contains information about the data objects that must be loaded. This part has a repeating structure of keyword sequences, one for each piece of information that must be loaded. It might contain optional comments:

     –	Information about index values of a data object: Each index field and its value are described in corresponding rows like the following rows:

    COMMENT: Index field #1

    GROUP_FIELD_NAME:InvoiceNumber

    GROUP_FIELD_VALUE:929631

    These are repeated for each index value that must be assigned to the data object. The following keywords are used:

     •	COMMENT

     •	GROUP_FIELD_NAME

     •	GROUP_FIELD_VALUE

    The value syntax must reflect the definition chosen when creating the application.

     –	Information about the file or data object that is loaded. Each data object that the index values are assigned to is described in the following way:

    COMMENT: document data starts at beginning of file

    GROUP_OFFSET:0

    COMMENT: document data goes to end of file

    GROUP_LENGTH:0

    GROUP_FILENAME:Sample-invoice-1.pdf

    In general, index values could be assigned to separate parts of a single file. More often, however, separate sets of index values refer to different files, as described here. Using 0 for the offset and length indicates that the index data is pointing to the beginning of the file mentioned, and describes all of its content. The following keywords are used:

     •	COMMENT

     •	GROUP_OFFSET

     •	GROUP_LENGTH

     •	GROUP_FILENAME

    Example 11-1 shows a complete sample for loading one invoice.

    Example 11-1   Loading one invoice
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    COMMENT:

    COMMENT: Generic Indexer Example 1

    COMMENT: Different input file for each document

    COMMENT:

    COMMENT: Specify code page of the index data

    CODEPAGE:1208

    COMMENT: Document #1

    COMMENT: Index field #1

    GROUP_FIELD_NAME:InvoiceNumber

    GROUP_FIELD_VALUE:929631

    COMMENT: Index field #2

    GROUP_FIELD_NAME:InvoiceDate

    GROUP_FIELD_VALUE:05/01/14

    COMMENT: Index field #3

    GROUP_FIELD_NAME:Recipient

    GROUP_FIELD_VALUE:Jackie Sample

    COMMENT: Index field #4

    GROUP_FIELD_NAME:Amount

    GROUP_FIELD_VALUE:18.00

    COMMENT: document data starts at beginning of file

    GROUP_OFFSET:0

    COMMENT: document data goes to end of file

    GROUP_LENGTH:0

    GROUP_FILENAME:Sample-invoice-1.pdf
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    Figure 11-3 shows a sample invoice that is loaded into Content Manager OnDemand for the scenario.
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    Figure 11-3   A sample invoice for scenario

    Defining the Application Group

    To define how the data is to be stored and index information is persisted in IBM Content Manager OnDemand, an Application Group must be defined. To do this, follow these simple steps:

    1.	Start the Content Manager OnDemand administration client from the Windows Start menu by selecting Start → All Programs → IBM OnDemand32 → OnDemand32 Administrator English and log in to the Content Manager OnDemand server by double-clicking it and using User ID admin with password ondemand.

    2.	Add a new application group by right-clicking the Application Group tree node and choosing New Application Group, as illustrated in Figure 11-4.
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    Figure 11-4   Starting creating a new application group

    3.	On the General tab, give the new application group a name, and choose a meaningful description. In this scenario, use Invoices as the Name and Redbooks Publications Sample PDF Invoices as the Description, as shown in Figure 11-5. Choose the Storage Management tab to proceed.

    [image: ]

    Figure 11-5   Defining the name and description for the application group

    4.	Select Cache Only - Library Server from the Storage Set Name selection, as presented in Figure 11-6, and select the Permissions tab to advance to the next step.
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    Figure 11-6   Defining the storage setting for an application group

    5.	To reduce complexity, this scenario does not need detailed security settings in Content Manager OnDemand. Select Administrator and click the Field Definition tab to proceed, as illustrated in Figure 11-7.
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    Figure 11-7   Defining permission settings for an application group

    After the application group is defined, next is to define the database table layout by adding fields and configuring their details using the following steps: 

    1.	Add field names to the new application group:

     –	InvoiveNumber

     –	InvoiceDate

     –	Recipient

     –	Amount

    To do this, type the field name into the Database Field Name text box and click Add, as shown in Figure 11-8. After all four field names are added, select the Field Information tab.
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    Figure 11-8   Defining database table field names for an application group

    2.	On the Field Information tab, the details about each field must be configured as illustrated in Figure 11-9. This is done by selecting each field name from the Name drop-down list, and setting the specific options for each field. Set the options for the four fields describing invoices, as shown in Table 11-1.
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    Figure 11-9   Defining database field details for an application group

    Table 11-1   Database field information for invoices

    
      
        	
          Name

        
        	
          Type

        
        	
          Data Type

        
        	
          Length (String only)

        
        	
          Segment

        
      

      
        	
          InvoiceNumber

        
        	
          Filter

        
        	
          String

        
        	
          20

        
        	
          no

        
      

      
        	
          InvoiceDate

        
        	
          Filter

        
        	
          Date

        
        	
          N/A

        
        	
          yes

        
      

      
        	
          Recipient

        
        	
          Filter

        
        	
          String

        
        	
          40

        
        	
          no

        
      

      
        	
          Amount

        
        	
          Filter

        
        	
          Decimal

        
        	
          N/A

        
        	
          no

        
      

    

    3.	After defining the details for all of the fields, click OK to create the new application group.

    Defining the application

    The application defines how data from a specific report or data source is loaded into an application group. Create a new application for invoices by following these steps:

    1.	Start the Content Manager OnDemand administration client by following step on from “Defining the Application Group” on page 341, if it is not already open.

    2.	Select the Application node and right-click it. Choose New Application from the menu, as shown in Figure 11-10.
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    Figure 11-10   Start creation of a new application

    3.	Give the new application the name Invoices 2014 and define a proper description (like Redbooks Publications Sample PDF Invoices for 2014), as shown in Figure 11-11. 

    4.	For the Application Group selection, click select and choose Invoices from the list of application groups in the window that appeared after clicking select. Close this window by clicking OK. Advance to the next step by clicking OK.
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    Figure 11-11   Start of the definition of a new application

    5.	From the Data Type drop-down list, select PDF, as presented in Figure 11-12. Click OK to proceed to the next step.
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    Figure 11-12   Viewer information for a new application

    6.	On the Indexer Information tab, select Generic from the drop-down list for Indexer, as shown in Figure 11-13. Click OK to go to the next step.
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    Figure 11-13   Select the generic indexer for the new application

    7.	The Load Information defines how data for the fields must be presented and handled. For instance, the date format must be defined as illustrated in Figure 11-14. In this case, use the following format for the invoice dates:

    %m/%d/%y like 12/13/14 meaning the 13th of December, 2014

    8.	Click OK four more times, until the new application is configured.
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    Figure 11-14   Defining data type-specific information for loading

    Defining the folder

    A folder defines how an application group can be queried, and how data is presented in the hit list. It is possible, to assign one or more application groups to a folder. For now, only one group is assigned to the new folder by following these steps:

    1.	Start the Content Manager OnDemand administration client by following step on from “Defining the Application Group” on page 341, if it is not already open.

    2.	Add a new folder by selecting the Folder tree node and choose New Folder from the menu (right click) as shown in Figure 11-15.
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    Figure 11-15   Starting to create a new folder

    3.	In the window that opens, give the folder a meaningful name and description. This information is presented to the user. It is not technical and must relate to the business problem that will be addressed. In this scenario, Content Manager OnDemand is used to gain deeper insight about the relationship to a customer. 

    Type Customer View in the Name text box, as illustrated in Figure 11-16, select the Invoices application group, and click Add. Click OK to advance to the next step.
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    Figure 11-16   Defining general settings for a new folder

    4.	On the Permissions tab, select Administrator, as presented in Figure 11-17. This scenario does not include sophisticated security models. If needed, that can be added at a later stage, but is out of scope for this book. Click OK to proceed.
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    Figure 11-17   Defining permissions for a new folder

    5.	On the Field Definition tab shown in Figure 11-18 on page 355, create one Folder Field for every Application Group field that should be queried by the user. Not all Application Groups must contain the same set of fields, but it is a leading practice that at least the most important query fields should be contained in all Application Groups assigned to a folder. 

    6.	To create a query field, define a meaningful Name, optionally a Description, a Data Type, and a Mapping Type. After filling the entry boxes, click Add to proceed with the next field. Repeat this step for all fields contained in Table 11-2. Click OK to go to the next step.

    Table 11-2   Folder field definition

    
      
        	
          Name

        
        	
          Description

        
        	
          Data type

        
        	
          Mapping type

        
      

      
        	
          Invoice Number

        
        	
          Invoice Number

        
        	
          String

        
        	
          single

        
      

      
        	
          Recipient

        
        	
          Recipient

        
        	
          String

        
        	
          single

        
      

      
        	
          Amount

        
        	
          Amount

        
        	
          Decimal

        
        	
          single

        
      

      
        	
          Invoice Date

        
        	
          Invoice Date

        
        	
          Date

        
        	
          single

        
      

    

    Figure 11-18 illustrates defining query fields in the Add a Folder window.
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    Figure 11-18   Defining query fields for folders

    7.	The Field Information tab is used to define how the user can interact with the folder query fields. Information about data types, data manipulation, data format, and allowed operators are defined in this dialog step, as illustrated in Figure 11-19 on page 357. To define this information for all fields, select every field in the Name drop down list and set the values according to Table 11-3. 

    Note that for this scenario, only a few settings are needed. If the order of fields should be changed (for instance, because they where created in a different order than documented in this book) this can be done by setting the position in the field Query and Hit according to your needs. After defining all fields, click OK to advance to the final step.

    Table 11-3   Defining field information for folder fields

    
      
        	
          Name

        
        	
          Default Operator

        
        	
          Allowed Operators

        
        	
          Display Format

        
        	
          Default Format

        
      

      
        	
          Invoice Number

        
        	
          Like

        
        	
          Equals, Not Equals, Like, Not Like

        
        	
          N/A

        
        	
          N/A

        
      

      
        	
          Recipient

        
        	
          Like

        
        	
          Equals, Not Equals, Like, Not Like

        
        	
          N/A

        
        	
          N/A

        
      

      
        	
          Amount

        
        	
          Equal

        
        	
          Equal, Not Equal, Less Than, Less Than or Equal, Greater Than, Greater than or Equal, Between, Not Between

        
        	
          2 Decimal Places

        
        	
          N/A

        
      

      
        	
          Invoice Date

        
        	
          Between

        
        	
          Equal, Between

        
        	
          %m/%d/%y

        
        	
          %m/%d/%y

        
      

    

    Figure 11-19 shows the Field information tab.
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    Figure 11-19   Definition of field information for every folder field

    8.	The final action is to map the folder query fields to fields of Application Groups. For now, only one Application Group is assigned to this folder, and there is a one-to-one relationship between folder fields and application group fields. 

    On the dialog presented in Figure 11-20 on page 358 sequentially select each folder field from the Name drop-down list. Select the corresponding application group field by clicking it in the Application Group Fields box, and click Add to create the mapping. When done, click OK to create the folder.
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    Figure 11-20   Creating a mapping between folder fields and application group fields

    Loading the sample data and verifying the configuration

    After creating the application group, the application, and a corresponding folder, the sample data can be loaded and the result can be verified. The sample data for invoices is contained in an archive file in the additional material to this book, and is named Content Manager OnDemand_Invoices_Load.zip, as described in 11.2.2, “Configuration prerequisites” on page 335. 

    Use these steps to load the sample invoices:

    1.	Open a Windows command prompt and switch to the directory in which the archive file was extracted. The content is shown in Figure 11-21.
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    Figure 11-21   Content of the sample data for invoices

    2.	To load the invoices, start the invoices_load.bat batch file (Figure 11-22).
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    Figure 11-22   Loading the sample invoices using the batch file invoice_loader.bat

    3.	Invoices have been successfully loaded if the batch file at the end of execution displays messages about the Load ID, Rows added to the database, and a final success confirmation.

    11.4.2  Configuration for loading a payment journal

    To show a completely different approach of configuring data storage, archiving, and access to data in Content Manager OnDemand, the payment journal archive is configured step-by-step like it was done for the PDF Invoices. Instead, the downloadable material that is associated with this book includes a preconfigured application group, application, and test data for archiving and storing payment reports. This chapter describes how the XML-based configuration works.

    Defining the application and the application group

    Follow these few simple steps to import preconfigured definitions into the Content Manager OnDemand system:

    1.	Use the Windows Explorer to locate the CMOD-Payment-Load directory, that was created by extracting the CMOD-Payment-Load archive from the additional material in this book (see 11.2.2, “Configuration prerequisites” on page 335). Copy the .xml file from it into the xml directory located under the installation directory of Content Manager OnDemand (see Figure 11-23 as a reference).
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    Figure 11-23   The XML files needed for the configuration import into Content Manager OnDemand

    2.	In Windows, open a command prompt and change into the xml directory under the Content Manager OnDemand installation directory. Use the command prompt shown in Figure 11-24 to start the configuration import. The following example shows the command syntax:

    arsxml add -h <hostname> -u admin -p <password> -d . -i payment2014.xml

    Replace <hostname> either with localhost, the host name, or the IP address configured for the system where Content Manager OnDemand is running. As a password, use the one configured when initially configuring Content Manager OnDemand. The default for this use case is ondemand.

    As a result, the Payment2014 application and the PaymentJournal application group are added to Content Manager OnDemand’s configuration. The next step is to add this new application group to the Customer View folder using the Content Manager OnDemand administration client.
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    Figure 11-24   Starting the xml admin tool for Content Manager OnDemand

    Extending the folder to include the new application group

    To include the new application group, follow these steps:

    1.	To get started, perform the following actions, as shown in Figure 11-25:

    a.	Open the Content Manager OnDemand administration client from the Windows Start menu.

    b.	Log in to the Content Manager OnDemand server. 

    c.	Go to the Customer View folder.

    d.	Right-click the folder and select Update.
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    Figure 11-25   Start adding the payment application group to a folder in Content Manager OnDemand

    2.	On the General tab, add the new application group to the folder, as shown in Figure 11-26:

    a.	Selecting it in the left column.

    b.	Move it to the right by clicking Add. 

    c.	To proceed, click the Field Definition tab.

    [image: ]

    Figure 11-26   Add a new application group to a folder

    3.	Because the payment report has a slightly different set of information fields, and this additional data does add value for the user, the relevant information must be added to the folder for searching and displaying in hit lists, as shown in Figure 11-27:

    a.	Start by adding a new field. 

    b.	Complete a Name (Payment Date), an optional Description, a Field Type (Date), and a Mapping Type (Single). 

    c.	Go on by clicking the Field Information tab.
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    Figure 11-27   Create an additional field for a folder

    4.	On the Field Information tab, set the field details as shown in Figure 11-28:

    a.	For this, select the new field from the Name drop-down list.

    b.	Define the Default Operator as Between.

    c.	Select Allowed Operators Equal and Between

    d.	Select %m/%d/%y for the Formats. 

    e.	Select the Interval.

    f.	Click the Field Mapping tab to proceed.
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    Figure 11-28   Setting details for a new folder field

    5.	As a final step to include the new application group into the folder, the folder fields must also be mapped to the fields of the new application group. This step tells Content Manager OnDemand to query information from all application groups that are part of the mapping. 

    6.	Figure 11-29 on page 367 shows how to extend the existing mapping. For the folder fields that should be mapped to the new application group, perform the following sequence of steps:

    a.	Select the folder field from the Name drop down list. 

    b.	Select the corresponding field for the new application group (PaymentJournal) in the Application Group Fields list.

    c.	Click Add to add the mapping to the list of existing mappings.

    d.	Do this for all of the fields shown in Table 11-4.

    e.	Click OK to store the new settings. 

    Table 11-4   Folder Field Mapping for PaymentJournal

    
      
        	
          Folder Field

        
        	
          Application Group

        
        	
          Application Group Field

        
      

      
        	
          Invoice Number

        
        	
          PaymentJournal

        
        	
          TxInvoiceNumber

        
      

      
        	
          Payment Date

        
        	
          PaymentJournal

        
        	
          TxDate

        
      

      
        	
          Amount

        
        	
          PaymentJournal

        
        	
          TxAmount
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    Figure 11-29   Adding new application group fields to the folder field mapping

    Loading the sample data and verifying the configuration

    After configuring the new application and application group in combination with a folder to query the content, loading the sample data is the next step. The sample data is contained in the additional material as an archive, as described in 11.2.2, “Configuration prerequisites” on page 335. The specific data for payment journals is contained in an archive file named CMOD_Payment_Load.zip.

    To load the data, follow these steps:

    1.	Open a Windows command prompt and switch to the directory in which the archive file was extracted. The content is shown in Figure 11-30.
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    Figure 11-30   Sample data contents for the payment journal

    2.	Start the payment_loader.bat batch file, as shown in Figure 11-31 on page 369.
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    Figure 11-31   Loading sample payment data using the batch file payment_loader.bat

    3.	The data is loaded successfully if the final messages of the batch file indicate the Load ID, the number of rows added, the compression result, and a final success message.

    11.4.3  Configuring IBM Content Navigator and IBM Case Manager to include Content Manager OnDemand data into the case environment

    To add a capability for querying information from Content Manager OnDemand repository to the caseworker environment, IBM Content Navigator must be configured to include this feature and present it on the IBM Case Manager desktop. This section shows how this integration is done. 

    This section builds on the configuration performed in “Verification with IBM Content Navigator” on page 328.

    Follow these steps to add a search feature for IBM Content Manager OnDemand to the case environment:

    1.	Open the IBM Content Navigator administration desktop by pointing a supported browser to the following URL:

    http://localhost:9080/navigator?desktopn=admin

    The localhost can be exchanged by the IP address or real host name of the system running IBM Content Navigator.

    2.	Log in to the administration desktop using the following credentials:

     –	User ID admin 

     –	Password IBMFileNetP8

    3.	Open the list of desktops by selecting Desktops on the left side, as shown in Figure 11-32, and open the Case Manager (ID is ICM) desktop by double-clicking it on the right side.
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    Figure 11-32   Opening the Case Manager desktop in Content Navigator

    4.	Choose the Repositories tab and add the Content Manager OnDemand repository to it, as illustrated in Figure 11-33:

    a.	Selecting OD on the left side

    b.	Click the right-arrow between the two lists. 

    c.	Choose the Appearance tab to proceed.
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    Figure 11-33   Adding the Content Manager OnDemand repository to the Case Manager desktop

    5.	On the Appearance tab, scroll down to the Desktop Features section and make sure that Search and Browse are contained in the right list of selected features, as presented in Figure 11-34. If not, select them on the left, add them by clicking the right-arrow between the lists, and select the default repository for Browse and Search in the section below the feature lists.

    [image: ]

    Figure 11-34   Ensuring, that the Search and Browse features are available

    Save the desktop configuration by clicking Save and Close above the desktop pane.

    6.	Verify the configuration by opening the Case Manager desktop. Direct the browser to this URL:

    http://localhost:9080/navigator?desktop=icm

    Log in to the desktop using User ID admin with the password IBMFileNetP8.

    7.	Open the search feature (the magnifying glass icon) by selecting it on the left vertical icon bar and choose the OD repository, as shown in Figure 11-35.
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    Figure 11-35   Verifying access from Case Manager to Content Manager OnDemand

    8.	Issue a search and look at the results list, as shown in Figure 11-36 on page 375. To start a search, select the Customer View on the left from the list of all searches. On the right pane, change the operator for the criteria Amount to Greater than and type 200 into the criteria field. 

    9.	Click Search to start the search. The list of criteria collapses and a result set is presented instead. It does contain PDF icons and line data icons to illustrate that the results come from the invoices application group and the payment journal.
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    Figure 11-36   Search results from Content Manager OnDemand presented in the caseworker desktop

    Now, the caseworker can use Content Manager OnDemand to gain deeper insight about the customer, when it comes to complaints.

    11.4.4  Configuring FileNet Content Federation Services to integrate Content Manager OnDemand with a FileNet P8 catalog

    This section describes how Content Manager OnDemand and FileNet P8 can be integrated using the Content Federation Service for Content Manager OnDemand (also referred to as CFS-OD or FileNet Content Federation Services if the general capability is addressed). 

    The basic design of FileNet Content Federation Services is to federate content from non-P8 repositories into FileNet P8 by creating a catalog in FileNet P8 that has information about all external items that should be accessible through FileNet P8 clients or applications. 

    The second design principle of FileNet Content Federation Services is that this integration is transparent to the user and the applications. All federated content looks like it is a native FileNet P8 content object. 

     

    
      
        	
          Note: Federating content from Content Manager OnDemand into another repository needs thorough planning. In typical customer setups, Content Manager OnDemand holds a huge amount of data, and daily loads much new content. Content Manager OnDemand is optimized to work with this data in a specific way.

          When planning for federation, size, amount, and performance of the target repository does require detailed planning about what really must be federated. Otherwise, the target repository might get overloaded.

        
      

    

    In this scenario FileNet Content Federation is used in two solution components. It is integrated with IBM Enterprise Records to reach out to content stored in Content Manager OnDemand for records management, and it is the basis to access Content Manager OnDemand content from a caseworker environment on the context of a specific case. 

    Follow these steps to configure FileNet Content Federation Services on both sides, FileNet P8 and Content Manager OnDemand. For this, an administrative user for IBM FileNet P8 is needed and one for Content Manager OnDemand. The following list includes the defaults for this scenario:

     –	IBM FileNet P8: user p8admin with a password of IBMFileNetP8.

     –	IBM Content Manager OnDemand: user admin with a password of ondemand.

    11.4.5  Configuring IBM FileNet P8 basics for FileNet Content Federation Services

    The first part of the configuration is done using the Administration Console for Content Platform Engine (ACCE) application to define administrative settings in IBM FileNet P8. A Fixed Content Device and a Storage Area need to be configured:

    1.	Open the ACCE application by pointing your browser to the following URL:

    http://localhost:9080/acce

    Login using the FileNet P8 admin user as documented previously.

    2.	Expand the FileNet P8 Domain → Global Configuration as shown in Figure 11-37 on page 377, and find the Section for Fixed Content Devices (FCD) by clicking the twistie in this order: P8Domain → Global Configuration → Administration → Fixed Content Device.
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    Figure 11-37   Start creating a Fixed Content Device in FileNet P8 ACCE

    3.	Click New to start creating a new FCD.

    4.	To create a new FCD, a sequence of steps in a type of wizard need to be completed as follows:

    a.	Give the new FCD a name, as shown in Figure 11-38. Use CMOD-FCD for this scenario.
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    Figure 11-38   Naming the new Fixed Content device

    b.	Click Next to advance to the next step.

    c.	Specify the type of the new FCD. Figure 11-39 illustrates selecting IBM Content Manager OnDemand. Click Next to proceed.
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    Figure 11-39   Selecting the Fixed Content Device type

    d.	Define the FCD details, as shown in Figure 11-40 and Figure 11-41 on page 379. Specifically, in this scenario, use TARGETOSDS for Federation Java Naming and Directory Interface (JNDI) data source and TARGETOSDSXA for Federation JNDI XA data source. 

    e.	Specify Content Manager OnDemand user admin and the password ondemand. Click Next to proceed to the final step.
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    Figure 11-40   Details for Fixed Content Device 1 of 2
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    Figure 11-41   Details for Fixed Content Device 2 of 2

    f.	On the Summary page presented in Figure 11-42, click Finish to configure the FCD.
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    Figure 11-42   Summary of details for the Fixed Content Device

    With this step, the FCD is created. Continue by creating the Storage Area.

    5.	Go to the Storage Area section, as shown in Figure 11-43. For this, open the TARGETOS Object Store from the P8Domain → Object Stores section by double-clicking it. Expand the Administrative section and select the Storage Area entry. Click New to start creating a new Storage Area.
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    Figure 11-43   Start creating a new Storage Area

    6.	To create a new Storage Area, follow a wizard through a sequence of steps:

    a.	Start by defining the Storage Area name, as shown in Figure 11-44. In this scenario, give it a name of CMOD_SA and click Next to proceed.
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    Figure 11-44   Start creation of a Storage Area

    b.	Link this Storage Area to the Fixed Content Device created in the previous steps by selecting the FCD named CMOD_FCD from the drop-down list for Fixed content device, as illustrated in Figure 11-45. 

    c.	Set the Retention mode to Non-aligned and click Next to advance to the next step.
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    Figure 11-45   Link Storage Area and Fixed Content Device

    d.	Specify the disk storage area, as shown in Figure 11-46. Be sure to use the Universal Naming Convention (UNC) name of an existing share if you are on Windows. Click Next to proceed.
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    Figure 11-46   Define disk storage for the Storage Area

    e.	Select the Default Database Storage Policy as presented in Figure 11-47 and click Next.
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    Figure 11-47   Define a Default Database Storage Policy for the Storage Area

    f.	On the summary page shown in Figure 11-48, click Finish to start creating the Storage Area. Figure 11-49 on page 383 shows the successful creation of the Storage Area.
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    Figure 11-48   Create the Storage Area
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    Figure 11-49   Storage Area created successfully

    With this step, FCD and Storage Area are created successfully and ready to be used by FileNet Content Federation Services. This concludes the first part of preparation for the integration of FileNet Content Federation Services with OnDemand.

    11.4.6  Preparing Content Manager OnDemand for FileNet Content Federation Services integration

    The next task is performed using the Content Manager OnDemand Administrator client. Follow these steps to complete it:

    1.	Start the Content Manager OnDemand Administrator client from the Windows Start menu, and log in to the Content Manager OnDemand repository by double-clicking it. Use the user admin and a password of ondemand.

    2.	Click the Application Group section and repeat the following steps for each of the two application groups, named Invoices and PaymentJournal:

    a.	Select the application group and click-right it to open the menu. Select update to open the properties in write mode.

    b.	On the General tab, click Advanced.

    c.	Make sure that, in the Interoperate with FileNet P8 Platform section, Yes is selected for Use Content Federation Services, and that Federate Documents automatically is also selected, as shown in Figure 11-50. 

    d.	Click OK to close the window and choose the Field Definition tab to proceed.
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    Figure 11-50   Enable an Application Group for FileNet Content Federation Services: General settings

    e.	On the Field Definition tab, type cfsod as the Database Field Name and click Add to add the new field to the application group, as presented in Figure 11-51. 

    f.	Make a note of each field and its data type (take that information from the Field Information tab in the next step) that should be federated over to FileNet P8. Select the Field Information tab.
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    Figure 11-51   Create a new Database Field Name for FileNet Content Federation Services integration

    g.	On the Field Information tab, select the field named cfsod from the Name drop down list, as illustrated in Figure 11-52. Make sure that the Type is set to Filter, and that CFS-CMOD is selected. Click OK to persist the new settings.
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    Figure 11-52   Define characteristics of the FileNet Content Federation Services database field

    3.	The preparation of Content Manager OnDemand for interoperation with FileNet Content Federation is done after all application groups that contain content that should be federated are enabled for FileNet Content Federation Services. Close the Content Manager OnDemand Administrator.

    11.4.7  Extending a case solution to include federated content

    The third configuration step takes part in IBM Case Manager. For this, open the Case Manager Builder application by directing a browser to the following URL:

    http://localhost:9080/CaseBuilder/designer/DesignerHome.jsp

    Follow these steps to create the FileNet P8 document class for holding the information federated with Content Manager OnDemand:

    1.	In Case Manager Builder, open the case template named Customer Response Management by selecting Edit, and select the Document Types tab, as shown in Figure 11-53. Click Add Document Type to proceed.
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    Figure 11-53   Start Creating a new Document Type in Case Manager Builder

    2.	Perform the following steps for each Application Group that should be federated from Content Manager OnDemand into FileNet P8 (Invoices and PaymentJournal in this case):

    a.	Give the new document type a name corresponding to the name in Content Manager OnDemand, as presented in Figure 11-54. Use CMOD_Invoices for the Invoices application group and CMOD_Payment for PaymentJournal.
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    Figure 11-54   Create a new Document Type for a case solution

    b.	For each application group property that should be federated into the new document type, click Add Property and complete the dialog that appears. Either select Existing and choose a matching property from the case properties list, or select New and give it a corresponding Name and Data Type. This is illustrated in Figure 11-55.
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    Figure 11-55   Case Manager Builder choose Properties for Document Type

    c.	Make sure that there is a property named OD-P8ID of type Integer in addition to the metadata properties, as shown in Figure 11-56.
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    Figure 11-56   Case Manager Builder create a new Property for a Document Type

    3.	Close the solution by clicking Save and Close in the top action bar of Case Manager Builder.

    Finally, the mapping between the application group and the document type, and the corresponding fields from Content Manager OnDemand and FileNet P8, needs to be created: 

    1.	This is done in ACCE using a browser. Point the browser to the following URL:

    http://localhost:9080/acce

    2.	Log in using p8admin as the user and IBMFileNetP8 as the password. 

    3.	Find the tab Replication Class Mapping in the object store TARGET. Open TARGET by selecting it from P8Domain → Object Store → TARGET and double-clicking it. This is presented in Figure 11-57. 
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    Figure 11-57   Start creating a new Replication Class Mapping

    4.	Click New to start creating a new mapping. Repeat the following steps for all document types that need to be federated. In this case this is CMOD Invoices and CMOD Payments:

    a.	As shown in Figure 11-58, select the CMOD_FCD Fixed Content Device (as created for the federation with Content Manager OnDemand) from the drop-down list for External Repository. 

    b.	Select the Class Mapping by choosing the application group in the list of External Classes and corresponding Content Platform Engine Class. Select both as Replication direction. Click OK. 
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    Figure 11-58   Create a new Replication Class Mapping

    c.	Open the newly created Replication Class Mapping by double-clicking it and choose the Replication Property Mappings tab. To create new field mappings, click New as illustrated in Figure 11-59. Repeat this for as many fields as should be mapped.
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    Figure 11-59   Start creating new Replication Field Mappings

    d.	As shown in Figure 11-60, choose the field from the External Class and select the corresponding field in the list of fields for the Content Platform Engine Class. Note that only type matching fields are presented in the right list. Make sure that cfsod is mapped to OD-P8ID.
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    Figure 11-60   Define a property mapping

    e.	As a result, the list of mappings as presented in Figure 11-61 is created. Click Close to finish the setup.
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    Figure 11-61   Result of field mappings (this is the mapping for Content Manager OnDemand Invoices)

    11.4.8  Starting the federation task

    After the configuration of IBM FileNet P8, IBM Content Manager OnDemand, and IBM Case Manager, the federation process itself can be started by exporting the items that should be federated into the federation database. To do this, follow these steps:

    1.	Open Windows Explorer and change to the installation directory for IBM Content Manager OnDemand Web Enablement Kit. Create the directories CMODExporter, CMODExporter\trace, and CMODExporter\config, as shown in Figure 11-62.
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    Figure 11-62   Directory structure used by the Content Manager OnDemand FileNet Content Federation Services exporter

    2.	Store the exporter settings by running the following program in a Windows command line:

    java -cp "C:\Program Files\IBM\tdsV6.3db2\java\db2jcc4.jar";"C:\Program Files\IBM\tdsV6.3db2\java\db2jcc_license_cu.jar";"C:\Program Files\IBM\OnDemand Web Enablement Kit\V9.0\exporter\CFSODExporter.jar" com.ibm.cm.od.exporter.Exporter configure -u Administrator,osdbuser -p itsoadmin,IBMFileNetP8 -e db2,db2 -I ARCHIVE,TARGETDB -h localhost,localhost -o 50000,50000 -d "C:/Program Files/IBM/onDemand Web Enablement Kit/V9.0/CMODexporter/trace" -n 200 -t 1 -f "C:\Program Files\IBM\OnDemand Web Enablement Kit\V9.0\CMODexporter\config\exporter_fcd.config"

     

    
      
        	
          Note: The command must be entered as ONE single line, and the documentation for running the Content Manager OnDemand exporter can be unclear in some places: 

          •Flag -I: The documentation talks about database instances. It really needs the database, instead. Use the database name of Content Manager OnDemand and the Target Object Store used for the federation, such as ARCHIVE,TARGETDB.

          •Flag -d: The path following the -d flag to configure the directory for tracing must be given with forward slash (/) rather than back slash (\).

        
      

    

    The output of the command looks like that shown in Figure 11-63.
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    Figure 11-63   Result of storing the Content Manager OnDemand FileNet Content Federation Services exporter configuration

    3.	After storing the exporter settings, the federation run can take place the first time by running this command in a Windows command prompt:

    java -cp "C:\Program Files\IBM\tdsV6.3db2\java\db2jcc4.jar";"C:\Program Files\IBM\tdsV6.3db2\java\db2jcc_license_cu.jar";"C:\Program Files\IBM\OnDemand Web Enablement Kit\V9.0\exporter\CFSODExporter.jar" com.ibm.cm.od.exporter.Exporter federate -f "C:\Program Files\IBM\OnDemand Web Enablement Kit\V9.0\CMODexporter\config\exporter_fcd.config"

    The result is presented in Figure 11-64.

    [image: ]

    Figure 11-64   Result of running the Content Manager OnDemand FileNet Content Federation Services exporter

     

    
      
        	
          Note: if you see this Java exception upon subsequent runs of the exporter, the configuration file was corrupted. This can happen if it was touched with an editor or otherwise changed:

          javax.crypto.BadPaddingException: Given final block not properly padded
at com.sun.crypto.provider.CipherCore.doFinal(CipherCore.java:811)
at com.sun.crypto.provider.CipherCore.doFinal(CipherCore.java:676)
at com.sun.crypto.provider.DESedeCipher.engineDoFinal(DESedeCipher.java:294)
at javax.crypto.Cipher.doFinal(Cipher.java:2087)
at com.ibm.cm.od.exporter.ODExporterUtil.decryptString(ODExporterUtil.java:726)
at com.ibm.cm.od.exporter.ODExporterDB.configureDB(ODExporterDB.java:127)
at com.ibm.cm.od.exporter.ODExporterDB.<init>(ODExporterDB.java:61)
at com.ibm.cm.od.exporter.ODExporter.federateODMetadata(ODExporter.java:
76)
at com.ibm.cm.od.exporter.Exporter.main(Exporter.java:168)
federateODMetadata encountered an exception:
javax.crypto.BadPaddingException: Given final block not properly padded

          In that case, rerun the command described in Step 2 previously.

        
      

    

    Upon successful completion, and if there was content that had to be federated, the result is that the exporter generated federation orders in the FileNet Content Federation Services database. 

    11.4.9  Verifying the federated items and working with them in IBM Case Manager

    After a few minutes, when the FileNet Content Federation Services importer has finished its work, the federated objects from Content Manager OnDemand are accessible through FileNet P8 clients. When performing a query against the new document type in IBM Content Navigator, the federated items appear as normal hit list entries like those shown in Figure 11-65.
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    Figure 11-65   Result of a query for Invoices in FileNet P8 after federation with Content Manager OnDemand

    If there is no content found after successfully running the exporter and waiting for a few minutes, it might be that no content in Content Manager OnDemand was marked to be federated. This happens if the content of Content Manager OnDemand was loaded before the CFS-OD configuration was performed. 

    In this case, perform the following steps:

    1.	Use the Content Manager OnDemand user client, search for the content, and manually mark it for federation, as shown in Figure 11-66. Multiple items can be selected and processed at the same time.
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    Figure 11-66   Manually mark Content Manager OnDemand content for federation to FileNet P8

    2.	The content can now also be used in the caseworker environment. Depending on the case configuration, in the case overview, go to the Documents tab. 

    3.	Click Add to add a new document to the case. Search for the Item by selecting the appropriate document type in FileNet P8 and add it to the case as presented in Figure 11-67 and Figure 11-68 on page 401.
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    Figure 11-67   Search for CMOD invoice inside the case client to add it to a case
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    Figure 11-68   Result after adding a Content Manager OnDemand Content Item to a case
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Installing and configuring IBM Enterprise Records

    This chapter describes the procedure to install and configure an IBM Enterprise Records environment and integrate it with IBM Case Manager. 

    This chapter provides information about the following topics:

    •Overview

    •Prerequisites

    •Installing IBM Enterprise Records

    •Configuring IBM Enterprise Records

    12.1  Overview

    IBM Enterprise Records can be an add-on component to IBM Enterprise Content Manager solutions. IBM Enterprise Records enables organizations to create and maintain accurate, secure, and reliable records for any electronic information according to fiscal, legal, and regulatory requirements.

    IBM Enterprise Records is designed to uniquely combine content, process, and connectivity into a compliance infrastructure to automate and streamline records-based activities, eliminate unnecessary user participation, enforce compliance, and create business advantage through a compelling return on investment (ROI).

    IBM Enterprise Records supports the full lifecycle of records. Enforcement and compliance become both achievable and cost-effective. IBM Enterprise Records Manager also provides the flexibility to create single or multiple file plans for the purpose of managing records across the enterprise. A file plan represents a record classification and a storage schema that comprise a hierarchical structure of record management entities.

    IBM Enterprise Records helps solve regulatory compliance challenges by achieving the following goals:

    •Automating the entire records management lifecycle process

    •Imperceptibly enforcing consistent compliance and records management policy throughout an enterprise

    •Organizing, securely storing, and quickly retrieving essential company records

    Figure 12-1 shows the use case solution components that we build for this book. In this chapter, we build IBM Enterprise Records, one of the core components for the IBM Enterprise Content Management (ECM) solution. The shaded boxes with solid lines in the figure represent the components and products that we have built so far.
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    Figure 12-1   Use case context in relation to the overall solution components

    12.2  Prerequisites

    The hardware and software prerequisites are described in this section.

    12.2.1  Hardware prerequisites

    Refer to the hardware requirements listed for the IBM Case Manager Platform Installation Tool (CMPIT) installed in 4.2, “Prerequisites” on page 38.

    12.2.2  Software prerequisites

    A fully configured, and running IBM FileNet P8 5.2 Platform environment is required before installing and configuring IBM Enterprise Records. For instructions on how to set up the FileNet environment, see chapter Chapter 4, “Installing and configuring IBM Case Manager” on page 35.

    The case solution described in Chapter 5, “Implementing the IBM Case Manager use case” on page 73 should also be created and deployed before continuing.

    12.3  Installing IBM Enterprise Records

    This section describes the installation steps for IBM Enterprise Records.

    12.3.1  Downloading the installer components

    The IBM Enterprise Records installer, shown in Table 12-1, can be downloaded from IBM Passport Advantage:

    http://www.ibm.com/software/passportadvantage/pao_customer.html

    Table 12-1   Enterprise Records installer

    
      
        	
          Software

        
        	
          Part number (Windows)

        
      

      
        	
          IBM Enterprise Records 5.1.2 Windows Multilingual

        
        	
          CIX7VML

        
      

    

    The FileNet Content Platform Engine client installer, shown in Table 12-2, can be downloaded from IBM Support Fix Central:

    https://www.ibm.com/support/fixcentral/

    Table 12-2   Client installer

    
      
        	
          Software

        
        	
           Download file

        
      

      
        	
          Content Platform Engine Client 5.2 Fix Pack 3

        
        	
          5.2.0.3-P8CPE-CLIENT-WIN-FP003a.zip

        
      

    

    12.3.2  Running the IBM Enterprise Records installer

    Complete the following steps to install IBM Enterprise Records using the downloaded installer:

    1.	Log in as the (local) Administrator user, and go to the downloaded IBM Enterprise Records installer archive folder.

    2.	Extract the contents of the installer archive.

    3.	Run the 5.1.2-IER-WIN.exe installer.

    4.	Accept the default installation location, as shown in Figure 12-2.
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    Figure 12-2   Enterprise Records installation directory

    5.	Review the pre-installation summary, shown in Figure 12-3, and click Install.
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    Figure 12-3   Pre-installation summary

    6.	When the installation is complete, click Done.

    12.3.3  Running the IBM FileNet Content Platform Engine Client

    Install the current Content Platform Engine Client files on Enterprise Records using the following steps: 

    1.	Go to the Content Platform Engine Client Fix Pack archive folder.

    2.	Extract the contents of the fix pack archive.

    3.	Run the fix pack 5.2.0.3-P8CPE-CLIENT-WIN-FP003.exe installer.

    4.	Enter the Content Platform Engine client/server parameters, as shown in Figure 12-4:

     –	Host Name: localhost

     –	Port number: 9080

    5.	Click Next.
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    Figure 12-4   Content Platform Engine client download parameters

    6.	Select only IBM Enterprise Records, and clear all other FileNet P8 Applications, as shown in Figure 12-5.
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    Figure 12-5   Select FileNet P8 applications

    7.	Review the default Enterprise Records installation directory, and click Next.

    8.	Click Next to stop the IBM Case Foundation Components.

    9.	Review the pre-installation summary, and click Install.

    10.	Click Next to start the IBM Case Foundation Components, and then click Done.

    12.4  Configuring IBM Enterprise Records

    After the installation is complete, you must create a new file plan object store (FPOS) using the Administration Console for Content Platform Engine (ACCE), configure the IBM Enterprise Records object stores using the Enterprise Records Configuration Manager, and then configure the Enterprise Records administration plug-in inside IBM Content Navigator.

    12.4.1  Create a File Plan object store (FPOS)

    The following steps describe the procedure to create a File Plan object store.

    Creating a DB2 database

    Complete the following steps to create a DB2 database:

    1.	Create a Windows batch file, as shown in Example 12-1.

    Example 12-1   Database create script - create_FPOS_DB.bat
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    REM Initialize script variables

    set DBNAME=FPOSDB

    set DBDRIVE=C:

    set DBDIR=\DB2TDS63\NODE0000

    set DBUSER=osdbuser

     

    REM Close all open connections

    db2 -v CONNECT RESET

     

    REM Create the database

    db2 -v -t ^

    CREATE DATABASE %DBNAME% AUTOMATIC STORAGE YES ON '%DBDRIVE%' ^

    USING CODESET UTF-8 TERRITORY US COLLATE USING SYSTEM PAGESIZE 32768;

     

    REM Connect to the database

    db2 CONNECT TO %DBNAME%

     

    REM Create the database tablespaces

    db2 -v -t ^

    CREATE REGULAR TABLESPACE %DBNAME%_TS PAGESIZE 32 K ^

    MANAGED BY AUTOMATIC STORAGE EXTENTSIZE 16 OVERHEAD 10.5 ^

    PREFETCHSIZE 16 TRANSFERRATE 0.14 BUFFERPOOL IBMDEFAULTBP ^

    DROPPED TABLE RECOVERY ON;

     

    db2 -v -t ^

    CREATE USER TEMPORARY TABLESPACE USRTEMP_TS PAGESIZE 32 K ^

    MANAGED BY AUTOMATIC STORAGE EXTENTSIZE 16 OVERHEAD 10.5 ^

    PREFETCHSIZE 16 TRANSFERRATE 0.14 BUFFERPOOL IBMDEFAULTBP;

     

    REM Set the database access permissions

    db2 GRANT CREATETAB, CONNECT, SECADM ON DATABASE TO USER %DBUSER%

    db2 GRANT USE OF TABLESPACE %DBNAME%_TS TO USER %DBUSER%

    db2 GRANT USE OF TABLESPACE USRTEMP_TS TO USER %DBUSER%

     

    REM Set the database configuration parameter

    db2 UPDATE DATABASE CONFIGURATION USING APPLHEAPSZ 2560 IMMEDIATE

     

    REM  close all open connections

    db2 -v CONNECT RESET
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    2.	Start the IBM DB2 Command Window from the Start menu, as shown in Figure 12-6.
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    Figure 12-6   Start DB2 command line processor

    3.	Change directory to the location of the file (create_FPOS_DB.bat) created in step 1 on page 410, and run the batch file, as shown in Figure 12-7.
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    Figure 12-7   DB2 command line processor

    Creating the JDBC data source for the FPOS database

    Use the following steps to create the JDBC data source for the FPOS database:

    1.	Start the FileNet Configuration Manager using the start menu, as shown in Figure 12-8.
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    Figure 12-8   Start FileNet Configuration Manager

    2.	Click File → Open Profile, and browse to the C:\Program Files (x86)\IBM\cmpit\install-scripts\profiles\CEConfig folder. Select the CEConfig.cfgp profile, as shown in Figure 12-9. Click Open.
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    Figure 12-9   Open configuration profile

    3.	Right-click Configure Case History Object Store and select Add New Task → Configure Object Store JDBC Data Sources, as shown in Figure 12-10.
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    Figure 12-10   Add new task

    4.	Open (double-click) the task added in step 3 on page 414. Complete the following parameters as shown in Figure 12-11 on page 415:

     –	JDBC driver name: DB2 Universal JDBC Driver

     –	JDBC driver version: 4.0

     –	JDBC data source name: FNFPOSDS

     –	JDBC XA data source name: FNFPOSDSXA

     –	Database server name: localhost

     –	Database port number: 50000

     –	Database name: FPOSDB

     –	Database user name: osdbuser

     –	Database password: see the C:\Program Files (x86)\IBM\cmpit\
accounts.txt file

    5.	Click Save. Then click Test Database Connection.

    6.	On successful completion of the database connection test, click Run Task.
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    Figure 12-11   JDBC Data Sources task parameters

    Creating a database connection

    Use the following steps to create a database connection:

    1.	Log in to the Administration Console for Content Platform Engine:

    a.	Use the following URL:

    http://localhost:9080/acce/ 

    b.	Use the following credentials:

     –	User name: P8Admin

     –	Password: See the C:\Program Files (x86)\IBM\cmpit\accounts.txt file

    2.	Go to Global Configuration → Administration → Database Connections, and click New to start the database connection creation wizard.

    3.	In the Display name field, enter FPOS Database Connection, as shown in Figure 12-12. Click Next. 
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    Figure 12-12   Database connection name

    4.	Enter FNFPOSDS in the JNDI data source field, and press the Tab key on your keyboard. FNFPOSDSXA populates the JNDI XA data source field, as shown in Figure 12-13. Click Next.
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    Figure 12-13   Database connection JNDI data sources

    5.	In the Summary pane, click Finish. Verify that the New Database Connection was successfully created, and then click Close.

    Creating the FPOS Object Store

    To create the FPOS Object Store, use the following steps:

    1.	In the Administration Console for Content Platform Engine, click Object Stores, and then New. Alternatively, right-click Object Stores and select New Object Store to start the Object Store creation wizard.

    2.	In the Display name field, enter FPOS, as shown in Figure 12-14. Click Next.
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    Figure 12-14   Create object store wizard

    3.	In the Database connection field, select the connection created in “Creating a database connection” on page 415 from the drop-down menu, and enter FPOS in the Schema name field, as shown in Figure 12-15. Click Next.
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    Figure 12-15   Select database connection

    4.	In the Select the Type of Storage Area for Content pane, verify that Database is selected, as shown in Figure 12-16. Click Next.
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    Figure 12-16   Select Storage Area type

    5.	In the Grant Administrative Access pane click Add.

    6.	Enter P8Admins in the Search field. 

    7.	Click Search, select P8Admins from the results, click the top arrow to add it, and click OK, as shown in Figure 12-17. Click Next.
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    Figure 12-17   Grant administrative access

    8.	In the Grant Basic Access pane, repeat the procedure in step 6 on page 420 to add the #AUTHENTICATED-USERS group, as shown in Figure 12-18.
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    Figure 12-18   Grant basic access

    9.	Click Workplace/ Workplace XT Configuration, as shown in Figure 12-19, to ensure that the required add-ons are installed when the object store is created. Click Next.

     

    
      
        	
          Note: Make sure none of the Enterprise Records Add-ons are selected. They will be added later in section 12.4.2, “Configuring Enterprise Records object stores” on page 424.
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    Figure 12-19   Object store add-ons

    10.	In the Summary pane, review the information, and click Finish.

    11.	Verify that your object store was successfully created, and click Close.

    12.4.2  Configuring Enterprise Records object stores

    To configure Enterprise Records object stores, complete the following steps:

    1.	Start the Enterprise Records Configuration Manager tool:

    C:\Program Files (x86)\IBM\EnterpriseRecords\configure\configmgr.exe

    2.	Click File → New Installation Profile

    3.	Select the Object store configuration for new installation Profile type, as shown in Figure 12-20. Click Next.
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    Figure 12-20   Create configuration profile

    4.	Enter the Content Engine server connection properties, as shown in Figure 12-21:

     –	Content Engine server WSI URL: 

    http://localhost:9080/wsi/FNCEWS40MTOM

     –	Content Engine administrator user name: P8Admin

     –	Content Engine administrator password: See the C:\Program Files (x86)\IBM\cmpit\accounts.txt file

    5.	Click Test Connection, and then click Finish.
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    Figure 12-21   Content Engine server properties

    6.	Open (double-click) the Create Marking Sets and Add-ons task. Enter the task parameters, as shown in Figure 12-22:

     –	GCD Administrator: P8Admin

     –	GCD password: See the C:\Program Files (x86)\IBM\cmpit\
accounts.txt file

     –	Data Model: Base

    7.	Click Save, and then click Run Task.
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    Figure 12-22   Create marking sets and add-ons task

    8.	Open (double-click) the Configure File Plan Object Stores task. Select the task parameters, as shown in Figure 12-23:

     –	Object Store: FPOS

     –	Data Model: Base

    9.	Click Save, and then click Run Task.
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    Figure 12-23   Configure file plan object store task

    10.	Open (double-click) the Configure Record Object Store task. Select the task parameters, as shown in Figure 12-24:

     –	Object Store: TARGET

     –	Can Declare: Document

    11.	Click Save, and then click Run Task.
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    Figure 12-24   Configure record object store task

    12.	Open (double-click) the Import Templates task. Select the task parameters, as shown in Figure 12-25:

     –	File plan object Store: FPOS

     –	Templates: Both

    13.	Click Save, and then click Run Task.
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    Figure 12-25   Import templates task

    14.	Open (double-click) the Configure Workflows task. Select the task parameters, as shown in Figure 12-26. 

     –	Connection Point: P8ConnPt1

     –	Administrator user name: P8Admin

     –	Password: Refer file C:\Program Files (x86)\IBM\cmpit\accounts.txt

    15.	Click Save, and then click Run Task.
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    Figure 12-26   Configure workflows task

    16.	Open (double-click) the Transfer Workflows task. Select the task parameters, as shown in Figure 12-27:

     –	File plan object Store: FPOS

     –	Connection Point: P8ConnPt1

    17.	Click Save, and then click Run Task.
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    Figure 12-27   Transfer workflows task

    12.4.3  Configuring Enterprise Records in Content Navigator

    This section describes the required configuration tasks for Enterprise Records in Content Navigator.

    Creating repositories

    Complete the following steps to create repositories:

    1.	Log in to the IBM Content Navigator: 

    a.	Use the following URL:

    http://localhost:9080/navigator/?desktop=admin 

    b.	Use the following credentials: 

     –	User name: P8Admin

     –	Password: See the C:\Program Files (x86)\IBM\cmpit\accounts.txt file

    2.	Go to Repositories → New Repository. Enter the repository parameters, as shown in Figure 12-28:

     –	Display name: FPOS

     –	ID: FPOS

     –	Server URL: http://localhost:2809/FileNet/Engine

     –	Object store symbolic name: FPOS

     –	Object store display name: FPOS
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    Figure 12-28   Repository parameters

    3.	With the following credentials, click Connect:

     –	User name: P8Admin

     –	Password: Refer file C:\Program Files (x86)\IBM\cmpit\accounts.txt

    4.	Click Save and Close.

    Register IBM Enterprise Records administration client plug-in

    Complete the following steps to register IBM Enterprise Records administration client plug-in:

    1.	Go to Plug-ins → and click New Plug-in, as shown in Figure 12-29.
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    Figure 12-29   Content Navigator - create plug-in

    2.	Select JAR file path, and enter the full path to the Enterprise Records plug-in file, as shown in Figure 12-30:

    C:\Program Files (x86)\IBM\EnterpriseRecords\Plugins\

    EnterpriseRecordsPlugin\IERApplicationPlugin.jar

    3.	Click Load.

    [image: ]

    Figure 12-30   Load Enterprise Records plug-in

    4.	Review the plug-in details, as shown in Figure 12-31. Click Save.
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    Figure 12-31   Save Enterprise Records plug-in

    Enabling record declaration

    To enable record declaration, complete the following steps:

    1.	Scroll down to the Declare tab. Select the FPOS object store and click Connect. Enter the credentials:

     –	User name: P8Admin

     –	Password: See the C:\Program Files (x86)\IBM\cmpit\accounts.txt file

    2.	Select the Enable for Records Declaration option for the FPOS object store, as shown in Figure 12-32.
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    Figure 12-32   Enable repository for records declaration

    3.	Click Save and Close.

    Configuring the IBM Enterprise Records desktop

    The IBM Enterprise Records desktop was created automatically in “Register IBM Enterprise Records administration client plug-in” on page 433. To configure the Enterprise Records desktop, complete the following steps:

    1.	In IBM Content Navigator, go to Desktops, select IERDesktop, and click Edit, as shown in Figure 12-33.
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    Figure 12-33   Configure Enterprise Records desktop

    2.	On the General tab, select the Authentication repository FPOS, as shown in Figure 12-34.
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    Figure 12-34   Enterprise Records Desktop - add authentication repository

    3.	On the Repositories tab, move the FPOS and ICMTARGET repositories to the Selected Repositories list, as shown in Figure 12-35.
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    Figure 12-35   Enterprise Records desktop - selected repositories

    4.	Click Save and Close.

    12.4.4  Configuring Enterprise Records security and file plans

    This section describes the steps to configure Enterprise Records security and file plans.

    Configuring security for the file plan object store

    Complete the following steps to configure security for the file plan object store:

    1.	Access IBM Enterprise Records using the following URL and credentials:

     –	URL: http://localhost:9080/navigator/?desktop=IER

     –	User name: P8Admin

     –	Password: See the C:\Program Files (x86)\IBM\cmpit\accounts.txt file

    2.	The security wizard is started automatically as shown in Figure 12-36.
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    Figure 12-36   Set Security wizard

    3.	Click Add to assign these users to each role:

     –	Records Administrator: P8Admin

     –	Records Manager: P8Admin

     –	Records Privileged User: tester

     –	Records User: tester

    4.	Click Run.

    Create a record category

    Use the following steps to create a record category: 

    1.	In the IBM Enterprise Records desktop, click Browse File Plan, as shown in Figure 12-37.
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    Figure 12-37   Browse file plan

    2.	Click Add Record Category, and enter the property values, as shown in Figure 12-38.

     –	Record Category Name: Customer Response Management Records

     –	Record Category Identifier: CTRMRecords
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    Figure 12-38   Add record category

    3.	Click Add.

    The Enterprise Records environment is now ready for declaring records.
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Implementing an IBM Enterprise Records use case

    This chapter describes the procedure to integrate IBM Enterprise Records with IBM Case Manager. This integration enables case documents to be declared as records. The integration adds records management capability to the IBM Enterprise Content Management (ECM) solution that we are building.

    This chapter provides information about the following topics:

    •Overview

    •Prerequisites

    •Integrating IBM Enterprise Records with IBM Case Manager

    •Updating the case solution to use the IBM Enterprise Records component queue

    •Editing workflow to support record declaration

    •Verification

     

    13.1  Overview

    IBM Enterprise Records is a fully functional records management system that supports all of the primary records management functionality, including:

    •File plan design and creation

    •Record declaration and classification

    •Record retention and disposition

    •Management of electronic and physical records

    •Record search and retrieval

    •Record holds

    •Auditing and reporting

    IBM Enterprise Records is much more than just a records management system. Because of its integration with IBM FileNet P8 Platform, the benefits and capabilities are much greater than the sum of its parts, The following list includes some of these benefits:

    •Compliance infrastructure (not a point solution)

    •Active compliance

    •Fully integrated architecture and repository

    •ZeroClick automated records capture

    •Federated records management and search

    IBM Enterprise Records combines content, process, and compliance services into an infrastructure that is built upon a single, fully integrated repository that manages all of your content (documents, emails, and records).

    IBM Enterprise Records provides the ability to perform consolidated searches and retrievals. Compliance policies are uniformly enforced at the technology layer, and do not have to rely on action by business users or records managers. Using the same event-based architecture of the IBM FileNet P8 Platform that enables active content in a business process, IBM Enterprise Records creates an active compliance infrastructure using ZeroClick technology.

    ZeroClick ensures leading practice records declaration, classification, and administration, while minimizing the effect on the business users and records administrators. ZeroClick streamlines the declaration and classification of records based on user events and actions, such as the filing of an electronic document into a folder, or internal and external system events, such as the receipt of a transaction from another system. 

    ZeroClick is designed to eliminate user interactions, therefore minimizing user-related errors, time, and cost factors. With ZeroClick, records are active elements, as opposed to passive elements, that are tightly integrated with your business applications.

    13.2  Prerequisites

    The ECM solution that we build for our use case scenario is the Customer Response Management solution. This solution should be created and deployed, as described in Chapter 5, “Implementing the IBM Case Manager use case” on page 73. 

    The Enterprise Records environment should be installed and configured, as described in Chapter 12, “Installing and configuring IBM Enterprise Records” on page 403.

    13.3  Integrating IBM Enterprise Records with IBM Case Manager

    This section describes the integration of Enterprise Records with Case Manager.

    13.3.1  Adding the Enterprise Records component queue to the Case Manager environment

    This section describes the procedure to add the Enterprise Content Manager component queue, RM_Operations, to the Case Manager environment:

    1.	Ensure that the workflow definition file, DeclareRecord.pep, exists in the <downloaded_IER_installer_location>\Samples\Workflow folder.

    2.	Log in to the Case Manager Builder application:

     –	URL: http://localhost:9080/CaseBuilder

     –	User name: P8Admin

     –	Password: Refer file C:\Program Files (x86)\IBM\cmpit\accounts.txt

    3.	Select the case solution, Customer Response Management, created in 5.4.1, “Creating a solution” on page 78. Click More Actions → Open Process Designer.

    4.	Select the case type, Solution Workflow Collection, as shown in Figure 13-1. Click OK.
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    Figure 13-1   Open solution workflow collection

    5.	Click File → Insert → Local Workflow, as shown in Figure 13-2.
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    Figure 13-2   Insert workflow

    6.	Browse to the <downloaded_IER_installer_location>\Samples\Workflow folder, and select the DeclareRecord.pep file. Click Open.

    7.	When prompted to lock the configuration file, as shown in Figure 13-3, click Yes.
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    Figure 13-3   Lock configuration file prompt

    8.	When prompted to update the base work class, as shown in Figure 13-4, click No.
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    Figure 13-4   Update based work class prompt

    9.	Save the workflow collection by clicking File → Solution → Save, as shown in Figure 13-5.
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    Figure 13-5   Save solution configuration

    10.	Verify the component queue, RM_Operations was successfully added by clicking View → Configuration, as shown in Figure 13-6.
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    Figure 13-6   Verify component queue

    13.4  Updating the case solution to use the IBM Enterprise Records component queue

    This section describes how to update the case solution to use the Enterprise Records component queue.

    13.4.1  Adding case properties to support record declaration

    The following case properties are required to declare records:

    1.	Property Name Choices. Click Properties → Manage Choice Lists, and add this choice list of property names, as shown in Figure 13-7:

     –	DocumentTitle

     –	MediaType

     –	Format

     –	SendOn

     –	From

     –	Reviewer

     –	EmailSubject
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    Figure 13-7   Choice list - Property Name Choices

    2.	PropertyNames. Click Properties → Add Property → New, and add a Multi-Value string property containing the record’s required property names from the choice list created in step 1, as shown in Figure 13-8.
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    Figure 13-8   Case property - PropertyNames

    3.	PropertyValues. Add a Multi-Value string property to hold the record’s required property values, as shown in Figure 13-9.
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    Figure 13-9   Case property - PropertyValues

    4.	RecordID. Add a string property that contains the Globally Unique Identifier (GUID)4 returned when a document is declared as a record, as shown in Figure 13-10.

    [image: ]

    Figure 13-10   Case property - RecordID

    5.	RMEntityType. Add another string property with the default value set to ElectronicRecordInfo, as shown in Figure 13-11.
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    Figure 13-11   Case property - RMEntityType

    13.4.2  Exposing properties in case type

    Edit the Request case type. Click Properties → Add Property → Existing and select the properties created in 13.4.1, “Adding case properties to support record declaration” on page 450, as shown in Figure 13-12.
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    Figure 13-12   Expose case properties to case type

    13.4.3  Adding an optional case task to declare records

    Use the following steps to add an optional case task to a declare record:

    1.	Click Tasks → Add Task → Task. On the General tab, set the following parameters, as shown in Figure 13-13:

     –	Name: Declare Record

     –	Description: Declare the Request Decision Correspondence Document as a record

     –	This task starts: Automatically

     –	This task is: Hidden
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    Figure 13-13   Add task - General parameters

    2.	Click the Preconditions tab, and set the following parameters, as shown in Figure 13-14:

     –	What preconditions must be met for this task to start?: A document is filed in the case

     –	Document types: Request Decision Correspondence

    3.	Click Add Condition and select these parameter values:

     –	Property: Dispute Resolved

     –	Operator: is equal

     –	Value: True

    4.	Click OK.
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    Figure 13-14   Add task - preconditions

    Editing the case task steps

    Complete the following steps to edit the case task:

    1.	Select the Declare Record case task, created in the previous step, and click Edit Steps, as shown in Figure 13-15.
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    Figure 13-15   Edit case task steps

    2.	Add a Role Lane for the Customer Service Representative role, as shown in Figure 13-16. 

    3.	Click Save, and then click Close.
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    Figure 13-16   Add role lane

    13.5  Editing workflow to support record declaration

    This section describes the process to edit the workflow to support record declaration.

    1.	In Case Manager Builder, select the Declare Record case task, and click Open Process Designer, as shown in Figure 13-17.
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    Figure 13-17   Open Process Designer

    2.	Go to Workflow Properties → Attachments, add an attachment, RecordDocument, and select Initiating Attachment, as shown in Figure 13-18.
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    Figure 13-18   Add Initiating Attachment

    3.	Add another attachment, FolderContainer. For the Value, browse to the File Plan folder, as shown in Figure 13-19.
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    Figure 13-19   Add a folder container attachment

    4.	Select the Record Category, Customer Response Management Records, as shown in Figure 13-20.
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    Figure 13-20   Select record category

    Assigning values to case properties used in the workflow

    Complete the following steps to assign values to case properties:

    1.	Select the LaunchStep task and click the Assignments tab. 

    2.	Under Field Assignments, click Name and add the F_CaseFolder.CTRM_PropertyNames case property, as shown in Figure 13-21.
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    Figure 13-21   Create Field Assignment - Property Names

    3.	Click Expression and enter the property names as shown in Figure 13-22: 

    {"DocumentTitle","MediaType","Format","SendOn","From","Reviewer","EmailSubject"}

     

    
      
        	
          Note: The property names should be entered exactly as shown above, including the braces {}.

        
      

    

    4.	Click OK.
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    Figure 13-22   Assign parameter values - Property Names

    5.	Repeat step 1 and 2 to assign the following values to the case property F_CaseFolder.CTRM_PropertyValues, as shown in Figure 13-23: 

    {"Record Title","Paper","PDF","07/04/2014","CSR","Manager","Case Decision"}

     

    
      
        	
          Note: We are assigning the record property values in the Launch Step as an example. In a real environment, this assignment is done using a workflow step.
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    Figure 13-23   Assign parameter values - Property Values

    Adding a component step to declare records

    Complete the following steps to add a component step that declares records:

    1.	Add a new component step, Declare Record, as shown in Figure 13-24.
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    Figure 13-24   Add a component step

    2.	Add the declareRecord operation from the RM_Operations component queue, as shown in Figure 13-25.
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    Figure 13-25   Add operation declareRecord

    3.	Set the operation parameters as follows:

     –	Folder: FolderContainer

     –	Document: RecordDocument

    4.	To set the value of the RMType parameter, select the <Build Expression> option, as shown in Figure 13-26.
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    Figure 13-26   Set operation parameter - RMType

    5.	Select Business Objects Fields, then select F_CaseFolder. Scroll the properties list and select the CTRM_RMEntityType property. Click Insert, as shown in Figure 13-27.
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    Figure 13-27   Select operation parameter value

    6.	Click OK.

    7.	Repeat the step to set the value of the PropertyName parameter, as shown in Figure 13-28.
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    Figure 13-28   Set parameter value - PropertyNames

    8.	Repeat the step one more time to set the value of the PropertyValues parameter, as shown in Figure 13-29.
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    Figure 13-29   Set parameter value - PropertyValues

    9.	To set the value of the DocumentID parameter, click Expression and the F_CaseFolder.CTRM_RecordID type, as shown in Figure 13-30.

    [image: ]

    Figure 13-30   Set parameter value - DocumentId

    10.	Click File → Validate Workflow Collection. Then click File → Save and Close.

    11.	In Case Manager Builder, click Validate, then click Save and Close. 

    12.	Deploy the solution.

    The record declaration is done automatically when a document of type Request Decision Correspondence is added to the case.

    13.6  Verification

    Verify the record declaration task completion status:

    1.	Open the Case Details page in Case Manager Client. 

    2.	Click the Tasks tab, as shown in Figure 13-31.
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    Figure 13-31   Verify task completion - Declare record

    The completed status indicates that the record was created successfully.

    To verify that the record was created successfully perform the following steps:

    1.	Log in to the Enterprise Records desktop:

     –	URL: http://localhost:9080/navigator/?desktop=IER

     –	User name: P8Admin

     –	Password: see the C:\Program Files (x86)\IBM\cmpit\accounts.txt file

    2.	Browse to the FPOS\File Plan\Customer Response Management Records record category folder and view the record, as shown in Figure 13-32.

    [image: ]

    Figure 13-32   Verify record declaration

    The case document shows as a record, indicating a successful record declaration.
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Installing and configuring IBM Watson Content Analytics

    This chapter introduces the basic concepts of IBM Watson Content Analytics, and the installation and configuration procedures to access and crawl the solution case data in IBM Case Manager. It helps mine customer values in unstructured and structured information, with a powerful natural language processing engine and an interactive analysis tool. 

    Watson Content Analytics can crawl structured and unstructured text data in cases in IBM Case Manager and analyze the data of the cases to find the value from the cases.

    This chapter provides information about the following topics:

    •IBM Watson Content Analytics overview

    •Prerequisites

    •Installing IBM Watson Content Analytics

    •Validating installation

    •Configuring Watson to access solution data

    14.1  IBM Watson Content Analytics overview

    Much textual data and structured data is stored in enterprise repositories. Because the textual data is not organized and structured, it is difficult to get valuable insights from the vast data stored in the enterprise repositories directly, by reading through textual data word by word. Even if you distribute the task to many people, it is difficult to analyze with a consistent standard.

    With the powerful linguistic processing engine and the interactive analysis tool, Watson Content Analytics provides a solution that processes the large amount of textual data with structured data. These capabilities help you organize and analyze the data with a consistent standard, including trends, unusual correlations, and unusual characteristics of the data. 

    Watson Content Analytics delivers new business understanding and visibility based on the analysis results. For example, you can identify patterns, view trends over time, and reveal unusual correlations or anomalies. You can explain why events are occurring, and find new opportunities by aggregating the voices of customers, suppliers, and the market. You can track and drive improvement in non-quantitative business metrics through analysis of the content.

    You can define many facets (or aspects) of your data, with each facet potentially leading to valuable insights for various users. In addition, Watson Content Analytics has a capability that generates ready-for-use facets, such as Part of Speech facets, Named Entity facets, and Sentiment facets, from textual data. 

    You can analyze the data by using and combining this wide variation of facets. For example, suppose there are weekend travel reports in a tourist company. You might define a weekend destination facet that consists of major places where people travel over the weekend. You might also define an activity facet that consists of typical activities that people do during their weekend travel. 

    With such facets, a tourist industry analyst can analyze what types of people tend to travel to which specific locations, and also what kinds of words appeared in the textual data of the specific location. You can further identify the types of activities that they engage in over the weekend.

    Watson Content Analytics has a tool for reporting statistics, and for obtaining actionable insights. Actionable insights refers to insights into data that lead to action. Watson Content Analytics provides far more value than merely reducing the workload of manual analysis. 

    Watson Content Analytics brings the power of business intelligence (BI) to all of your enterprise information, not just your structured information. The result helps you achieve the most value from all your data, regardless of its structure.

    Watson Content Analytics can integrate with IBM Case Manager to analyze unstructured and structured contents of cases to get insights. As the number of cases grows in the system, business analysts must analyze cases to measure the quality and quantity of case processed by the hosting organizations. 

    The analysis helps the organization to measure its delivery of business commitments, and identify shortfalls to pursue opportunities. Because the cases also include case documents, artifacts, and comments, you must acquire information from unstructured artifacts.

    Figure 14-1 shows the use case solution components that we build for this book. In this chapter, we build Watson Content Analytics, one of the core components for the ECM solution. The shaded boxes with solid lines in the figure represent the components and products that we have built so far.
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    Figure 14-1   Use case context in relation to the overall solution components

    14.2  Prerequisites

    This section describes the prerequisites, including software prerequisites and configuration prerequisites for the installation and configuration of Watson Content Analytics.

    14.2.1  Software prerequisites

    The following software must be installed for this ECM solution scenario:

    •IBM Case Manager. The instructions describing installation are found in Chapter 4, “Installing and configuring IBM Case Manager” on page 35.

    14.2.2  Required software packages

    IBM FileNet Content Platform Engine Client is required for the scenario in order for Watson Content Analytics crawlers to access cases of IBM Case Manager. 14.4.1, “Installing Content Platform Engine Client” on page 487 provides installation instruction.

    14.2.3  Configuration prerequisites

    Before you configure IBM Watson Content Analytics crawlers to crawl case data, it is necessary to create a target case solution in IBM Case Manager.

    14.3  Installing IBM Watson Content Analytics

    This section provides the instructions to install Watson Content Analytics. This describes an easy and simple configuration of the installation for the solution scenario. 

    Perform the following steps to install IBM Watson Content Analytics version 3.5:

    1.	Extract the installation image file, and find the launchpad command in the extracted files.

    2.	Run launchpad.exe to start installation through launchpad.

    3.	At the language selection windows, select English and click OK (Figure 14-2).
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    Figure 14-2   Language selection of the launchpad

    4.	Click Install Product and click Launch IBM Watson Content Analytics installation program to start the installer program (Figure 14-3).
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    Figure 14-3   Welcome window of the launch pad

    5.	Select English and click OK (Figure 14-4).
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    Figure 14-4   Language selection of the installer

    6.	Read and accept the license agreement, and then click Next (Figure 14-5).

    [image: ]

    Figure 14-5   Software Agreement

    7.	Specify the installation options (Figure 14-6 on page 484):

    a.	In the Fully qualified host name field, type the fully qualified host name of the installation target system.

    b.	In the User name field, type the administrator account name.

    c.	Select the Create user account check box to create a new user.

    d.	In the Password and Confirm password fields, type the password of the administrator account.

    e.	From the Server type list, select Master: All on one server.

    Figure 14-6 shows the installation options.
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    Figure 14-6   Specifying Installation options

    8.	Wait for the installation to complete and the completion window to display.

    9.	Click Yes, restart my system, and restart the system (Figure 14-7).
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    Figure 14-7   Completion of the installation

    After Watson Content Analytics is successfully installed, make sure that you also install the current fix pack for the product. For more information, see the IBM Fix Central website:

    http://www.ibm.com/support/fixcentral

    14.4  Validating installation

    This section describes how to validate the installation. Watson Content Analytics has a validation program. You can run the validation program from the First Steps window. Complete the following steps to perform the validation:

    1.	After the installation (14.3, “Installing IBM Watson Content Analytics” on page 480), the First Steps window opens automatically. 

    2.	Then, click Start Server (Figure 14-8), and wait to start all of the required sessions of Watson Content Analytics.

    [image: ]

    Figure 14-8   First Steps window

    3.	After the line “FFQC5394I All services required to use the system are started” is displayed in the Verify Installation window, click Close to close the window (Figure 14-9).
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    Figure 14-9   Starting the required services

    4.	Click Verify Installation in the First Steps window to verify the installation.

    5.	After the line “FFQP0081I The scenarios to verify installation are now complete. Review the displayed output before you use the server” is displayed in the Verify Installation window, click Close to close the window (Figure 14-10).
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    Figure 14-10   Verifying the installation

    6.	Click Exit in the First Steps window to close the window.

    14.4.1  Installing Content Platform Engine Client

    This section provides the instructions to run an installation of Content Platform Engine client. In the scenario, crawlers which crawl the data of IBM Case Manager are created. To collect the data of IBM Case Manager, the crawler requires Content Platform Engine Client, and you must install the software for Content Platform Engine Client on the server where the crawlers of Watson Content Analytics are installed.

    1.	Run 5.2.0.3-P8CPE-CLIENT-WIN-FP003.exe in the installer package of the IBM Case Manager fix pack directory to run Content Platform Engine Client installer. Refer 4.3, “Downloading IBM CMPIT components” on page 38.

    2.	Click Next in the Introduction window.

    3.	Click Next (Figure 14-11).
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    Figure 14-11   Specifying Content Platform Engine Client installation path

    4.	Type localhost in the Filenet Content Platform Engine Server host name field, type 9080 in the Port number field, and select HTTP from the Protocol list in this scenario. A pop-up window opens. Click Next (Figure 14-12). 
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    Figure 14-12   Specifying Content Platform Engine Client download parameters

    5.	Select only Other applications to specify the applications that the Content Platform Engine Client adds client modules to. Click Next (Figure 14-13).

    .[image: ]

    Figure 14-13   Specifying FileNet P8 application 

    6.	Specify the installation directory of the Content Platform Engine Client. Enter C:\Program Files\IBM\FileNet\CEClient in this scenario, and click Next (Figure 14-14).
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    Figure 14-14   Specifying the installation directory

    7.	Select WebSphere Application Server from the Application server type list in this scenario, and click Next (Figure 14-15).

    [image: ]

    Figure 14-15   Specifying the application server type

    8.	Verify the URLs populated in the Content Platform Engine URL, Content Platform Engine upload URL, and Content Platform Engine download URL fields, and then click Next (Figure 14-16).
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    Figure 14-16   Specifying URLs of the Content Plartform Engine

    9.	Verify the URL in the Content Platform Engine URL (WSI) filed, and click Next (Figure 14-17).
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    Figure 14-17   Specifying the Content Platform Engine URL

    10.	Click Next to stop IBM Case Foundation components (Figure 14-18).
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    Figure 14-18   Stopping components of IBM Case Foundation components

    11.	Click Install in the Preinstallation Summary window.

    12.	Wait to finish the installation, and then select all check boxes and click Next (Figure 14-19).
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    Figure 14-19   Starting IBM Case Foundation components

    13.	Click Done to complete the installation (Figure 14-20).
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    Figure 14-20   Completing the installation of Content Platform Engine Client 

    14.4.2  Running a script to resolve FileNet Content Platform Engine Client paths

    This section describes the instructions to run a script to resolve Content Platform Engine Client paths:

    1.	Run the escrfilenet.vbs script from a command window.

    2.	Enter the path selected for the Content Engine Client components. In this scenario, enter C:\Program Files\IBM\FileNet\CEClient, and click OK.

    3.	Click OK in a pop-up window that notifies the completion of the setup.

    4.	To apply the configuration, restarting the Watson Content Analytics services is required. Shut down and start the Watson Content Analytics services:

    a.	From the system start menu, click Start → IBM Watson Content Analytics → Shut Down.

    b.	After the shut down has finished, click Start Up.

    14.5  Configuring Watson to access solution data

    This section describes how to configure Watson Content Analytics to access, gather, and process solution data.

    14.5.1  Starting the administration console and creating a collection

    This section describes the instructions to create a collection:

    1.	Log in to the administration console. 

    2.	Type the administrator user ID in the User ID field, and type the password in the Password field. 

    3.	Then, click Log In (Figure 14-21).
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    Figure 14-21   The administration console window

    4.	Click Create Collection to create a collection for the solution scenario. (Figure 14-22).
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    Figure 14-22   The administration console window

    5.	Type Customer Response Management in the Collection name field, select Content analytics collection from the Collection type list, and click Advanced Options to open the advance options list (Figure 14-23).
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    Figure 14-23   Creating a collection

    6.	Select Enable sentiment analysis from the Sentiment analysis list to enable the sentiment analysis option (Figure 14-24), and then click OK at the bottom of the page.
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    Figure 14-24   Enabling Sentiment analysis option

    14.5.2  Configuring crawler and parser for the case solution

    To configure the crawler and parser, follow these steps:

    1.	Click the plus sign (+) on the right side of Crawlers to add a crawler that crawls the case data (Figure 14-25).
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    Figure 14-25   After creating a Watson Content Analytics collection

    2.	Select Case Manager from the Crawler type list (Figure 14-26). Click Next.
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    Figure 14-26   Creating a crawler: selecting the crawler type

    3.	Type the content engine web service URL. In this scenario, type http://localhost:9080/wsi/FNCEWS40MTOM, type the user name and password of the Case Manager administrator, and click Next (Figure 14-27).
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    Figure 14-27   Creating a crawler: Specifying the connection credentials

    4.	Select Customer Response Management under TARGET/RootFolder/IBM Case Manager/Solution Developments. Click the right arrow button located between the “Available sources” box and the “Sources to crawl” box to add the solution to sources to crawl, and click Next (Figure 14-28).
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    Figure 14-28   Creating a crawler: adding the solution to sources to crawl

    5.	Click Finish (Figure 14-29).
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    Figure 14-29   Create a crawler: finishing creating a crawler
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Content analysis with IBM Watson Content Analytics

    This chapter provides information about how the analytics component of the use case solution works in the scenario. IBM Watson Content Analytics gives insight from the contents of the cases of IBM Case Manager. With Watson Content Analytics, content analysis helps the user do tasks managed by IBM Case Manager.

    This chapter describes the following topics:

    •Content analysis overview

    •Prerequisites

    •How this ties into the scenario

    •Creating analysis facets

    •Scenario: Analyzing customers’ sentiments about a product using sentiment analysis

    15.1  Content analysis overview

    This section describes the benefits and basic concepts of content analysis with Watson Content Analytics.

    15.1.1  Needs and benefits of content analysis

    Unstructured text data can be complex and ambiguous. Because of the ambiguities of natural language, textual data often obscures factual information and insight. This is information that you can otherwise use for actions to make better business decisions. 

    Content analysis unleashes the value trapped in your text data. It is a tool that you can use to report statistics, and to obtain actionable insights, which are business insights that lead to actions for better business operations. Content analysis is used to reduce your manual workload of text analysis, and to enable a higher level of analysis that provides insights that were not previously attainable.

    For example, by reading customer contact records one by one, you can understand what happened to each customer, but you cannot understand if they are unique cases or common cases, or if such cases are increasing or decreasing. Such information can be acquired only by analyzing the data set as a whole. However, an entire data set generally contains enormous varieties of information.

    This is the challenge that Watson Content Analytics excels at. It enables you to analyze entire data sets to find patterns and trends, and provides tools to help you find and focus on those particular patterns and trends that are important to you. 

    By using content analysis, users can take actions based on the insights that they obtain from their data, and make their business operations more efficient and better-managed. For example, when a customer service representative is searching for information related to a defective product, analytics can help her understand detailed information about the product, lot numbers, customers, and solution.

    When applying content analytics in business solution scenarios, the following list provides a wide range of examples of the advantages that you can gain:

    •Improvements to product development and product quality analysis

    •Enhancements to criminal intelligence and public safety, finding patterns in text that indicate criminal behavior

    •Improvements to fraud analytics to better identify fraudulent trends and patterns

    •Improvement in healthcare outcomes and improvement in patient health 

    •Analysis of customer feedback and sentiment from emails and online 3postings

    Content analysis provides insight for better decision making in a wide range of business solution scenarios.

    15.1.2  Concept of content analysis

    At the beginning of content analysis, you need to gather data to be analyzed. For example, if you want to understand how your customer perceives your products or services, you need to gather data that contains your customers’ opinions.

    After you gather the data, you can start analyzing the data. Watson Content Analytics generates grammatical information about the textual data included in documents, such as Noun, Verb, Adjective, Adverb and other parts of speech. This information is useful for analysis of your data. 

    A review of the Part of Speech facets (or analysis axes) gives you an overview of what subjects are involved, and of the major concepts in the data set. In addition to the Part of Speech facets, you can define and create facets that become an analysis axis. For example, you can define facets of created date, the customer associated to the documents, location, and so on.

    Then, you can browse through the facets generated by the linguistic processor of Watson Content Analytics, and the facets defined by you. Watson Content Analytics helps you analyze contents with the following views:

    •Documents view. Shows a list of the actual content of individual documents and their metadata. By reading the original text, you can quickly verify that the text supports the analysis results.

    •Facets view. Shows a list of keywords of a selected facet. This view is useful for seeing the keywords that make up a given facet in your data.

    •Time Series view. Shows the frequency change over time. You can analyze the frequency of a selected facet over time, and refine documents by a selected date range.

    •Trends view. Shows sharp and unexpected increases in frequency over time.

    •Deviations view. Shows the deviation of keywords for a given time period. This view focuses on how much the frequency of a facet deviates from the expected average for a given time period, not from its past history as in the Trends view.

    •Facet Pairs view. Shows the correlation of keywords from two selected facets in a grid view. This view enables you to find correlations between keywords in the selected facets.

    •Connections view. Shows the correlation of keywords from two selected facets in a network graph. This view enables you to visually see the connections between two selected facets.

    •Sentiment view. Shows the positive, negative, and mixed sentiment of text. This view enables you to quickly understand how types of positive and negative sentiments correspond to facet values.

    •Dashboard view. Shows a configured dashboard layout with one or more graphs and tables in a single view. With this view, you can see multiple views at the same time.

    In this chapter, we use Watson Content Analytics to gain insight about a defective product from IBM Case Manager case data by using sentiment analysis through the Sentiment view for better decision making.

    15.2  Prerequisites

    This section describes prerequisites for this part of the scenario.

    15.2.1  Software prerequisites

    This chapter requires the following components:

    •IBM Case Manager: See Chapter 4, “Installing and configuring IBM Case Manager” on page 35.

    •IBM Watson Content Analytics: See Chapter 14, “Installing and configuring IBM Watson Content Analytics” on page 477.

    15.2.2  Configuration prerequisites

    The sentiment analysis option of Watson Content Analytics must be enabled. See 14.5.1, “Starting the administration console and creating a collection” on page 493.

    Before you configure Watson Content Analytics crawlers to crawl case data, it is necessary to create some cases in IBM Case Manager.

    15.3  How this ties into the scenario

    This section describes how Watson Content Analytics ties into the use case scenario.

    The Manager (Tim) in Company A verifies the Specialist’s (Rebecca’s) decision, and makes a decision whether to refund or replace a product or service. The Manager should know if the complaint or request is an already-known issue. 

    With Watson Content Analytics, the Manager (Tim) can refer to an analysis result in all of the existing cases from the perspective of the product. The Manager can check frequent complaints or requests about the target product or service, and decide whether the issue was caused by a defect, or needs more investigation.

    15.3.1  Where we are in the scenario

    Watson Content Analytics helps the Manager (Tim) to verify the Specialist’s conclusion to refund or replace the product or service in the routed case from the Specialist (Rebecca) (Figure 15-1).
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    Figure 15-1   Where we are in the scenario

    15.3.2  What role does this solution cover

    In the scenario, information from Watson Content Analytics is used by the Manager (Tim) to understand the analysis results of the existing cases of the target product or service, and verify the Specialist’s (Rebecca’s) conclusion.

    15.3.3  Where you will be at the end of this chapter in the scenario

    After following the instructions in this chapter, the IBM Enterprise Content Management (ECM) solution is enriched with the analysis of the existing cases, and the caseworker can gain a view of total product or service quality through the existing cases. It is also possible to give feedback to the development team for quality improvement based on the analysis.

    15.4  Creating analysis facets

    This section describes how to create analysis facets for the scenario. It describes how to configure a crawler to crawl the IBM Case Manager data, how to configure a user dictionary, and how to process the data for the scenario.

    15.4.1  Configuring a crawler

    Watson Content Analytics can be configured to generate document fields and analysis facets corresponding to the case properties:

    1.	Click the start button in the Crawlers pane to start the Case Manager crawler.

    2.	Click the pencil icon button (Figure 15-2 on page 507) and select Edit crawl space from the list.
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    Figure 15-2   Dashboard view of the administration console

    3.	Click the pencil button to edit crawler options (Figure 15-3).
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    Figure 15-3   Editing the crawler options

    4.	Select the target solution space and click Edit Metadata.

    5.	Select default in the Index Field Name list in the Folder.Annotations.CmAcmCommentText row, and click OK (Figure 15-4).
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    Figure 15-4   Editing the metadata options

    6.	Select the solution and click Edit options (Figure 15-5 on page 509).
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    Figure 15-5   Editing the crawl space and the options

    7.	Add fields to analyze properties of the cases (Figure 15-6 on page 510):

    a.	Click + Add Field for 14 times to add 14 fields.

    b.	Select CTRM_Description from the Field Name list, and select body from the Index field name list.

    c.	Select CTRM_CustomerCity from the Field Name list, select new from the Index field name list, and type city. Select Returnable and Faceted search.

    d.	Select CTRM_CustomerCountry from the Field Name list, select new from the Index field name list, and type country. Select Returnable and Faceted search.

    e.	Select CTRM_CustomerState from the Field Name list, select new from the Index field name list, and type state. Select Returnable and Faceted search.

    f.	Select CTRM_DisputeType from the Field Name list, select new from the Index field name list, and type dispute_type. Select Returnable and Faceted search.

    g.	Select CTRM_ProductDispute from the Field Name list, select new from the Index field name list, and type resolved. Select Returnable and Faceted search.

    h.	Select CTRM_ProductID1 from the Field Name list, select new from the Index field name list, and type product_id. Select Returnable and Faceted search.

    i.	Select CTRM_CustomerEmail from the Field Name list, select new from the Index field name list, and type email. Select Returnable.

    j.	Select CTRM_CustomerID from the Field Name list, select new from the the Index field name list, and type customer_id. Select Returnable.

    k.	Select CTRM_CustomerName from the Field Name list, select new from the Index field name list, and type customer_name. Select Returnable.

    l.	Select CTRM_CustomerPhone from the Field Name list, select new from the Index field name list, and type phone. Select Returnable.

    m.	Select CTRM_CustomerStreetAddress from the Field Name list, select new from the Index field name list, and type street_address. Select Returnable.

    n.	Select CTRM_CustomerZip from the Field Name list, select new from the Index field name list, and type zip. Select Returnable.

    o.	Select CTRM_TotalAmount from the Field Name list, select new from the Index field name list, and type total_amount. Select Returnable.

    p.	Click OK at the bottom.

    Figure 15-6 shows the newly added fields used to analyze the case properties.
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    Figure 15-6   Adding fields to analyze the case properties

    8.	Click Return.

    9.	Click the stop button and then click the start button of the IBM Case Manager crawler to restart the crawler to apply the configuration change to the crawler (Figure 15-7).
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    Figure 15-7   Stopping and starting the created crawler

    15.4.2  Creating a dictionary to analyze domain-specific words

    The natural language processing engine of Watson Content Analytics extracts the words and terms from unstructured data, and generates Part of Speech facets automatically. However, the engine extracts general words, but does not extract domain-specific words, such as a car model name for the auto industry. 

    In this situation, you can create dictionaries to register words to the engine and configure Watson Content Analytics to create facets for the words. This section describes how to create a dictionary and add a technical term, such as GPS.

    To create a dictionary, follow these steps:

    1.	Click the pencil button on Analytic Resources, and click User dictionaries (Figure 15-8).
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    Figure 15-8   Adding User dictionaries

    2.	Type parts in the text box as the prefix of the dictionary file name, and click Create Dictionary (Figure 15-9).

    [image: ]

    Figure 15-9   Creating a dictionary file

    3.	Click Add Words (Figure 15-10).
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    Figure 15-10   Editing the dictionary

    4.	Add domain-specific terms to analyze the solution in a specific field. Type GPS to add the term to the dictionary, and click OK (Figure 15-11).
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    Figure 15-11   Adding a word to the dictionary

    5.	Go back to the dashboard. Click Customer Response Management in the breadcrumb list.

    6.	Click the right arrow button to deploy the analytic resources to apply the configuration change (Figure 15-12).
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    Figure 15-12   Deploying analytic resources

    7.	Click the restart a full index build button to build the index with the new configuration, and pause to return to the waiting state (Figure 15-13).
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    Figure 15-13   Restarting a full index build

    15.5  Scenario: Analyzing customers’ sentiments about a product using sentiment analysis

    This section describes what sentiment analysis is, and presents an actual use case in which Watson Content Analytics analyzes sentiment expressions of descriptions of cases. 

    15.5.1  Sentiment analysis

    Sentiment analysis enables business analysts to understand the sentiment associated with various concepts in the text of the documents and content that is being analyzed. For example, you are able to understand the customer sentiment (positive, negative, ambivalent, or neutral) associated with each of the keywords. After you have a general idea of the sentiment, you can view specific details of positive and negative words and phrases, and trends associated with each. 

    You can also preview the sentiment words in conjunction with surrounding document snippets in preview. Adding the sentimentality to the query enables for further drill down in other views of the Watson Content Analytics miner interface.

    In this scenario, you analyze customers’ overall sentiment about the target defective product. In addition, you investigate the targets of the customers’ negative sentiments. Finally, you verify the result by seeing the actual document.

    15.5.2  Starting the Watson Content Analytics miner application

    Watson Content Analytics miner is a web-based application that is bundled with Watson Content Analytics. The web application is the installation of the product. Start the Watson Content Analytics miner application from the system start by clicking Start.

    Alternatively, you can directly access the Content Analytics miner at the following website:

    http://<your server name>:8393/ui/analytics

    15.5.3  Analyzing customer sentiment

    The following steps provide instructions to analyze customer sentiment through the Sentiment view:

    1.	Drill down by target product_id. Open the Facets tab and click product_id from the left Facet Navigation pane. Select a product ID and click Add to query with Boolean AND to refine cases with the product ID (Figure 15-14).
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    Figure 15-14   Refining cases with the product ID

    2.	Click the Sentiment tab.

    3.	Click the Target-expression mode button to investigate targets of customers’ sentiment (Figure 15-15).
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    Figure 15-15   The Sentiment view

    4.	Investigate high score negative targets. Select a sentiment target and check the negative expression (Figure 15-16).
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    Figure 15-16   The Target-expression mode

    5.	Click negative expressions to see the actual descriptions containing the selected negative expression. Then, you can know the reasons for frequent complaints about the product (Figure 15-17).
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    Figure 15-17   Investigating actual descriptions of the cases

    Now, you know the reasons for frequent complaints about the target product, and that the same complaints as the current case were already reported frequently. Then, the Manager (Tim) can make a decision to refund or replace the product. Company A can also decide if they need to improve the product by fixing the frequently defective component.
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Installing and configuring IBM Content Classification

    IBM Content Classification can automatically classify documents into categories or topics, by analyzing their content. It learns from example how to identify a certain category. The categories can be used by the IBM Enterprise Content Management (ECM) application in the decision-making process.

    This chapter describes the setup process of IBM Content Classification 8.8, and its integration with other ECM products. 

    This chapter describes the following topics:

    •Overview

    •Installing IBM Content Classification

    •Installing additional fix packs

    •Configuring IBM Content Classification

    •Integrating IBM Content Classification with other ECM products

    16.1  Overview

    IBM Content Classification uses a combination of text-based analysis and rule-based analysis to determine how each document is classified. IBM Content Classification can classify document content into categories. 

    Understanding and classifying text is an old problem in the field of artificial intelligence. Determining the most likely category in which to classify a new content item is not trivial.

    With IBM classification technology, applications can understand and classify unstructured free-form text. IBM Content Classification attempts to understand information based on its existing knowledge. It “learns” how to distinguish and classify data based on its acquired information. 

    For example, the technology learns how to distinguish between text about dogs and cats, after you provide it with example text about dogs and another set of example text about cats. Then, the system attempts to correctly classify new text as being related to dogs or cats. 

    IBM Content Classification learns from real-world examples and stores classification information into what is referred to as a knowledge base. IBM Content Classification consults the knowledge base to classify new text into categories based on their similarity to text seen in the past. 

    To create the knowledge base, IBM Content Classification is first “trained” by using a body of sample data, such as emails, documents, or other text, that has been pre-classified into appropriate categories. This body of data is known as a content set. The content set consists of sample text that represents the kind of information that the system is expected to classify. It creates statistical models that make up the knowledge base of a system. 

    After IBM Content Classification is trained, new text can be submitted for classification by using a process called matching. The IBM Content Classification-based application analyzes the new text and computes relevancy scores for each category in the knowledge base, as a measure of how closely the text matches each category. 

    After creating and training a knowledge base, you can build an IBM Content Classification decision plan that contains rules that refer to the knowledge base suggestions. The decision plan can also extract metadata that is associated with the text. 

    IBM Content Classification can classify content only according to rules and keyword-based analysis. For this scenario, you create a rules-only decision plan. Each rule specifies conditions that might cause a document to be classified (classification triggers) and the classification actions that are to be applied. During run time, the classification process evaluates the document content and metadata (document properties). 

    For more information, see “Decision Plan Design, Implementation, and Use Considerations” on the following website:

    http://www.ibm.com/support/docview.wss?uid=swg27023248

     

    
      
        	
          Reference materials: For information about building and maintaining a decision plan and knowledge base in IBM Content Classification, see the following resources:

          •IBM Content Classification tutorial

          http://www.ibm.com/support/knowledgecenter/SSBRAM_8.8.0/com.ibm.classify.tutorial.doc/tutorials.html

          •IBM Content Classification 8.8 documentation

          http://www.ibm.com/support/knowledgecenter/SSBRAM_8.8.0/contentclassification_8.8.0.html

          For hints and tips about building a knowledge base and decision plan, see IBM Classification Module: Make It Work for You, SG24-7707.

        
      

    

    Figure 16-1 shows the use case solution components that we build for this book. In this chapter, we build IBM Content Classification, one of the core components for the ECM solution. The shaded boxes with solid lines in the figure represent the components and products that we have built so far.
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    Figure 16-1   Use case context in relation to the overall solution components

    16.2  Installing IBM Content Classification 8.8

    This section describes the procedure for installing IBM Content Classification. The demonstration shown here uses version 8.8.

    16.2.1  Download the installation kit

    The first step in using IBM Content Classification 8.8 is to download the installation kit from IBM Passport Advantage:

    http://www-01.ibm.com/software/passportadvantage/pao_customer.html

    For example, if you plan to work on Windows, you should use CI99AEN classificationsetup88_win32. 

    16.2.2  Running the IBM Content Classification installer

    Log in as the (local) Administrator user and navigate to the downloaded IBM Content Classification installer location.

    Follow these steps to install IBM Content Classification on Windows:

    1.	Run classificationsetup88_win32, and you see the Introduction window, as shown in Figure 16-2. Click Next.
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    Figure 16-2   Installation Introduction

    2.	Accept the Software License Agreement, as shown in Figure 16-3, and click Next.
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    Figure 16-3   Software License Agreement

    3.	Choose the installation directory, as shown in Figure 16-4, and click Next.
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    Figure 16-4   Choose installation directory

    4.	Choose the installation set. It is advisable to use ALL, as shown in Figure 16-5.
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    Figure 16-5   Choose installation set

    5.	Accept the Local Server Parameters. It is advisable to use the defaults, as shown in Figure 16-6, and click Next. 
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    Figure 16-6   Local Server Parameters

    6.	Choose the location of the Administration and Data server. In general, you can choose to run them on the same computer, as shown in Figure 16-7, and click Next.
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    Figure 16-7   Server location

    7.	Choose the Listener configuration. The Listener port is the gateway by which clients interact with the IBM Content Classification server. It is advisable to run the Listener on the same computer where you are installing (Figure 16-8).
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    Figure 16-8   Listener configuration

    8.	Accept the default port for the Text Extractor configuration (Figure 16-9).
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    Figure 16-9   Choosing Text Extractors

    9.	Choose the Classification Center parameters, as shown in Figure 16-10. The Classification Center is a web-based application that integrates the IBM Content Classification server with the ECM repositories. See 16.4.2, “Use IBM Content Classification in the ECM repositories for content organization” on page 535. 
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    Figure 16-10   Classification Center parameters

    10.	Review the Pre-installation Summary, as shown in Figure 16-11, and click Install.
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    Figure 16-11   Pre-installation summary

    11.	Run Install and, when the installation completes successfully, you should see a panel similar to that shown in Figure 16-12.
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    Figure 16-12   Install is complete

    16.2.3  Configuring and running IBM Content Classification

    This section explains at a high level how to deploy the knowledge bases and decision plans in IBM Content Classification for using the classification service in the ECM solution. It does not attempt to teach you how to do everything in IBM Content Classification. For comprehensive IBM Content Classification product usage, see the materials referenced in the shaded box in 16.1, “Overview” on page 520.

    Creating and deploying IBM Content Classification resources entails the following tasks, which are explained in the sections that follow:

    •Starting the IBM Content Classification server

    •Deploying knowledge bases and decision plans

    Testing the IBM Content Classification system

    To test that IBM Content Classification is running correctly, you can go through the Tutorial by selecting Start → All Programs → IBM Content Classification 8.8 → Content Classification Tutorial. Running through the tutorial will ensure that IBM Content Classification is running correctly.

    Starting the IBM Content Classification server

    Before you run the knowledge base and decision plan, start the IBM Content Classification server:

    1.	Click Services in your taskbar to open the Services Management Console in Windows.

    2.	Make sure that the IBM Content Classification Process Manager is running. If it is not running, in Windows, right-click IBM Content Classification Process Manager and select Start the service.

    3.	Open the Content Classification Management Console by selecting Start → All Programs → IBM Content Classification 8.8 → Management Console.

    The IBM Content Classification Management Console is the Content Classification Server administration tool with which you can manage all of the knowledge bases and decision plans. Content Classification Management Console is used to ensure that the decision plans and knowledge bases that are needed are installed on the server and running. 

    Deploying knowledge bases and decision plans

    To create a knowledge base or a decision plan, follow the steps presented in the Tutorial on the following websites:

    •http://www-01.ibm.com/support/knowledgecenter/api/content/SSBRAM_8.8.0/com.ibm.classify.tutorial.doc/abstract.html

    •http://www-01.ibm.com/support/knowledgecenter/api/content/SSBRAM_8.8.0/com.ibm.classify.tutorial.doc/module1.html

    •http://www-01.ibm.com/support/knowledgecenter/api/content/SSBRAM_8.8.0/com.ibm.classify.tutorial.doc/module4.htm

    To deploy the knowledge base or decision plan to the IBM Content Classification server, you can use one of the following applications:

    •Classification Workbench. Open Classification Workbench by selecting Start → All Programs → IBM Content Classification 8.8 → Classification Workbench

    See the following website:

    http://www-01.ibm.com/support/knowledgecenter/SSBRAM_8.8.0/com.ibm.classify.workbench.doc/c_WBG_Exporting_a_KB_to_Classification_Module.htm

    •Management Console. Open the Content Classification Management Console by selecting Start → All Programs → IBM Content Classification 8.8 → Management Console

    See the following websites:

     –	http://www.ibm.com/support/knowledgecenter/api/content/SSBRAM_8.8.0/com.ibm.classify.tutorial.doc/module2.htm

     –	http://www.ibm.com/support/knowledgecenter/api/content/SSBRAM_8.8.0/com.ibm.classify.tutorial.doc/module5.htm

    For information about testing the knowledge base and decision plan running on the IBM Content Classification server, see the following websites: 

    •http://www.ibm.com/support/knowledgecenter/api/content/SSBRAM_8.8.0/com.ibm.classify.tutorial.doc/module4.htm

    •http://www.ibm.com/support/knowledgecenter/api/content/SSBRAM_8.8.0/com.ibm.classify.tutorial.doc/module6.htm

     

    
      
        	
          More information: For more tips about tuning IBM Content Classification (previously known as IBM Classification Module), see IBM Classification Module: Make It Work for You, SG24-7707.

        
      

    

    16.3  Install additional fix packs

    This section describes how to install additional fix packs.

    16.3.1  Install Fix Pack 1

    After you have installed IBM Content Classification 8.8, you should apply Fix Pack 1 (or any more recently available Fix Pack or interim fix). For example, if you plan to install on Windows, you should download classificationsetup88FP1_win32 (or the most recent available Fix Pack or interim fix) from Fix Central:

    1.	Log in as the (local) Administrator user to the Fix Central website: 

    http://www.ibm.com/support/fixcentral/

    2.	Navigate to the downloaded IBM Content Classification installer location.

    Follow these steps to install IBM Content Classification Fix Pack 1 on Windows:

    1.	Run classificationsetup88FP1_win32, and you see the Introduction window shown in Figure 16-13. Click Next.
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    Figure 16-13   Content Classification 8.8 Fix Pack 1 installation introduction

    2.	Review the Fix Pack license agreement shown in Figure 16-14. Click Next.
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    Figure 16-14   IBM Content Classification 8.8 Fix Pack 1 license agreement

    3.	Review the Pre-Installation summary shown in Figure 16-15. Click Install.
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    Figure 16-15   Content Classification 8.8 Fix Pack 1 Pre-Installation Summary

    4.	Run Install and, when the installation completes successfully, you should see the Install Complete window shown in Figure 16-16.
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    Figure 16-16   Installation is complete

    To test that IBM Content Classification is running properly, you can go through the Tutorial by selecting Start → All Programs → IBM Content Classification 8.8 → Content Classification Tutorial. You can run parts of it if you have run it entirely after installing 8.8.

     

    
      
        	
          Note: Apply any additional fix packs or interim fixes for IBM Content Classification 8.8 as appropriate in your environment.

        
      

    

    16.4  Integrate IBM Content Classification with ECM products

    IBM Content Classification is integrated with many ECM products, providing content analysis, topic and category identification, information extraction from the content, and actionable insights.

    Figure 16-17 depicts the integration of IBM Content Classification with other ECM products to support various use cases. 
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    Figure 16-17   IBM Content Classification brings value in various ECM scenarios

    In the product documentation, you can find a high-level description of all of the available integrations on the following website:

    http://www-01.ibm.com/support/knowledgecenter/SSBRAM_8.8.0/com.ibm.classify.admin.doc/g_AG_Integrating.html

    16.4.1  Use IBM Content Classification in the injection phase

    IBM Content Classification can be used when documents (including emails) are loaded into the ECM repository. At this phase, IBM Content Classification can be used to analyze the documents or email content, and suggest information that can be used to decide whether to simply archive these documents or perform some action based on these documents and where to place them. 

    IBM Content Classification can also decide what properties to assign to the documents, and if the documents should be declared as records. IBM Content Classification can analyze and classify content, such as documents and email, when they are captured by IBM Content Collector or by IBM Datacap for archiving. 

    Based on the analysis results, Content Collector or Datacap can make more intelligent determinations about how to handle the content. For example, Content Classification can help determine what information needs to be retained because it contains business value.

    For more information about using IBM Content Classification in the injection phase, see the following websites:

    •Content Classification and IBM Content Collector

    http://www-01.ibm.com/support/knowledgecenter/SSBRAM_8.8.0/com.ibm.classify.admin.doc/c_AG_ICC.html

    •Content Classification and IBM Datacap

    http://www-01.ibm.com/support/knowledgecenter/SSBRAM_8.8.0/com.ibm.classify.admin.doc/c_AG_datacap_int.html

    16.4.2  Use IBM Content Classification in the ECM repositories for content organization

    IBM Content Classification can be used in integration with ECM repositories. You can classify and reclassify content in IBM FileNet Content Manager or IBM Content Manager repositories using the Classification Center. The system analyzes content, determines where items belong in the repository, and can automatically set document properties and move items to the correct folders or document classes, including:

    •Support for document classification and taxonomy automation within the content management system.

    •Automatic assignment of document properties or metadata when the content is classified. Documents can be automatically moved to the correct enterprise repository.

    •Consistent, reliable, auditable content classification for FileNet Content Manager or IBM Content Manager content.

    For more information about this, see the following websites:

    •IBM Content Classification and IBM Content Manager

    http://www-01.ibm.com/support/knowledgecenter/api/content/SSBRAM_8.8.0/com.ibm.classify.admin.doc/c_AG_CM.htm

    •IBM Content Classification and IBM FileNet Content Manager

    http://www-01.ibm.com/support/knowledgecenter/api/content/SSBRAM_8.8.0/com.ibm.classify.admin.doc/c_AG_P8.htm

    16.4.3  Using IBM Content Classification for records declaration

    IBM Content Classification can be used in integration with IBM Enterprise Records for automatic email archiving and retention and for records declaration, including:

    •Organize content and make records declaration decisions automatically, using the Classification Center.

    •Classify records currently in an existing ECM repository, organizing them in place using the Classification Center.

    •Classify records during the content collection process using modular tasks in IBM Content Collector.

    For more information, see the IBM Knowledge Center about IBM Content Classification integration with FileNet Content Manager:

    http://www-01.ibm.com/support/knowledgecenter/SSBRAM_8.8.0/com.ibm.classify.admin.doc/c_AG_P8.htm

    16.4.4  IBM Content Classification and StoredIQ

    You can integrate IBM Content Classification decision plans and knowledge bases into the IBM StoredIQ® infoset-generation process. Classification technology reduces the burden on data experts by automating the analysis of large amounts of data with minimal human intervention. The integration enables you to automatically classify data wherever it is.

    For more information, see the IBM Knowledge Center about IBM Content Classification integration with StoredIQ:

    http://www.ibm.com/support/knowledgecenter/SSBRAM_8.8.0/com.ibm.classify.admin.doc/c_AG_StoredIQ.htm

    16.4.5  Content Classification at the entry point: integration with Content Navigator

    You can use the Content Classification plug-in for IBM Content Navigator to analyze the content of a document before it is added to the repository, and automatically suggest the correct folder or document class. It guides the user with suggestions based on a trained set of documents, and based on user feedback.

    In this way, users can save time and reduce errors.

    Figure 16-18 presents the Classification plug-in for Content Navigator.
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    Figure 16-18   Classification plug-in for Content Navigator

    For more information, see IBM Knowledge Center about IBM Content Classification integration with IBM Content Navigator:

    http://www.ibm.com/support/knowledgecenter/SSBRAM_8.8.0/com.ibm.classify.admin.doc/c_AG_ICN.htm

     

    
      
        	
          Summary: IBM Content Classification brings value to ECM solutions. Through automated and advanced classification, knowledge workers gain the following advantages:

          •Have quick access to relevant content

          •Have the information they need to use to complete tasks

          •Are not burdened with enforcing compliance and retention policies

          •Can analyze content relevant to specific subject matter

          IBM Content Classification improves productivity by applying automatic actions and reducing the burden on the organization’s knowledge workers.
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Implementing an IBM Content Classification 
use case

    This chapter describes how IBM Content Classification is used in the IBM Enterprise Content Management (ECM) Customer Response Management solution scenario. IBM Content Classification analyzes the customer comments or complaints, and provides actionable insight that is used within IBM Case Manager tasks.

    This chapter describes the following topics:

    •IBM Content Classification overview

    •How Content Classification ties into the scenario

    •Creating and deploying the IBM Content Classification resource

    •Integrating Content Classification into the Case Manager solution 

    17.1  IBM Content Classification overview 

    Today, organizations are struggling with huge amounts of content. This explosive growth is enabling enhanced collaboration, productivity, and innovation, but at the same time, it dramatically increases IT costs and risk exposure. Managing huge amounts of content is a real challenge.

    Lack of trusted information is forcing line-of-business organizations in companies of all sizes, in virtually every industry, to change the way that they view content, and to see it as a strategic asset. In this context, deep understanding of the content helps deliver high-value business solutions with positive outcomes and real business transformation.

    Leading organizations recognize that their enterprise content is not just a cumbersome liability to be managed, but that it is an incredibly valuable asset waiting to be “tapped” or “mined” for insight that can help meet business challenges and create organizational advantage.   

    Their problem is how to gain control over the data so that their decision making is better-informed. 

    IBM, with its ECM portfolio, can help address these challenges. IBM Content Classification brings much value to this portfolio, integrating with almost all of the ECM products and unlocking the information buried under the unstructured content. 

    Classification is necessary for most, if not all, facets of business. By properly classifying content, you ensure that the content is accessible, that it is compliant for Legal and Discovery purposes, and that it can be analyzed to obtain consistent and reliable value.

    17.2  How IBM Content Classification ties into the scenario

    This section describes how IBM Content Classification ties into our use case scenario.

    17.2.1  Scenario walkthrough

    The original scenario, described in Chapter 2, “Use case scenario” on page 11, begins as the Client (Jackie) places a call to the fictitious Company A because she has had issues with a product and service that she recently received. By using IBM Content Classification, we can take a new approach to this familiar scenario. 

    The Client (Jackie) logs in to Company A’s client portal. Within the portal, she browses through its content and decides to submit a question using a web form that captures her free-form text question. When she submits the information through the web form, the information is captured and is passed to IBM Content Classification. IBM Content Classification performs free-form text analysis and classification. 

    Company A used to receive hundreds to thousands of general inquiry questions using telephone. In many instances the answers to the inquiries could be found on their company’s website. Since implementing the online form, the calls have dropped dramatically, because IBM Content Classification can automatically deliver the appropriate response back to the client. 

    If IBM Content Classification analysis determines that Company A must further process the Client’s question, a new case is required because the path to resolution is beyond a simple response. Using the captured information, IBM Content Classification creates a new case within IBM Case Manager. 

    17.2.2  Step breakdown

    Figure 17-1 outlines a summary of the key steps involved in the scenario, which varies from the original calling scenario as described in Chapter 2, “Use case scenario” on page 11.
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    Figure 17-1   High-level scenario flow with Content Classification

    The following list includes the key steps in the scenario:

    1.	Jackie logs in to her client portal and submits a question using a web form.

    2.	The inquiry is analyzed and classified by IBM Content Classification.

    3.	If the analysis finds that there is a simple, already-available answer, the response is immediately delivered to Jackie.

    4.	Otherwise, IBM Content Classification saves the information (the question text, the identified Request Type, and so on) into a document. The event of adding this document to the ECM repository initiates a new case in our ECM solution.

    5.	The system automatically generates and sends a note to Jackie: “Thank you for contacting Company A. Your inquiry was received and we’ll be in touch with you soon”.

    6.	The case is routed to Rebecca, the appropriate Specialist in product-related complaints who can handle the case.

    The remaining steps are the same as described in Chapter 2, “Use case scenario” on page 11.

    17.2.3  The roles and use cases covered in this solution

    In this use case, the Client (Jackie) writes a comment on the Company A website soliciting help regarding a product defect that she found. This comment is analyzed by IBM Content Classification and found to be related to a product defect that requires initiating a new case to follow the problem until its resolution. 

    Another time Jackie wrote a different comment to ask about the opening hours of the California branch of Company A. This comment was analyzed by IBM Content Classification and found to be a general inquiry that has an already-
available answer. Therefore, it does not require any follow-up, so no case is opened. 

    In this way, general comments are dealt with up front, with no need for a complex workflow. Company A’s caseworkers, such as client service representative (CSR) and product and services Specialists, can focus on solving problems related to product defects or services issues, while the general comment is responded to automatically in most cases.

    Figure 17-2 presents Company A’s Client portal (for example, a Contact-Us web form) where the company’s customers can write their comments, ask their questions, or submit their complaints.
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    Figure 17-2   Company A’s Contact Us web form

    17.2.4  Where you will be at the end of this chapter

    After following the instructions in this chapter, you will enrich the ECM solution with the IBM Content Classification integration that enables the automatic content analysis of, and decision-making about, the user’s comments or complaints. This reduces the burden on Company A’s case and knowledge workers, such as CSRs. 

    17.3  Creating and deploying the IBM Content Classification resource

    This section explains the step-by-step procedures for creating the knowledge bases and decision plan in IBM Content Classification, and for deploying them to the production server. For comprehensive IBM Content Classification product usage, see the materials referenced in the Overview section shaded box.

    Creating and deploying IBM Content Classification resources entails the following tasks, which are explained in the sections that follow:

    1.	Planning the Content Classification assets 

    2.	Starting the Content Classification server

    3.	Creating the Content Classification resources

    4.	Creating the knowledge base and decision plan

    5.	Deploying the knowledge base and decision plan

    Planning the Content Classification assets

    Content Classification supports the scenario described in 17.2, “How IBM Content Classification ties into the scenario” on page 541: 

    •Identifying the request type of questions, such as those sent by clients through web forms

    •Extracting additional pieces of information (for example, the ProductID)

    To prepare these capabilities, you need to create the following Content Classification assets:

    1.	Train a knowledge base (for example, name it CustomerSupportKB) to identify if a user request, question, or comment is of type Product Complaint, Service Complaint, or General Issue. For this purpose, you need to gather a few examples of questions that are relevant for each type, and use Classification Workbench to create the knowledge base. For more details, see 16.2.3, “Configuring and running IBM Content Classification” on page 529.

    2.	Build a decision plan that performs the following tasks:

    a.	Identify the Request Type by starting the CustomerSupportKB knowledge base that we created.

    b.	Write a rule that extracts the ProductID, if specified in the user’s question.

    Starting the Content Classification server

    To test that Content Classification is running correctly, you can go through the tutorial steps by selecting Start → All Programs → IBM Content Classification 8.8 → Content Classification Tutorial. 

    Before you create and run the knowledge base and decision plan, start the Content Classification server:

    1.	Click the Services icon in your taskbar to open the Services Management Console in Windows.

    2.	Make sure that the IBM Content Classification Process Manager is running. If it is not running, in Windows, right-click IBM Content Classification Process Manager and select Start the service.

    3.	Open the Content Classification Management Console by selecting Start → All Programs → IBM Content Classification 8.8 → Management Console.

    The Content Classification Management Console is the Content Classification server administration tool with which you can manage all of the knowledge bases and decision plans. In this chapter, Content Classification Management Console is used to ensure that the decision plans and knowledge bases, when created, are installed on the server and running. 

    Creating the Content Classification resources

    The main steps to create and deploy Content Classification resources include:

    1.	Start Classification Workbench by selecting Start → All Programs → IBM Content Classification 8.8 → Classification Workbench.

    2.	Select Project → New → Knowledge Base or Project → New → Decision Plan.

    3.	In the New Project window, type the name of the knowledge base or decision plan. Then click Next.

    4.	Import the content set (a set of documents organized into folders representing the categories, or a set of Extensible Markup Language (XML) files) to be used for training. These content items are used as examples to train a knowledge base, or to define rules in the decision plan and test them:

    a.	Train a knowledge base called CustomerSupportKB. 

    b.	Develop the decision plan rules in a project called CustomerSupportDP: 

    i.	Define a rule that identifies the question request type. See Figure 17-3.

    [image: ]

    Figure 17-3   Identify Request Type

    ii.	Define a rule that extracts the ProductID (as an example of information that can be extracted from the question or complaint text) by specifying the pattern or the regular expression that characterizes it in this case. See Figure 17-4.
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    Figure 17-4   Extract ProductID

    For comprehensive instructions about how to create a knowledge base or a decision plan, follow the steps presented in the tutorial on the following website:

    http://www-01.ibm.com/support/knowledgecenter/SSBRAM_8.8.0/com.ibm.classify.tutorial.doc/abstract.htm

    Deploying the knowledge base and decision plan 

    To use the knowledge base and decision plan that you created, you must deploy them to the Content Classification server. The following steps show you how to deploy a decision plan:

    1.	In Classification Workbench, select Project → Export.

    2.	Select Decision Plan, and click Next.

    3.	Select IBM Content Classification Server, and click Next.

    4.	In the Connection window, specify the Content Classification Server computer name and port. Click Next.

    5.	In the Publish Decision Plan window, select Create a new Decision Plan on the Content Classification server, and for Specify a name for the new decision plan, enter CustomerSupportDP, then click Next.

    6.	Verify that the CustomerSupportDP decision plan functions properly, as explained in the Content Classification tutorial. 

    Set up the client application

    Content Classification is a stand-alone web-service that can be started from a custom application, or by other ECM products that use it, as shown, for example, in 16.4, “Integrate IBM Content Classification with ECM products” on page 533. 

    To use Content Classification services, you must:

    1.	Set up the Content Classification server.

    2.	Deploy the custom application that you have built.

    3.	Set up the integration configuration.

    In our scenario, the custom application is a simple web application that simulates Company A’s client portal, and enables clients to send their questions or inquiries. The app either sends an already-available answer to the client or open a case that starts a resolution process through the web interface.

     

    
      
        	
          More information: For more tips about tuning IBM Content Classification (previously known as Classification Module), see IBM Classification Module: Make It Work for You, SG24-7707.

        
      

    

    17.4  Integrating Content Classification into the ECM solution

    In the scenario presented in 17.2.2, “Step breakdown” on page 542, users access the Company A’s Client portal and submit their comments, questions, and complaints. 

    17.4.1  Starting IBM Content Classification from the Company A client portal side

    The user comment or complaint is analyzed by Content Classification by running it through the CustomerSupportDP decision plan that produces the following output:

    Complaint Topic Intent	Product Complaint, Service Complaint, or General Issue.

    Product ID	Information that is extracted from the user’s complaint (if provided by the user as part of the free-form text).

    An XML file, Complaint Document, is created. It contains all of the pieces of information provided by the user in the web form (Comment, Name, email address), and the additional information that resulted from the Content Classification analysis. This sample client application saves the complaint text, the request type, the Product ID, and so on, in a document, as shown in Figure 17-5.
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    Figure 17-5   Content Classification Client application XML output Complaint Document

    17.4.2  Integrating IBM Content Classification into the IBM Case Manager solution

    In this scenario, Content Classification is started in a client application before the case is opened in the Case Manager application, and only for that subset of user’s comments that are identified as Product Complaint or Service Complaint. The General Issues comments are not initiating any operation case. 

    When a comment is identified as a Product Complaint (the Request Type tag in the Complaint Document XML file is Product Complaint), it should be added to the FileNet Content Manager repository under the Document Class Request Classification, and a case should automatically be opened on the path dealing with Product Complaints. Follow these steps to integrate the outcome of Content Classification into the Case Manager solution:

    1.	Edit the Case Manager solution using Case Manager Builder.

    2.	To add a Task, go to Case types and choose the Request case type, as shown in Figure 17-6.
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    Figure 17-6   Choose Case Type - Request

    3.	Make sure that the Starting document type is Request Classification (Figure 17-7).

    [image: ]

    Figure 17-7   Starting Document Type - Request Classification

    4.	Choose Tasks. 

    5.	Define a task called Initial ProductComplaint, as shown in Figure 17-8.
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    Figure 17-8   Required Task - Initial ProductComplaint

    6.	Set the Precondition for Document types to Request Classification, as shown in Figure 17-9.
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    Figure 17-9   Case starts when a document is filed under the Request Classification document class

    7.	Set it to start Automatically, as shown in Figure 17-10.
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    Figure 17-10   Case Automatically starts

    8.	Choose Edit Steps to add the workflow steps. Because a previously generated XML document is added to the IBM FileNet Content Manager repository under the Request Classification Document Class, a Case is automatically initiated, and the document is attached to the case workflow.

    9.	Open Process Designer to add the workflow process steps.

    10.	Go to Workflow Properties and define (or confirm the existence of) the workflow fields and attachments:

    a.	Click Data Fields and define a String Array that carries the Document Content through the Workflow processing. For example, name it DocContentArray. See Figure 17-11.
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    Figure 17-11   Workflow Data Fields

    b.	Click Attachments, define an attachment, and name it MainDocument. See Figure 17-12.
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    Figure 17-12   Workflow attachments - MainDocument

    11.	Add a Component and name it getContent. You can find more information regarding FileNet Content Engine operations at the following websites:

    •http://www-01.ibm.com/support/knowledgecenter/SSNW2F_5.2.0/com.ibm.p8.pe.user.doc/bpfwd028.htm?lang=en

    •http://www-01.ibm.com/support/knowledgecenter/SSNW2F_5.2.0/com.ibm.p8.pe.dev.java.ceops.doc/filenet/contentops/ContentOperations.html?lang=en

    12.	Add a Component and name it Assign. Set the following Case Properties by extracting specific pieces of information from the XML file using the Process Engine XPath extraction functionality, as shown in Figure 17-13. You can find more information on the following website:

    http://www-01.ibm.com/support/knowledgecenter/SSNW2F_5.2.0/com.ibm.p8.pe.user.doc/bpfe015.htm?lang=en
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    Figure 17-13   Workflow Extract Case properties

    13.	One example of populating a Case Field is setting the field called F_CaseFolder.JCRM_ClaimDescription using the XPath expression shown in Example 17-1.

    Example 17-1   XPath expression to extract fields from the XML document
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    xmlstringexpr(DocContentArray[3], "/", "/*[local-name()=""Corpus_Item""]/*[local-name()=""Body""]")
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    14.	Save the workflow (see Figure 17-14), by selecting File → Solution → Save and Close. 
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    Figure 17-14   Case Workflow

    15.	Validate, Commit changes, and Deploy the Case Solution. 

    16.	To test the case creation and the document processing, add a new XML document to the Request Classification Document Class, and validate the case that has been created.

     

    
      
        	
          Note: In real-life projects, there are multiple components and methods that you can use to add new documents to an ECM repository, and to initiate a case. The following list includes some of these components and methods:

          •IBM Content Collector 

          •IBM Datacap 

          •ECM Repository application programming interface (API)

          •Bulk Import Tool for FileNet Content Manager

        
      

    

    17.	Inspect the case using the Case Manager Client and observe that the case has been automatically initiated and its properties populated (see Figure 17-16 on page 555), including the Request Type being Product. Note also that the Initial ProductComplaint Task (see Figure 17-15 on page 555) has been started. 
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    Figure 17-15   Case instance tasks - Initial ProductComplaint
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    Figure 17-16   Case instance generated from the Customer Product Complaint with case fields automatically populated from the XML fields

    This example scenario shows how Content Classification can be started at various points within an ECM Solution to analyze the text and identify its topic (in this example, whether the user comment is a Product Complaint or a Service Complaint versus General Issues). Content Classification also extracts additional pieces of information from the comment’s free-form text (for example, ProductID in this case). This information can be used in the ECM Solution workflow later on. 

    The Content Classification web service can be started at any point inside the ECM Solution workflow to analyze the content of the documents attached to the case. This is beneficial whenever there is a need to analyze the content and make a decision based upon the content analysis findings. Content Classification usage is flexible, and can be easily started as a web service, or by using its Client’s API. 

    For more information about how to use a web service as part of a Case Workflow, see the following website:

    http://www-01.ibm.com/support/knowledgecenter/SSNW2F_5.2.0/com.ibm.p8.pe.designerui.doc/bpfdh190.htm?lang=en

     

    
      
        	
          Summary: IBM Content Classification can be easily incorporated into various ECM solutions, facilitating automated, advanced classification and text analytics, enabling businesses to achieve the following goals:

          •Derive insight from unstructured content.

          •Have quick access to relevant content.

          •Bring the correct information into the Business Process at the correct time to the correct person.

          Content Classification improves productivity by applying automatic actions and reducing the burden on the organization’s knowledge workers.
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Complex use case scenario

    This chapter describes the design of a use case that is more complex than described in Chapter 2, “Use case scenario” on page 11. No implementation is provided. The goal is to focus on the design of a more complex solution as required for the complex use case.

    It should be noted here that, just as in real life, there is more than one way to design a solution. The intent is to show design principles and guidelines about a solution that has the variety of products all working together.

    18.1  Use case scenario

    The complex use case deals with the healthcare industry. Specifically, the use case deals with the birth of a baby from the mother’s first visit, to the doctor’s office, to the final delivery of the baby. The scenario consists of five doctor’s offices that are within a physicians group and participate at the same hospital. Within the scenario, some of the doctor’s offices also share information, or doctors have two locations.

    Figure 18-1 shows a simple view of the previously mentioned interactions.
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    Figure 18-1   Hospital and doctor office interactions

    The group of doctors is looking for a solution that will help them manage their patients from start to finish. The initial scenario is new born delivery, from the time the mother comes in for the first visit to the day that the mother and baby are released. The case solution should satisfy the following sets of requirements:

    •Ability to see all relevant data about the patient within a single window

    •Ability to access all relevant medical data about a patient

    •Ability to access all medical documentation about a patient

    •Access to all prescriptions and medical treatments

    •Ability to order prescriptions, treatments, and tests

    •Ability to access bills and payments

    •Ability to take action regarding a patient

    Another requirement is that the patient’s information is not always or entirely available when the mother checks into the hospital. Although this hospital enables preregistration, it is almost as though she is a new patient and all of the existing medical information is absent. 

    The collective of doctors would like the entire patient case file to be available at the hospital when the mother checks in. This requirement also applies across the doctor’s offices, because some doctors work in more than one office. Rather than the medical information being localized to the individual doctor’s office, they would like it to be accessible from any office or hospital.

    The hospital system is available to be accessed 24x7 with no downtime, to enable patients to be viewed and processed at any hour of the day. The existing systems of record within the offices and hospital are already at this level of up time. This solution must be at the same level as them, 99.9% uptime (also known as three 9s).

    After the system is in place, the doctors and hospitals would like to gain some knowledge or insights into their patients, the processes, and the types of tests, procedures, and medications that are used the most and why. Are there trends that they can use to better help their patients? Are there medical trends about certain types of patients that they need to be aware of to treat differently? The answers to these types of questions will provide them insight.

    18.2  Design approach

    This section goes over the design process for creating a solution to meet the complex use case. The design of any solution can be done in several different ways. This is one approach to solving this challenge, based on the assumptions and information known. The key part of this design within the scope of this book is the approach that is being taken.

    Based on the set of requirements, the approach is to look at the case management aspects and see what else is needed to support the solution that the case management product cannot.

     

    
      
        	
          Note: Case management is being chosen as the main solution focus for a couple of reasons. The first reason is that there is a concept of a thing that has a life, actions taken against, has data that is needed, an indeterministic path, and is focused on outcomes. The second reason is that, with those parts identified, the rest of the solution provides clarity on what is core and what is supplemental to the case to support it (whether that is other products, policies, procedures, or business actions to achieve the end goal).

        
      

    

    The first step in a case solution is to define what the case is. Figure 18-2 shows a business interaction diagram, where the center is the case itself interacting with the various people, documents, and systems. This solution covers two case objects, Patient (the Mother) and the Child (newborn). The objects outside of the case all interact with it.
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    Figure 18-2   Case business context diagram

    18.2.1  Case design

    The case design process is to be taken from a business point of view entirely. The case itself is a type of business entity, either a customer, patient, manufacturing plant, or oil rig. It is a noun of some business meaning that has an expected outcome and some type of lifecycle.

    Knowledge workers interact with this case at varying times throughout its life, to perform work, make decisions, or answer questions. The path to the outcome is not known, and it is highly likely that it is different for each instance of the case.

    Case object

    When looking at this use case, the first important design aspect is the determination of what the case is. This decision affects everything that is designed going forward. If your case is too narrow in focus, the benefit of the system as a whole is lost, and the solution offers little to no added value. If you design at too high a level, the lack of continued context is lost throughout the solution, and additional complexities will be needed.

    The Patient is selected as the case object for a few reasons:

    •A patient is a high-level enough “thing” that has context of a life, a goal, activities, and information that exists about them.

    •Patient is extensive enough of a topic that the data itself has meaning, purpose, and business value to the overall organization.

    •The procedure itself (delivery) is another option, but offers only the context of that individual view. Delivery is more appropriately viewed as a Case Type. This would allow for different Case Types, like illnesses or diseases, such as diabetics and general health aspect, or annual visits as part of a cast type of general wellness. Within all of these case types, the key focus is on the patient, data, and lifecycle, which in this case is an actual person’s life.

    •This would give the doctor’s offices and hospitals the 360 view of the patient. Different case types could be worked at the same time, while having the over-arching Patient and then being able to see all of the cases against them. 

    For example, a mother is having a baby, but the baby is also being treated for diabetes. Being aware of this fact alone would help the doctor or nurse when they prescribed treatment or medicine, to see what has actually been ordered or prescribed, as opposed to relying on the patient to remember the details.

    The children that are created (born) would also be considered patients, and the treatment, medication, and data would be their own cases. The activities performed would be against that child, not against the mother. Although some of the data is the same as for the mother, the rest of it is unique to the new child. At this level, the children are no different than their mother, and can have tests, procedures, and documentation.

    Case data

    With the case object now identified, the next part with this is to determine what data is needed for the case to reach its goals and objectives. The solution presents all of the information needed to the person at that point in time. That information does not necessarily need to be with the Case Management solution. 

    This solution is more a system of engagement than a system of record, in this situation. The hospital’s and doctor’s offices have several other systems of record that track patients and their data. This solution must interact with those systems to present the information to the knowledge worker when needed.

    As a system of engagement, the majority of the data is in external systems. To prevent data replication, concurrency, and accuracy issues, it would be best served not to bring that data into this system. However, the data might be needed for processing, reporting, or other functions not easily addressed by displaying data, like analytics.

    The following core case data would be needed:

    •Patient’s Name

    •Current Doctor

    •Doctor’s Office

    •Affiliated Hospital

    •Expected Due Date

    •Date of Inception

    •Patient Zip Code

    •Patient’s Insurance Carrier

    •Patient’s Insurance Plan Number

    •Patient’s Age

    •Patient’s Zip Code

    •Patient’s Ethnicity

     

    
      
        	
          Note: This data set is core to the patient. At this time in the design, it is not known what else is needed for reporting and analytics. This set of information is a common part that is missed within a project. Within a given project plan, it would be advised to create a task that ensures that these two parts are validated before continuing on to the detailed design phase.

        
      

    

    This initial set of data is mostly static types of information. There are data elements that could change throughout the patient’s life, and the solution must address the potential changes to that data. For the purposes of the use case, it is determined that this system is the engagement for all of the patient’s activities.

     

    
      
        	
          Note: Many case management solutions are designed toward a system of engagement. This means that the solution is more about providing the correct information at the correct time, as opposed to ensuring data accuracy and storage. Case management solutions would work with these systems of records to obtain the information and present the information.

        
      

    

    Case documents

    Within the scope of a case solution, the identification of documents, their organization, and their properties, should follow the same design patterns as they would within an ECM-only solution.

     

    
      
        	
          Note: Briefly, an ECM design is that which focuses on the documents and their usage. A simplistic view of this is to categorize documents into similarities based on property data and security requirements. This aspect ties to a physical grouping of documents, and then you look to logistically break them apart into sub-classes for different usages.

          ECM design takes into account not only the business usage of the documents, but the storage and retrieval aspects of their physical usage. There is not a specific answer for this design, because there are variables that influence decisions about the types of storage, document security, and physical storage security.

          The intent is to be aware of these design patterns when dealing with case documents.

        
      

    

    The following list of documents include those that exit for this solution:

    •Patient Application (created when patient first comes into the doctor’s office)

    •Medical Card

    •Doctor Notes

    •Nurse Notes

    •Prescriptions

    •Medical Reports

    •Billing Statements

    •Invoices

    •Hospital Registration

    •Consent Forms

    •Test Results

    •Lab Results

    •Birth Plan

    Each document, although still belonging to the case, has properties that describe itself as a stand-alone document. Within the context of the solution, some documents are system-generated and stored within the core ECM repository, and some are stored within IBM Content Manager OnDemand because they are a report-generated type of document. The rest of the documents come from sources external to the system, and must be captured accordingly.

    Case tasks

    The tasks or business activities associated with the case are what give it life or action. These help the case reach its end state, complete its goal, and achieve the wanted outcome. Tasks come into play after the case has been identified, after the data for the case has been determined, and after the goals and outcomes have been set.

    To determine the business activities, look for Verbs associated to the case Noun. The patient needs activities to be completed in some manner for her to deliver the baby, as one possible outcome. Here is a list of some activities that would occur in this possible outcome:

    •Check into Hospital

    •Order epidural

    •Order test - glucose, strep B, and so on

    •Order prescription

    •Check out of hospital

    •Schedule review of results

    •Schedule sonograms

    •Setup C-section procedure

    •Schedule class - Lamaze, breast feeding, and so on

    •Order labs - disorders, blood panel, and so on

    •Complete hospital pre-registration

    •Determine room assignment

    •Complete birth plan

    •Complete medical release

    •Complete consent of medical treatment

    •Complete blood transfusion procedure

    •Order amnesties

    It is important to note that there are some activities that do not warrant an actual process task. Events like schedule an appointment, while they are a Verb in context, are something that are done immediately at the case level. They do not need a workflow or task to complete them.

    The task itself should be focused on just completing that specific activity and nothing else. To help ensure that effect took keeping a general design rule of no more than five steps within a task definition. There will always be exceptions, and a task itself could run a traditional business process. However, in general, the maximum five-step rule helps you design the correct types of tasks.

     

    
      
        	
          Note: This design approach enables for tasks to be truly focused on specific business activities and the relationships between the activities. This can also enable task reuse. If a specific business activity is part of a larger task, that specific task cannot be used within the case lifecycle as needed without running the entire defined process.

        
      

    

    Case interaction

    As shown in Figure 18-2 on page 560, there are several external entities that the case interacts with. The intent in this section is to outline those types of interactions. These interactions are all system-based, because the user interactions are covered from a task perspective and user interface (UI) perspective.

    The following list includes some of the entities where interactions are required:

    •Calendaring

    •Electronic medical records (EMR)

    •Billing

    •Documentation

    •Labs and tests

    •Procedures

    •Medication

    For each entity, a list of specific interactions must be created. This falls into a more technical type of design, and is covered in more detail in 18.4, “High-level design” on page 580.

    The next aspect of interactions to be determined is at the role level, which ties people into the identified entities and activities. These are the basic roles that we have defined:

    •Doctor

    •Nurse (at this point, it is unknown if the Nurse role must be broken down into more specific roles)

    •Medical Staff (at this point in the design, it is unknown if this role must be broken down into more specific roles)

    •Clerical Staff

    There are a couple of roles that might need to be broken down, depending on how exactly the work must be distributed, or assigned and tracked. For example, is there a difference between a doctor office Nurse and a hospital Nurse? Are there different types of roles a Nurse can play within a hospital? Medical Staff might be too generic as well. A person who administers the epidural is not the same as the staff member who checks the patient out. 

    At this point in the design, it is left as is until more information is obtained through task design.

    At this point in the case design is outlined and the process of laying out the solution overview can begin.

    18.3  Solution overview

    This section describes the solution of this use case.

    18.3.1  Case goals

    The first part of the case is to determine the goals (or objectives) of the case. To help understand the objective, a simplified lifecycle is depicted in Figure 18-3. This shows the different phases that a patient goes through.

    [image: ]

    Figure 18-3   Patient lifecycle

    With a lifecycle defined, the ability to determine outcomes might become clearer. The following list describes the outcomes for this use case:

    •Baby delivery

    •Early termination

    •Miscarriage

    •Adoption

    For the purposes of this chapter, the baby delivery is the only outcome of focus. The rest of the design focuses on completing this goal, which would include data, tasks, documents, and user interactions

    CMMN design

    Case Management Model and Notation (CMMN) is a modeling notation for a case management solution. This notation is provided by the Object Management Group (OMG) that has the specification laid out in detail. This is, at the time of this writing, a new specification, and there are limited tools available to perform the modeling. 

    The modeling of a case is more around the actual runtime instance of the case, and how it can interact. The case itself is not modeling by what the events and actions are. They are what can be called the first class citizens of the case within the model.

    The modeling of a case is not to provide a complete description of the case and how it works entirely, but more to provide context of a running case to aid in the design process. Rather, identify known tasks, documents, rules, and events that contribute to a case reaching its goals or outcomes.

    Currently, there is no import mechanism of these models into the software products. As such, this modeling notation is more helpful in realizing the business needs and objectives, as opposed to a way to completely gather and implement a solution.

    Figure 18-4 on page 568 shows an initial and simple CMMN notation for this use case. The model did not get into the stages and planning model aspects, just the start of the tasks and documents.

    The following list provides an explanation of the notation used within the model:

    •The box showing a hand is called a non-blocking Human Task. In this context, it is started by a person, because it is started upon instantiation.

    •The box with another box is called a Process Task. This has more to do with a traditional business process type of task.

    •The box with a folder is a task that is used to initiate another case.

    •The circle is an event listener. In this case, it is waiting for the document arrival to occur.

    •The empty triangle on the left of a task is called a Sentry. A Sentry monitors for important situations to occur, or for events happening within the case.

    •The arrow at the bottom of the task denotes that it will start automatically.

    •The three lines at the bottom of the task denote that it is started manually.

    There are other notations that are possible. These were just the few that we have chosen for this model, as shown in Figure 18-4.
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    Figure 18-4   Patent case model

    The intent of providing this model is to provide additional context to the use case, and to show the use of this modeling notation. It should be noted that, although this notation is beneficial, it is a runtime view of the case, with focus on the business activities. As you noticed, there is little if any aspect of understanding the data of the case. There is a heavy focus on the tasks and their dependencies, and how they are instantiated. 

     

    
      
        	
          Note: The question about how to model case data is not part of this notation. At this point in time, there are no leading practices. There are only practices in practicality that achieve the best way for the given project and solution to identify what is needed in a manner that is understood by both the business and the implementors of the solution. 

          A Unified Modeling Language (UML) Static Structure type diagram might be all that is needed to obtain this information.

        
      

    

    Within this model, many tasks were intentionally left out. The model is showing the basics of CMMN notation. There are different types of tasks, and different ways how they are started and run.

    Although the notation has strong benefits, it is important to remember the intent and purpose of this modeling notation, just like any notation, and not force everything to be modeled for the sake of modeling.

    18.3.2  Case data interaction

    The case obtains data from several sources. It must be known if the data is needed within the system itself, or just needs to be displayed. As a system of record, that data is not required within the case system, unless its being there facilitates the case in its lifecycle or reporting.

    The following list includes the sources for this use case:

    •Doctor

    •Medical staff

    •Patient application

    •EMR system (patient medical information)

    •Billing system

    Figure 18-5 on page 570 shows the start of a case. A case can be started from several options: 

    •Patient calls or comes into the doctor’s office.

    •Patient completes an application and mails, emails, or faxes it in.

    •Patient completes the form on the web.

    Within the initial data provided by the patient, a medical record integration is needed to complete the form, as shown in Figure 18-5.
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    Figure 18-5   Case data start interaction

    This is one example of the case data needed during the solution design. The identification then points out what is needed in the rest of the design.

    Another example of case data interaction is when the patient enters the hospital (Figure 18-6 on page 571). This is an example of the more data-intensive aspects of this use case and case lifecycle. The document type of application is listed here as well, but this is a hospital application. This makes it clear that our solution must differentiate between different types of applications. When that determination is made, it processes a different set of data.

    Figure 18-6 shows an example of case data interaction.
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    Figure 18-6   Case data hospital admittance interaction

    As shown, there are several additional data elements that are being brought into the case. In this particular instance, that data integration is only a visual integration for two of them. The Billing integration would be to show a list of all of the invoices that have existed for the patient. The same is true with Hospital Admissions, where the interaction is more to get the patient information needed. Activities later on are based on that data.

    It is important to note that, to adhere to the requirements listed, when patients arrive they will be set up with a bed, and all of the billing and paperwork would be handled with as little intrusion on the patients as possible.

    The last interaction to be covered is when the baby is delivered. When this occurs, a new case is created. The reason is that the definition of a case is at a patient level. When the baby is born, the baby becomes a patient with his own set of data, lifecycle, and activities.

    As shown in Figure 18-7, two cases exist: The original patient (mother) and the new patient (baby). As noted, the data interactions are that the medical records, hospital admissions, and some medical aspects are all needed. Also, the majority of the basic case information is replicated from the original case, because that will all carry over.
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    Figure 18-7   Case data delivery interaction

    With the baby now being its own case, all of the data, activities, and information are managed outside of the parent. Although the solution maintains a relationship between the cases, they exist separately. In the event of more than one baby, each baby would be its own case, and a relationship would be maintained between them.

     

    
      
        	
          Note: To re-emphasize, the case design within this chapter has been focused on the case data and its interactions. The intent is to show the continued design focus needed for these types of solutions.

        
      

    

    18.3.3  Document design

    The document design follows the approach of basic Document Management. Identify the types (classes) of documents that are used within the system. 

     

     

     

     

    
      
        	
          Note: Although the product notation is called a Document Type, the implementation is a Document Class. With that in mind, a Document Class is a collection of like documents, properties, and security. This approach should be used as a starting point around all documents.

        
      

    

    The following list includes the types identified from this use case:

    •Application. There is more than one type of application, and these are handled by the Document Type property.

    •Medical Notes. There is a range of sources and types, because they could come from an actual document, or from a comments section completed on a form that is saved as a document.

    •Test Results. These would be any document that is returned from an external source or X-Rays.

    •Insurance Forms. These are many different document types to cover all types of insurance information.

     

    
      
        	
          Note: At this stage in the design, we are assuming a single document class. However, given the nature of how IBM Case Manager works with some tasks, it might be necessary to break this document class into others, to enable the task operations to more effectively be used. 

          You can use proper ECM class design to accomplish this by creating sub-classes to the main class. The implementation of this requires some diligence, but you can create the sub-classes in the target object store (TOS) after deployment of the solution. When it comes time to port the solution to test or production, you must deploy the solution, deploy the subclasses, and then redeploy the solution again to get all of the proper dependencies in place

          An example of this would be Application. At the high-level design, it is already known that there are two types of Applications that instantiate different activities. This would be a requirement to do as described. The documents, properties, and security are the same, but the use of them is different.

        
      

    

    At this point in the design, the focus of the properties should only be what is needed to describe the document itself. Many of these properties are case-based, so the data can be shared. Other properties might not be case-based.

    18.3.4  UI design

    The UI design is brought out at this level to help point out areas of interaction that deal with data. Regarding the case data that has been referenced, some is stored within the system, and some is not. This difference must be articulated to ensure that data is kept in the correct manner.

    Case owner

    The first UI to look at is what is called the role case owner. This is the person that owns the case and all aspects of the interactions of the case. The person acting in this role would be known as a Knowledge Worker. Tying this to the use case, the Doctor would be the case owner. It is possible that a Nurse would also be able to access and see this view as many times as they complete actions for doctors.

    As the case owners, they need information available that enables them to understand, evaluate, and work with the case. The following list includes necessary information:

    •Patient information

    •Medical history

    •Prescriptions

    •Outstanding labs or tests

    •Calendar

    •Patient history

    •Task list

    Medical History must be a custom UI, because it references an external system. Calendaring is also a UI component that is referencing the hospital’s existing solution. The rest of these components are part of the default package solution.

     

    
      
        	
          Note: Calendering is an aspect that could be built into the FileNet P8 Platform. For the purposes of this use case, it is assumed to be an existing system.

        
      

    

    Caseworker

    This UI is designated for all others that need a case view of the patient. It is assumed that they are looking at a case to validate or look up some information. This interaction is not the same as them being specifically assigned work. The caseworker role would typically be performed by the medical staff or a Nurse. This view is one that is shown when the caseworker searches for a case.

     

    
      
        	
          Note: There is a feature in IBM Case Manager Builder when setting up the Case Type that enables different pages based on role for the Case Details Page. To enable this to work, this feature is where, in the product, you allow the changing of default pages by role.

        
      

    

    Other roles

    The other roles within the solution typically respond to the work that is needed.

    18.3.5  Task design

    The tasks are business activities that are needed to give the case motion and life. They help the case accomplish its goals and objectives. Although some might not be defined at this point in time, the ones that are known are created to enable them to be run. Within the scope of this use case, there are known activities. The order and frequency of them is not known.

    There are other tasks or activities whose needs are not known at this time. These are referred to as ad hoc tasks. The product supports this ability, and at this time there is no need to have any design effort for them.

     

    
      
        	
          Note: Tasks should be thought of in terms of verbs, whereas the case is a noun in basic design principals. Each activity should be doing something, from as simple an activity as an email notification to a complex predefined business process. A general rule to help ensure that tasks have the correct focus is to not have more than 3 - 5 steps for a task. 

          If it is longer than that, then it is possible that the task is more than a simple business activity, and there is much reuse. There are always exceptions, but this is a general guideline to help create an Adaptive solution, which is what the A in ACM stands for (Adaptive Case Management).

        
      

    

    Here is a list of some tasks that are needed for this use case:

    •Order tests. This enables the person to order tests on the patient.

    •Set up high risk. This is a process that sets up other tests and procedures for a high-risk pregnancy.

     

    
      
        	
          Note: The determination for this task comes from business rules. There are several factors that make this determination, and that logic needs to be outside of the task definition.

        
      

    

    •Pre-register at hospital. There is a process when the preregistration document is submitted that performs several activities. Within the scope of task design, this task is responsible for starting several other tasks.

    •Perform amniocentesis test. This is a specific test that is needed during high-risk pregnancies under additional circumstances.

    •Process initial application. This is the task that takes the incoming application and sets up the case with key patient data.

     

    
      
        	
          Note: This design should differentiate between Adaptive and ad hoc. Ad hoc is associated with a task that has not been defined.

        
      

    

    18.3.6  Other solution design aspects

    There are others parts of the solution that need to be addressed outside of the case itself.

    Incoming documents

    There are several documents that arrive by email, mail, or fax. As a result, the solution must address these to ensure that they are collected, categorized, and stored properly.

    For this part of the solution, there are three products used to help address these documents:

    •IBM Datacap

    •IBM Content Classification

    •IBM Content Collector for Email 

    Each product has a specific function, to handle the different ways that documents can arrive.

    IBM Datacap is used to process mailed-in documents that can be scanned and then saved into the system. Datacap must be able to recognize what type of document it is, and pull the appropriate index information to classify the document correctly.

    IBM Content Collector for Email is used to monitor specific mailboxes for incoming email, and store it within the system.

    IBM Content Classification has a more specific approach in its identification of documents. 

    There are three parts. This identification assists the other two products to process the documents more efficiently:

    •Identification of a Document Type to facilitate indexing

    •Identification of Record Category

    •Identification of specific documents that contain Health Insurance Portability and Accountability Act (HIPAA) information, and an additional property information to enable the security on these to be set appropriately

    IBM Datacap and IBM Content Collector for Email ensure that all documents that are created outside of the doctors office or hospitals are captured and placed within the system accordingly. The use of IBM Content Classification helps the process be faster and more accurate, and addresses a specific security requirement around certain document types.

    Figure 18-8 shows the design of the capture process, as identified by the requirements stated. There are the three users interactions, how they add documents into the system, and how those documents get into the end repository state.
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    Figure 18-8   Document ingestion process

    For each process, IBM Content Classification is used for the identification and classification of the documents. Although it is an inline process for Content Collector for Email and Datacap, it is different for documents that come in from Content Navigator or Case Manager. After they are added, the Content Platform Engine calls into Content Classification to obtain that key information, and store the documents correctly.

     

    
      
        	
          Note: Internally generated documents are added using the Case Manager and Content Navigator UIs. There is no need to have an additional process. It should be noted that the Content Classification Knowledge Base regarding the HIPPA requirements is still used against all new documents to ensure proper security.

        
      

    

    Payment documents

    There are certain types of documents that are generated internally that are not of a typical Microsoft Word or Portable Document Format (PDF) origin. These are the invoices that are generated to patients. These come from a system that generates Advanced Function Presentation (AFP) streams to print them all out. 

    These types of documents require a sub-system that can support and store them efficiently. This is IBM Content Manager OnDemand. Content Manager OnDemand can store the AFP streams in an extremely efficient manner, and with an efficient indexing mechanism. All of the invoice documents that are generated are stored within 	Content Manager OnDemand.

    There is a connector, FileNet Content Federated System, that enables a connection between Case System and Content Manager OnDemand. The connector places a document-like placeholder in the system to enable the association of those invoices to the appropriate patients.

    Although this integration is simple in design, the availability of these invoices to the staff of the hospital proves of great use when patients have questions, or concerns about explanations regarding a particular bill that they received.

    Policy management and records retention

    The hospital and doctor’s office have a policy management plan that outlines the control regarding many types of documents that exist within their organization. The focus of this use case is around pregnancy. There are some documents that are needed for the life of the patient, while others are destroyed after the case is closed. Others still are destroyed after the case closes plus a period of time.

    All of this is outlined in a File Plan in IBM Enterprise Records. This controls and enforces the records retention policy that is in place. The record categories that are defined are also used in the configuration of IBM Content Classification to create the Records Knowledge Base.

     

    
      
        	
          Note: During the requirements of the records management system, record categories are determined. This determination is often done by looking at specific documents. Because IBM Content Classification is used to make that determination during this process, it is good to collect or keep track of ownerships of each document type, because the documents are needed by Content Classification to create the Knowledge Base.

        
      

    

    A Records Manager person will have access to the configuration and processes that will be defined. This is an entirely different set of requirements and implementation. For the purposes of this use case, it is assumed that all appropriate configuration has been done and is implemented.

    Reporting and analytics

    Unlike traditional business process management (BPM) solutions, the reporting aspects of this solution are not the same. There is no need to monitor workloads and make sure everyone is doing their job. In this case, reporting is more focused on two parts.

     

    
      
        	
          Note: The traditional BPM-style reports might be needed in other case management solutions. In this use case, work has never been monitored or controlled in that manner, nor is there a want for it to be managed in that manner.

        
      

    

    The first part is to ensure that the infrastructure and processes are efficient. An example of this is to run a report on beds allocated, reserved, and free. This information, although report-based, is to be used during the admission process, to ensure that the patient is placed in the appropriate bed.

    The second part of reporting falls under the analytics aspects. This ties into the initial requirements that this solution provides to the doctors within this group. There needs to be certain demographic information about the patients captured, such as age, postal code, ethnicity, previous conditions, mediations, and illnesses incurred, that will enable the doctors to run several different views on a continual basis to see if there are any correlations within the demographic information. 

    This is a starting point. Other views could focus on the medication used, the time of the delivery, the type of delivery, and time of day, and if any of these factors have any bearing on recovery or simple satisfaction with the process as a whole.

    IBM Watson Content Analytics provides this information. Watson Content Analytics can use the case data itself, and all of the content within the case(s), to provide insights about all of the information available to the doctors. To accomplish the insights, it is assumed that at least two annotators are needed. 

    IBM has an International Classification of Diseases, ninth revision (IDC-9) Code annotator to be able to pull out these codes and tie them into medical terms. The second is an annotator that can obtain key medical terms that relate to pregnancy, and aspects that the doctors want to and must be aware of that will be used when talking to their patients.

    18.4  High-level design

    Figure 18-9 is the system context diagram to define the central system and the interactions that occur. As shown, the central system is composed of several ECM software products.
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    Figure 18-9   System context diagram

    The overall intent of the diagram is to place context on what the solution consists of, and what external interactions are needed. The rest of the design focuses on these two main aspects.

    18.4.1  Architecture design

    This section lays out the software components that are needed for the given solution. 

    Logical diagram

    The logical diagram shown in Figure 18-10 on page 582 outlines the service components of the solution. There are no custom components listed in this diagram because at this point in the design they are part of the IBM Case Manager and Content Navigator components.

     

    
      
        	
          Note: The front end (UI) components for this solution are built as a plug-in to Content Navigator. At the high level, this diagram does not get into that kind of detail. The aspects of custom development are covered in 18.3.4, “UI design” on page 574.

        
      

    

    Figure 18-10 shows a logical diagram of the solution software components.
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    Figure 18-10   Logical diagram

    The diagram covers the main components and their interactions with each other. All but one of the components are part of the product suite. The custom plug-in (denoted with the red line around the box) is where any custom UIs needed for the solution are created and used.

    The product boxes would typically be described in this section, but for the purposes of this book and chapter, it is skipped.

     

    
      
        	
          Note: For IBM Datacap, there are additional services named RuleRunner and Fingerprint. These services are not called out here because for this use case there is not enough demand to move them into separate components, but they are being used.

        
      

    

    Physical diagram

    Figure 18-11 on page 584 depicts the physical placement of servers and what components are associated to each. This is a highly available solution due to the overall hospital needs. The design in this chapter does not cover sizing requirements and get into server size, memory or processor usage. 

    The overall user population of the system is relatively small, less than 100. With that number of users, the hardware needed to support the solution is not large, but the solution is designed for future growth capabilities, and to ensure that the system is highly available and a disaster recovery capable

     

    
      
        	
          Note: Details about the highly available configuration and need is covered in 18.5, “High availability and disaster recovery considerations” on page 592. 

        
      

    

    The diagram only shows arrows of integration of server to other server. Other interactions were intentionally left out to prevent the diagram from being too complex. The other interactions, being product-based, are covered in other IBM Redbooks publications, articles, and documentation. The arrows shown here are to cover the specific communication between the load balancers.

    Figure 18-11 shows the server placement and components.
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    Figure 18-11   Physical view diagram

    In Figure 18-11, WCA stands for IBM Watson Content Analytics, ICC for eMail stands for IBM Content Collector for Email, and CMOD stands for IBM Content Manager OnDemand.

     

    
      
        	
          Note: The software components can also scale horizontally, meaning that within each server there can be additional instances running.

        
      

    

    For each set of servers, there is a load balancer on top of it. These load balancers can be hardware or software based. Servers and components that communicate to a set of servers go through the load balancer, and not directly to the underlying server. In a configuration as such, the use of Virtual Internet Protocol addresses (IPs) is used within the configuration.

    Also, the use of WebSphere Application Server Network Deployment, or other comparable products, is only needed within the scope of the Application Server (Content Navigator and Case) and the Content Platform Engine Server.

    To handle performance of the solution, the application and Content Platform Engine servers were broken out. This enables Content Navigator and Case UI to expand at a different rate than the Content Platform Engine server. Given the nature of web applications and how Content Platform Engine operates, it is highly likely that there will be more Content Navigator or Case instances than there are Content Platform Engine instances running.

    IBM Content Manager OnDemand is a software product that does not support an active/active server configuration. Therefore the section server is of lighter shade to signify that it is not online or active and is there in standby mode. Content Manager OnDemand does have the ability to scale many of its services, but the master server is only a single instance at this time.

     

    
      
        	
          Note: There are many performance aspects to IBM Content Manager OnDemand that are not being described within the scope of this chapter. For the purposes of this design it is assumed that the documents, volumes, and processing needs are small enough to suggest only a single-server layout. There are many factors that contribute to proper sizing of the Content Manager OnDemand services that are not covered within this scope.

        
      

    

    The IBM Content Manager OnDemand servers are also showing an active/passive server configuration.

    In this layout, the File Share servers must have a Network File System (NFS) head or something of the like as part of that storage subsystem. This is needed specifically for the content services, because more than one service will be accessing the files immediately. There are a few options around this that are covered here.

    The remaining details of the configuration are covered in 18.5, “High availability and disaster recovery considerations” on page 592, in which we describe the high availability and disaster recovery aspects of the solution.

    18.4.2  Component interaction design

    This design is to cover the interactions of the solution that involve external aspects or other customization that are needed to complete the solution.

    This section only focuses on the user interfaces. At this point in the design, it is understood that all interactions with external data sources are accessed by using typical interface mechanisms, such as web services or other APIs, that would be tied into a step within a task or a serving layer within the IBM FileNet Content Platform Engine to perform various data interactions.

    Case owner: Doctor view

    The default view of the case owner must show all of the information about the patient that enables the Doctor to make an accurate assessment. To achieve this, many of the standard widgets that exist within the product work as is. To display the Task information as needed, a customized widget is required.

    The widgets shown in the reddish tint are denoting custom UIs that must be developed for this solution.

     

    
      
        	
          Note: Widget development within this context is intended to be a focused effort to show and interact only what is needed. Content of what is needed would be obtained from the model data of IBM Content Navigator or case UI framework. This design approach should enable maximum reuse across multiple views. As shown within this design, custom widgets are used in more than one view.

        
      

    

    Figure 18-12 illustrates the case owner - Doctor view.
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    Figure 18-12   Case owner - doctor view

    The Task custom widget requires two pieces of information:

    •The list of tasks to start

    •The current status on all running tasks

    The list of tasks to start is already covered within the scope of existing widgets. Therefore this customization is a modification or extension of that existing widget. What will be added is where each current running task is in its execution path. This would enable the doctor to have some idea on the expected time of delivery.

    It should be noted that although this is similar to the Case Visualizer, this is just a point in time look at where tasks are, as opposed to a holistic view of the entire patient’s history. It is a way to see what has happened to the patient from the beginning.

    The calendar custom widget is to provide the ability to view, edit, and create appointments against their main scheduling system.

     

    
      
        	
          Note: If there is no existing scheduling system, a potential design would be to create objects (contentless document objects or custom objects) to represent the entries or appointments, and create a widget to display a calendar and show appointments. The objects would be what is created, edited, and displayed.

        
      

    

    The case notes or comments is a section for the person to add and see what has been written about the patient since the beginning. This will be a document that is saved into the repository as an actual document to enable FileNet Content Manager OnDemand to analyze it and gain additional information. It is a custom widget (versus case comments), because it is stored as a document and has some basic word editing capability to make writing notes easier. 

     

    
      
        	
          Note: This is an area where the use case might be expanded to make the notes contain more information, depending on completed tasks, the time the patient has been seen, and other factors that would be important about the patient to be captured.

        
      

    

    The analytics and documents view would be intended to be shrunk or full-sized when looking to view that particular information. This would work better as a tabbed view, but that would require customization. Therefore, this approach is being used. 

    If within the scope of the project there is the ability to create a better widget, that would be explored. For this design, they are separate widgets. The analytics widget is being shown here to provide some insight to the doctor for this patient based on other data within the system.

    Case owner: Nurse view

    The default view for this case owner needs to show all of the information that enables them to service the patient as best as possible.

    There is only one slight difference from the UI perspective, but it is important for the given role.

    Figure 18-13 illustrates the case owner - Nurse view.
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    Figure 18-13   Case Owner - Nurse view

    The only difference is the change to remove the analytics widget and replace it with another document view widget that is configured to point to the FileNet Content Manager OnDemand system. During detail design, it determines if additional customization is needed to enable that widget to read in the patient information, to populate the key search information, and only present documents related to the patient.

     

    
      
        	
          Note: A JavaScript adapter or modification of the existing widget are options that would need to be proved out to determine the best mechanism needed for the type of user interaction needed.

        
      

    

    Given that the role of a nurse is so close to the Doctor, especially around the data, the UIs are similar, and the differences are where their roles are different.

    Case Worker view

    The default view for all task steps unless noted. This view is a basic view to enable the person performing the task at that point in time to see the patient information.

    Figure 18-14 illustrates the Case Worker view.
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    Figure 18-14   Case Worker view

    The one custom widget, same as the other roles, enables this UI to cover all the needed information for the caseworker to do the needed tasks. For example, the request for labs or prescriptions, or other such items, only needs access to the patient data and the documents. Access to the document UI enables adding in the x-rays, lab results, and other documentation that would be generated.

     

    
      
        	
          Note: A more complete solution would have either Word Document or Forms as the result of the test results that would be completed from the other system and then saved into the repository. Filling out a prescription could be a Form Template that contains all of the patient information, and the doctor completes the medication, which is verified against a central system for accuracy, and then saved and sent to the pharmacy. This is a simple example of how to extend the existing solution providing control where needed and simplicity for the users, while at the same time adding accuracy of information and timeliness of delivery to the pharmacist.

        
      

    

    Caseworker: Hospital Administration view

    A specific scenario within the use case is hospital admissions. This is where interaction with the Hospital system is needed to set up aspects like assignment of a bed and other key parts to enable the patient to get the proper care. This requires another custom UI to interact with that system.

    Figure 18-15 illustrates the Caseworker - Hospital Administration view.
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    Figure 18-15   Caseworker - Hospital Admissions view

    The Hospital Information widget would be the portal into that system. This would be a custom UI to enable the admissions staff to process the patient without leaving this application, and to complete the task in one UI.

     

    
      
        	
          Note: There is a design assumption within this context that, as part of this task, some pre-work is done through a system step as part of the task. This UI would only show information that requires a person to make a decision about, or validate, certain pieces of that information.

        
      

    

    18.5  High availability and disaster recovery considerations

    When looking to design a system to handle requirements related to high availability (HA), many times the actual requirements are either non-existent, unclear, or too basic to provide any real value. There are the rare times when the requirements are appropriately detailed, because the client has a business continuity plan (BCP) already set up.

    Briefly, a BCP (or continuity of operations planning (COOP) in the government space) is a plan that states what must happen in the event of a disaster. There are many parts of this plan, and one of them is systems-related. If one of these exists, the requirements around the disaster recovery (DR) part of the solution are much clearer. If you are unfamiliar with this type of planning and you are working on a solution to that seemly needs this, read up on this topic.

    Many times HA and DR are combined. The typical reason is that, in some cases, solving for one solves for both. The fact is that they are completely different topics, and are solved for different reasons. HA involves continuous operations, like the FileNet Content Platform Engine. The Content Platform Engine cannot be unavailable for X amount of time. 

    DR is looking at redundancy at the entire system level. What if there is a fire, an explosion, or worse, a major disaster that causes a city to be evacuated. Having two instances running to handle HA requirements does nothing if the server room catches on fire.

    There are other factors that influence the design for HA and DR, including backup and restore of systems. Consider a case in which the backup of the system takes 2 hours but we can only have the system offline for 10 minutes. What if we have all of the backups stored to tape and the recovery times takes 12 hours, but our DR plan says we need the system up and running in 5 hours? 

    The backup process has to be accounted for in the design of these two topics. Performance can also come into play, but might typically benefit from an HA configuration. The part of performance to be aware of is in an HA situation, what are the performance goals while running in degraded mode? For example, if one of two servers is offline, the system is up but now running at half capacity.

    Overall, there are several factors to consider, and this list includes just a few factors that it is necessary to understand and address when designing a system that has these requirements:

    •System Availability Need. This is typically referenced by 3 9s, or 24x7.

    •DR scope. This includes room, floor, building, block, city, county, state, and geographic region.

    •DR time to recovery. How much time is allowed to bring the secondary system up? These are sometimes referenced in terms of recovery time objective (RTO) and recovery point objective (RPO).

    •In the event of a system outage, what are the changes to the key performance factors of the system?

    There is a difference between a service level agreement (SLA) of 3 9s (99.9% uptime) and 24x7 access. The 99.9% uptime has a set amount of time that the system can be down. There are typically penalties if the SLA is not kept. When referencing 24x7, the concept is that the website needs to be accessible at any point in time. There is no indication that certain services might not be available, or that it could be down for maintenance at any point.

    To help put this into perspective, 3 9s, or 99.9% uptime, means that the system can only be down for 8.76 hours per year. In this scenario, that is basically one outage a year. There is no backup window, and there is no maintenance window. At times these must be negotiated so that they are not part of the SLA uptime. 

    When approaching this level of an HA solution, the hardware costs and software costs can get extremely expensive. Everything must be duplicated, all the way to the network routers coming into the server room, power supplies, generators, racks, cabling, and storage. There can be no single point of failure.

     

    
      
        	
          Note: If our solution is to be 99.9% uptime and there are interactions with other systems, if they are not operating at least 99.9% of the time, then your solution cannot make the same claim. Within the entire scope, the lowest dominator determines the number of 9s. For example, if there is only one network switch coming into the server room, the solution cannot be stated as three 9s because it will be classified much lower then that.

        
      

    

    18.5.1  Patient care HA/DR considerations

    In the case of the hospital, there is a BCP that specifies a DR plan specific to the system implemented. Each system gets a rating that determines its HA and DR level. In this use case, there are three levels: 1 - Mission Critical, 2 - Business Essential, and 3 - Business Supportive.

     

    
      
        	
          Note: These are fictitiously levels made up for this book, any similarities to real ratings is coincidental.

        
      

    

    This solution is rated as a 2, because patient care and work can be performed without the system, but at a cost to efficiency and potential care. Therefore, the system must be available on a 24x7 basis at a rating of 1 9, 90%, which translates into 36.5 days of the year the solution can be down.

    In this scenario, there is a benefit that the overall infrastructure is already set up to support five 9s, therefore our solution will benefit from that, and it only needs to adhere internally to the 90% uptime SLA. To ensure that at a minimum each service must run on two different physical servers on separate racks, potentially within the same data center. This determination is made when looking at other factors.

    These other factors include the following considerations:

    •Localization of the DR site. This means how far away the DR site needs to be.

    •Network connectivity to DR sites.

    •Backup Strategy.

    The Doctor’s offices and hospital support a specific area within a county. Within this scope, having a DR site outside of that area would not be of any use to them. Taking the extreme of considering that the entire county is destroyed, then there would be no need for the offices or the hospital. This is also supported by the BCP that is developed, and the DR sites are all within a given county.

    As a result, it is determined that the main system would be within the hospital, and the secondary site within one of the offices. The determination of which one would be based on availability of infrastructure, costs and supportability.

     

    
      
        	
          Note: The hospital itself would typically have the types of DR sites already listed. Many times they have an alternative location entirely, which serves as their DR site for all of their systems. Also, the use of cloud systems would work to support the DR use case as well.

        
      

    

    When it is known where the DR site is located, the next step is to determine how it can be connected to the main system. Is the site close enough for network connectivity, or is it a cold site where backups would be stored? Given the proximity of the hospitals and offices, it is realized that a high-speed connection is available. The availability of the high-speed connection opens options for our overall system configuration.

    18.5.2  Solution HA/DR strategy

    When the requirements and considerations have been identified, the solution now needs to be mapped to them and laid out.

    Figure 18-16 is a diagram of the proposed physical server locations and connections. Each location gets its own server running all of the necessary hardware. This diagram only shows aspects specific to this software solution.

    [image: ]

    Figure 18-16   Physical DR layout

    It should be noted that the load balancers are not listed here. The two supporting servers in this diagram are the Database and the File Server. These servers and services are replicated instantaneously between both locations. This is possible due to the limited distance between sites, and the high-speed connection that exists.

    This DR site is an active standby, as opposed to a cold site or warm site. It is also called a hot site because the servers are running or are in use. A warm site is one where the servers are running but not connected to the external environment, and a cold site is one where the servers and applications are physically present, but nothing is running.

    Figure 18-17 is an implementation-specific diagram of the WebSphere Application Server services configuration in this instance. It shows the use of WebSphere Application Server Network Deployment. This diagram outlines the use clusters, cells, and nodes.

    [image: ]

    Figure 18-17   WebSphere Application Server services configuration

    The reason for showing this specific aspect of the solution is that this configuration is where WebSphere Application Server Network Deployment is needed to manage the Enterprise JavaBeans (EJB) transactions between IBM Content Navigator and the IBM Content Platform Engine service. To get to the HA requirements, this type of implementation is needed.

     

    
      
        	
          Note: There are other configuration options that support an HA configuration. This one is chosen due to the requirements listed.

        
      

    

    The next aspect of the configuration is the determination of the backup strategy to support the requirements as well. With required up time, there is no maintenance window to perform a typical offline backup. Within the solution, the products all support different type of offline and online backups. To effectively make the decision, each product’s service must be determined as a criticality factor to know the risk for the data within the service. 

    Here is the breakout by service and its own criticality:

    •Case Manager and Content - Critical service. This is because this is the main service for the entire solution.

    •Content Manager OnDemand - Mostly Critical. The source of the information is within the main hospital system. Although a significant inconvenience, the information is available in some form if this system is unavailable.

    •Capture Process (Datacap, Content Collector for Email and Content Classification) - Critical service. This brings in information about the given patient and identifies it. This service also has a limited exposure of data, because all information is processed through these products in moments, and no data is stored within them.

    •Content Manager OnDemand - Nice to have service. This functionality is not mission critical, despite having a great benefit. A patient can be seen and worked on without this service.

    The main service to backup is the case and content system. Though the content service supports online backups, the current release of this case does not. Therefore, this does not enable the uptime requirements. There are options to address such a constraint. 

    For this solution, the DR site is used to perform the backup. There is a risk in this approach, because the sync link between the two solutions would need to be stopped, the snapshot performed, and then the link re-established. During this time there is a business risk of lost data while the link is not in operation. 

    The time frame is small, because the ability and power of data snapshots can be performed in seconds. Therefore although there is a risk, it is limited. In this specific use case, this is an acceptable risk.

     

    
      
        	
          Note: This approach enables the availability of Case and Content to be continuously available.

        
      

    

    Content Manager OnDemand is a mostly critical service, because the product itself only supports an Active/Passive availability mode. This configuration counts against the overall availability of the solution. Because the data itself is in other systems, the limitation is acceptable.

    Content Manager OnDemand also supports an Active/Passive mode for the main server. Although the indexing and searching service can be extended, the main server is only an Active/Passive mode. The classification of this service as nice to have helps reduce the awareness of this service being down.

    Storage and databases

    This topic, although outside of the product set, is being addressed to mention an important aspect of each item.

    To support the replication and fault tolerances being described, this typically involves the higher end version of all of the database software that exists. DB2 and Oracle require their higher-end versions to support the dual instance running of servers. This is mentioned to ensure proper licensing and configuration for the databases.

    For storage, in this configuration, the FileNet Content Platform Engine requires a storage device that can support access from multiple sources at the same time. This means the physical storage device supports network-attached storage (NAS) of a software layer running on the Content Platform Engine server to simulate something similar to IBM General Parallel File System (IBM GPFS™). 

    Although GPFS is not an NAS solution, it enables multiple servers to treat a storage area network (SAN) device appropriately in this type of configuration.The FileNet Content Platform Engine service is the only one that requires this type of connection. The other services do not, so a typical SAN device works effectively for them.
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Additional material

    This book refers to additional material that can be downloaded from the Internet, as described in the following sections. 

    Locating the web material

    The web material associated with this book is available in softcopy on the Internet from the IBM Redbooks web server:

    ftp://www.redbooks.ibm.com/redbooks/SG248226

    Alternatively, you can go to the IBM Redbooks website:

    ibm.com/redbooks

    Select the Additional materials and open the directory that corresponds with the IBM Redbooks form number, SG24-8226.
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IBM Datacap signature script

    This appendix provides the code for signature VBScript used by IBM Datacap.

    Signature script used in IBM Datacap

    This script is written in VBScript, and it is used in Datacap for signature handling.

    Example B-1   The Signature Script used, written in VBScript

    [image: ]

    <?xml version='1.0' ?>

    <rrx namespace="FastComplaintsCustom" v="8.1.0.2"><i ref="rrunner"/><g>

      <![CDATA[

    '--------------------------------------------------------

    ' Custom Action

    ' Carries no warranties

    '-------------------------------------------------------- 

     

     

    ]]></g>

     

    <f name="SetBarcodeDimensionsToField" access="public" qi="Sample starter RRX Library">

      <p name="BarCodeNo"/>

      <p name="BarcodeTop"/>

      <p name="BarcodeBottom"/>

      <p name="BarcodeLeft"/>

      <p name="BarcodeRight"/>

      <ap>

       First argument determines the barcode to use. The remaining 4 indicate which coordinate from that barcode should be copied to the current field this action is attached to.<br/>

      </ap>

      <h>

             Identify the barcode you want to use by its number i.e. 0,1,2,3,4 etc. The associated variables for Top, Left, Height and Width of that barcode are captured and applied to field this action is attached to. The values that are copied is dependant upon which coordinate you select to use indiacted by a Y. Use an N to indicate bot to copy this coordinate<br/>

        <e>

            SetBarcodeDimensionsToField(1,N,Y,N,Y)<br/>

        </e>

      </h>

      <lvl>

          Field.

      </lvl>

      <ret>

        <br/>

        Returns <b>TRUE</b> if successful else returns <b>FALSE.</b>

      </ret>

      <see>

     

      </see>

      <g>

      <![CDATA[

     

        Dim oParent

     

        SetBarcodeDimensionsToField = False

     

        Writelog(BarcodeTop & BarcodeBottom & BarcodeLeft & BarcodeRight)

     

        Set oPage = currentObj.Parent

     

        sRect=Trim(CurrentObj.Variable("Position"))

     

        writelog("Current coordinates " & sRect)

     

        If len(sRect)=0 then sRect="0,0,0,0"

        arRect=Split(sRect,",")

     

        

        writelog("Looking for barcode " & BarCodeNo)

        

        if BarCodeTop = "Y" then

    	writelog("Looking at var " & "Top" & BarCodeNo)

    	vTop = cint(oPage.Variable("Top" & BarCodeNo))

    	writelog("TOP : " & vTop)

    	arRect(1) = vTop

        end if

     

         if BarCodeBottom = "Y" then

    	writelog("Looking at var " & "Height" & BarCodeNo)

    	vHeight = oPage.Variable("Height" & BarCodeNo)

    	writelog("Height : " & vHeight)

    	vTop = oPage.Variable("Top" & BarCodeNo)

    	vBottom = cint(vTop) + cint(vHeight)

    	writelog("Bottom : " & vBottom)

    	arRect(3) = vBottom

        end if

     

        if BarCodeLeft = "Y" then

    	writelog("Looking at var " & "Left" & BarCodeNo)

    	vLeft = cint(oPage.Variable("Left" & BarCodeNo))

    	writelog("Left: " & vLeft)

    	arRect(0) = vLeft

        end if

     

        if BarCodeRight = "Y" then

    	writelog("Looking at var " & "Width" & BarCodeNo)

    	vWidth = oPage.Variable("Width" & BarCodeNo)

    	writelog("Width : " & vWidth)

    	vLeft = oPage.Variable("Left" & BarCodeNo)

    	vRight = cint(vLeft) + cint(vWidth)

    	writelog("Right : " & vRight)

    	arRect(2) = vRight

        end if

     

        writelog("New coordinates are : " & arRect(0) & "," & arRect(1) & "," & arRect(2) & "," & arRect(3))

        CurrentObj.Variable("Position") = arRect(0) & "," & arRect(1) & "," & arRect(2) & "," & arRect(3)

     

        SetBarcodeDimensionsToField = True 

     

     

     

     

      ]]>

      </g>

    </f>

     

     

    <f name="CopyBarcodeCoordinateToRight" access="public" qi="Sample starter RRX Library">

      <p name="BarCodeNo"/>

      <p name="BarcodeTop"/>

      <p name="BarcodeBottom"/>

      <p name="BarcodeLeft"/>

      <p name="BarcodeRight"/>

      <ap>

       Document your parameters here<br/>

      </ap>

      <h>

             This action copies the value of the selected barcode coordinate as indicated by a 'Y' to the lower right coordinate of the current field. Please only use one Y in the arguments or other values might affect the intended result<br/>

        <e>

            CopyBarcodeCoordinateToRight(1,N,N,Y,N)<br/>

        </e>

      </h>

      <lvl>

          Field

      </lvl>

      <ret>

        Returns <b>TRUE</b> if successful else returns <b>FALSE.</b>

      </ret>

      <see>

     

      </see>

      <g>

      <![CDATA[

     

        Dim oParent

     

        CopyBarcodeCoordinateToRight = False

     

        Writelog(BarcodeTop & BarcodeBottom & BarcodeLeft & BarcodeRight)

     

        Set oPage = currentObj.Parent

     

        sRect=Trim(CurrentObj.Variable("Position"))

     

        writelog("Current coordinates " & sRect)

     

        If len(sRect)=0 then sRect="0,0,0,0"

        arRect=Split(sRect,",")

     

        

        writelog("Looking for barcode " & BarCodeNo)

        

        if BarCodeTop = "Y" then

    	writelog("Looking at var " & "Top" & BarCodeNo)

    	vTop = cint(oPage.Variable("Top" & BarCodeNo))

    	writelog("TOP : " & vTop)

    	arRect(2) = vTop

        end if

     

         if BarCodeBottom = "Y" then

    	writelog("Looking at var " & "Height" & BarCodeNo)

    	vHeight = oPage.Variable("Height" & BarCodeNo)

    	writelog("Height : " & vHeight)

    	vTop = oPage.Variable("Top" & BarCodeNo)

    	vBottom = cint(vTop) + cint(vHeight)

    	writelog("Bottom : " & vBottom)

    	arRect(2) = vBottom

        end if

     

        if BarCodeLeft = "Y" then

    	writelog("Looking at var " & "Left" & BarCodeNo)

    	vLeft = cint(oPage.Variable("Left" & BarCodeNo))

    	writelog("Left: " & vLeft)

    	arRect(2) = vLeft

        end if

     

        if BarCodeRight = "Y" then

    	writelog("Looking at var " & "Width" & BarCodeNo)

    	vWidth = oPage.Variable("Width" & BarCodeNo)

    	writelog("Width : " & vWidth)

    	vLeft = oPage.Variable("Left" & BarCodeNo)

    	vRight = cint(vLeft) + cint(vWidth)

    	writelog("Right : " & vRight)

    	arRect(2) = vRight

        end if

     

        writelog("New coordinates are : " & arRect(0) & "," & arRect(1) & "," & arRect(2) & "," & arRect(3))

        CurrentObj.Variable("Position") = arRect(0) & "," & arRect(1) & "," & arRect(2) & "," & arRect(3)

     

        CopyBarcodeCoordinateToRight = True 

     

     

     

     

      ]]>

      </g>

    </f>

     

     

     

    <f name="SignatureYesZone" access="public" qi="Sample starter RRX Library">

     

      <ap>

       Document your parameters here<br/>

      </ap>

      <h>

             Inherits the zonal coordinate of the parent field and creates a small zone within the parent big enough to interogate most of the signature area.<br/>

        <e>

            SignatureYesZone()<br/>

        </e>

      </h>

      <lvl>

    	Field

      </lvl>

      <ret>

        Returns <b>TRUE</b> if successful else returns <b>FALSE.</b>

      </ret>

      <see>

        

      </see>

      <g>

      <![CDATA[

     

        Dim oParent

     

        SignatureYesZone = False

     

        Set oParent = currentObj.Parent

     

        sRect=Trim(oParent.Variable("Position"))

     

        If len(sRect)=0 then 

    	Exit Function

        end if

     

        arRect=Split(sRect,",")

     

    	' determine a 3 rd

     

    	if (cint(arRect(3)) - cint(arRect(1))) > 15 then

     

    		diff = cint(arRect(3)) - cint(arRect(1))

    		vTop = diff / 3

    		arRect(0) = cint(arRect(0)) + 1

    		arRect(1) = cint(arRect(1)) + 12

    		arRect(2) = cint(arRect(2)) - 1

    		arRect(3) = cint(arRect(3)) - 12

     

    	end if

     

        writelog("New coordinates for YES are : " & arRect(0) & "," & arRect(1) & "," & arRect(2) & "," & arRect(3))

        CurrentObj.Variable("Position") = arRect(0) & "," & arRect(1) & "," & arRect(2) & "," & arRect(3)

     

        SignatureYesZone = True 

     

      ]]>

      </g>

    </f>

     

    <f name="SignatureNoZone" access="public" qi="Sample starter RRX Library">

     

      <ap>

       Document your parameters here<br/>

      </ap>

      <h>

             Define the no zone of the siganture. This is a small zone in the upper right hand side of the parent zone<br/>

        <e>

            SignatureNoZone()<br/>

        </e>

      </h>

      <lvl>

          Field

      </lvl>

      <ret>

        Returns <b>TRUE</b> if successful else returns <b>FALSE.</b>

      </ret>

      <see>

        

      </see>

      <g>

      <![CDATA[

     

        Dim oParent

     

        SignatureNoZone = False

     

        Set oParent = currentObj.Parent

     

        sRect=Trim(oParent.Variable("Position"))

     

        If len(sRect)=0 then 

    	Exit Function

        end if

     

        arRect=Split(sRect,",")

     

    	' determine a 3 rd

     

    	if (cint(arRect(3)) - cint(arRect(1))) > 15 then

     

    	arRect(0) = cint(arRect(2)) - 10

    	arRect(1) = cint(arRect(1)) + 1

    	arRect(2) = cint(arRect(2)) - 1

    	arRect(3) = cint(arRect(1)) + 10

     

    	end if

     

        writelog("New coordinates for NO are : " & arRect(0) & "," & arRect(1) & "," & arRect(2) & "," & arRect(3))

        CurrentObj.Variable("Position") = arRect(0) & "," & arRect(1) & "," & arRect(2) & "," & arRect(3)

     

        SignatureNoZone = True 

     

     

      ]]>

      </g>

    </f>

     

    </rrx>

    [image: ]

     

  
    Related publications

    The publications listed in this section are considered particularly suitable for providing more information about the topics covered in this book.

    IBM Redbooks

    The following IBM Redbooks publications provide additional information about the topics in this document. Note that some publications referenced in this list might be available in softcopy only:

    •IBM Case Manager and IBM FileNet P8 product Redbooks publications:

     –	Advanced Case Management with IBM Case Manager, SG24-7929

     –	IBM FileNet Content Manager Implementation Best Practices and Recommendations, SG24-7547

     –	IBM FileNet P8 Platform and Architecture, SG24-7667

     –	Introducing IBM FileNet Business Process Manager, SG24-7509
(IBM FileNet Business Process Manager is currently known as IBM Case Foundation)

     –	Developing Applications with IBM FileNet P8 APIs, SG24-7743

    •IBM Datacap Redbooks publication:

     –	Implementing Imaging Solutions with IBM Production Imaging Edition and IBM Datacap Taskmaster Capture, SG24-7969

    •IBM Content Manager OnDemand Redbooks publications:

     –	IBM Content Manager OnDemand Guide, SG24-6915

     –	Implementing Content Manager OnDemand Solutions with Case Studies, SG24-7511

     –	IBM Content Manager OnDemand Web Enablement Kit Java APIs: The Basics and Beyond, SG24-7646

     –	Content Manager OnDemand Backup, Recovery, and High Availability, SG24-6444

    •IBM Enterprise Records Redbooks publication and technote:

     –	Understanding IBM FileNet Records Manager, SG24-7623

     –	Quick Reference: Records Management 101, TIPS0595

    •IBM Watson Content Analytics Redbooks publication and solution guide:

     –	IBM Watson Content Analytics: Discovering Actionable Insight from Your Content, SG24-7877

     –	Building Enterprise Search Solutions using IBM Content Analytics with Enterprise Search, tips1147
(IBM Content Analytics is currently known as IBM Watson Content Analytics)

    •IBM Content Classification Redbooks and Redpaper publications:

     –	IBM Classification Module: Make It Work for You, SG24-7707

     –	IBM Content Collector Integration with IBM Classification Module, REDP-4705

    •Other related Redbooks publications:

     –	Customizing and Extending IBM Content Navigator, SG24-8055

     –	Federated Content Management: Accessing Content from Disparate Repositories with IBM Content Federation Services and IBM Content Integrator, SG24-7742

    You can search for, view, download, or order these documents and other Redbooks, Redpapers, Web Docs, drafts, and additional materials, on the following website: 

    ibm.com/redbooks

    Online resources

    These websites are also relevant as further information sources:

    •IBM Knowledge Center for ECM products:

    http://www.ibm.com/support/knowledgecenter

    From the table of contents on the left navigation pane, expand Enterprise Content Management, and see documentations under the links for:

     –	FileNet P8 Platform

     –	Case Manager

     –	Case Foundation

     –	Content Manager OnDemand for i, Multiplatform, and z/OS

     –	Enterprise Records

     –	Content Classification

     –	Content Collector

     –	Content Navigator

    •IBM Knowledge Center for IBM Watson Content Analytics:

    http://www.ibm.com/support/knowledgecenter

    From the table of contents on the left navigation pane, expand Watson Group, and see documentation under the link for IBM Watson Content Analytics 

    Help from IBM

    IBM Support and downloads

    ibm.com/support

    IBM Global Services

    ibm.com/services
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    Building IBM Enterprise Content Management Solutions From End to End

    Content Management

    Solutions From End to End

    Integrating IBM Case Manager and IBM Datacap

Integrating IBM Content Manager OnDemand and IBM Enterprise Records

Using IBM Watson Content Analytics and IBM Content Classification

    IBM Enterprise Content Management (ECM) solutions provide efficient and effective ways to capture content, manage the content and business processes, discover insights from the content, and derive actions to improve business processes, products, and services.

    This IBM Redbooks publication introduces and highlights some of the IBM ECM products that can be implemented and integrated together to create end-to-end ECM solutions, including IBM Case Manager, IBM Datacap, IBM Content Manager OnDemand, IBM Enterprise Records, IBM Watson Content Analytics, and IBM Content Classification.

    For each product involved in the ECM solution, this IBM Redbooks publication briefly describes what it is, its functions and capabilities, and provides step-by-step procedures for installing, configuring, and implementing it. In addition, we provide procedures for integrating these products together to create an end-to-end ECM solution to achieve the overall solution objectives.

    Not all of the products are required to be integrated into an ECM solution. Depending on your business requirements, you can choose a subset of these products to be built into your ECM solutions.

    This book serves as a hands-on learning guide for information technology (IT) specialists who plan to build ECM solutions from end-to-end, for a proof of concept (PoC) environment, or for a proof of technology environment. For implementing a production-strength ECM solution, also refer to IBM Knowledge Center, IBM Redbooks publications, and IBM Software Services.
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